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यूनिट 1. निब्र ेऑफिस राइटर का उपयोग कर निनिटि िॉक्यमूेंटेशि (एिवाांस) 

पररचय 

 

आपिे िौवीं कक्षा में निबे्र ऑफिस राइटर का उपयोग करके मूि शब्द प्रसांस्करण की अवधारणा सीखी ह।ै एक विड 

प्रोसेससांग के मूि कायड िैसे िॉक  ्यूमेंट बिािा, सांपादि करिा, िॉमेटटांग को कवर फकया िाता ह।ै आपिे िॉक  ्यूमेंट 

को सेव करिा और सप्रांट करिा भी सीख निया ह।ै आि के प्रोिेशिि सेट अप में, आपको एक िॉक  ्यूमेंट बिािे के 

निए और अनधक नवशेषताओं को िाििा होगा िो एक प्रोिेशिि स  ्टाइि में प्रस्तुत फकया िा सकता ह ैऔर सभी 

के द्वारा निसे पसांद फकया िाता ह।ै निब्र ेऑफिस राइटर में कई प्रकार की सुनवधाए ँऔर कमाांि प्रदाि की िाती हैं 

िो आपको एक सुसांगत िॉमेट के साथ एक आकषडक और प्रस्तुत करिे योग्य िॉक  ्यूमेंट बिािे में सक्षम बिाता ह।ै 

इसके अिावा, इस तरह के िॉक  ्यूमेंट को एक और सभी को पढ़िा, समझिा और सांपाफदत करिा आसाि ह।ै 

 

इस इकाई में, आप स  ्टाइि का उपयोग करके एक िॉक  ्यूमेंट िॉमेट करिा सीखेंगे। आप िॉक  ्यूमेंट का उपयोग 

करके स  ्टाइि बिािे में सक्षम होंग े- स  ्टाइि िॉमेट, िई स  ्टाइि बिाएां, स  ्टाइि को एप  ्िाय करें, स  ्टाइि को 

एप  ्िाय करें और इस िॉक  ्यूमेंट को िॉमेट करिे के निए अन्य िॉक  ्यूमेंट के टेम्पिेट का उपयोग करें। 

 

हमेशा केवि टेक  ्स  ्ट िॉक  ्यूमेंट की तुििा में नचत्रों वाि ेिॉक  ्यूमेंट को समझिा आसाि होता ह।ै नचत्रों में नविुअि 

अपीि होती ह,ै क्योंफक हमारा मनस्तष्क फकसी भी अन्य िािकारी की तुििा में रांगों के निए िल्दी प्रनतफिया 

करता ह।ै निनिटि िॉक  ्यूमेंट में, एक नचत्र एक ड्राइांग, चाटड, िोटो, िोगो, ग्राि या एकि वीनियो फे्रम हो सकता 

ह।ै  

 

निब्र ेऑफिस राइटर इमेि के साथ काम करिे के निए नवनभन्न उपकरण प्रदाि करता ह।ै दसूरे अध्याय में आप 

नचत्रों के साथ एक िॉक  ्यूमेंट बिािा सीखेंगे। आप इसे और अनधक आकषडक बिाि े के निए िॉक  ्यूमेंट में नचत्र 

सनम्मनित insert और सांशोनधत modify कर सकते हैं।  

 

तीसरे अध्याय में निबे्र ऑफिस राइटर की कुछ उन्नत नवशेषताएां शानमि की गई हैं नििका उपयोग प्रोिेशिि 

िॉक  ्यूमेंट बिािे के निए फकया िाता ह।ै आप "टेबि ऑफ़ कॉन्टेंट्स" िीचर का उपयोग कर पाएांगे, िो नवनभन्न 

प्रकार के हसेिांग स्टाइि पर आधाररत ह।ै आप टेम््िेट का उपयोग करके प्रोिेशिि िॉक  ्यूमेंट बिा पाएांगे। टै्रक 

पररवतडि एक महत्वपूणड नवशेषता ह ैनिसका उपयोग प्रत्येक प्रयोक  ्ता द्वारा फकए िा रह ेसांपादि का टै्रक रखिे के 

निए भी फकया िाता ह।ै 
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इस पाठ्यपुस्तक में, हमिे प्रफिया को प्रदर्शडत करिे के निए उबांटू नििक्स के तहत निब्र ेऑफिस सांस्करण 6.4 के 

स्िीिशॉट का उपयोग फकया ह।ै सवांिोज़ ्िेटफ़ॉमड के तहत निब्र ेऑफिस के अन्य सांस्करणों में स्िीिशॉट की 

प्रस्तुनत अिग फदखाई द ेसकती ह।ै िेफकि यह ध्याि फदया िा सकता ह ैफक फकसी भी ्िेटफ़ॉमड के तहत फकसी भी 

सांस्करण में कायडक्षमता functionality, नवशेषताए ँfeatures और कमाांि समाि हैं। 

अध्याय 1. Styles का पररचय  

पररचय 

कक्षा IX में, आपिे राइटर में िॉक  ्यूमेंट बिािा, िॉमेट करिा और सांपाफदत edit करिा सीख निया ह।ै आि की 

दनुिया में, प्रोिेशिि स  ्टाइि में बिाया और प्रस्तुत फकया गया एक िॉक्यूमेंट सभी द्वारा सराहिा की िाती ह।ै 

राइटर में एक आकषडक निनिटि िॉक  ्यूमेंट बिािे के दो तरीके हैं। एक तरीका मैन्युअि रूप से एक िॉक  ्यूमेंट को 

िॉमेट करिा ह ैऔर दसूरा तरीका स  ्टाइि को एप  ्िाय करिा ह।ै 

 

आपिे कक्षा IX में मैन्युअि िॉमेटटांग सीखी, िहाँ आपिे िॉक  ्यूमेंट के एक भाग को चुिा िैसे फक पेि, पैराग्राि या 

शब्दों को िॉमेट फकया िािा ह ैऔर फिर फ़ॉमेटटांग टूि बार का उपयोग करके िॉमटे इिेक  ्ट को िाग ूफकया ह।ै 

िॉक  ्यूमेंट में अिग-अिग भाग (भागों) को िॉमेट करिे के निए, एक ही स  ्टाइि के साथ, िॉक  ्यूमेंट के सभी भाग 

के निए चरणों को दोहराया गया। इसनिए, यफद िॉमेट के फकसी भी पहिू में पररवतडि वाांनछत ह,ै तो िॉक  ्यूमेंट के 

निए पूरी प्रफिया को दोहराया गया था। मैन्युअि िॉमेट करिा िोकनप्रय ह,ै क्योंफक इसका उपयोग करिा आसाि 

ह ैऔर इसके निए कम ज्ञाि की आवश्यकता होती ह।ै ससुांगत िॉमेट के साथ एक बडी ररपोटड बिािा मुनश्कि हो 

िाता ह ैिब मैिुअि िॉमेटटांग का उपयोग फकया िाता ह।ै िॉमेट में असांगनत से बचिे के निए और फकसी िॉक  ्यूमेंट 

को िॉमेट करि ेमें समय और प्रयास को कम करिे के निए, हम राइटर में स्टाइि का उपयोग करते हैं। इस अध्याय 

में आप सीखेंगे फक फकस तरह से फकसी िॉक्यूमेंट को स्टाइि फकया िाए - स्टाइि िॉमेट्स, िई स्टाइि बिाएां, 

स्टाइल्स को ए्िाई करें, स्टाइल्स को ए्िाई करें और करेंट िॉक्यूमेंट को िॉमेट करिे के निए दसूरे िॉक्यूमेंट के 

टेम््िेट का भी इस्तेमाि करें।  

 

1.2 स  ्टाइि का पररचय 

एक स  ्टाइि और कुछ िहीं बनल्क सभी िॉमेट सांबांधी सूचिाओं का एक सांग्रह ह,ै निसे आप सेव करिा चाहते हैं 

और फिर िॉक  ्यूमेंट पर एप  ्िाइ करते हैं। उदाहरण के निए, फ़ॉन्ट के निम्ननिनखत नववरण को शीषडक title style 

द्वारा Style के रूप में store फकया िा सकता ह।ै 

साइि- 12 

िाम - बुकमैि ओल्ि स्टाइि 

वेट - बोल्ि 

एिाइिमेंट – िेफ्ट  



  

3 

 

अब हम िॉक  ्यूमेंट के सभी शीषडकों titles के निए title style का उपयोग कर सकते हैं और इसे ही िगातार 

उपयोग कर सकत ेहैं। िॉक  ्यूमेंट में शीषडक की स  ्टाइि को बदििे के निए, आपको बस टाइटि स  ्टाइि को अपिटे 

करिे और िॉक  ्यूमेंट में िाग ूकरिे की आवश्यकता ह।ै इसी तरह, पूरे िॉक  ्यूमेंट के िॉमेट को बदििे के निए, बस 

उस पर िाग ूस  ्टाइि को बदिें। स  ्टाइि का उपयोग करिे से आप िॉक  ्यूमेंट की अपीयरेंस से अपिा ध्याि 

िॉक  ्यूमेंट की सामग्री पर िे िा सकते हैं। इस अध्याय में आप सीखेंगे फक निब्र ेऑफिस राइटर में स  ्टाइि को कैस े

बिाया और िाग ूफकया िाए। यहाां हम निब्र ेऑफिस सांस्करण 6.4 का उपयोग कर रह ेहैं 
 

1.3 Style की श्रनेणयाां categories 

राइटर छह स  ्टाइि categories प्रदाि की गई ह,ै िो इस प्रकार हैं : 

पिे - राइटर के सभी िॉक्यमूेंट पृष्ठों पर आधाररत होते हैं, इसनिए उन्हें िॉमेट करिे के निए, पेि स्टाइि का 

उपयोग फकया िाता ह।ै यह पृष्ठ आकार, इसके मार्िडि, header and footer, फु़टिोट, बॉिडर और बैक ग्राउांि 

िैसे मूि पृष्ठ िेआउट को पररभानषत करता ह।ै 

 

एक िॉक  ्यूमेंट में एक या कई पृष्ठ स्टाइि हो सकती हैं। यफद पृष्ठ स  ्टाइि निर्दडष्ट िहीं ह,ै तो राइटर अपिी 

अांतर्िडनहत निफ़ॉल्ट पृष्ठ स  ्टाइि का उपयोग करता ह।ै 

 

परैाग्राि - पृष्ठ िॉमेट पर निणडय िेिे के बाद, िॉक  ्यूमेंट में अगिा काम इसमें दी गई सामग्री content पर फकया 

िाता ह,ै िो पैराग्राि में व  ्यवनस्थत की िाती ह।ै िब आप Enter कुां िी दबाते हैं तो एक पैराग्राि शुरू होता ह ै

और समाप्त होता ह।ै पैराग्राि िॉमेटटांग में टैब स्टॉप, टेक  ्स  ्ट एिाइिमेंट, िाइि स  ्पेस और सीमाए ँशानमि हैं। 

आम तौर पर इसमें कैरेक्टर स्टाइसिांग नवशेषताए ँभी शानमि होती हैं। 

  

कैरेक  ्टर - इस स्टाइि का उपयोग अक्षरों के ब्िॉक पर काम करिे के निए फकया िाता ह ैअथाडत । पूरे पैराग्राि के 

बिाय पैराग्राि में शब्द। कैरेक  ्टर स  ्टाइि का उपयोग करके, आप दसूरे भाग को प्रभानवत फकए नबिा पैराग्राि के 

एक नहस्से की उपनस्थनत को बदि सकते हैं। कैरेक  ्टर स्टाइि टेक  ्स  ्ट का रांग, टेक  ्स  ्ट का आकार बदिि,े टेक  ्स  ्ट को 

हाइिाइट करि,े उस पर ज़ोर दिेे की सुनवधा दतेी हैं। 

 

फे़्रम - फे़्रम का उपयोग करके, एक िॉक  ्यूमेंट को अिुभागों में व्यवनस्थत फकया िा सकता ह,ै ताफक पृष्ठ के प्रत्येक 

अिुभाग में अिग-अिग उपनस्थनत हो। फे्रम कां टेिर की तरह होते हैं िो टेक  ्स  ्ट, ग्राफिक्स और निस  ्ट वाि ेहो 

सकते हैं। इसनिए, फे़्रम स्टाइि िाग ूकरिे से इसके आकार, नस्थनत, सीमा को निर्दडष्ट करके एक फे़्रम को िॉमेट 

करिे की सुनवधा नमिती ह ैफक नचत्र के चारों ओर टेक  ्स  ्ट कैसे रखा िाता ह।ै 
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निस  ्ट - फकसी िॉक  ्यूमेंट में स  ्टाइि सूनचयों के निए, राइटर एक अिग शे्रणी प्रदाि करता ह।ै इसका उपयोग 

नवनभन्न प्रकार की सांख्याओं या गोनियों को निर्दडष्ट करके, सांख्यात्मक िॉमेट निर्दडष्ट करके सूनचयों को स्टाइि 

करिे के निए फकया िा सकता ह।ै 

 

टेबि - टेबि का उपयोग करके, बडी मात्रा में िािकारी को व्यवनस्थत और प्रभावी ढांग से प्रस्तुत फकया िा सकता 

ह।ै टेबि स्टाइि शे्रणी में अिग-अिग टेक  ्स  ्ट या बॉिडर रांग (एस) का उपयोग करके, टेबि को िोडकर, टेबि के 

अांदर टेक  ्स  ्ट एिाइि करि,े नवनभन्न पैटिड या टेक  ्स  ्ट रांग होिे से टेबि को िॉमेट करिे की सुनवधा नमिती ह।ै 

 

1.4 स्टाइि और िॉमटेटांग 

राइटर एक िॉक  ्यूमेंट को स  ्टाइि / फ़ॉमेटटांग करिे के निए कई नवकल्प और उपकरण प्रदाि करता ह।ै िौवीं कक्षा 

में सीख ेगए सभी फ़ॉमेटटांग नवकल्प, निन्हें फ़ॉमेटटांग टूिबार का उपयोग करके िाग ू फकया िा सकता ह,ै इसे 

स्टाइि मेिू का उपयोग करके भी िाग ू फकया िा सकता ह।ै इस अिुभाग में, हम सीखेंगे फक स्टाइि िीचर का 

उपयोग करके फकसी िॉक  ्यूमेंट को कैसे िॉमेट फकया िाए। 

 

राइटर में कई predefined स्टाइि हैं, निन्हें निम्ननिनखत नवनधयों का उपयोग करके पहचँा िा सकता ह ै: 

(i) मेिू बार से स्टाइि नवकल्प का 

उपयोग करिा। 

 

नचत्र 1.1 मेन्यू बार से स्टाइि और 

टूिबार में ड्रॉप िाउि निस  ्ट  

(ii) स्टाइि ड्रॉप िाउि निस  ्ट बॉक्स का उपयोग करिा, िैसा टूि बार से नचत्र 1.1 में फदखाया गया ह।ै फकसी भी 

समय, टेक  ्स  ्ट बॉक्स में वतडमाि पैराग्राि स  ्टाइि प्रदर्शडत की िाती ह।ै 

यफद टूिबार फदखाई िहीं दतेा ह,ै तो View > Toolbars पर नक्िक करें और enable करें 

िॉमेट / "िॉमटे (स्टाइि)"। नचत्र में फदखाया िाता ह ैफक मौिूदा स  ्टाइि को अपिटे करिे या िई स  ्टाइि बिाि े

के निए नवकल्प हैं।   

 

 (iii) साइिबार मेिू का उपयोग करिा। स्टाइि आइकि पर नक्िक करिे वाि ेसाइिबार पर, स्टाइि उप-मेिू 

प्रदर्शडत करता ह ैिैसा फक नचत्र 1.2 में फदखाया गया ह।ै 
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नचत्र 1.2 स्टाइि साइिबार से सब मेिू  

आइए साइिबार मेिू का उपयोग करके स  ्टाइि को िाग ूकरिा सीखें। नचत्र 1.3 स्टाइल्स साइिबार के उप मेिू के 

शीषड पर नवनभन्न नवकल्प फदखाए गए हैं।  

 

 
नचत्र 1.3 बटि साइिबार सब मेिू के टॉप पर 

पहिे छह आइकि स  ्टाइि की शे्रणी का नसिेक्शि करिे की सुनवधा दतेे हैं, िैसे फक पैरा स  ्टाइि, कैरेक  ्टर 

स  ्टाइि, फे्रम स  ्टाइि, पृष्ठ स  ्टाइि, निस  ्ट स  ्टाइि और टेबि स  ्टाइि पर काम करिे के निए। उस शे्रणी में 

मौिूदा स  ्टाइि की निस  ्ट प्रदर्शडत करिे के निए इिमें से फकसी एक बटि पर नक्िक करें। शो प्रीव्यू नवकल्प को 

चुििे वािी सवांिो के िीचे से निस  ्ट में िाम के साथ इसकी स  ्टाइि प्रदर्शडत होती ह।ै 

पहिे बटि पर नक्िक करि,े यािी पैराग्राि स्टाइि स ेनवनभन्न पैराग्राि स  ्टाइि को फदखाया िाता ह ैिैसा फक 

नचत्र 1.4 में फदखाया गया ह ैिब Show previews का नसिेक्शि िहीं फकया िाता ह ैऔर नचत्र 1.5 का 

नसिेक्शि करें िब Show previews का नसिेक  ्शि फकया िाता ह।ै  

                                         
नचत्र 1.4 Show previews के                            नचत्र 1.5 Show previews के साथ पैराग्राि स्टाइि  
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नबिा पैराग्राि स्टाइि  

इस मेिू के निचिे भाग में, ऊपर प्रदर्शडत की िािे वािी स  ्टाइि निस  ्ट के निए फफ़ल्टर का नसिेक्शि करिे के 

निए ड्रॉप िाउि निस  ्ट ह।ै निफ़ॉल्ट रूप से यह फफ़ल्टर Hierarchical में सेट ह ैिैसा फक नचत्र 1.5 में फदखाया 

गया ह।ै 

असाइिमेंट : प्रत्येक स  ्टाइि का नसिेक्शि करें - कैरेक  ्टर स  ्टाइि, फे़्रम स  ्टाइि, पृष्ठ स  ्टाइि, निस  ्ट स  ्टाइि 

और टेबि स  ्टाइि और प्रत्येक शे्रणी के अांतगडत स  ्टाइि को सूचीबद्ध करें। 

 

आइए हम इि स  ्टाइि का उपयोग फकसी िॉक  ्यूमेंट में करें। पैराग्राि, कैरेक  ्टर, फे्रम, पृष्ठ, निस  ्ट, टेबि िैसी 

फकसी भी स  ्टाइि को िाग ूकरिे के निए, निम्ननिनखत चरणों का पािि करें। 

चरण 1. िॉमेट फकए िािे वािे टेक्स्ट का नसिेक्शि करें। चयनित टेक  ्स  ्ट कैरेक  ्टर, शब्दों, रेखाओं, पैराग्राि, 

पृष्ठ, फे्रम या टेबि का सांग्रह हो सकता ह।ै 

चरण 2. चयनित टेक  ्स  ्ट को िॉमेट करिे के निए, स्टाइल्स बार के ऊपर से बटि पर नक्िक करके उपयुक्त स  ्टाइि 

चुिें। 

चरण 3. उस शे्रणी के निए स  ्टाइि की एक निस  ्ट फदखाई दतेी ह।ै चयनित टेक  ्स  ्ट पर िाग ूकरिे के निए इनछछत 

स  ्टाइि पर िबि नक्िक करें। 

प्रायोनगक गनतनवनध 1 - पैराग्राि स्टाइि से एक मौिूदा हसैिांग स  ्टाइि एप  ्िाय करें। 

चरण 1. निम्ननिनखत टेक  ्स  ्ट के साथ " noise.odt " िामक एक िया िॉक  ्यूमेंट बिाएां। ऊपर टाइटि “Noise 

Pollution” िोडें, िैसा फक नचत्र 1.6 में फदखाया गया ह।ै  

 

नचत्र 1.6 noise.odt 

चरण 3. शीषडक का नसिेक्शि करें - Noise Pollution 

चरण 4. साइिबार का उपयोग करके स्टाइल्स मेिू खोिें और हसेिांग नवकल्प पर िाएां। 

चरण 5. एप  ्िाइ करि ेके निए Heading 4 पर िबि नक्िक करें। ध्याि दें फक नचत्र 1.7 से पता चिता ह ैफक 

हसेिांग 4 स  ्टाइि शीषडक "Noise Pollution" पर िाग ूहोती ह।ै 
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नचत्र 1.7 पैरा स्टाइि के 4 नवकल्प Heading िागू करिा 

 

पहिे स ेतय Heading Style शीषडक स  ्टाइि का उपयोग करते हए, आप उन्हें िॉक  ्यूमेंट ब्राउज़ करिे के  निए 

बुक माकड  के रूप में उपयोग करिे की सुनवधा दतेे हैं । 

प्रायोनगक गनतनवनध 2 – एक मौिूदा पेि स  ्टाइि "noise" पर एप  ्िाय करें 

चरण 1. गनतनवनध 1 में बिाई गई फ़ाइि “noise.odt” खोिें। 

चरण 2. Insert > Page Break का नसिेक्शि करके शुरुआत में एक खािी पृष्ठ िािें, िैसा फक नचत्र 1.8 में 

फदखाया गया ह।ै  

 
नचत्र 1.8 Page Break को िाििा 

 
 

चरण 3. ध्याि दें फक नचत्र 1.9 में, पृष्ठ नवराम सनम्मनित करि ेसे matter दसूरे पृष्ठ पर चिा िाएगा। अब, पृष्ठ 2 

की शुरुआत में कसडर रखें, िहाां matter नचत्र 1.9 में फदखाया गया ह।ै 

चरण 4. साइि बार स ेस्टाइि मेिू खोिें और पेि स्टाइल्स नवकल्प चुिें िैसा फक नचत्र 1.9 में फदखाया गया ह।ै 

चरण 5. िैंिस्केप के निए पेि ओररएांटेशि बदििे के निए िैंिस्केप पर िबि नक्िक करें। इस पृष्ठ स्टाइि को 

िाग ूकरिे के बाद, आप दखे सकते हैं फक िॉक  ्यूमेंट पृष्ठों का ओररएांटेशि िैंिस्केप से पोटे्रट में बदि गया ह।ै 

 

 
नचत्र 1.9 पेि साइि मेिू से स्टाइि नवकल्प पृष्ठ िैंिस्केप का नसिेक्शि 

 

िोट - पृष्ठ पर पेि स  ्टाइि िागू करिे से सांपूणड िॉक  ्यूमेंट प्रभानवत हो सकता ह।ै 
 

 

असाइिमेंट  

एक बडी फ़ाइि के एक पृष्ठ पर िैंिस्केप नवकल्प िाग ूकरिे का प्रयास करें। पता करें, स्टाइि के पैराग्राि शे्रणी में 

फदए गए फकस नस्थनत में कां िीशिि स्टाइि फफ़ल्टर का उपयोग फकया िा सकता ह?ै  
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1.5 फिि िॉमटे Fill Format 

 

यफद िॉक  ्यूमेंट में नवनभन्न स्थािों पर मौिूद शब्दों पर एक स  ्टाइि (माि िें फक कैरेक  ्टर) को िाग ूफकया िाए तो 

क्या होगा? आपको प्रत्येक शब्द अिग दखेिा होगा और फिर प्रत्येक शब्द पर इसे िाग ूकरिे के निए वाांनछत 

स  ्टाइि पर िबि नक्िक करिा होगा।  
 

राइटर में इसे फ़ॉमेट नवकल्प के माध्यम से करिे का एक सुनवधाििक तरीका प्रदाि फकया िाता ह।ै यह स्टाइि 

मेिू पर दाईं ओर से दसूरा आइकि ह,ै िैसा फक नचत्र 1.3 में फदखाया गया ह।ै यह तरीका बहत उपयोगी ह ैिब एक 

ही स  ्टाइि को िॉक  ्यूमेंट में नबखरे हए कई स्थािों पर िागू फकया िािा ह।ै फिि िॉमटे को नबखरे हए स्टाइि के 

निए इस्तेमाि फकया िा सकता ह ै- पेि, फे्रम, टेबि, निस्ट, पैराग्राि या कैरेक्टर। इसका उपयोग करिे के निए, 

निम्न चरणों का पािि करें।  

 

चरण 1. स्टाइि करि ेके निए िॉक  ्यमूेंट खोिें 

चरण 2. स्टाइि सवांिो खोिें और वाांनछत स  ्टाइि शे्रणी और फिर ड्रॉप िाउि निस  ्ट से वाांनछत स  ्टाइि चुिें।  

चरण 3. फिि िॉमेट बटि को सेिेक्ट करें। 

चरण 4. चयनित स  ्टाइि को िाग ूकरिे के निए, माउस पॉइांटर को वाांनछत स्थाि पर िे िाएां और नक्िक करें। 

उनचत प्रकार की सामग्री पर स  ्टाइि िाग ूकरिे के निए ध्याि रखें। 

चरण 5. चरण 4 तब तक दोहराए ँिब तक पूरे िॉक  ्यूमेंट में उस स  ्टाइि के निए सभी पररवतडि िहीं फकए िात े

हैं। 

चरण 6. Fill Format नवकल्प से बाहर आिे के निए, फिर स ेFill Format बटि पर नक्िक करें या Esc कुां िी 

दबाएां। 

 
 

प्रायोनगक गनतनवनध 3 - िॉक्यूमेंट में अिग-अिग िगहों पर पैराग्राि िॉमेटटांग का उपयोग करके पैराग्राि की 

उपनस्थनत बदििे के निए िॉमेट िॉमड का उपयोग करें। गनतनवनध के निए टेक  ्स  ्ट के कम से कम 5 पृष्ठों के साथ 

एक फ़ाइि "document.odt" का उपयोग फकया िाता ह।ै 

 

चरण 1. एक फ़ाइि खोिें "Document.odt" निसमें टेक  ्स  ्ट के 5 पृष्ठ हों। नचत्र 1.10 में दसूरे पृष्ठ पर फदए गए 

इांिेंटेि वाक्य का निरीक्षण करें। 

 
नचत्र 1.10 फ़ाइि िॉक्यूमेंटेशि का दसूरा पृष्ठ 
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चरण 2. साइिबार से स्टाइि मेिू पर िाएां और पैराग्राि शे्रणी पर नक्िक करें, और ड्रॉप िाउि निस  ्ट से निस  ्ट 

पैराग्राि का नसिेक्शि करें िसैा फक नचत्र 1.11 में फदखाया गया ह।ै 

 

नचत्र 1.11 पैराग्राि स्टाइि श्रेणी में निस  ्ट पैराग्राि नवकल्प का नसिेक्शि 

 

चरण 3. निस  ्ट पैराग्राि के उपयोग से स्टाइि की िािे वािी वाक्य की शुरुआत पर नक्िक करें। 

चरण 4. अब फिि बटि पर नक्िक करें, वाांनछत िॉमेट का उपयोग करके सभी वाक्यों के निए स  ्टाइि िाग ूकरि े

के निए ऐसा ही करते रहें। नचत्र 1.12 में दखेें फक इांिेंटेि निस  ्ट आइटम Fill Format बटि को िागू करिे के बाद 

कैसे फदखते हैं। 

चरण 5. भरें बटि को निसेबि करिे के निए "Esc" कुां िी दबाएां 

 

नचत्र 1.12 Fill Format बटि का उपयोग करिा 

1.6 एक िई स  ्टाइि बिािा और अपिटे करिा 

अब तक आपिे फकसी िॉक  ्यूमेंट को िॉमेट करिे के निए केवि predefined स  ्टाइि का उपयोग फकया ह।ै यफद 

राइटर द्वारा निर्दडष्ट मौिूदा स  ्टाइि आपकी आवश्यकता से मेि िहीं खाती ह,ै तो कस्टम स्टाइि बिािा भी 

सांभव ह।ै कस्टम स्टाइि को कई तरीकों से बिाया िा सकता ह,ै नििमें से दो सरि तरीके हैं - नसिेक्शि से और 

दसूरा ड्रगै और ड्रॉप का उपयोग करते हए, निसे यहाां बताया गया ह।ै 

1. नसिके्शि स े- स्टाइि मेिू में अांनतम बटि, स्टाइल्स एक्शि बटि का उपयोग िई स  ्टाइि बिािे या मौिूदा 

स  ्टाइि को सांशोनधत करि ेके निए फकया िाता ह।ै इसका उपयोग निस  ्ट में िॉक  ्यूमेंट / टेम्पिेट में पररभानषत 

स  ्टाइि को िोि करिे के निए भी फकया िा सकता ह।ै आइए िािें फक िई स  ्टाइि कैसे बिाएां; िो एक्शि बटि 

की ड्रॉप िाउि निस  ्ट में पहिा कायड ह।ै 
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नचत्र 1.13 िई स  ्टाइि बिािे के निए नसिेक्शि से िई स  ्टाइि का नसिेक्शि करिा 

 

चरण 1. िॉक  ्यूमेंट के भाग का नसिेक्शि करें, िैसे फक पृष्ठ, पैराग्राि, कैरेक  ्टर, इसकी उपनस्थनत को बदििे के 

निए। आवश्यकता के अिुसार इसे िॉमेट करें। 
 

चरण 2. स  ्टाइि मेिू के शीषड पर नस्थत बटि से, शे्रणी (पैराग्राि, कैरेक  ्टर, पृष्ठ) चुिें, निसके निए िई स  ्टाइि 

बिाई िािी ह।ै 

चरण 3. सबसे पहिे Style action बटि का नसिेक्शि करें। नचत्र 1.13 में फदखाए गए नवकल्पों की निस  ्ट 

प्रदर्शडत की िाती ह।ै नसिेक्शि से New Style पर नक्िक करें। 

चरण 4. फिएट स्टाइि िायिॉग सवांिो में, िई स  ्टाइि का िाम टाइप करें, "MyStyle" िैसा फक नचत्र 1.14 में 

फदखाया गया ह।ै मौिूदा स  ्टाइि के िाम सवांिो में प्रदर्शडत फकए गए हैं। 
 

चरण 5. िई स  ्टाइि के िाम को सेव करिे के निए OK नक्िक करें। ध्याि दें फक स  ्टाइि की निस  ्ट में िव निर्मडत 

स  ्टाइि "MyStyle" का िाम फदखाई दतेा ह।ै 

 
नचत्र. 1.14 एक िई स  ्टाइि MyStyle बिािा 

प्रायोनगक गनतनवनध 4 - एक कस्टम पैराग्राि स  ्टाइि "my Style" बिािे के निए, प्रायोनगक गनतनवनध1 में 

बिाई गई फ़ाइि “noise.odt” का उपयोग करें।  

चरण 1. प्रायोनगक गनतनवनध 1 में बिाई गई फ़ाइि “noise.odt” खोिें। 

चरण 2. फ़ॉन्ट िेस के साथ पैराग्राि की सामग्री को िॉमेट करें - एररयि, फ़ॉन्ट आकार 12, िाइि स  ्पेस 1.5। 

चरण 3. साइिबार के स्टाइि मेिू से पैराग्राि बटि का नसिेक्शि करें िैसा फक नचत्र 1.15 में फदखाया गया ह।ै 
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नचत्र 1.15 पैरा स  ्टाइि का नसिेक्शि 

 

चरण 4. स्टाइि एक्शि बटि का नसिेक्शि करें। 

चरण 5. नसिेक्शि से िई स  ्टाइि पर नक्िक करें। एक Create Style dialog box फदखाई दगेा। 

 
नचत्र 1.16 नसिेक्शि का उपयोग करके िई स  ्टाइि बिाएां 

चरण 6. बॉक्स में स  ्टाइि िाम के रूप में "myStyle" टाइप करें और OK पर नक्िक करें। स  ्टाइि का िाम 

(myStyle) पैरा शे्रणी के तहत ड्रॉप िाउि निस  ्ट में फदखाई दगेा। 

 
नचत्र 1.17 िए बिाए गए myStyle पैराग्राि श्रेणी के तहत स्टाइि निस  ्ट का नहस्सा बि िाते हैं  

 

एक स  ्टाइि को अपिटे करिा 

predefined स  ्टाइि में एक छोटे स ेबदिाव के निए एक िई स  ्टाइि बिािे के बिाय, एक मौिूदा स  ्टाइि को 

मिचाह ेतरीके स ेसांशोनधत फकया िा सकता ह।ै Updating Current Style को अपिटे करते हए, निस  ्ट में 

दसूरा नवकल्प ऐसा करिे के निए उपयोग फकया िा सकता ह।ै 
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नचत्र 1.18 अपिेटेि स्टाइि नवकल्प का नसिेक्शि करिा 

पेि, फे्रम या पैराग्राि स  ्टाइि की मौिूदा user defined स  ्टाइि को सांशोनधत करिे के निए निम्ननिनखत 

चरणों का पािि करें। 

चरण 1. सांशोनधत करिे के निए पृष्ठ / पैराग्राि का नसिेक्शि करें। 

चरण 2. आवश्यकता के अिुसार चयनित भाग को िॉमेट करें। 

चरण 3. स  ्टाइि मेिू पर िाएां, और बटि पर नक्िक करें, निसकी स  ्टाइि आप अपिटे करिा चाहते हैं। 

चरण 4. स्टाइि एक्शि बटि का उपयोग करके अपिटेेि सेिेक्टेि स्टाइि पर नक्िक करें। 

िोट - सुनिनित करें फक सांशोनधत फकया गया पहिू पूरे नसिेक्शि के दौराि समाि रहता ह।ै उदाहरण के निए, 

पैराग्राि में, यफद आप फ़ॉन्ट िेस या साइि बदि रह ेहैं, तो पूरे पैराग्राि में यह एक समाि रहिा चानहए। 

2. ड्रैग एांि ड्रॉप का उपयोग करिा 

िई स  ्टाइि बिािे का एक और तरीका ड्रगै एांि ड्रॉप नवनध का उपयोग करिा ह।ै यह बिािे का बहत आसाि 

तरीका ह,ै क्योंफक टेक  ्स  ्ट का वाांनछत िॉमेट फकया गया भाग नसिड  स्टाइि मेिू में सही स्थाि पर ड्रगै एांि ड्रॉप 

फकया गया ह।ै 

ड्रगै एांि ड्रॉप नवनध का उपयोग करके एक िई स  ्टाइि बिािे के निए निम्ननिनखत चरणों का उपयोग करें। 

चरण 1. िॉक  ्यूमेंट से टेक  ्स  ्ट का नसिेक्शि करें और इसके िॉमेट को इछछािुसार बदिें। 

चरण 2. स  ्टाइि मेिू के शीषड पर नस्थत बटिों स,े स  ्टाइि बिािे के निए वाांनछत शे्रणी चुिें। 

चरण 3. वाांनछत स  ्टाइि पर नक्िक करें निसके तहत, िई स  ्टाइि बिाई िािी ह।ै 

चरण 4. िॉक  ्यूमेंट से टेक  ्स  ्ट के चयनित नहस्से को ड्रगै करें और इसे स्टाइि मेिू पर ड्रॉप करें। 

िोट - टेक  ्स  ्ट को ड्रगै करते समय, कसडर आकार की िाचँ करें, क्योंफक यह इांनिकेट करिे के निए बदिता ह ैफक 

ऐसा करिा सांभव ह ैया िहीं। 

चरण 5. Create Style सवांिो फदखाई दतेी ह ै(नचत्र 1.17), िई स  ्टाइि का िाम निखें। मौिूदा स  ्टाइि के िाम 

सवांिो में प्रदर्शडत फकए गए हैं। 

चरण 6. िई स  ्टाइि के िाम को सेव करिे के निए OK नक्िक करें। 
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Create Style सवांिो कस्टम स  ्टाइि की निस  ्ट प्रदर्शडत करती ह।ै मौिूदा स  ्टाइि को अपिटे करिे के निए, 

निस  ्ट से स  ्टाइि का िाम चुिें। तो स्टाइि बिािे / अपिेट करिे के निए उसी नवनध का उपयोग फकया िा सकता 

ह।ै 

पेि स्टाइि बिािे के निए ड्रगै एांि ड्रॉप का उपयोग िहीं फकया िा सकता ह।ै 

प्रायोनगक गनतनवनध 5 - myStyle में िाइि स्पेससांग को 1 और िॉन्ट साइि को 10 में बदिकर ड्रगै एांि ड्रॉप का 

उपयोग करके एक िया स्टाइि "myStyle1" बिाएां। 

चरण 1. प्रायोनगक गनतनवनध1 में बिाई गई फ़ाइि “noise.odt” खोिें। 
 

चरण 2. िॉण्ट की सामग्री को िॉण्ट आकार 13 और िाइि स  ्पेस 1 के साथ िॉमेट करें। 

चरण 3. साइिबार के स्टाइि मेिू से पैराग्राि बटि का नसिेक्शि करें िैसा फक नचत्र 1.19 में फदखाया गया ह।ै 

 
नचत्र 1.19 साइिबार के स्टाइि मेिू में पैरा स्टाइि 

चरण 4. अब चयनित टेक  ्स  ्ट को स्टाइि मेिू पर ड्रगै करें िैसा नचत्र 1.20 में फदखाया गया ह।ै 

 
नचत्र 1.20 डै्रग और ड्रॉप का उपयोग करके एक िई स  ्टाइि बिािा 

चरण 5. OK पे्रस करें। स  ्टाइि िाम (myStyle1) ड्रॉप िाउि में फदखाई दगेा, िैसा फक नचत्र 1.21 में फदखाया 

गया ह।ै 

 
नचत्र 1.21 िई स  ्टाइि myStyle1 डै्रग और ड्रॉप का उपयोग करके बिाई गई ह ैिो स्टाइि निस  ्ट में फदखाई दतेी है 

 

1.7 िोि स्टाइि (टेम्पिेट या िॉक  ्यमूेंट से) 

एक िई स  ्टाइि बिाि ेया मौिूदा स  ्टाइि को सांशोनधत करि ेके अिावा, एक िया िॉक  ्यूमेंट स्टाइि / िॉमेट 

फकया िा सकता ह ैनिसमें पूवड-निधाडररत टेम्पिेट्स या फकसी अन्य िॉक  ्यूमेंट का उपयोग फकया िाता ह ैिो हमारी 

आवश्यकता के अिुरूप ह।ै यह टेम््िेट / िॉक्यूमेंट की सभी स  ्टाइि को हमारे स्टाइि मेिू में िािे में मदद करता ह ै

और हमारे कायड को िॉमेट करिा आसाि बिाता ह।ै  
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स्टाइि मेिू के स्टाइि एक्शि बटि में अांनतम नवकल्प िोि स्टाइि ह।ै इसका उपयोग मौिूदा टेम्पिेट या 

िॉक  ्यूमेंट से स  ्टाइि की प्रनतनिनप बिािे के निए फकया िाता ह।ै एक बार कॉपी करिे के बाद, स  ्टाइि की निस  ट 

में, आप एक िया िॉक  ्यूमेंट बिा सकते हैं निसमें कोई अनतररक  त प्रयास िहीं करिा होता ह।ै 

 

नचत्र 1.22 स्टाइि एक्शि बटि से िोि स्टाइि नवकल्प का नसिेक्शि करिा 

टेम्पिेट / िॉक  यूमेंट स ेस  ्टाइि की कॉपी बिािे के निए निम्ननिनखत चरणों का पािि करें 

चरण 1. स्टाइल्स मेिू में, िोि स्टाइल्स पर नक्िक करें िैसा नचत्र 1.22 में फदखाया गया ह।ै 

चरण 2. यह िोि स्टाइि िायिॉग बॉक्स को खोिेगा िैसा फक नचत्र 1.23 में फदखाया गया ह।ै 

िोि स्टाइि िायिॉग बॉक्स में, अपिे िॉक  ्यूमेंट की शे्रणी चुिें। 

 

नचत्र 1.23 िोि स्टाइि िायिॉग सवांिो की श्रेनणयों से My Templates का नसिेक्शि करिा 

चरण 3. स  ्टाइि को कॉपी करिे के निए वाांनछत टेम्पिेट ढूांढें और चुिें। ध्याि दें फक My Templates शे्रणी में 

कोई टेम्पिेट सांग्रहीत िहीं हैं 

चरण 4. एक ही dialog सवांिो स ेकॉपी फकए िाि ेवाि ेस  ्टाइि के प्रकारों के नवकल्पों का नसिेक्शि करें, िैसे फक 

टेक  ्स  ्ट के निए पैराग्राि और वणड स  ्टाइि, फे़्रम, पृष्ठ या िांबटरांग (निस  ्ट स  ्टाइि)। ओवरराइट नवकल्प का 

नसिेक्शि करके, कॉपी की िा रही स  ्टाइि को फकसी भी मौिूदा स  ्टाइि को उसी िाम से बदि फदया िाएगा। 

चरण 5. स्टाइल्स को कॉपी करिे के निए ओके पर नक्िक करें। 
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चरण 6. स  ्टाइि को एक फ़ाइि स ेकॉपी फकए िािे के मामि ेमें फिर टेम्पिेट नवकल्प के बिाय, From File 

बटि पर नक्िक करें। एक फ़ाइि नसिेक्शि िायिॉग बॉक्स प्रदर्शडत होता ह।ै अपिे कां ्यूटर से वाांनछत िॉक  ्यूमेंट 

का नसिेक्शि करें। 

 

1.8 स  ्टाइि को िागू करिा 

िब भी कोई िया िॉक  ्यूमेंट बिाया िाता ह,ै तो राइटर उस पर एक निफ़ॉल्ट स  ्टाइि िागू करता ह,ै और उसी 

नस्थनत में प्रदर्शडत होता ह ैिसैा फक नचत्र 1.24 में फदखाया गया ह।ै 

 

नचत्र. 1.24 status bar पर वतडमाि निफ़ॉल्ट स  ्टाइि प्रदर्शडत होती ह ै
 

आप निफ़ॉल्ट स  ्टाइि को बिाए रखिे या इसे बदििे के निए चुि सकते हैं। अब आप िािते हैं फक साइिबार मेिू 

का उपयोग कैसे करें। 

अपिे आप खोििा : सेक्शि 1.4 में निस  ्ट में दी गई स्टाइि नवकल्पों को एक्सेस करिे के अन्य तरीके िािें। 

अपिी प्रगनत िाांचें 

 

क. बहनवकल्प प्रश्न 

1. निबे्र ऑफिस राइटर में फदए गए िॉक  ्यूमेंट को बिािे के निए निम्ननिनखत में से कौि-सी नवशेषताएां उपयोग की िाती 

हैं? 

(a) Page borders  

(b) Envelope  

(c) Picture from File  

(d) Indexes and Tables. 

 

2. राइटर में स्टाइल्स मेि ू(साइिबार से) काम करिे के नवकल्प प्रदाि करता ह ै

(ए) पैरा स्टाइि 

(बी) फे़्रम स्टाइि 

(सी) पेि स्टाइल्स 

(िी) उपरोक्त सभी 

3. निबे्र ऑफिस राइटर में टेम्पिटे क्या ह?ै 

(ए) प्री निटमड नि फकया गया form और िॉक  ्यूमेंट फ़ाइि की नवनध 
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(बी) एक प्रकार की स  ्टाइि 

(सी) एक प्रकार का िॉक्यूमेंट 

(िी) राइटर में िॉक्यूमेंट का क्िस्टर। 

 

4. निम्न में से कौि आपके पेि िॉक  ्यूमेंट की स  ्टेटस, पृष्ठों की सांख्या बताता ह?ै 

(ए) स  ्टेटस बार 

(बी) स्टैंििड टूिबार 

(सी) िॉमेट 

(िी) टाइटि बार 
 

5. स  ्टाइि मेि ूको एक्सेस करिे के निए निम्न में से फकसका उपयोग फकया िा सकता ह ै

(ए) F11 function कुां िी 

(b) साइिबार मेि ू

(c) टूिबार िॉमेटटांग 

(d) उपरोक्त सभी 

 

ख. ररक  ्त स  ्थाि भरें  

1. __________ नवनभन्न िॉमेट का एक सांग्रह ह ै

2. स्टाइि नवशेष रूप से __________ में उपयोगी हैं। 

3. स  ्टाइि का उनचत उपयोग फकसी िॉक  ्यूमेंट में __________ को बेहतर बिाता है 

4. स्टाइि सवांिो के शीषड पर पहिे पाँच बटि __________ की श्रेणी चुििे के निए होते हैं।  

5. predefined __________ का उपयोग करिे से िॉक  ्यूमेंट में बुकमाकड  बिाया िा सकता है। 

6. एक िई फ़ाइि खोििे पर _________ स  ्टाइि का उपयोग िॉक  ्यूमेंट िॉमेटटांग के निए फकया िाता ह।ै 

7. पेि िेआउट दस्तावेिों में, आप टेक्स्ट बॉक्स और ग्राफिक्स की तरह __________ को व्यवनस्थत कर सकते हैं। 

8. कैरेक  ्टर स  ्टाइि को अक्सर __________ स  ्टाइि में एकीकृत फकया िाता ह।ै 

9. __________ िॉक  ्यूमेंट में नवनभन्न स्थािों पर स  ्टाइि िागू करिे की सुनवधा देता ह।ै 

10. predefined स  ्टाइि __________ डै्रग एांि ड्रॉप नवनध द्वारा अपिेट की िाएगी 

 
 

ग. िघु उत्तर वाि ेप्रश्न 

1. निबे्र ऑफिस राइटर में स  ्टाइि से आप क्या समझते हैं? 

2. िॉक्यूमेंट निज़ाइि के निए मैन्युअि िॉमेटटांग पर स्टाइि का उपयोग करिे के िायद ेनिखें। 

3. निबे्र ऑफिस राइटर में स  ्टाइि की नवनभन्न श्रेनणयाां क्या हैं? 

4. एक स  ्टाइि को अपिेट करिे के निए चरणों को निखें। 

5. निबे्र ऑफिस राइटर में कस्टम स  ्टाइि से आप क्या समझते हैं? 

6. फकसी िॉक्यूमेंट में इांट्रोिक्शि पैराग्राि को उसके िॉन्ट (िेस, आकार, विि, रांग), उसके ऊपर स्पेस और हसेिांग को िांबर 

देकर बडे पैमािे पर नििाइि फकया िािा ह।ै िॉमेटटांग टूि बार का उपयोग करिे के निए उपयोग फकए िािे वािे कदम 

निम्ननिनखत हैं 
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i) पररचय का नसिेक्शि करें (पैराग्राि) 

ii) टूिबार से ओपि िॉन्ट निस  ्ट 

iii) फ़ॉन्ट का नसिेक्शि करें 

iv) टूिबार से ओपि िॉन्ट का आकार 

v) इनछछत फ़ॉन्ट आकार का नसिेक्शि करें 

vi) टूिबार से फ़ॉन्ट भार (बोल्ि) चुिें 

vii) टूिबार से ओपि फ़ॉन्ट रांग 

viii) वाांनछत रांग का नसिेक्शि करें 

ix) िॉमेट मेि ूनवकल्प का उपयोग करके, स  ्पेस> पैराग्राि> इांिेंट और स  ्पेस का नसिेक्शि करें 

x) पैराग्राि के ऊपर स्थाि एनिट करें 

xi) टूिबार से िमाांफकत निस  ्ट का नसिेक्शि करके सांख्या िोडें। 
 

साथडक के पास एक िॉक्यूमेंट ह ैनिसमें नवनभन्न पृष्ठों पर पाँच पररचयात्मक पैराग्राि शानमि हैं। सभी को िॉमेट करिे के 

निए उसे फकतिे चरणों की आवश्यकता होगी? स्टाइि मेि ूका उपयोग करके इसे करिे के निए आवश्यक कदमों को निखकर 

उसकी मदद करें। आपको कायड पूरा करिे के निए फकतिे चरणों की आवश्यकता ह?ै 

7. दो उदाहरण दें, िहाां स्टाइि के बिाय मैिुअि िॉमेटटांग का उपयोग करिा िायदेमांद होगा। 

8.एक नस्थनत दें, निसमें आप अपिे िॉक  ्यूमेंट को स्टाइि करिे के निए फफ़ि िॉमेट का उपयोग करिा पसांद करेंगे। 

9. एक टेम्पिेट से स  ्टाइि (ओं) को िोि करिे के निए चरण निखें। 

 

 

व्यावहाररक अभ्यास  

प्रायोनगक कायड 1  

1. श्री आर के शमाड अपिी िौकरी बदिि ेकी योििा बिा रह ेहैं। िई िौकरी खोििे में मदद करिे के निए वे एक कां पिी 

(www.naukri.in) से सांपकड  करते हैं। श्री आर के शमाड को कां पिी में अपिा CV / Resume प्रस्तुत करिे के निए कहा 

िाता ह।ै उि  ्होंिे "template.com" से एक िमूिा CV िाउििोि फकया ह।ै उि  ्हें उसी िॉमेट में अपिा सीवी बिािे में 

उिकी मदद करें। कां ्यूटर में भनवष्य के सांदभड के निए िॉमेट को "CV1" के रूप में सेव करें । 
 

प्रायोनगक कायड  2 

2. राघव ि ेअपिे नशक्षक की ओर से मिचाह ेरूप में पररवर्तडत करिे के निए एक non styled text document प्राप्त 

हआ। उसे भनवष्य के सांदभड के निए इसे "reportStyle" के रूप में सेव करिा होगा। इसका पािि करिे की प्रफिया निखें। 
 

मिू िॉक  ्यमूेंट 

 
नचत्र 1.25 2 मूि िॉक्यूमेंट 
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स्टाइि िॉक  ्यमूेंट का एनपयरेंस 

नचत्र 1.26 स्टाइि िॉक्यूमेंट का एनपयरेंस 

 

3. कें द्रीय नवद्यािय िांबर 3, अपिे स्कूि के निए एक मानसक निनिटि समाचार पत्र प्रकानशत करिे की योििा 

बिा रहा ह।ै 12 वीं कक्षा के रवीश पाांिे, कां ्यूटर पर इसे नििाइि करिे के निए निम्मेदार समूह का मुनखया हैं। 

समाचार पत्र का आकार अांनतम रूप से 5 इांच (िांबाई) 8 इांच (ऊां चाई) ह।ै यह भी तय फकया गया फक : 

 समाचार पत्र में 4 पि  ्िों वाि ेदो पेि होंगे। 

 पहिे  पि  ्िे में स्कूि के बारे में सांनक्षप्त िािकारी प्रदाि की िाएगी। 

 दसूरे में एक टेबि होगी, निसमें नपछिे वषड के स्कूि के बोिड परीक्षा पररणाम प्रदर्शडत होंगे।  

 तीसरे पि  ्िे पर वतडमाि सत्र के निए स्कूि की उपिनब्धयाां (कम से कम 4) दी िाएांगी। 

 अांनतम पि  ्िे में छात्रों द्वारा निख ेगए िेख या कनवताए ँ(कम से कम 2) होंगी। 

 

आपको टीम का नहस्सा होिे के िाते साइि बार से स्टाइि मेिू का उपयोग करके कायड करिा आवश्यक ह ै: 

क) समाचार पत्र को नििाइि करिे के निए उपयुक्त स  ्टाइि शे्रणी (पृष्ठ, फे्रम, और टेबि) का सुझाव फदया िाता 

ह।ै 

ख) इसकी निनिटि कॉपी बिाएां। 

ग) उपयुक्त पि  िों पर िेफ्ट पेि और राइट पेि िॉमेट एप  ्िाय करें। 

घ) सभी पि  िों पर समाि मार्िडि निधाडररत करें, सभी पर समाि border बिाएां। 

ड) प्रत्येक पि  ्िे पर पेि िांबर िोडें। पृष्ठ सांख्या िुटर में "पृष्ठ -" सांख्या के रूप में फदखाई दिेी चानहए। प्रत्येक पि  ्ि े

पर इि सांख्याओं को दाएां एिाइि करें। 

च) हसेिांग और सब हसेिांग के निए, समाचार पत्र में हसेिांग 2 और हसेिांग 4 का उपयोग करें। 

छ) पहिे पि  ्िे पर, स्कूि के बारे में िािकारी प्रदर्शडत करते समय, इसे आकषडक बिािे के निए अपिी पसांद के 

कैरेक  ्टर स्टाइि का उपयोग करें। 

ि) नग्रि रोज़ और कॉिम का उपयोग करते हए, बोिड पररणाम की टेबि का उपयोग करें। 

झ) टेबि की प्रत्येक पांनक्त में एक सांख्या होिी चानहए - रोमि में, सामग्री के प्रीफिक  ्स  ्ि। 

त्र) फे़्रम में स्कूि की उपिनब्धयों को व्यवनस्थत करें, िहा ँफे्रम्स ऑफ़ पैराग्राि शे्रणी का उपयोग करके व्यनक्तगत 

फे्रम को स्टाइि फकया िािा ह।ै 

ट) नसिेक्शि नवनध का उपयोग करके, सांबांनधत शे्रणी में स  ्टाइि को सेव करें, ताफक भनवष्य के समाचारपनत्र काओं 

को निरांतरता बिाए रखिे के निए प्रकानशत फकया िा सके। 
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अध  ्याय 2. Images के साथ काम करिा 

2.1 पररचय 

एक अछछे सांवादात्मक िॉक  ्यूमेंट को पढ़िा और समझिा आसाि ह।ै एक विड प्रोसेससांग एन्िकेशि में समृद्ध 

नवशेषताएां हैं िो हमें एक इांटरैनक्टव िॉक  ्यूमेंट बिािे की सुनवधा दतेी हैं। नचत्रों वािा िॉक  ्यूमेंट हमेशा शुद्ध साद े

िॉक  ्यूमेंट की तुििा में समझिा आसाि होता ह।ै नचत्रों में नविुअि अपीि होती ह,ै क्योंफक हमारा मि फकसी भी 

अन्य िािकारी की तुििा में रांगों के निए िल्दी प्रनतफिया करता ह।ै एक नचत्र एक ड्राइांग, चाटड, िोटो, िोगो, 

ग्राि या एकि वीनियो फे्रम हो सकता ह।ै निनिटि िॉक  ्यूमेंट में एक नचत्र एक ग्राफिक या इमेि प्रनतनिनधत्व हो 

सकता ह,ै िो एक निनिटि इमेि ह।ै अब तक, हमिे नवनभन्न नवशेषताओं िैसे फक िॉमेट और स  ्टाइि का उपयोग 

करके एक टेक  ्स  ्ट िॉक  ्यूमेंट बिाया ह।ै इस अध्याय में आप नचत्रों के साथ एक िॉक  ्यूमेंट बिािा सीखेंगे। आप इस े

और अनधक आकषडक बिािे के निए िॉक  ्यूमेंट में नचत्र सनम्मनित करिा और सांशोनधत करिा सीखेंगे।  

निब्र ेऑफिस राइटर इमेि के साथ काम करिे के निए नवनभन्न उपकरण प्रदाि करता ह।ै एक तस्वीर एक निनिटि 

इमेि ह,ै िो फक नपक्सेि के रूप में ज्ञात निनिटि माि 0 या 1 के पररनमत सेट में इमेि का प्रनतनिनधत्व करती ह।ै 

ये िाइि एक्सटेंशि के साथ नवनभन्न प्रकार की ग्राफिक्स फ़ाइिों में GIF, JPG / JPEG, PNG और BMP के 

रूप में सांग्रहीत फकए िाते हैं। 

2.2 एक िॉक  ्यमूेंट में एक इमिे को शानमि करिा 

निब्र ेऑफिस राइटर स ेहमें नवनभन्न उपकरण प्रदाि करके इमेि, आकृनतयों, चाटड और आरेखों पर काम करि ेकी 

सुनवधा नमिती ह।ै कां ्यूटर पर सांग्रहीत इमेि फ़ाइि को नवनभन्न तरीकों का उपयोग करके एक िॉक  ्यूमेंट में िािा 

िा सकता ह ैिैस े- सनम्मनित इमेि िायिॉग का उपयोग करिा, ड्रगै और ड्रॉप नवकल्प का उपयोग करिा, कॉपी 

और पेस्ट नवकल्प का उपयोग करके और अांत में सिांक करके। 

 

इमिे नवकल्प Inserting का उपयोग करके इमिे सनम्मनित करिा 

Insert Image dialog box का उपयोग करके एक इमेि िाििे की एक सामान्य प्रफिया निम्नािुसार ह।ै 

चरण 1. निब्र ेऑफिस राइटर में एक इमेि िाििे के निए िॉक  ्यूमेंट खोिें। 

चरण 2. वहाां कसडर रखें िहाँ आप एक इमेि insert करिा चाहते हैं। 

चरण 3. मेन्यू बार से Insert> Image पर नसिेक्ट करें और नक्िक करें 

चरण 4. एक इांसटड इमेि िायिॉग बॉक्स खुिेगा निसमें नपक्चर िाइि िाििे की सुनवधा होगी। 
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चरण 5. फ़ाइि का नसिेक्शि करें और िॉक  ्यूमेंट में एक इमेि सनम्मनित करि ेके निए ओपि बटि पर नक्िक 

करें। 

प्रायोनगक गनतनवनध 1 - नपछिे चै्टर में बिाई गई िाइि “noise.odt” में इांसटड इमेि िायिॉग बॉक्स का 

उपयोग करके एक इमेि िािें। 

चरण 1. सुनिनित करें फक आपकी कां ्यूटर हािड निस्क में एक इमेि फ़ाइि ह।ै अन्यथा इांटरिेट से एक प्रासांनगक 

इमेि िाउििोि करें। 

चरण 2. अध्याय 1 की प्रायोनगक गनतनवनध 1 में बिाए गए निब्र ेऑफिस राइटर में “noise.odt” फ़ाइि 

खोिें। 

 

चरण 3. इमेि फ़ाइि सनम्मनित करिे के निए कसडर को टेक्स्ट की अगिी पांनक्त में रखें, और फिर मेिू बार में 

Insert मेिू पर नक्िक करें िसैा फक नचत्र 2.1 में फदखाया गया ह।ै 

 
नचत्र 2.1 इमेि िाििे के निए Insert करिे के निए मेिू का नसिेक्शि 

चरण 4. इमेि नवकल्प पर नक्िक करें, एक इमेि का नसिके्शि करिे के निए इमेि ब्राउसज़ांग सवांिो िािें। वाांनछत 

इमेि का नसिेक्शि करें िैसा फक नचत्र 2.2 में फदखाया गया ह।ै 

 
नचत्र 2.2 इमेि ब्राउसज़ांग सवांिो Insert िािें 

 

चरण 5. ओपि बटि पर नक्िक करें। इमेि वाांनछत स्थाि पर फदखाई दतेी ह ैिैसा फक नचत्र 2.3 में फदखाया गया ह।ै 
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नचत्र 2.3 इमेि noise.odt शोर में Insert की गई ह।ै  

 

ड्रैग एांि ड्रॉप नवकल्प का उपयोग करके इमिे Insert करिा 

िॉक  ्यूमेंट में नचत्र िाििे का एक अन्य नवकल्प ड्रगै एांि ड्रॉप नवकल्प का उपयोग करिा ह।ै मािक प्रफिया नसिड  

इमेि को उसके स्रोत से ड्रगै करते हैं और इसे िॉक  ्यूमेंट में वाांनछत स्थाि पर ड्रॉप कर दतेी ह।ै Insert Image 

dialog बॉक्स का उपयोग करके एक इमेि िाििे की एक सामान्य प्रफिया निम्नािुसार ह।ै 

चरण 1. निब्र ेऑफिस राइटर में एक इमेि िाििे के निए िॉक  ्यमूेंट खोिें। 

चरण 2. एक फ़ाइि ब्राउज़र सवांिो खोिें (नवि + ई) और िािी िािे वािी इमेि फ़ाइि का नसिेक्शि करें। 

चरण 3. इमेि को िॉक  ्यूमेंट में Drag करें। 

चरण 4. इसे िॉक  ्यूमेंट में वहाां पर Drop कर दें, िहाां आप इसे फदखािा चाहते हैं। 

 

कॉपी और पसे्ट नवनध का उपयोग करके इमिे Insert करिा 

 

िैसा फक िॉक  ्यूमेंट में एक इमेि िाििे का एक और तरीका ऊपर कहा गया ह,ै कॉपी और पेस्ट नवनध का उपयोग 

करके ह।ै इस मामि ेमें इमेि को ड्रगे करि ेके बिाय, इमेि को कॉपी करें और फिर िॉक  ्यूमेंट के वाांनछत स्थाि पर 

पेस्ट करें। 
 

ऊपर बताई गई फकसी भी नवनध का उपयोग करके एक इमेि सनम्मनित करिे से िॉक  ्यूमेंट में इमेि फ़ाइि की एक 

प्रनत बच िाती ह ैिहाँ भी इमेि िािी िाती ह,ै इसका अथड ह ैफक इमेि िॉक  ्यूमेंट में एम्बेििे हो िाती ह।ै 

प्रायोनगक गनतनवनध 2 - नक्िपबोिड का उपयोग करके एक नचत्र (स्रोत) से दसूरे िॉक  यूमेंट (िक्ष्य) में एक इमेि 

िािें। स्रोत फ़ाइि “typewriter.odt” ह ैनिसमें टाइपराइटर की अिग-अिग इमेि हैं, और िक्ष्य फ़ाइि 

नपछिे अध्याय में बिाया गया “documentation.odt”. ह।ै 

चरण 1. ओपि सोसड फ़ाइि“typewriter.odt” और टारगेटिाइि documentation.odt”.ह।ै  

चरण 2. स्रोत िॉक  ्यूमेंट में, कॉपी की िािे वािी इमेि का नसिेक्शि करें, िैसा फक नचत्र 2.4 में फदखाया गया ह।ै 
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नचत्र 2.4 typewriter.odt में चयनित इमेि 

 

चरण 3. चयनित इमेि पर माउस पॉइांटर िे िाए ँऔर कीबोिड शॉटडकट (Ctrl + C) या राइट-नक्िक का उपयोग 

करके इमेि को कॉपी करें और इमेि को नक्िपबोिड पर कॉपी करिे के निए सांदभड मेिू से कॉपी नवकल्प का 

नसिेक्शि करें। 

चरण 4. िक्ष्य फ़ाइि पर नस्वच करें,  “documentation.odt”। 

चरण 5. उस स्थाि पर कसडर रखें िहाां आप इमेि को insert करिा चाहते हैं िैसा फक नचत्र 2.5 में फदखाया गया 

ह।ै 

 

नचत्र 2.5 documentation.odt में इमेि िाििे के निए कसडर रखिा 

 

चरण 6. कीबोिड शॉटडकट (Ctrl + V) का उपयोग करके इमेि को पेस्ट करें या इमेि पेस्ट करिे के निए context 

menu से पेस्ट नवकल्प का नसिेक्शि करें। 

 
नचत्र  2.6 typewriter.odt से इमेि िाििे के बाद documentation.odt 

 

यफद िॉक  ्यूमेंट में एक ही इमेि की कई कॉपी insert करिे की आवश्यकता होती ह ैतो इमेि को insert करिे के 

बिाय इमेि के सिांक को सवे करिा िायदमेांद ह।ै एक सिांक िाििे पर, इमेि के बिाय अपिे सांदभड को स  ्टोर 

करता ह,ै निससे िॉक  ्यूमेंट का आकार कम हो िाता ह,ै क्योंफक िॉक  ्यूमेंट के साथ एक अिग फ़ाइि के रूप में 

वास्तनवक इमेि को केवि एक बार सेव फकया िाता ह।ै 
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िब भी सिांक वािा कोई िॉक  ्यूमेंट खोिा िाता ह,ै तो इमेि फ़ाइि उस स्थाि पर merge हो िाती ह,ै िहाां 

सांदभड स  ्टोर फकया गया था, और प्रयोक  ्ता को स्िीि पर प्रदर्शडत फकया गया। इमेि फ़ाइि को सिांक करिे के निए 

निम्न चरणों का पािि करें। 

 

Insert Image िायिॉग बॉक्स में, सिांक नवकल्प की िाचँ करें िैसा फक नचत्र 2.7 में फदखाया गया ह ै

 
नचत्र 2.7 Insert image िायिॉग बॉक्स सवांिो में सिांक चेक बॉक्स 

एक इमेि सिांक करिे के निए कीबोिड शॉटडकट - Ctrl + Shift कुां िी दबाए रखते हए इमेि को ड्रगै एांि ड्रॉप करें। 
 

असाइिमेंट 

खोि करें फक राइटर गैिरी या फकसी अन्य निवाइस से एक इमेि कैसे िािें ? 
 

2.3 एक इमिे को सांशोनधत MODIFYकरिा 

कभी-कभी हमें िॉक  ्यूमेंट की आवश्यकता के अिुरूप िॉक  ्यूमेंट में िािी गई इमेि को सांशोनधत करिा पड सकता 

ह।ै इमेि टूिबार का उपयोग इमेि को आकार दिे,े िॉप करि,े हटािे और घुमािे के निए फकया िाता ह।ै 
 

2.3.1 इमिे टूिबार का उपयोग करिा 

िब कोई नचत्र िािा िाता ह ैया िॉक  ्यूमेंट में चुिा िाता ह ैतो इमेि टूिबार ऑटोमेरटक रूप से प्रकट होता ह।ै 

यफद आप इसे हमेशा स्िीि पर रखिा चाहते हैं, तो मेिू बार से View > Toolbars > Image पर नक्िक करें। 

Image टूि बार को नचत्र 2.8 में फदखाया गया ह।ै तानिका 2.1 में नवनभन्न टूि का वणडि इस इमेि टूिबार के 

माध्यम स ेउपिब्ध फदया गया ह।ै 

 

 
 

नचत्र 2.8 इमेि टूि बार 

तानिका 2.1 इमिे टूिबार का वणडि 

टूि इमिे पर प्रभाव 

Image Filter इमेि में सुधार के निए ग्यारह प्रकार के फफ़ल्टर फफ़ल्टर उपिब्ध हैं। नववरण 

टेबि 2.2 में फदया गया ह।ै  
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Image Mode इमेि को black & white, gray-scale or a watermark मोि में बदिा िा 

सकता ह ै

Crop इमेि के अिचाह ेनहस्से को काट दतेा ह।ै 

Flip Horizontally इमेि को 180o तक आड ेरूप से नलिप करता ह ै 

Flip Vertically इमेि को नफ्िप 180o तक वर्टडकि रूप से नफ्िप करता ह ै 

Rotate 90o left 

 

Rotate 90o right 

इमेि को 90o िेफ्ट या राइट रोटेट करता ह,ै िो चुिे गए बटि पर निभडर करता 

ह ै

Rotate इस टूि का उपयोग करके फकसी भी कोण से इमेि को रोटेट फकया िा सकता ह।ै 

Transparency पारदर्शडता प्रनतशत में फदए गए वैि  ्यू का उपयोग करके एक इमेि को ट्राांसपेरेट 

बिाती ह।ै 

Color brightness, contrast and gamma के निए ड्रॉप िाउि निस  ्ट (िैसा फक 

नचत्र 2.9 में फदखाया गया ह)ै में स े Red, Blue or Green color को 

सांशोनधत या समायोिि फकया िा सकता ह।ै 

 

इमेि टूिबार स ेफकसी भी टूि को िाग ूकरिे के निए, उस इमेि का नसिेक्शि करें निस पर टूि को एप  ्िाय फकया 

िािा ह ैऔर फिर उपकरण पर नक्िक करें। किर बटि पर नक्िक करि ेसे रांग की ड्रॉप िाउि निस  ्ट प्रदर्शडत होगी 

िैसा फक नचत्र 2.9 में फदखाया गया ह।ै इसमें छह घटक होते हैं। इि घटकों के प्रनतशत में कमी को बढ़ाया िा सकता 

ह।ै पहिे घटक िमशः तीि प्राथनमक रांगों रेि, ग्रीि और ब्िू का प्रनतनिनधत्व करते हैं। चौथा घटक Brightness 

का प्रनतनिनधत्व करता ह,ै पाांचवाां घटक कां ट्रास्ट का प्रनतनिनधत्व करता ह ैऔर अांनतम छठा घटक गामा को दशाडता 

ह।ै 

 
नचत्र 2.9 किर ड्रॉप िाउि निस  ्ट 

Image Filter पर नक्िक करि ेसे 11 फफ़ल्टर के साथ एक सवांिो खुिती ह,ै िैसा फक नचत्र 2.10 में फदखाया गया 

ह।ै टेबि 2.2 में इमेि फफ़ल्टर सवांिो में उपिब्ध नवनभन्न उपकरणों का सांनक्षप्त नववरण फदया गया ह।ै 
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नचत्र 2.10 इमेि फफ़ल्टर सवांिो 

टेबि 2.2 Image Filter का नववरण  

 

Tool Image पर प्रभाव 

Invert रांगीि इमेि के रांग मूल्यों को Invert करता ह।ै यफद इमेि गे्र-स्केि की ह ैतो इसकी 

brightness Invert हो िाती ह।ै 

Smooth इमेि के contrast को Soft बिाता ह।ै एक अन्य िायिॉग बॉक्स पैरामीटर को 

समायोनित करिे के निए प्रकट होता ह।ै 

Sharpen इमेि का contrast बढ़ िाता ह।ै 

Remove Noise इमेि से एकि नपक्सेि निकािता ह ै

Solarization तस्वीरों में टोि को उिटिे के निए प्रयुक्त। अांधेरा light फदखाई दतेा ह ैऔर प्रकाश 

dark फदखाई दतेा ह।ै एक अन्य िायिॉग बॉक्स पैरामीटर को समायोनित करिे के 

निए प्रकट होता ह।ै 

Aging नचत्र पर समय के प्रभाव का अिुकरण करता ह।ै इसे नक्िक करिे पर, पैरामीटर को 

समायोनित करिे के निए एक और िायिॉग बॉक्स फदखाई दतेा ह।ै 

Posterize नचत्र में रांगों को कम करके नचत्र की तरह फदखाई दतेा ह।ै िब इस आइकि पर नक्िक 

फकया िाता ह,ै तो एक और िायिॉग बॉक्स एििस्ट होिे के निए फदखाई दतेा ह।ै 

Charcoal Sketch इमेि को चारकोि स्केच के रूप में बदिता ह।ै 

Relief पैरामीटर समायोनित करि े के निए िायिॉग बॉक्स का उपयोग करके shadow 

बिािे के निए प्रकाश स्रोत को समायोनित करता ह।ै  

Mosaic एक रांग के एक क्षेत्र में नपक्सेि के समूह में शानमि होता ह।ै एक अन्य िायिॉग बॉक्स 

पैरामीटर समायोनित करिे के निए प्रकट होता ह।ै 

 

प्रायोनगक गनतनवनध 3 - एक िॉक  ्यूमेंट में एक इमेि िािें और इमेि को घुमाएां। 
 

चरण 1. निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट खोिें। 
 

चरण 2. Insert menu पर िाएां और Image >> From File चुिें 
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चरण 3. िाइबे्ररी से एक इमेि िािें िैसा फक नचत्र 2.11 में फदखाया गया ह।ै 

 
नचत्र  2.11 एक िए िॉक  ्यूमेंट में Image िािी गई  

चरण 4. इमेि सेिेक्ट करें और फिर रोटेट टूि पर नक्िक करें। ध्याि दें फक चार िॉट्स हैंिि के रूप में िािा िाता 

ह,ै इमेि के चार कोिों पर फदखाई फदया। 

चरण 5. फकसी भी कोिे पर माउस को िे िाएां और ध्याि दें फक rotate” symbol सफिय ह।ै 

चरण 6. इमेि के ऊपरी दाएां कोिे पर रोटेट प्रतीक पर नक्िक करें और इसे िीचे की ओर खींचें, िैसा फक नचत्र 

2.12 में फदखाया गया ह।ै 

चरण 7. अब rotated image नचत्र 2.13 में फदखाया गया ह।ै 
 

                    

नचत्र 2.12 Rotating इमेि                   नचत्र 2.13 इमेि रोटेशि के बाद 

प्रायोनगक गनतनवनध 4 - एक िई िाइि में एक इमेि िॉप करें। 

चरण 1. निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट खोिें। 

चरण 2. िॉक  ्यूमेंट में एक इमेि िािें िैसा फक ऊपर फदखाए गए Insert >> Image >> From File नवकल्प 

स ेनचत्र 2.14 का उपयोग करके फदखाया गया ह।ै 

 
नचत्र 2.14 इमेि िाििे के बाद िॉक  ्यूमेंट 

 

चरण 3. इमेि पर नक्िक करके इमेि का नसिेक्शि करें। ध्याि दें फक चयनित इमेि आठ छोटे वगों से नघरा हआ ह ै

िैसा फक नचत्र 2.14 में फदखाया गया ह।ै 
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चरण 4. इमेि टूि बार स ेिॉप टूि पर नक्िक करें। अब ध्याि दें फक इमेि के आसपास के आठ छोटे वगड िीिे रांग 

के हैंिि में बदि िाएांगे िैसा फक नचत्र 2.15 में फदखाया गया ह।ै य ेइमेि को िॉप करिे के निए उपयोग फकए िािे 

वाि ेहैंिि हैं।  

 
नचत्र 2.15 इमेि को िॉप करिे के निए पररवर्तडत हैंिि 

चरण 5. इमेि के इि फकिारों में से फकसी पर नक्िक करें और कसडर को इमेि के कें द्र की ओर खींचें िैसा फक नचत्र 

2.16 में फदखाया गया ह।ै ध्याि दें फक dotted रेखाओं तक इमेि को िॉप फकया िा रहा ह।ै आवश्यकता के 

अिुसार फकसी भी फकिारे को खींचकर इमेि को िॉप करिा सांभव ह।ै 

 
नचत्र 2.16 इमेि को िॉप करिा 

चरण 6. पृष्ठ पर कहीं भी नक्िक करें या crop tool छोडिे के निए Esc कुां िी दबाएां और नचत्र 2.17 में फदखाए 

गए अिुसार िॉप की गई इमेि का निरीक्षण करें। 

 
नचत्र 2.17 ऊपरी दाएां फकिारे से cropping के बाद की इमेि 

 

2.3.2 एक इमिे का आकार बदििा Resizing 

कभी-कभी आप इमेि को फकसी िॉक  ्यूमेंट में वाांनछत स्थाि पर फिट करिे के निए आकार बदििा चाह सकते हैं। 

आकार बदििा इमेि के आकार को कम करिे या बढ़ािे की प्रफिया ह।ै यह नवनभन्न तरीकों से फकया िा सकता ह।ै 

एक इमेि को आकार दिे ेका त्वररत और आसाि तरीका इमेि के आकार के हैंिि की dragging से करिा ह।ै 

इमेि का आकार बदििे के निए निम्न चरणों का उपयोग करें : 
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चरण 1. नपछिी गनतनवनध में िािी गई इमेि पर नक्िक करें। ध्याि दें फक नचत्र 2.14 में फदखाए गए अिुसार 

साइसज़ांग हैंिि को प्रदर्शडत करिे के निए आठ आकार के हैंिि इमेि को घेरे हए हैं।  

चरण 2. साइसज़ांग हैंिि में स ेएक पर पॉइांटर को रखें। यह pointer पररवतडि आकार की फदशा का सांकेत दतेा ह।ै 

चरण 3. नचत्र 2.18 में फदखाए अिुसार नचत्र का आकार बदििे के निए नक्िक करें और drag करें। 

 
नचत्र 2.18 इमेि का आकार बदििा Resizing 

 

चरण 4. िए आकार से सांतुष्ट होिे पर माउस बटि को छोड दें और माि िें फक इमेि का आकार कम हो गया ह।ै 

कोिे के हैंिि को खींचकर, कोई एक साथ इमेि की चौडाई और ऊां चाई दोिों का आकार बदि सकता ह,ै िबफक 

अन्य चार हैंिि एक समय में केवि एक आयाम का आकार बदि सकते हैं। 

ध्याि दें फक इमेि को आकार दतेे समय आकार को वाांनछत आकार में बदि फदया िाता ह ैबस हमि ेउपरोक्त 

गनतनवनध में इमेि के आकार को कम कर फदया ह,ै िेफकि इमेि को वैसे ही िहीं काटा िाता ह ैिैस ेहमि ेनपछिी 

गनतनवनध में इमेि को िॉप फकया ह।ै 

 

2.3.3 Deleting an image इमिे हटािा 

िॉक  ्यूमेंट से इमेि को हटािा सांभव ह ैिैसे हम टेक  ्स  ्ट को हटाते हैं। इमेि को हटािे के निए, बस इमेि पर नक्िक 

करके इमेि का नसिेक्शि करें और Delete बटि दबाएां। 

2.4 DRAWING OBJECTS ड्राइांग ऑब्िके्ट 

यफद आपको अपिे िॉक  ्यूमेंट में लिोचाटड या कॉि आउट बॉक्स खींचिे की आवश्यकता ह,ै तो निब्र ेऑफिस राइटर 

ऐसे काम के निए ड्राइांग टूि की सुनवधा प्रदाि करता ह।ै राइटर में उपिब्ध ड्राइांग टूल्स का सेट उपयोग करिा 

आसाि ह,ै और अछछी Propertiesवत्ता के नििाइि, आरेख और नचत्र बिािे में मदद करता ह।ै एक बार िब 

आप नचत्र बिाते हैं, तो आप इसे सीधे िॉक  ्यूमेंट में रख सकते हैं। इि आरेखों को अन्य packages में से कॉपी या 

import भी फकया िा सकता ह।ै 

 

2.4.1 Using Drawing Tools ड्राइांग टूल्स का उपयोग करिा 

राइटर सवांिो में ड्रॉइांग टूिबार प्रदर्शडत करिे के निए, View > Toolbars > Drawing पर नक्िक करें िैसा 

फक नचत्र 2.19 में फदखाया गया ह।ै यह राइटर सवांिो में ड्राइांग टूिबार प्रदर्शडत करेगा िैसा फक नचत्र 2.20 में 
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फदखाया गया ह।ै टूिबार में आपकी पसांद के फकसी भी निज़ाइि को बिािे के निए नवनभन्न प्रकार के नवनभन्न मूि 

ड्राइांग ऑब्िेक्ट होते हैं। 

 
नचत्र 2.19 Drawing tools करिा 

 

 
नचत्र 2.20 ड्राइांग टूिबार 

 

िॉक  ्यूमेंट में निज़ाइि बिाि े के निए कई निफ़ॉल्ट ड्राइांग ऑब्िेक्ट का उपयोग फकया िाता ह।ै उिका उपयोग 

करिे के निए -  

चरण 1. िॉक  ्यूमेंट में कसडर रखें िहाां आप चाहते हैं फक ड्राइांग हो रखा (anchored)। यफद आवश्यक हो, तो आप 

बाद में anchor बदि सकते हैं। 

चरण 2. Drawing toolbar से उपकरण का नसिेक्शि करें िैसा फक नचत्र 2.20 में फदखाया गया ह।ै माउस 

पॉइांटर एक ड्रॉइांग-िां क्शि पॉइांटर में बदिता ह।ै 

िोट - स्िीि पर एक और टूिबार फदखाई दतेा ह,ै Drawing Object Properties इसे नचत्र 2.21 में फदखाया 

गया ह ैऔर बाद में अगिे भाग में समझाया गया ह।ै 

चरण 3. पॉइांटर को उस िॉक्यूमेंट में उस िगह पर िे िाए ँिहाँ आप चाहते हैं फक इमेि फदखाई द ेऔर फिर ड्राइांग 

ऑब्िेक्ट बिािे के निए नक्िक-एांि-ड्रगै करें। 

चरण 4. ड्राइांग खत्म करिे के निए माउस बटि छोडें। 

चरण 5. चयनित ड्राइांग फ़ां क्शि सफिय रहता ह,ै ताफक आप उसी प्रकार का एक अन्य ऑब्िेक्ट आकर्षडत कर सकें । 

चरण 6. चयनित ड्राइांग फ़ां क्शि को रद्द करिे के निए, Esc कुां िी दबाएां या ड्राइांग टूिबार पर नसिेक्शि करें 

आइकि (तीर) पर नक्िक करें। 

प्रायोनगक गनतनवनध 5 - 3 पररवार के सदस्यों, श्री आर के शमाड (भव्य नपता), श्री बी शमाड (नपता), श्रीमती 

सुिीता शमाड (माता) का एक ट्री बिाएां। 
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चरण 1. निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट खोिें। Drawing toolbar को एिबेि करें और यह सुनिनित 

करें फक यह िॉक  ्यूमेंट सवांिो के िीचे प्रदर्शडत फकया गया ह ैिैसा फक नचत्र 2.21 में फदखाया गया ह।ै 

चरण 2. टूिबार से Rectangle Round tool का नसिेक्शि करें। कसडर को उस स्थाि पर रखें िहाां आप 

पररवार के ट्री को बिािा चाहते हैं। rectangle tool पर नक्िक करें और इस ेrectangle बिािे के निए स्थाि 

पर drag करें। उसी तरह, अन्य दो rectangles बिाए ँिसैा फक नचत्र 2.21 में फदखाया गया ह।ै  

 

नचत्र 2.21 पररवार के ट्री के निए ड्राइांग टूि का उपयोग करके बिाए गए Rectangles 

 

चरण 2. सभी तीि rectangular बक्से में टेक  ्स  ्ट दिड करें िसैा फक नचत्र 2.22 में फदखाया गया ह।ै टेक  ्स  ्ट दिड 

करिे के निए, rectangle का नसिेक्शि करें और फिर टेक  ्स  ्ट निखें। 

चरण 3. नचत्र 2.22 में फदखाए गए पदािुिनमत सांबांध फदखािे वािी रेखाएां खींचिे के निए िाइि टूि से िाइि के 

प्रकार (तीर के साथ सरि रेखा और रेखा) का नसिेक्शि करें। 

 

नचत्र 2.22 rectangles का उपयोग करते हए पररवार का ट्री  

चरण 4. फ़ाइि "family.odt" में िायग्राम सेव करें। 

 

निस वस्तु पर आप काम कर रह ेहैं, उसके properties को बदििा भी सांभव ह।ै राइटर में properties बदिि े

हतेु ड्राइांग ऑब्िेक्ट Properties टूिबार में उपकरण प्रदाि फकया िाता ह ैअथाडत फकसी वस्तु को customizing 

(अिुकूनित) करिा। इि उपकरणों के उपयोग से वस्तु को नवनभन्न पहिुओं पर स्थािाांतररत, आकार, घुमाया, 

सांपाफदत और कॉनन्फ़गर फकया िा सकता ह।ै 

वस्तु के गुणों को सांशोनधत / सांपाफदत फकया िा सकता ह,ै या तो इसके निमाडण के समय यािी इससे पहिे फक आप 

उन्हें बिािा शुरू करें या इसके निमाडण के बाद। िब निमाडण से पहिे properties को सांशोनधत फकया िाता ह,ै तो 
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इसे निफ़ॉल्ट माि (सेटटांग) के रूप में िािा िाता ह।ै properties पर काम करिे के निए, आप टूिबार से टूि का 

उपयोग कर सकते हैं और ऑब्िेक्ट के वाांनछत पहिू को बदि सकत ेहैं। properties को ऑब्िेक्ट पर राइट नक्िक 

करके भी सांशोनधत फकया िा सकता ह।ै 

2.4.2 Drawing Object के properties को स्थानपत Setting करिा या बदििा 

िॉक  ्यूमेंट में ड्राइांग ऑब्िेक्ट का नसिेक्शि करिे पर, ऑब्िेक्ट ऑब्िेक्ट को आरेनखत करिा टूिबार नचत्र 2.23 में 

फदखाया गया ह।ै यह एक फ्िोटटांग टूिबार ह,ै और इसे स्िीि पर कहीं भी रखा िा सकता ह।ै 

 
नचत्र 2.23 Drawing Object Toolbar में Properties  

 

ऑब्िेक्ट बिािे स ेपहिे properties सेट करिे के निए, निम्ननिनखत चरणों का पािि करें। 

चरण 1. ड्राइांग टूिबार स,े उस ऑब्िेक्ट का नसिेक्शि करें निसे आप बिािा चाहते हैं। 

चरण 2. ड्राइांग ऑब्िेक्ट Properties टूिबार से, सांशोनधत फकए िािे वाि ेproperties के आइकि पर नक्िक 

करें। 

चरण 3. पैरामीटर का माि बदिें। 

चरण 4. सभी वाांनछत properties को बदििे के निए चरण 2 और 3 को दोहराएां। 

चरण 5. नपछिे अिुभाग में फदए गए चरणों का पािि करके वाांनछत नचत्र बिाएां। एक वस्तु के properties में 

फकए गए पररवतडि, इसे बिािे से पहि,े केवि इस सत्र के निए उपिब्ध हैं। 
 

ऑब्िेक्ट के properties बदििे के निए निम्न चरणों का पािि करें 

चरण 1. उस ऑब्िेक्ट का नसिेक्शि करें निसके properties को सांशोनधत फकया िािा ह।ै 

चरण 2. फकसी ऑब्िेक्ट को बिािे से पहिे properties सेट करिे की नपछिी प्रफिया के चरण 2 से 5 का पािि 

करें। 
 

प्रायोनगक गनतनवनध 6 - गनतनवनध 5 में बिाई गई फ़ाइि "family.odt" में, दो और सदस्य, एक बेटा मास्टर 

रोनहत शमाड और एक बेटी बबेी दीनपका शमाड िोडें। फ़ाइि की एक प्रनतनिनप बिाए।ँ फिर पररवार के ट्री में प्रयुक्त 

Rectangle के properties को बदिें (Fill color – lime yellow, border line – Oragne having 

0.08” width) और Line (color – black, Style – ultrafine dashed)। 

 

चरण 1. निब्र ेऑफिस राइटर में िाइि “family.odt” खोिें। 

चरण 2. diagram में दो और सदस्यों को reflect करिे के निए दो गोि rectangle िोडें और उिमें टेक  ्स  ्ट 

िोडें।  

चरण 3. एक कॉपी को "family1.odt" के रूप में सेव करें। "Family.odt" में काम करत ेरहें 

चरण 4. नसिेक्शि उपकरण का उपयोग करके एक  rectangle का नसिेक्शि करें। 
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चरण 5. ड्राइांग ऑब्िेक्ट Properties टूिबार में Fill Color टूि पर नक्िक करें, और नचत्र 2.24 में फदखाए 

गए अिुसार रांग चयनित rectangle को बदिें। 

 

नचत्र 2.24 rectangle में Fill Color tool का उपयोग करिा 

चरण 6. उसी तरह सभी rectangles का रांग बदिें। 

चरण 7. ड्राइांग में एक रेखा का नसिेक्शि करें। िाइि किर टूि पर नक्िक करें और िाइि किर को ब्िू से ब्िैक में 

बदििे के निए ब्िैक किर चुिें। उसी तरह, सभी िाइिों के रांग को कािे रांग में बदिें िैसा फक नचत्र 2.25 में 

फदखाया गया ह।ै 

 
नचत्र 2.25 िाइि रांग बदििे के निए Line Color tool का उपयोग करिा 

चरण 8. आप िाइि किर टूि और border की चौडाई का उपयोग करके rectangle के border के रांग को 

value को िाइि चौडाई नवकल्प में निर्दडष्ट करके भी बदि सकते हैं । 

चरण 9. वैकनल्पक रूप स ेआपके ऑब्िेक्ट पर राइट नक्िक करके िाइि का रांग और चौडाई बदि सकते हैं और 

फिर सांदभड मेिू से "रेखा" नवकल्प का नसिेक्शि कर सकत ेहैं िैसा फक नचत्र 2.26 में फदखाया गया ह।ै 

 

नचत्र 2.26 सांदभड मेिू से िाइि नवकल्प का नसिेक्शि करिे के निए ऑब्िेक्ट पर राइट नक्िक करें 

चरण 10. सभी rectangles की िाइि का रांग और चौडाई बदििे के निए, नशफ्ट बटि को दबाकर और प्रत्येक 

rectangle पर नक्िक करके सभी rectangle का नसिेक्शि करें। इससे Line dialog window खुिेगी िैसा 

फक नचत्र 2.27 में फदखाया गया ह।ै रेखा के रांग को "ऑरेंि" में बदिें और रेखा की चौडाई को "0.08" के रूप में 

निर्दडष्ट करें िैसा फक नचत्र 2.27 में फदखाया गया ह ैऔर OK बटि पर नक्िक करें। 
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नचत्र 2.27 Line dialog window में चयनित वस्तुओं के निए िाइि का रांग और िाइि की चौडाई निर्दडष्ट करिा 

नचत्र 2.28 में दखेें, रेखा का रांग और चौडाई निर्दडष्ट अिुसार बदि गई ह ै

 
2.28 वाांनछत object properties के साथ Family Tree 

 

2.4.3 objects का Resizing और समहू बिािा Grouping 

कभी-कभी आप िॉक  ्यूमेंट में फकसी नवशेष स्थाि पर इसे समायोनित करिे के निए ड्राइांग के आकार को बदििा 

चाह सकते हैं। यह या तो इसका आकार बदिकर या इसका आकार और आकार दोिों बदिकर फकया िा सकता ह।ै 

ड्राइांग को आकार दिेे के निए निम्न चरणों का पािि करें। 

 

चरण 1. Resize की िािे वािी वस्तु का नसिेक्शि करें। कोिों और फकिारों पर सभी आठ हैंिि फदखाई देंगे। 

चरण 2. फकसी भी हैंिि पर नक्िक करें और उसे अपिे िए स्थाि पर खींचें। आपके action के आधार पर, 

ऑब्िेक्ट को ऊपर या िीचे बढ़ाया िाएगा। यह भी फक ऑब्िेक्ट का आकार बिारहगेा या िहीं, यह उस हैंिि पर 

निभडर करेगा, निसे आप रीसाइसज़ांग चुिते हैं। 

चरण 3. ड्राइांग के मूि आकार को आकार दिेे और बिाए रखिे के निए, corner हैंिि का उपयोग करें। 

चरण 4. corner के हैंिि का उपयोग गैर-आिुपानतक रूप से ड्राइांग को रीसाइज़ करेगा। 
 

असाइिमेंट  

दोिों मामिों में, ऑब्िेक्ट का आकार बदिते हए SHIFT कुां िी का उपयोग करें। 

Grouping drawing objects ड्राइांग ऑब्िके्ट्स को समहूीकृत करिा 

एक से अनधक overlapping shape वाि ेऑब्िेक्ट को draw करते हए, स्िीि पर वे एक एकि इकाई की 

फदखाई दतेे हए एक साथ रहते हैं। िेफकि वास्तव में वे अिग-अिग shapes के साथ अिग-अिग entities पर 

होते हैं। इसनिए, िब आप उन्हें edit करिे के निए चुिते हैं तो आपको प्रत्येक के shape पर काम करिा होगा। 
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निब्र ेऑफिस राइटर इि नवनभन्न आकृनतयों को समूहीकृत करिे की सुनवधा दतेा ह,ै ताफक उिके shape और 

नस्थनत को प्रभानवत फकए नबिा एकि इकाई के रूप में व्यवहार फकया िा सके। एक बार समूहीकृत होिे के बाद, 

उस समूह स ेसांबांनधत सभी shape इसके सदस्य बि िाते हैं और एक सदस्य पर िाग ूएक पररवतडि सभी पर काम 

करता ह।ै ड्राइांग ऑब्िेक्ट को group समूनहत करिे के निए निम्न चरणों का पािि करें। 
 

ड्राइांग ऑब्िके्ट को समहूीकृत करि ेके निए : 

चरण 1. ऑब्िेक्ट पर नक्िक करके इस का नसिेक्शि करें। 

चरण 2. नशफ्ट बटि को होि  ्ि करें और समूह में शानमि करिे के निए उस पर नक्िक करके अन्य सभी वस्तुओं का 

नसिेक्शि करते रहें। 

चरण 3. ड्रॉइांग ऑब्िेक्ट प्रॉपटी टूिबार से एक गु्रप टूि चिुें। (नचत्र 2.23)। वैकनल्पक रूप स,े मुख्य मेिू Format 

> Group > Group स ेनसिेक्शि भी वही काम करेगा। 

चरण 4. यह प्रफिया चयनित ड्राइांग ऑब्िेक्ट को समूनहत करेगी। 

गु्रप ऑ्शि के तहत चार नवकल्प हैं। ये Group, Ungroup, Enter Group, Exit Group हैं। इि नवकल्पों 

के निए नचत्र 2.29 में फदखाए गए नचह्ि भी Drawing Object Properties टूिबार में मौिूद हैं। 

 

 
 

नचत्र 2.29 ड्राइांग ऑब्िेक्ट Properties टूिबार में Grouping tools समूहीकरण उपकरण 

प्रायोनगक गनतनवनध 7 - गनतनवनध 5 और 6 में बिाए गए िैनमिी ट्री के सभी आइटम को गु्रप में "familiy1.odt" 

िाइि में गु्रप करें। समूह का उपयोग करके, िैनमिी ट्री में प्रयुक्त properties of Rectangle (Fill color – 

lime yellow, border line – orange with 0.08” width) और Line (color – black, Style – 

ultrafine dashed)। 

 

चरण 1. राइटर में पहिे बिाए गए िॉक  ्यूमेंट "family.odt" को खोिें। 

चरण 2. सभी िाइिों का नसिेक्शि करें। इसके निए पहिी पांनक्त पर नक्िक करें, Shift बटि दबाए रखें और उन्हें 

समूहीकृत करिे के निए अन्य पांनक्तयों का नसिेक्शि करते रहें। 

चरण 3. ड्रॉइांग ऑब्िेक्ट प्रॉपटी टूिबार में गु्रप टूि पर नक्िक करें। ध्याि दें फक सभी िाइिें एक साथ समूहीकृत हैं 

िैसा फक नचत्र 2.30 में फदखाया गया ह।ै अब एक साथ समूहीकृत सभी रेखाओं का रांग बदिकर कािा कर दें। 

 
नचत्र 2.30 सभी िाइिों को एक साथ समूहीकृत फकया गया और रांग को कािे रांग में बदि फदया गया 
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चरण 4. इसी तरह सभी the rectangles का नसिेक्शि करें, उन्हें समूनहत करें और उसके fill color को lime 

yellow, border line को orange रांग और border width को 0.08 तक बदि दें, िैसा फक नपछिी गनतनवनध 

में फकया गया था। ध्याि दें फक सभी rectangles का रांग िारांगी रांग में बदि गया िैसा फक नचत्र 2.28 में फदखाया 

गया ह।ै 

2.4.4 टेक  ्स  ्ट में इमिे की पोनिशसिांग  

एक बार ड्राइांग ऑब्िेक्ट को बिािे, िॉमेटटांग, आकार बदििे और समूहीकरण करिे का कायड पूरा हो िािे के 

बाद, इसे टेक्स्ट और अन्य इमेि या ड्रॉइांग के साथ िॉक  ्यूमेंट में पोस्ट करिा होगा। एक इमेि की नस्थनत को चार 

सेटटांग्स द्वारा नियांनत्रत फकया िाता ह।ै 

1. व्यवस्था Arrangement 

2. एांकटरांग 

3. एिाइिमेंट 

4. टेक  ्स  ्ट रैप करिा 

इि सेटटांग्स को तीि तरीकों का उपयोग करके एक्सेस फकया िा सकता ह ै- िॉमेट मेिू का उपयोग करके, ऑब्िेक्ट 

पर राइट नक्िक करिे के बाद सांदभड मेिू का उपयोग करके, ड्रॉइांग के properties को बदििे के निए ड्रॉइांग 

ऑब्िेक्ट properties टूिबार का उपयोग करके। आइए िािें फक ड्राइांग को पृष्ठ में स्थाि दिेे के निए ड्राइांग 

ऑब्िेक्ट properties टूिबार का उपयोग कैसे करें। 

 

व्यवस्था Arrangement - अनतव्यापी वस्तुओं में व्यवस्था अन्य ड्राइांग या टेक  ्स  ्ट के सांबांध में वतडमाि ड्राइांग की 

नस्थनत निधाडररत करती ह।ै ड्राइांग ऑब्िेक्ट properties टूिबार में व्यवस्था उपकरण शानमि हैं िैसा फक नचत्र 

2.31 में फदखाया गया ह।ै ये छः उपकरण हैं िो बायें से दायें की ओर आत ेहैं, िैसे फक सब्रांग टू फ्रां ट, फ़ॉरविड वि, बैक 

वि, सेंि टू बैक, टू फ़ोरग्राउांि, टू बैकग्राउांि, निन्हें सांक्षेप में टेबि 2.3 में समझाया गया ह।ै 

 
नचत्र 2.31 Drawing Object Properties में Image arrangement tools  

 

टेबि 2.3 इमिे व्यवस्था उपकरण का नववरण 

टूि प्रभाव 

Bring to Front सभी objects / इमेि के शीषड पर इमेि रखें 

Forward One ओवरिैसपांग इमेि होिे पर इमेि को एक िेवि ऊपर िाएां 

Back One ओवरिैसपांग इमेि में इमेि को एक स्तर िीचे भेिें 

Send to Back सभी objects / इमेि के िीचे इमेि रखें 

To Foreground  

To Background 

drawing ऑब्िेक्ट को टेक  ्स  ्ट के पीछे या सामिे िे िाता ह।ै 
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िोट - पहिे चार सटेटांग्स एक इमेि या ड्राइांग पर िाग ूफकए िा सकते हैं, िेफकि अांनतम दो केवि नचत्र के निए 

उपिब्ध हैं। 

एांकटरांग - एांकटरांग इमेि या ड्राइांग के निए एक सांदभड सबांद ुके रूप में कायड करता ह।ै एांकटरांग एक इमेि को पृष्ठ, 

पैराग्राि, कैरेक  ्टर या फे्रम में अपिी नस्थनत को बिाए रखिे की सुनवधा दतेा ह।ै एांकर उपकरण नचत्र 2.32 में 

फदखाया गया ह।ै िीच ेकी ओर तीर पर नक्िक करके आप दखे सकते हैं फक पेि, पैराग्राि, कैरेक्टर या फे्रम में फकसी 

इमेि को एांकर फकया िा सकता ह।ै इसनिए िब भी कोई पेि, पैराग्राि, कैरेक्टर या फे्रम एिाइि फकया िाता ह ै

तो एांकर की इमेि उसके साथ चिती ह।ै 

 
नचत्र 2.32 अपिे नवकल्पों के साथ एांकर उपकरण 

 

एिाइिमेंट - एिाइिमेंट अपिे एांकर के सांबांध में इमेि के खड ेया आड ेस्थाि की सुनवधा दतेा ह।ै Drawing 

Properties toolbar के िीचे एिाइिमेंट उपकरण नस्थत हैं, िैसा फक नचत्र 2.33 में फदखाया गया ह।ै एक 

इमेि छह अिग-अिग स  ्टाइि में एिाइि कर सकती ह ै- 3 आड ेऔर 3 खड े। 

 

नचत्र 2.33 ऑब्िेक्ट ऑब्िेक्ट टूिबार खींचिे में एिाइिमेंट उपकरण 

 
 

टेक्स्ट रैसपांग - यह टेक्स्ट के सांबांध में इमेि के ्िेसमेंट की सुनवधा दतेा ह।ै टेक्स्ट रैसपांग टूि ड्रॉइांग ऑब्िेक्ट प्रॉपटी 

टूिबार के तहत उपिब्ध हैं। नचत्र 2.34 में फदखाए गए अिुसार बाएां से दाएां तक अपिी उपनस्थनत के िम में छः 

नवकल्प हैं, रैप ऑि, पेि रैप, ऑ्शिि पेि रैप, रैप िेफ्ट, रैप राइट, रैप थ्रू। टेबि 2.4 में इि उपकरणों का 

सांनक्षप्त वणडि फकया गया ह।ै 

 
नचत्र 2.34 Drawing Object Properties toolbar में टेक  ्स  ्ट रैसपांग टूि 

 

टेबि 2.4 टेक्स्ट रैसपांग टूल्स का नववरण 

 

टूल्स रैसपांग इिेक  ्ट  

Wrap off टेक्स्ट इमेि के ऊपर और िीचे होता ह।ै  

Page Wrap इमेि के चारों ओर टेक  ्स  ्ट प्रवानहत होता ह।ै नचत्र को मूव करिे स े
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 पृष्ठ पर टेक  ्स  ्ट पुिः व्यवनस्थत हो िाएगा  

Optimal Page wrap 

 

 

पेि रैप में, यफद इमेि और मार्िडि के बीच का स्थाि 2 सेमी से कम ह,ै तो उस 

 

 तरि टेक्स्ट िहीं रखा िाएगा।  

Wrap left इमेि के बाईं ओर टेक  ्स  ्ट रखा गया ह।ै 

Wrap right इमेि के दाईं ओर टेक  ्स  ्ट रखा गया ह।ै 

Wrap through टेक  ्स  ्ट पर इमेि सुपर इांपोि फकया िाता ह।ै 

 

अपिी प्रगनत िाांचें  

क. बह नवकि  ्प प्रश  ्ि  

 

1.  पृष्ठ की पृष्ठभूनम में िो टेक  ्स  ्ट या इमेि धुांधिी faintly फदखाई दतेी ह ैउसे कहा िाता ह ै

(ए) वॉटर माकड  

(बी) टे्रि माकड  

(सी) कॉपी राइट 

(िी) एम्बॉससांग  

2. इमेि िॉमेट में JPG या JPEG का अथड ह ै 

(ए) Joint Photographic Experts Group  

(बी) Joint Picture Experts Group  

(सी) Joint Photographic Experts Graph  

(िी) Joint Photographic Experts General  

3. Drawing ऑब्िेक्ट Properties टूिबार में, प्रदाि फकए गए समूह नवकल्प हैं 

(ए) एनग्िट गु्रप 

(बी) अिगु्रप 

(सी) गु्रप एांटर  

(िी) उपरोक्त सभी 

4. निम्न में से कौि सी इमेि फ़ाइि के निए सही फ़ाइि एक्सटेंशि िहीं ह?ै  

(ए) GIF  

(बी) JPEG  

(सी) Odt  

(िी) PNG 

5. Image toolbar इसके निए एक उपकरण प्रदाि िहीं करता ह ै  

(a) Filtering  

(b) Cropping  

(c) Copying  
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(d) Flipping 

 

ख. ररक्त्स्थाि भरें : 

1.  _________ उपकरण इमेि के गैर वाांछिीय नहस्से को काट दतेा ह।ै 

2. इमेि की brightness और कां ट्रास्ट दोिों को बदिि ेके निए __________उपकरण का उपयोग फकया िा 

सकता ह।ै 

3. नचत्र ________ उपकरण पर समय के प्रभाव simulate करिे के निए प्रयोग फकया िाता ह।ै 

4. सभी objects के िीचे _________ इमेि िगाई िाती ह।ै 

5. एक इमेि को ___ द्वारा हटाया िा सकता ह ैऔर DELETE बटि दबाया िा सकता ह।ै 

6. ड्राइांग टूल्स में बेनसक शे्स निस्ट _________ शे्स प्रदाि करती ह।ै 

7. एांकर ड्राइांग के निए _________ सबांद ुके रूप में कायड करता ह।ै 

8. एक इमेि को horizontally aligning करिे के निए _________ नवकल्प हैं। 

9. इमेि के _________ हैंिि का उपयोग इसे घुमािे के निए फकया िाता ह।ै 

10. एक वस्तु _________ के निमाडण के properties को बदििा, उन्हें पूरे सत्र में बिाए रखिा 

 

ग. िघ ुउत्तर वाि ेप्रश्न  

1. निनिटि इमेि क्या ह?ै आप एक कैसे बिा सकते हैं? 

2. Drag & Drop नवनध का उपयोग करके गैिरी से एक इमेि insert करिे के निए चरण निखें। 

3. इमेि की cropping इसको resizing करिे से कैसे अिग ह?ै 

4. ड्राइांग टूिबार में कौि से उपकरण उपिब्ध हैं? फकसी भी 5 टूि का वणडि करें। 

5. एांबेसिांग से अिग इमेि की सिांककां ग कैसे होती ह?ै ऐसी नस्थनत दें निसमें आप एक इमेि सिांक करिा पसांद करेंगे। 

6. ड्राइांग ऑब्िेक्ट के निए properties बदििे के निए चरण निखें? 

7. ड्राइांग ऑब्िेक्ट को समूहीकृत करिे के क्या िाभ और कनमयाां हैं? 

8. Drawing ऑब्िेक्ट Properties टूिबार से फकसी भी दो उपकरण का वणडि करें? 

9. बेनसक ड्राइांग शेप में इमेि िाििे के निए स्टे्स निखें। 

10. एक िॉक  ्यूमेंट में इमेि की नस्थनत को नियांनत्रत करिे वािे कारक निखें। 

 
 

प्रायोनगक कायड  

अध्याय 1 के प्रायोनगक अभ्यास (प्रश्न 3) में, आपिे स्कूि का समाचार पत्र बिाया। समाचार पत्र की पेि वार 

सामग्री थी: 

ए) स्कूि की िािकारी 

बी) टेबि में दसवीं और बारहवीं कक्षा के निए पररणाम 

c) स्कूि की उपिनब्ध 
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d) छात्रों के िेख / कनवताएां 

समाचार पत्र की नविुअि अपीि में सुधार के निए, इसमें कुछ नचत्र िोडें। 

नचत्र िोडिे के निए निम्ननिनखत नववरण फदए गए हैं। 

 

पेि 1: िीचे दाएां कोिे में स्कूि की एक सांगत तस्वीर िोडें, िैसा फक नचत्र में फदखाया गया ह।ै िोटो में अछछा 

कां ट्रास्ट और ब्राइटिेस होिी चानहए। िोटो में ब्िैक बॉिडर िोडें। 

 

 

पेि 2: दसवीं और बारहवीं कक्षा के टॉपसड की तस्वीर िोडें। उपयुक्त टेबि में और उिके िाम के सामिे छात्र की 

तस्वीर प्रदर्शडत करिे के निए समायोिि करें। िैसा फक इस पृष्ठ को कािे रांग में मुफद्रत फकया िा सकता ह,ै उन्हें 

उनचत कां ट्रास  ्ट के साथ गे्रस्केि में पररवर्तडत करें। 

पेि 3: इस पेि पर दी गई स  ्टाइि में कुछ सांगत नचत्र िोडें। नचत्रों पर कम से कम दो प्रकार के इमेि फफ़ल्टर 

एप  ्िाय करें। 

 

 

मास्टर उफदत अपिे ड्राइांग नशक्षक को निनिटि ड्राइांग बिािे में मदद कर रह ेहैं। उिके नशक्षक 

िे उन्हें निम्ननिनखत दो नचत्र बिािे के निए चरणों को निखिे के निए कहा। पहिी ड्राइांग में, 

वस्तुओं को समूहीकृत फकया िाता ह ैऔर दसूरी ड्राइांग को पहिी ड्राइांग की वस्तुओं का 

आकार दकेर बिाया गया था। राइटर के ड्रॉइांग टूल्स का उपयोग करके आप उसकी मदद कैसे करेंगे?  

 

 नमस रोशिी ि े

एक फ्िोचाटड को अपिी ररपोटड में शानमि करिे के निए िाउििोि फकया ह।ै वह फ्िोचाटड की एक सांपादि योग्य 

प्रनतनिनप बिािे में आपकी मदद माांगती ह।ै राइटर के ड्रॉइांग टूल्स का उपयोग करके इसे बिािे के निए चरण 

निखें। 
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अध्याय 3. राइटर की उन्नत नवशषेताएां 

3.1 पररचय 

िैसा फक हम सभी िािते हैं फक निब्र ेऑफिस राइटर एक विड प्रोसेसर ह ैिो नवनभन्न प्रकार की सुनवधाए ँप्रदाि 

करता ह।ै हमिे पहिे से ही कुछ नवशेषताओं को सीखा है िैसे फक िॉमेट, सांपादि, टेबल्स और नचत्र सनम्मनित 

करिा, टेक  ्स  ्ट को स्टाइि करिा और िॉक  ्यूमेंट में ग्राफिक्स सनम्मनित करिा। इस अध्याय में हम निब्र ेऑफिस 

राइटर की कुछ उन्नत नवशेषताओं के बारे में िािेंगे, नििका उपयोग प्रोिेशिि िॉक्यूमेंट बिािे के निए फकया 

िाएगा। िॉक  ्यूमेंट की सामग्री की निसस्टांग दिेे के निए, हम टेबि ऑफ़ कॉन्टेंट्स िीचर का उपयोग कर सकते हैं 

िो नवनभन्न प्रकार की हसेिांग स  ्टाइि पर आधाररत ह।ै निब्र ेऑफिस राइटर प्रोिेशिि िॉक्यूमेंट बिािे के निए 

टेम््िेट भी प्रदाि करता ह।ै िब कई िोग एक ही िॉक  ्यूमेंट पर काम कर रह ेहोते हैं तो प्रत्येक व  ्यनक्त द्वारा फकए 

िा रह ेसांपादि का टै्रक रखिे के निए टै्रक पररवतडि सुनवधा का उपयोग फकया िा सकता ह।ै 

 

3.2 सामग्री की टेबि 

िौवीं कक्षा में, हमिे एक िॉक  ्यूमेंट में टेबि को सनम्मनित करिा सीखा था िहाँ िटेा को एक रो और कॉिम के 

िॉमेट में दशाडया गया था। इस अध्याय में हम नवषय-निस  ्ट (टीओसी) पर चचाड करेंगे। आपिे अपिी पुस्तकों की 

शुरुआत में सामग्री की टेबि दखेी होगी। इसमें उि नवषयों और उप-नवषयों की एक निस  ्ट शानमि है, निन्हें 

पुस्तक में पृष्ठ सांख्या के साथ कवर फकया गया ह ैिसैा फक नचत्र 3.3 में फदखाया गया ह।ै 

 

“Table of Contents”, एक िॉक  ्यूमेंट में सामग्री की एक स्वचानित टेबि सनम्मनित करिे की सुनवधा दतेी ह।ै 

इस टेबि की प्रनवनष्टयाँ या सामग्री िॉक  ्यूमेंट के हसेिांग और सब हसेिांग से स्वचानित रूप से िी िाती हैं। इसके 

अिावा, इि सामनग्रयों को टेबि में हाइपरसिांक फकया गया ह।ै इसनिए सामग्री की टेबि में फकसी भी नवषय पर 

नक्िक करके, हम सीधे चयनित नवषय पर िेनवगेट कर सकते हैं। िेफकि सामग्री की टेबि बिािे से पहिे, आपको 

सबसे पहिे शीषडकों की पदाििुम की अवधारणा को समझिा होगा। 

3.2 Hierarchy of Headings शीषडकों का पदाििुम 

निब्र ेऑफिस राइटर H1 से H10 के शीषडकों के 10 स्तरों का समथडि करता ह।ै इि शीषडकों को िॉक  ्यूमेंट के 

शीषडकों पर िाग ूफकया िाता ह।ै निम्न प्रफिया प्रदर्शडत करेगी फक इि शीषडकों को िॉक  ्यूमेंट में शीषडकों पर कैस े

िाग ूफकया िाए। 

चरण 1. निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट बिाएां और टेक  ्स  ्ट शीषडक 1 से शीषडक 10 दिड करें िैसा फक 

नचत्र 3.1 में फदखाया गया ह।ै 



  

41 

 

 

नचत्र 3.1 Hierarchy of Headings शीषडकों का पदािुिम 

 

चरण 2. राइट साइि बार से स्टाइल्स बटि पर नक्िक करें। Paragraph Styles और फिर Headings पर 

नक्िक करें। स्टाइल्स िायिॉग सवांिो हसेिांग 1 से हसेिांग 10 तक हसेिांग की निस  ्ट प्रदर्शडत करेगी िैसा फक नचत्र 3.1 

में फदखाया गया ह।ै 

चरण 3. िॉक्यूमेंट में टाइप फकए गए कसडर को हसेिांग 1 पर रखें। फिर स्टाइल्स िायिॉग सवांिो से हसेिांग 1 पर 

नक्िक करें। 

चरण 4. Heading 2 to Heading 10 के निए चरण 2 को दोहराएां। 

चरण 5. ध्याि दें फक हसेिांग 1 से हसेिांग 10 को document  के हसेिांग 1 से हसेिांग 10 तक एप  ्िाइ फकया िाता ह ै

और इि हसेिांग को ए्िाइि स्टाइि में बदि फदया गया ह ैिैसा फक नचत्र 3.2 में फदखाया गया ह।ै नचत्र 3.1 और 

नचत्र 3.2 में पररवतडि पर ध्याि दें। 

 
नचत्र 3.2 10 Headings िगािे के बाद िॉक  ्यूमेंट 

 

एक बार वाांनछत शीषडक स  ्टाइि को िॉक  ्यूमेंट में एप  ्िाइ कर फदया िाता ह,ै उसी hierarchy को सामग्री की 

टेबि में भी फदखाया िाएगा। 

3.2 सामग्री टेबि (टीओसी) बिािा 

इससे पहिे फक हम फकसी िॉक  ्यूमेंट में सामग्री या टीओसी की टेबि बिािा शुरू करें, हमें यह सुनिनित करिा 

होगा फक उनचत हसेिांग स्टाइि, िैसे हसेिांग 1, हसेिांग 2, हसेिांग 3 और इसी तरह िॉक  ्यूमेंट में िािे िाए।ँ सही 

टीओसी केवि तभी उत्पन्न होगी िब शीषडकों के निए उनचत पैराग्राफ़ स्टाइि को िॉक  ्यूमेंट में िाग ूफकया िाए। 

स्टाइि िॉक्यूमेंट बििे के बाद, फदए गए िॉक्यूमेंट में TOC िाििे के निए िीचे फदए गए चरणों का पािि करें:  

चरण 1. पहिे बिाई गई फ़ाइि को खोिें "document.odt"। 

चरण 2. स्टाइल्स िायिॉग बॉक्स से िॉक्यूमेंट में नवनभन्न हसेिांग पर उनचत हसेिांग स्टाइि असाइि करें। एक 

उदाहरण के निए, हिेर स  ्टाइि को “documentation.odt” फ़ाइि में नचत्र 3.3 में फदखाया गया ह।ै 
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नचत्र 3.3 headings styles प्रदाि करिे की योििा 

चरण 2. कसडर को उस नस्थनत पर रखें िहाां सामग्री की टेबि िािी िािी ह।ै आम तौर पर यह िॉक  ्यूमेंट की 

शुरुआत में ह।ै 

चरण 3. मुख्य मेिू स,े Insert > Table of Contents and Index >Table of Contents, Index or 

Bibliography. The Table of Contents, Index and Bibliography चिुें, िसैा बॉक्स नचत्र 3.4 में 

फदखाया गया ह।ै 

 

नचत्र 3.4 Table of Contents, Index or Bibliography dialog बॉक्स 

 

चरण 4. निफ़ॉल्ट रूप स,े टाइप टैब को िायिॉग बॉक्स के दाईं ओर TOC के preview के साथ चिुा िाएगा। 

dialog box के बाईं ओर, प्रकार और शीषडक अिुभाग ह।ै शीषडक टेक  ्स  ्ट बॉक्स में, TOC का निफ़ॉल्ट िाम, 

अथाडत । सामग्री की टेबि प्रदर्शडत की गई ह।ै आप केवि टेक्स्ट बॉक्स पर निखकर इस िाम को बदि सकते हैं। 

TOC का वाांनछत शीषडक टाइप करें "शीषडक" शीषडक टेक  ्स  ्ट बॉक्स में। शीषडक Preview भाग में बदिा िाएगा 

िैसा नचत्र 3.4 में फदखाया गया ह।ै 

निफ़ॉल्ट रूप से, Protected against Manual Changes के निए चेकबॉक्स का नसिेक्शि फकया िाता 

ह।ै यह TOC को फकसी आकनस्मक पररवतडि से बचाता ह।ै यफद यह बॉक्स unchecked ह,ै तो टीओसी की 

सामग्री को सीधे िॉक  ्यूमेंट पृष्ठ पर बदिा िा सकता ह,ै िसैे िॉक  ्यूमेंट पर कोई अन्य टेक  ्स  ्ट। 

इांिके्स निस  ्ट बिाएां या टेबि में, निस  ्ट निस  ्ट बॉक्स में सांपूणड िॉक  ्यूमेंट नवकल्प का नसिेक्शि फकया िाता ह।ै 

इसनिए टीओसी स्वचानित रूप से पूरे िॉक  ्यूमेंट के हसेिांग और सब-हसेिांग से बिाई िाएगी। 

आउटिाइि चेक बॉक्स का नसिेक्शि फकया िाता ह,ै इसनिए TOC की पूरी outline preview में फदखाई िाती 

ह।ै यफद आप इसे दखेिा िहीं चाहते हैं तो नक्िक करें और इसे हटा दें। 

चरण 5. ओके बटि पर नक्िक करें। िॉक  ्यूमेंट में टेबि की सामग्री insert की िाएगी िैसा फक नचत्र 3.5 में 

फदखाया गया ह।ै 
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नचत्र 3.5 फकसी िॉक  ्यूमेंट में insert की गई सामग्री की टेबि 

ध्याि दें फक टीओसी में पृष्ठ सांख्याओं के साथ सभी headings फदखाई देंगे। टीओसी में प्रनवनष्टयाां हाइपरसिांक हैं। 

फकसी भी प्रनवनष्ट पर माउस पॉइांटर िे िािे से headings के बाद हाइपरसिांक खोिि ेके निए Ctrl-नक्िक करि े

के निए एक टूि रटप फदखाई दगेी। Ctrl-नक्िक करिे पर कसडर सीधे चयनित अिभुाग शीषडक पर चिा िाएगा।  

प्रायोनगक गनतनवनध 1 - ररमनझम िे निब्र ेऑफिस राइटर में पयाडवरण प्रदषूण पर एक ररपोटड बिाई ह।ै उसिे 

िॉक  ्यूमेंट के सभी अिुभाग शीषडकों के निए उनचत headings स  ्टाइि को िाग ू फकया ह।ै अब, िॉक  ्यूमेंट की 

सामग्री को ररमनझम की सामग्री की टेबि के रूप में शीषडक के साथ िोडें। 

 

चरण 1. निब्र ेऑफिस राइटर में िॉक  ्यूमेंट खोिें। 

चरण 2. Insert > Table of Contents and Index > Table of Contents, 

Index or Bibliography नसिेक्शि करें। Table of Contents, Index and Bibliography dialog 

box प्रदर्शडत फकया िाएगा। 

चरण 3. टाइटि टेक्स्ट बॉक्स में टाइप करें, ररमनझम की सामग्री टेबि टाइप करें। 

चरण 4. ओके बटि पर नक्िक करें। ररमनझम के िॉक  ्यूमेंट में सामग्री की टेबि िािी िाएगी। 
 

3.2.3. टीओसी का अिकूुिि Customization 

एक बार TOC िाििे के बाद, हम अपिी आवश्यकताओं के अिुसार इस ेअिुकूनित कर सकते हैं। ऐसा करिे के 

निए TOC पर कहीं भी राइट नक्िक करें और पॉप अप मेिू से Edit Index नवकल्प चुिें िैसा फक नचत्र 3.6 में 

फदखाया गया ह।ै 

 

नचत्र. 3.6 पॉप अप मेिू से सांपादि सूचकाांक नवकल्प का नसिेक्शि करिा 

Table of Contents, Index or Bibliography के िायिॉग बॉक्स को नचत्र 3.7 में फदखाया गया ह।ै 

िैसा फक नपछिे भाग में दखेा गया है, िायिॉग बॉक्स में पाँच टैब हैं - Type, Entries, Styles, Columns 
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and Background। इि टैब के नवकल्पों का उपयोग नवनभन्न तरीकों से टेबि को सांपाफदत करिे के निए फकया 

िा सकता ह।ै फकए गए पररवतडि िायिॉग बॉक्स के Preview अिुभाग में फदखाई देंगे। 

 

नचत्र 3.7 Table of Contents, Index or Bibliography dialog window का नसिेक्शि 

 

टाइप टैब - यह TOC सनम्मनित करिे के निए सामग्री, प्रनवनष्टयाँ या ग्रांथ निस  ्ट िायिॉग बॉक्स खोििे के बाद 

निफ़ॉल्ट रूप से सफिय ह।ै 

एांट्री टैब - इस टैब में टीओसी में नवनभन्न प्रनवनष्टयों के निए स  ्टाइि को सेट करिे के नवकल्प होते हैं। 

स्टाइल्स टैब - इस टैब में सामग्री की टेबि में प्रत्येक स्तर के टेक  ्स  ्ट में वाांनछत स  ्टाइि को िागू करिे के नवकल्प 

होते हैं। फकसी भी स्तर पर एक कस्टम पैराग्राि स  ्टाइि िाग ूकरिे के निए, निम्न चरणों का पािि करें : 

चरण 1. नक्िक करें और स्तर निस  ्ट बॉक्स से स्तर का नसिके्शि करें। 

चरण 2. नक्िक करें और पैराग्राि स्टाइि निस  ्ट बॉक्स से वाांनछत पैराग्राि स  ्टाइि का नसिेक्शि करें।  

चरण 3. चयनित रूपरेखा स  ्टाइि को चयनित रूपरेखा स्तर पर िाग ूकरिे के निए <बटि पर नक्िक करें। निर्दडष्ट 

स  ्टाइि Levels list में वगाडकार कोष्ठक में फदखाई दतेी ह ैऔर Preview pane में भी फदखाई दगेी। 

चरण 4. चयनित स  ्टाइि को िागू करिे के निए ओके बटि पर नक्िक करें। 

िाग ू पैराग्राि स्टाइसिांग को हटािे के निए, स्तर निस  ्ट बॉक्स में वाांनछत स्तर का नसिेक्शि करें और फिर 

निफ़ॉल्ट बटि पर नक्िक करें। 

कॉिम टैब - इस टैब में उि कॉिम की सांख्या निधाडररत करिे के नवकल्प होते हैं, निन्हें हम अपिे TOC में रखिा 

चाहते हैं। 

बकैग्राउांि टैब - इस टैब में TOC की पृष्ठभूनम को बदििे के नवकल्प होते हैं िैसा फक नचत्र 3.8 में फदखाया गया ह।ै 

वतडमाि पृष्ठभूनम का रांग सफिय रांग सवांिो में प्रदर्शडत फकया िाएगा। 

 

नचत्र 3.8 Table of Contents, Index or Bibliography dialog window में Background Tab 

पृष्ठभूनम का रांग बदििे के निए निम्ननिनखत चरणों का पािि करें। 

चरण 1. िायिॉग बॉक्स के शीषड पर नस्थत रांग बटि पर नक्िक करें। 
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चरण 2. रांग पैिेट से वाांनछत रांग का नसिेक्शि करें। चयनित रांग न्यू किर सवांिो में फदखाई दगेा। 

चरण 3. कस्टम पैिेट में चयनित रांग िोडिे के निए, रांग पैिेट के िीचे बटि िोडें पर नक्िक करें। अब, िब भी 

आवश्यक हो, िोडा गया रांग फिर से उपयोग फकया िा सकता ह।ै 

चरण 4. TOC पर वाांनछत रांग िाग ूकरिे के निए OK नक्िक करें। 

 
नचत्र 3.9 बदिे background color पृष्ठभूनम रांग के साथ TOC 

TOC से पृष्ठभूनम का रांग निकाििे के निए, िायिॉग बॉक्स के शीषड पर मौिूद कोई भी बटि पर नक्िक करें। 

निब्र ेऑफिस राइटर भी टीओसी की पृष्ठभूनम के रूप में ग्राफिक को िोडिे की सुनवधा दतेा ह।ै 

इसके निए, िायिॉग बॉक्स की पृष्ठभूनम टैब में नबटमैप बटि का नसिेक्शि करें। वाांनछत ग्राफिक नवकल्प चुिें और 

ओके बटि पर नक्िक करें।  

 

 
नचत्र 3.10 background of the के रूप में ग्राफिक िोडिा 

 

3.2.4 सामग्री की टेबि का रखरखाव करिा 

िैसा फक हम अब िािते हैं फक फकसी भी समय फकसी भी नवषय पर सांपूणड टेबि का एक स्नैपशॉट सामग्री होती ह।ै 

यफद िॉक  ्यूमेंट अिुभाग शीषडकों या पृष्ठ िमाांकि में कोई पररवतडि फकया िाता ह,ै तो इसे सामग्री टेबि में भी 

प्रनतसबांनबत फकया िािा चानहए। सामग्री को बिाए रखिे में TOC को अपिटे करिा और TOC को हटािा 

शानमि ह ै
 

राइटर TOC को स्वचानित रूप से अपिटे िहीं करता ह।ै निम्ननिनखत गनतनवनध मैन्युअि रूप से TOC अपिेट 

करिे के निए प्रदर्शडत होगी। 

 

प्रायोनगक गनतनवनध 2 - िॉक  ्यूमेंट में कुछ और खांि िोड ेिाते हैं, तदिुसार टीओसी को बदििा होगा। TOC को 

मैन्युअि रूप से अपिटे करिे के निए, निम्न चरणों का पािि करें। 

चरण 1. टीओसी में कहीं भी राइट-नक्िक करें। 

 

चरण 2. पॉप-अप मेिू से िैसा फक नचत्र 3.11 में फदखाया गया है, अपिटे इांिके्स नवकल्प का नसिेक्शि करें। 

राइटर TOC को अपिटे करता ह ैताफक िॉक  ्यूमेंट में फकए गए फकसी भी 
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 पररवतडि को प्रनतसबांनबत फकया िा सके। TOC में फदखाई दिेे वाि ेपररवतडि नचत्र 3.12 में फदखाए गए हैं। 

                              

नचत्र 3.11 TOC को अपिेट करिे और                        नचत्र 3.12 अपिेटेि TOC  

सांपाफदत करिे के निए नवकल्पों का नसिेक्शि करिा  

 

टीओसी Delete करिा 

TOC को हटािे के निए, टेबि पर राइट नक्िक करें और पॉप-अप मेिू से नििीट इांिेक्स नवकल्प चुिें। टीओसी को 

हटा फदया िाएगा 

प्रायोनगक गनतनवनध2 - टीओसी िािे िािे के बाद ररमनझम िे अपिे िॉक्यूमेंट को सांपाफदत फकया ह।ै अब वह 

TOC को अपिटे करिा चाहती ह ैऔर गुिाबी रांग का बैकग्राउांि भी चाहती ह।ै ररमनझम को निि चरणों का 

पािि करिा चानहए, उन्हें निखें। 

चरण 1. TOC को अपिटे करिे के निए, TOC में कहीं भी राइट-नक्िक करें। पॉपअप मेिू से, अपिटे इांिके्स 

नवकल्प का नसिेक्शि करें िसैा फक नचत्र 3.11 में फदखाया गया ह।ै 

चरण 2. रांगीि पृष्ठभूनम को िागू करिे के निए, टीओसी पर कहीं भी राइट नक्िक करें और पॉप अप मेिू से 

सांपादि सूचकाांक नवकल्प का नसिेक्शि करें। 

चरण 3. सामग्री टेबि, सूचकाांक या ग्रांथ निस  ्ट िायिॉग बॉक्स से, पृष्ठभूनम टैब का नसिेक्शि करें। वतडमाि 

पृष्ठभूनम का रांग सफिय रांग सवांिो में प्रदर्शडत फकया िाएगा। 

चरण 4. िायिॉग बॉक्स के शीषड पर नस्थत रांग बटि पर नक्िक करें। 

चरण 5. किसड पैिेट से वाांनछत रांग का नसिेक्शि करें। चयनित रांग न्यू किर सवांिो में फदखाई दगेा। 

चरण 6. TOC पर वाांनछत रांग िाग ूकरिे के निए OK नक्िक करें। 
 

 

3.3 टेम्पिेट का उपयोग करिा 

एक टेम्पिेट एक पूवड निधाडररत िेआउट ह ैिो आसािी से प्रोिेशिि और / या औपचाररक िॉक  ्यूमेंट बिािे में 

मदद करता ह।ै नपछिे अध्यायों में, हमिे टेम््िेट का उपयोग करके नवनभन्न िॉक  ्यूमेंट ऑब्िेक्ट की स्टाइसिांग 

सीखी ह।ै इस खांि में, हम िॉक  ्यूमेंट टेम्पिेट बिािा सीखेंगे।  
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कभी-कभी ग्राफिक्स सनहत नवनशष्ट सामग्री को कॉपी करिे की आवश्यकता होती ह,ै िैसे फकसी कां पिी का िोगो, 

फकसी उत्पाद या टेक्स्ट की इमेि िैसे फकसी उत्पाद या कांपिी के टैग िाइिों, कािूिी िोरटस या यहाां तक फक हिेर 

और फु़टर िैसे कई दस्तावेज़ों में। 

सभी दस्तावेिों में वस्तुओं को िोडि ेऔर फिर िॉमेट करि े के बिाय, हम टेम््िेट का उपयोग कर सकत ेहैं। 

उदाहरण के निए, ररज्यूम, चै्टर या प्रोिेक्ट ररपोटड बिािे के निए टेम््िेट का उपयोग फकया िा सकता ह।ै एक 

टेम््िेट में सभी नवशेषताएां या ऑब्िेक्ट शानमि हो सकते हैं िो एक नियनमत िॉक  ्यूमेंट में हो सकते हैं - टेक  ्स  ्ट, 

ग्राफिक्स, स  ्टाइि और यहाां तक फक फकसी भी भाषा का उपयोग कर सकते हैं। एक टेम््िेट में हम पररभानषत 

हसेिांग, टेक्स्ट िॉमेट, स्टाइि, पेि िांबर, हिेर और िूटर बिा और सेव कर सकत ेहैं। िब इि टेम््िेट से िए 

िॉक्यूमेंट बिाए िाते हैं, तो उिमें एक ही कां टेंट सेग्रीगेशि, िॉमेटटांग िीचसड और अ्िाइि टेम््िेट की तरह ही 

उपनस्थनत होती ह।ै  

सी समय, राइटर हमें उस िॉक  ्यूमेंट की स  ्टाइि और सामग्री को सांपाफदत करिे की भी सुनवधा दतेा ह ैनिस पर 

टेम्पिेट िागू फकया गया ह।ै राइटर के सभी िॉक्यूमेंट टेम््िेट पर आधाररत होते हैं। यफद कोई नवनशष्ट टेम््िेट 

निर्दडष्ट िहीं फकया गया ह,ै तो राइटर द्वारा बिाई िा रही फ़ाइि के निए blank िॉक  ्यूमेंट टेम्पिेट के रूप में 

निफ़ॉल्ट टेम्पिेट का उपयोग करता ह।ै  

 

िॉक  ्यमूेंट के टेम्पिटे की िाचँ करिा 

यह दखेिे के निए फक िॉक  ्यूमेंट में कौि सा टेम्पिेट िुडा हआ ह,ै फ़ाइि मेिू से Properties नवकल्प चुिें। यह 

Properties िायिॉग बॉक्स प्रदर्शडत करेगा। Properties िायिॉग बॉक्स नचत्र 3.13 में फदखाया गया ह।ै चूांफक 

िॉक  ्यूमेंट निफ़ॉल्ट टेम्पिेट से बिाया गया था, इसनिए कोई भी टेम्पिेट नचत्र 3.13 में निस  ्ट में िहीं ह।ै 

 

नचत्र 3.13 कोई टेम्पिेट के साथ िॉक  ्यूमेंट Properties 

 

िब िॉक  ्यूमेंट टेम्पिेट के साथ बिाया िाता ह,ै तो यह सवांिो टेम्पिेट का िाम प्रदर्शडत करेगी। उदाहरण के निए, 

यफद आप टेम्पिेट के साथ एक िॉक  ्यूमेंट बिािा चाहते हैं। निम्न चरणों का पािि करें। 

चरण 1. File > New > Templates से एक िया िॉक  ्यूमेंट बिाएां ... 

चरण 2. एक टेम्पिेट नसिेक्शि सवांिो प्रदर्शडत की िाएगी िैसा फक नचत्र 3.14 में फदखाया गया ह।ै उदाहरण के 

निए एक टेम्पिेट का नसिेक्शि करें, पहिा टेम्पिेट "Modern business letter" चुिें। 
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चरण 3. ओपि बटि पर नक्िक करें, चयनित टेम्पिेट के साथ एक िॉक  ्यूमेंट खुि िाएगा िैसा फक नचत्र 3.15 में 

फदखाया गया ह।ै 

           

नचत्र 3.14 एक टेम्पिेट का नसिेक्शि करिा        नचत्र 3.15 नसिेक्शि करके बिाया गया िॉक  ्यूमेंट  

 

चरण 3. अब File> Properties स ेबिाए गए िॉक्यूमेंट के टेम्पिेट को चेक करें। ध्याि दें फक टेम्पिेट का िाम 

“Modern business letter sans serif“ नचत्र िायिॉग बॉक्स में टेम्पिेट के तहत प्रदर्शडत फकया 

गया ह ैिैसा फक नचत्र 3.16 में फदखाया गया ह।ै 

 

 
नचत्र 3.16 Modern business letter के िाम के साथ िॉक  ्यूमेंट Properties  

 

3.3.1 Creating a Template टेम्पिेट बिािा 

आपिे ऊपर दखेा ह ैफक predefined टेम्पिेट के साथ िॉक  ्यूमेंट कैसे बिाया िाता ह।ै भनवष्य के उपयोग के निए 

अपिे स्वयां के टेम्पिेट बिािा और वतडमाि स  ्टाइि और िॉक  ्यूमेंट की उपनस्थनत को सेव करिा भी सांभव ह।ै 

Writer में टेम्पिेट बिािे और सेव करिे के निए निम्न चरणों का पािि करें। 

चरण 1. निबे्र ऑफिस राइटर में िॉक्यूमेंट खोिें, निसका टेम्पिेट बिािा ह।ै 

चरण 2. मुख्य मेिू बार से, File > Templates > Save चुिें। Save As Template िायिॉग बॉक्स नचत्र 

3.17 में फदखाया गया ह।ै 

चरण 3. Template Name टेक  ्स  ्ट बॉक्स में िए टेम्पिेट (T1) का िाम टाइप करें। 

  
नचत्र 3.17 टेम्पिेट िायिॉग बॉक्स के रूप में सेव करें  
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चरण 4. बिाए िा रह ेटेम्पिेट की शे्रणी का नसिेक्शि करें। एक शे्रणी एक फ़ोल्िर की तरह ह ैिो टेम्पिेट्स को 

व्यवनस्थत करिे में मदद करता ह।ै कुछ शे्रनणयाां िो िायिॉग बॉक्स में दखेी िा सकती हैं, वे हैं मेरा टेम््िेट, 

नबििेस कॉरेस्पॉन्िेंस, ऑििाइि नबििेस िॉक्यूमेंट, पे्रिेंटेशि। 

चरण 5. वतडमाि टेम्पिेट को निफ़ॉल्ट टेम्पिेट बिाि ेके निए निफ़ॉल्ट टेम्पिेट चेकबॉक्स के रूप में सेट करें पर 

नक्िक करें और चिुें। 

चरण 6. टेम्पिेट को बचािे के निए सेव बटि पर नक्िक करें। राइटर में एक टेम््िेट को एक .ott के साथ सहिेा 

िाता ह।ै अब इस टेम््िेट फ़ाइि का उपयोग निब्र ेऑफिस राइटर में फकसी भी िॉक्यूमेंट द्वारा फकया िा सकता ह।ै 

 

3.3.2 इि-नबल्ट / सवे्ि टेम््िटे का उपयोग करिा 

निब्र ेऑफिस हमारे द्वारा बिाए और सहिेे गए इि-नबल्ट टेम््िेट, ऑििाइि टेम््िेट के साथ-साथ टेम््िेट का 

उपयोग करिे की सुनवधा दतेा ह।ै िॉक  ्यूमेंट को स्टाइि करिे के निए predefined टेम्पिेट का उपयोग करिे के 

निए निम्ननिनखत चरणों का पािि करें। 

 

चरण 1. निब्र ेऑफिस राइटर में िया िॉक  ्यूमेंट खोिें। 

चरण 2. मुख्य मेिू बार से, File > Templates > Manage Templates नसिेक  ्ट करें। टेम््िेट िायिॉग 

बॉक्स खोििे के निए आप कीबोिड शॉटडकट की Ctrl + Shift + N का भी उपयोग कर सकते हैं। टेम््िेट िायिॉग 

बॉक्स को नचत्र 3.18 में फदखाया गया ह ैिो सभी उपिब्ध टेम््िेट की निस  ्ट फदखा रहा ह।ै ध्याि दें फक यह नपछिे 

अिुभाग में निर्मडत टेम््िेट T1 को भी फदखाता ह।ै 

 

 
नचत्र 3.18 टेम्पिेट्स िायिॉग बॉक्स 

 

चरण 3. वाांनछत टेम्पिेट का नसिेक्शि करें, (टी 1 कहें) और ओपि बटि पर नक्िक करें। िया िॉक  ्यूमेंट (िाम के 

साथ शीषडक रनहत) उसी सामग्री के साथ खोिा िाएगा, िो सेव फकए गए टेम््िेट के रूप में प्रभाव और िॉमेट 

होगा। 

चरण 4. वाांनछत पररवतडि करें और फ़ाइि को सेव करें। 

 

प्रायोनगक गनतनवनध 3 - नियाज़ एक कपडा कारखािे में काम करता ह।ै उसे अपिे कारखािे में नििाइि फकए गए 

प्रत्येक पररधाि की ररपोटड और नसिाई दिेी होगी। उिका प्रबांधक प्रत्येक पररधाि के निए एक ही प्रकार की ररपोटड 

चाहता ह।ै हर बार टाइप करिे के बिाय, उन्हें राइटर की टेम्पिेट सुनवधा का उपयोग करिे का सुझाव फदया गया 

ह।ै वह अपिा निफ़ॉल्ट टेम््िेट बिािा चाहता ह ैऔर फिर एक ही िॉमेट और स  ्टाइि के साथ कई ररपोटड बिािे के  
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निए इसका उपयोग करता ह।ै इस कायड को पूरा करिे के निए समाधाि दें। 

प्रफिया 

Writer में टेम्पिेट बिािे और सेव करिे के निए निम्न चरणों का पािि करें। 

चरण 1. िॉक  ्यूमेंट बिाएां या खोिें निसका टेम्पिेट बिािा ह।ै 

चरण 2. मुख्य मेि ूबार स,े File > Templates > Save चिुें। Save As टेम्पिेट िायिॉग बॉक्स नचत्र 3.17 

में फदखाया गया ह।ै 

चरण 3. टेम्पिेट िाम टेक  ्स  ्ट बॉक्स में िए टेम्पिेट (Niaz_template) का िाम टाइप करें। 

चरण 4. टेम्पिेट की शे्रणी का नसिेक्शि करें (व्यवसाय पत्राचार) 

चरण 5. नक्िक करें और निफ़ॉल्ट टेम्पिेट चेकबॉक्स के रूप में सेट का नसिेक्शि करें। 

चरण 6. एक्सटेंशि .ott के साथ टेम्पिेट को बचािे के निए Save बटि पर नक्िक करें। अब  

टेम्पिेट का उपयोग करिे के निए निम्ननिनखत चरणों का पािि करें। 
 

चरण 1. File > Templates > Manage Templates चुिें। 

चरण 2. टेम्पिेट टेम्पिेट स ेवाांनछत टेम्पिेट, (Niaz_template) का नसिेक्शि करें। 

चरण 3. ओपि बटि पर नक्िक करें। नबिा शीषडक के िाम वािा िया िॉक  ्यूमेंट, सेव फकए गए टेम््िेट के समाि 

सामग्री, उपनस्थनत और िॉमटे प्रभाव के साथ खोिा िाएगा। 

चरण 4. वाांनछत पररवतडि करें और फ़ाइि को सेव करें। 
 

3.3.3 ऑििाइि टेम््िटे का उपयोग करिा 

निब्र ेऑफिस ऑििाइि टेम्पिेट्स की एक नवस्तृत शृ्रांखिा प्रदाि करता ह ैनिसे इांटरिटे से िाउििोि फकया िा 

सकता ह।ै एक बार िब ये टेम्पिेट आपके कां ्यूटर पर स्थानपत हो िाते हैं, तो वे टेम््िेट सवांिो में फदखाई देंगे। 

चरण 1. निब्र ेऑफिस राइटर के मेि मेन्यू बार से, File > Templates > Manage Templates चुिें। 

चरण 2. टेम्पिेट िायिॉग बॉक्स नचत्र 3.18 में फदखाया गया ह।ै Help बटि के ऊपर निचिे बाएां कोिे में छोटे 

गोि आइकि ब्राउज़ ऑििाइि टेम्पिेट दखेें। 

 
नचत्र 3.19 टेंपिेट िायिॉग बॉक्स में ऑििाइि टेम््िेट नवकल्प 

चरण 3. टेम््िेट सवांिो के िीचे बाईं ओर नस्थत ब्राउि ऑििाइि टेम््िेट बटि पर नक्िक करें। ओपि ऑफफ़स 

राइटर (https: // एक्सटेंशि.libreoffice.org/templates) का आनधकाररक टेम््िेट पृष्ठ ब्राउज़र में खुि 

िाएगा िैसा फक नचत्र 3.20 में फदखाया गया ह।ै 
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नचत्र 3.20 libreoffice.org का आनधकाररक टेम््िेट पेि 

चरण 1. यफद आप फकसी भी टेम्पिेट पर नक्िक करते हैं, तो आपको उस टेम्पिेट के बारे में नवस्तृत िािकारी 

फदखाई दगेी। 

चरण 2. वाांनछत टेम्पिेट िाउििोि करें, कैिेंिर निमाडता से इसे अपिे कां ्यूटर पर सेव करें। 

चरण 3. ओपि निब्र ेऑफिस राइटर। 

चरण 4. File > Templates > Open Template पर नक्िक करें ... 

चरण 5. ओपि िायिॉग बॉक्स से, टेम्पिेट कां पिी पत्र के निए ब्राउज़ करें, निसे खोिा िािा ह,ै और ओपि बटि 

पर नक्िक करें। 

चरण 6. टेम्पिेट फ़ाइि Comapny Letter.ott खुि िाएगा। 

चरण 7. सामग्री या उपनस्थनत में वाांनछत पररवतडि करें। 

चरण 8. फ़ाइि को टेक्स्ट फ़ाइि Comapny Letter.odt के रूप में सेव करें। Libreoffice.org 

https://extensions.libreoffice.org/extensions पर भी एक्सटेंशि प्रदाि करता ह।ै य े स्वतांत्र 

programs हैं निन्हें मुख्य मौिूदा एन्िकेशि से िोडा या हटाया िा सकता ह।ै 

कुछ टेम्पिेट एक्सटेंशि के रूप में उपिब्ध हैं निन्हें हमारे कां ्यूटर पर िाउििोि और इांस्टॉि फकया िा सकता ह।ै 

 

3.3.4 Template Import करिा 

एक बार टेम्पिेट को फकसी भी फ़ाइि या फ़ोल्िर में िाउििोि करिे और सेव करि ेके बाद, इसे इांपोटड करिा 

सांभव ह,ै ताफक टेम््िेट िायिॉग बॉक्स में टेम्पिेट की निस  ्ट में फदखाई द।े टेम्पिेट इांपोटड करिे के निए निम्न 

चरणों का उपयोग करें।  

चरण 1. टेम्पिेट िायिॉग बॉक्स खोिें। 

चरण 2. िायिॉग बॉक्स के निचिे दाएां कोिे में नस्थत इांपोटड टेम्पिेट्स बटि पर नक्िक करें। शे्रणी का नसिेक्शि 

करें िायिॉग बॉक्स खुिेगा िैसा फक नचत्र 3.21 में फदखाया गया ह।ै 

चरण 3. फकसी भी मौिूदा शे्रणी में िए टेम्पिेट को िोडिे के निए, निस  ्ट बॉक्स से उस शे्रणी को नक्िक करें और 

चुिें। अन्यथा नक्िक करें और एक िया शे्रणी बिाए ँचेक बॉक्स चुिें। 

चरण 4. टेक्स्ट बॉक्स में िई कैटेगरी का िाम टाइप करें। 
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नचत्र 3.21 श्रेणी िायिॉग बॉक्स का नसिेक्शि करें    नचत्र 3.22 टेम्पिेट्स इांपोटड फकया गया            टेम्पिेट िायिॉग बॉक्स 

चरण 5. ओके बटि पर नक्िक करें। ओपि िायिॉग बॉक्स फदखाई दगेा। 

चरण 6. उस फ़ोल्िर के निए ब्राउज़ करें िहाां िाउििोि की गई टेम्पिेट फ़ाइि कां पिी िैटर सेव फकया गया था। 

चरण 7. फ़ाइि का नसिेक्शि करें और ओपि बटि पर नक्िक करें। चयनित फ़ाइि को टेम््िेट की निस  ्ट में िोडा 

िाएगा िैसा फक नचत्र 3.22 में फदखाया गया ह।ै 

 
 

प्रायोनगक गनतनवनध 4 - नियाज़ के सहयोगी, बिसवांदर को अपिी कां पिी के सभी कमडचाररयों के निए राइटर का 

उपयोग करते हए एम््िॉई आईिी बिािी ह,ै िेफकि इसके निए कोई predefined टेम्पिेट िहीं ह।ै उसिे कुछ 

टेम््िेट खोिे हैं िो इांटरिेट से उसकी आवश्यकता के अिुरूप हैं। उसिे एक टेम््िेट बिािा और उसका उपयोग 

करिा सीख निया ह,ै िेफकि यह िहीं िािती ह ैफक इांटरिटे से ऑििाइि टेम््िेट कैसे िाउििोि करें और उसका 

उपयोग कैसे करें। 
 

इस समस्या को हि करिे के निए निम्न चरणों का पािि करें। 

चरण 1. निब्र ेऑफिस राइटर में िया िॉक  ्यूमेंट खोिें। 

चरण 2. कीबोिड शॉटडकट Ctrl + Shift + N का उपयोग करके टेम्पिेट िायिॉग बॉक्स खोिें। 

चरण 3. ऑििाइि टेम््िेट बटि पर नक्िक करें। 

चरण 4. ब्राउज़र में टेम््िेट पृष्ठ से वाांनछत टेम्पिेट, कमडचारी आईिी बैि पर नक्िक करें और नसिेक्शि करें, िैसा 

फक नचत्र 3.23 में फदखाया गया ह।ै टेम्पिेट का नववरण प्रदर्शडत फकया िाएगा। 

 
नचत्र 3.23 ऑििाइि टेम्पिेट कमडचारी आईिी बैि 

चरण 5. टेम्पिेट कमडचारी आईिी बैि िाउििोि करें और ब्राउज़र को बांद करें। निफ़ॉल्ट रूप से टेम्पिेट 

िाउििोि फ़ोल्िर में िाउििोि और सेव फकया िाता ह।ै 

चरण 6. टेम््िेट िायिॉग बॉक्स को फिर से खोिें और इांपोटड बटि पर नक्िक करें, िैसा फक नचत्र 3.24 में फदखाया 

गया ह।ै 
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नचत्र 3.24 इांपोटड टेम्पिेट पर नक्िक करिा 

चरण 7. चरण 7. इसके बाद शे्रणी का नसिेक्शि करें िायिॉग बॉक्स में शे्रणी का नसिेक्शि करें और OK बटि 

पर नक्िक करें िैसा फक नचत्र 3.25 में फदखाया गया ह।ै 

                             
नचत्र 3.25 Selecting Category              नचत्र 3.26 इांपोटड करिे के निए टेम्पिेट कमडचारी  

while importing Template                  आईिी बैि का नसिेक्शि करें 

चरण 8. टेम्पिेट कमडचारी नसिेक्शि बैि का नसिेक्शि करिे के निए िाउििोि फ़ोल्िर ब्राउज़ करें, िैसा फक 

नचत्र 3.26 में फदखाया गया ह।ै 

चरण 9. कमडचारी आईिी बैि टेम्पिेट िोडिे के निए ओपि बटि पर नक्िक करें। इम्पोटड फकया गया टेम््िेट नचत्र 

3.27 में फदखाए गए टेम््िेट की निस  ्ट में फदखाई दतेा ह।ै 

 
नचत्र. 3.27 टेम््िेट िायिॉग सवांिो में टेम््िेट की निस  ्ट अपिेट की गई 

 

चरण 10. कमडचारी आईिी बैि टेम्पिेट पर िबि नक्िक करें। चयनित टेम्पिेट के साथ एक िई सवांिो में एक िई 

फ़ाइि नचत्र 3.28 में फदखाई िाएगी। 

  
नचत्र 3.28 चयनित टेम्पिेट के साथ बिाया गया िया िॉक  ्यूमेंट 

चरण 11. वाांनछत पररवतडि करें और इसे िॉक  ्यूमेंट फ़ाइि के रूप में सेव करें। 

 

3.3.5 एक टेम्पिटे का सांपादि 

एक बार एक टेम््िेट बि िािे के बाद, िीचे फदए गए चरणों का पािि करके इसमें वाांनछत पररवतडि फकए िा 

सकते हैं। 

चरण 1. फ़ाइि> टेम्पिेट> टेम््िेट प्रबांनधत करें पर नक्िक करें। टेम््िेट 

िायिॉग बॉक्स प्रदर्शडत फकया िाएगा। 
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चरण 2. टेम्पिेट फ़ाइि (टी 1 कहें) पर राइट नक्िक करें निसे सांपाफदत करिा होगा। 

चरण 3. पॉप अप मेिू से सांपादि नवकल्प का नसिेक्शि करें। टेम््िेट फ़ाइि खोिी िाएगी। वाांनछत पररवतडि करें 

और फ़ाइि को सेव करें। अब यफद हम इस टेम्पिेट को फकसी भी िॉक  ्यूमेंट के निए िाग ूकरत ेहैं, तो सांपाफदत 

फ़ाइि का उपयोग फकया िाएगा। 

एक कस्टम निफ़ॉल्ट टेम्पिटे सटे करिा 

फकसी भी टेम्पिेट को निफ़ॉल्ट टेम्पिेट के रूप में सेट फकया िा सकता ह।ै राइटर एक निफ़ॉल्ट टेम्पिेट के रूप में 

एक blank िॉक  ्यूमेंट दतेा ह।ै उसी समय, फकसी भी टेम्पिेट फ़ाइि को िीच े फदए गए चरणों का पािि करके 

निफ़ॉल्ट टेम्पिेट के रूप में सेट फकया िा सकता ह:ै 

चरण 1. Ctrl + Shift + N दबाकर टेम्पिेट िायिॉग बॉक्स खोिें। 

चरण 2. उस टेम्पिेट पर राइट नक्िक करें निसे आप निफ़ॉल्ट टेम्पिेट के रूप में सेट करिा चाहते हैं। 

चरण 3. पॉप अप मेिू से, नवकल्प का नसिेक्शि करें निफ़ॉल्ट रूप में सेट करें िैसा फक नचत्र 3.29 में फदखाया गया 

ह।ै 

 
नचत्र 3.29 एक निफ़ॉल्ट टेम्पिेट की स्थापिा 

 

निफ़ॉल्ट आइकि टेम््िेट फ़ाइि के शीषड बाईं ओर फदखाई दगेा। अगिी बार िब आप File > New > Text 

Document का नसिेक्शि करके एक िया िॉक  ्यूमेंट बिाते हैं, तो िया िॉक  ्यूमेंट अांनतम सांपाफदत टेम्पिेट का 

उपयोग करेगा। 

3.3.6 एक टेम्पिटे मूव करिा 

िब आप फकसी टेम्पिेट पर माउस पॉइांटर को टेम््िेट िायिॉग बॉक्स में रखत ेहैं, तो टूि रटप टेम्पिेट और उसके 

सांबांनधत शे्रणी के िाम को प्रदर्शडत करता ह।ै आप िीचे फदए गए चरणों का पािि करके एक टेम्पिेट को एक शे्रणी 

स ेदसूरी शे्रणी में ि ेिा सकते हैं। 

चरण 1. टेम्पिेट िायिॉग बॉक्स खोिें। 

चरण 2. मूव होिे के निए टेम्पिेट पर नक्िक करें और चुिें। 

चरण 3. मूव बटि पर नक्िक करें। 

चरण 4. उस िई शे्रणी का नसिेक्शि करें िहाां टेम्पिेट को स्थािाांतररत करिा ह।ै 

चरण 5. ओके बटि पर नक्िक करें। 

 

3.3.7 एक टेम्पिटे Export करिा 
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Export टेम्पिेट आपके कां ्यूटर पर वाांनछत फ़ोल्िर में टेम्पिेट फ़ाइि को सांग्रहीत करिे की सुनवधा दतेा ह।ै यह 

एक शे्रणी फ़ोल्िर से दसूरे में एक टेम्पिेट को स्थािाांतररत करिे से अिग ह।ै िब कोई टेम्पिेट Export फकया 

िाता ह,ै तो उसे फकसी भी इनछछत स्थाि पर टेम्पिेट फ़ाइि के रूप में सहिेा िाता ह।ै टेम््िेट Export करिा कई 

उपयोगकताडओं के साथ टेम््िेट साझा करि ेके निए बहत उपयोगी सुनवधा ह।ै टेम्पिेट Export करिे के निए िीच े

फदए गए चरणों का पािि करें: 

चरण 1. टेम्पिेट िायिॉग बॉक्स में, Export फकए िािे वािे टेम्पिेट का नसिेक्शि करें। 

चरण 2. िायिॉग बॉक्स के िीचे दाईं ओर नस्थत Export बटि पर नक्िक करें िैसा फक नचत्र 3.30 में फदखाया 

गया ह।ै 

 
नचत्र 3.30 Export टेम्पिेट बटि का नसिेक्शि करिा 

चरण 3. उसके बाद सेिेक्ट पाथ िायिॉग बॉक्स फदखाई दतेा ह ैिैसा फक नचत्र 3.31 में उस फ़ोल्िर का नसिेक्शि 

करिे के निए ह ैिहाँ आप टेम्पिेट को एक्सपोटड करिा चाहते हैं। 

 
नचत्र 3.31 पथ िायिॉग बॉक्स का नसिेक्शि करें 

 

चरण 4. फ़ोल्िर का नसिेक्शि करें और OK बटि पर दबाएां। चयनित टेम्पिेट उस फ़ोल्िर और एक पुनष्टकरण 

िायिॉग बॉक्स में Export फकया िाएगा, िैसा नचत्र 3.32 में फदखाया गया ह।ै 

 
नचत्र 3.32 टेम्पिेट Export करिे के बाद पुनष्ट 

 

3.3.8 फकसी blank िॉक  ्यमूेंट में टेम््िटे िाग ूकरिा। 

आप उपिब्ध टेम्पिेट निस  ्ट से फकसी भी blank िॉक  ्यूमेंट में टेम्पिेट िाग ूकर सकते हैं। टेम््िेट िाग ूकरिे के 

निए निम्ननिनखत चरणों का पािि करें। 

चरण 1. File > New > Text Document का नसिके्शि करके निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट 

खोिें। 

चरण 2. File > New > Templates टेम्पिेट िायिॉग बॉक्स प्रदर्शडत करिे के निए टेम्पिेट। 

चरण 3. वाांनछत टेम्पिेट का नसिेक्शि करें। टेम्पिेट एक िई सवांिो में खोिा िाएगा। 
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चरण 4. नसिेक्शि के निए कीबोिड शॉटडकट कुां िी Ctrl + A का उपयोग करके टेम्पिेट की सांपूणड सामग्री को कॉपी 

करें और कॉपी करिे के निए Ctrl + C दबाएां। 

चरण 5. blank िॉक  ्यूमेंट खोिें और कीबोिड शॉटडकट कुां िी Ctrl + V का उपयोग करके टेम्पिेट की प्रनतनिनप 

बिाई गई सामग्री को पेस्ट करें। 

चरण 6. सामग्री को इछछािुसार िोडें या हटाएां और इसे एक टेक्स्ट फ़ाइि के रूप में सेव करें। टेम््िेट बि िािे के 

बाद, यह एक मौिूदा िॉक्यूमेंट में Insert >Text From File नवकल्प को चुिकर िाग ूफकया िा सकता ह।ै 

कां ्यूटर पर सहिेी गई टेम््िटे फ़ाइि को ब्राउज़ करें और चुिें। चयनित टेम्पिेट को िॉक  ्यूमेंट में िािा िाएगा। 
 

प्रायोनगक गनतनवनध 5 - नियाज़ उसके द्वारा बिाए गए टेम्पिेट को स्टोर करिा चाहता ह ैऔर एक अन्य निसे 

बिसवांदर िे िसे्कटॉप पर Company_Templates िाम के फ़ोल्िर में इांपोटड फकया था। 

इस कायड को पूरा करिे के निए निम्न चरणों का पािि करें।  

चरण 1. निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट बिाएां और  

टेम्पिेट िायिॉग बॉक्स खोििे के निए Ctrl+Shift+N दबाएां। 

चरण 2. Export फकए िािे वािे टेम्पिेट (Niaz_template) का नसिेक्शि करें। 

चरण 3. िायिॉग बॉक्स के निचिे दाईं ओर नस्थत Export बटि पर नक्िक करें। इस रूप में Save As िायिॉग 

बॉक्स सामिे आता ह।ै 

चरण 4. िसे्कटॉप पर सांग्रहीत Company_Templates िाम के फ़ोल्िर के निए ब्राउज़ करें। 

चरण 5. चयनित टेम्पिेट को Export करिे के निए फ़ोल्िर चुिें बटि पर नक्िक करें। 

चरण 6. Company_Templates फ़ोल्िर में टेम्पिेट कमडचारी बैि इांपोटड करिे के निए चरण 1 से 5 तक 

दोहराएां। 

 

3.4 Track Changes Feature टै्रक में बदिाव की सनुवधा  

टै्रक चेंि एक बहत शनक्तशािी टूि ह ैिो फकसी िॉक  ्यूमेंट की रट्पणी, सांपादि और review की प्रफिया को कई 

उपयोग करिे वािों के बीच एक आसाि प्रफिया बिाता ह।ै एक उपयोगकताड द्वारा बिाए गए िॉक  ्यूमेंट को स्वयां 

या अन्य प्रयोक  ्ताओं द्वारा review और सांपाफदत करिे की आवश्यकता होती ह।ै यफद िॉक  ्यूमेंट में कोई सांशोधि 

सीधे फकए िात ेहैं, तो मूि िॉक  ्यूमेंट खो सकता ह।ै इसके बिाय, राइटर का टै्रक चेंि िीचर मूि िॉक्यूमेंट में फकए 

गए सभी पररवतडिों का ररकॉिड रखिे के निए एक वैकनल्पक नवनध प्रदाि करता ह।ै दिड फकए गए सभी पररवतडिों 

को मूि राइटर द्वारा या तो स्वीकार या अस्वीकार फकया िा सकता ह।ै इसके अिावा, टै्रक चेंि िीचर हमें फकसी 

िॉक्यूमेंट की review करते हए रट्पणी िोडिे का नवकल्प भी दतेा ह।ै 

टै्रक चेंि टूिबार में नवनभन्न उपकरण होते हैं िो नवनभन्न उपयोग करिे वािों द्वारा फकए गए पररवतडिों को टै्रक 

करिे में मदद करते हैं। मुख्य मेिू बार से टै्रक पररवतडि टूिबार दखेिे के निए, View > Toolbars > Track 

Changes चुिें। टै्रक चेंि टूिबार नचत्र 3.33 में फदखाए गए राइटर सवांिो के निचिे बाएां कोिे में फदखाई दगेा। 
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नचत्र 3.33 टै्रक पररवतडि टूिबार 

टै्रक चेंि टूिबार पर मौिूद नवनभन्न बटि नचत्र 3.33 में फदखाए गए हैं निन्हें िीचे सांक्षेप में बताया गया ह।ै 

View Track Changes - इस बटि पर नक्िक करिे से नवनभन्न उपयोग करिे वािों द्वारा िॉक  ्यूमेंट में फकए 

गए सभी पररवतडि प्रदर्शडत होते हैं। 

ररकॉिड टै्रक पररवतडि - इस बटि पर नक्िक करके, टै्रक पररवतडि सुनवधा चािू ह।ै इसके बाद, फकए गए फकसी भी 

प्रकार के सांपादि को नचनह्ित फकया िाएगा। िॉक  ्यूमेंट में िोडा गया कोई भी कैरेक  ्टर एक अिग रांग में प्रदर्शडत 

फकया िाएगा और फकया गया कोई भी नििीशि स्ट्राइक-थ्रू स  ्टाइि में फदखाई दगेा। 

Previous Track Changes / Next Track Changes - फकए गए पररवतडिों के बीच िेनवगेट करिे के 

निए इि बटि पर नक्िक करें। 

Accept / Accept All Track Changes - एक बार सांपादि हो िािे के बाद, मूि राइटर स्वीकार फकए 

गए टै्रक पररवतडि बटि पर नक्िक करके िॉक  ्यूमेंट में फकए गए पररवतडि को स्वीकार कर सकता ह।ै िॉक  ्यूमेंट पर 

फकए गए सभी पररवतडिों को स्वीकार करते हए Accept All Track Changes बटि पर नक्िक करें। 

Reject / Reject All Track Changes - िॉक  ्यूमेंट के मूि राइटर िमशः Reject Track Changes 

or Reject All Track Changes को दबाकर िॉक  ्यूमेंट में फकए गए एक पररवतडि या सभी पररवतडिों को 

अस्वीकार कर सकते हैं। 

Manage Track Changes - इस बटि पर नक्िक करके Manage Changes िायिॉग बॉक्स प्रदर्शडत 

फकया िाता ह ै निसमें राइटर के िाम और सांशोधि के समय और समय के साथ िॉक  ्यूमेंट में फकए गए सभी 

पररवतडिों की एक नवस्ततृ निस  ्ट होती ह।ै 

Insert Comment - इस बटि का उपयोग फकसी िॉक  ्यूमेंट में comment रट्पणी िोडिे के निए फकया िाता 

ह।ै 

3.4.1 एक िॉक्यूमेंट review के निए तयैार करिा 

टै्रक पररवतडि सुनवधा का उपयोग तब फकया िाता ह ैिब कोई िॉक  ्यूमेंट review या सांपादि उद्दशे्यों के निए एक 

या अनधक उपयोग करिे वािों के साथ साझा फकया िाता ह।ै इसनिए, िॉक  ्यूमेंट को साझा करिे से पहि,े फकसी 

को यह सुनिनित करिा चानहए फक िो बदिाव फकए गए हैं, उन्हें दिड फकया िािा चानहए। यह सुनिनित करेगा 

फक review फकए िािे के बाद, िॉक  ्यूमेंट के मूि राइटर के पास फकए गए पररवतडिों को स्वीकार करिे या 
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अस्वीकार करिे का नवकल्प ह।ै इसनिए, िॉक  ्यूमेंट को review के निए भेिे िािे से पहिे, मूि राइटर को 

review के निए िॉक  ्यूमेंट तैयार करिा चानहए और फकए िा रह ेपररवतडिों को ररकॉिड करिा शुरू करिा चानहए। 

उसके निए, Edit > Track Changes >Record नवकल्प चुिें। वैकनल्पक रूप से टै्रक पररवतडि टूिबार से 

ररकॉिड बटि का नसिेक्शि करें। यह सुनिनित करिे के निए फक कोई प्रयोक  ्ता टै्रक पररवतडि नवकल्प को अक्षम 

करिे में सक्षम िहीं ह,ै हम पासविड के साथ िॉक  ्यूमेंट की रक्षा कर सकते हैं। उस के निए निम्न चरणों का पािि 

करें। 

चरण 1. निब्र ेऑफिस राइटर में एक िया िॉक  ्यूमेंट बिाएां। मुख्य मेिू से, select Edit > Track Changes 

> Protect नवकल्प चुिें। Enter पासविड िायिॉग बॉक्स फदखाई दगेा िैसा फक नचत्र 3.34 में फदखाया गया ह।ै 

वैकनल्पक रूप स,े आप िॉक  ्यूमेंट की सुरक्षा के निए टै्रक पररवतडि टूिबार पर नस्थत प्रोटेक्ट टै्रक चेंि बटि पर 

नक्िक कर सकते हैं। 

 

नचत्र 3.34 Changes button पर नक्िक करिे के बाद पासविड िाििे के निए पासविड िायिॉग में एांटर करें  

चरण 2. पासविड में एक ही पासविड दिड करें और टेक्स्ट बॉक्स की पुनष्ट करें और ओके बटि पर नक्िक करें। पासविड 

के साथ िॉक  ्यूमेंट को प्रोटेक  ्ट करिे के बाद, यफद कोई प्रयोक  ्ता टै्रक पररवतडि सुनवधा को निसेबि करिे की 

कोनशश करता ह,ै तो राइटर पासविड दिड करिे के निए सांकेत दगेा। 

3.4.2 ररकॉर्ििंग में पररवतडि 

एक बार टै्रक में बदिाव की सुनवधा चािू होिे के बाद, ररव  ्यूअर िॉक  ्यूमेंट में बदिावों को दिड करिा शुरू कर 

सकते हैं। उसके निए, Edit> Track Changes> Record नवकल्प पर नक्िक करें। वैकनल्पक रूप से टूिबार स े

ररकॉिड बटि का नसिेक्शि करें। पररवतडिों की ररकॉर्ििंग शुरू करिे के निए शॉटड कट की कुां िी Ctrl + Shift + C 

ह।ै 

एक बार ररकॉिड नवकल्प चुिे िािे के बाद, टै्रक में बदिाव की सुनवधा चािू ह।ै अब, हटाए िा रह े फकसी भी 

कैरेक  ्टर को स्ट्राइक-थ्र ू टेक्स्ट के रूप में फदखाया िाएगा और िोडा गया कोई भी कैरेक  ्टर अिग-अिग रांग में 

फदखाया िाएगा िैसा फक नचत्र 3.35 में फदखाया गया ह।ै 

इसके अिावा िब आप माउस पॉइांटर को फकसी भी बदिाव पर रखत ेहैं, तो एक टूि रटप प्रदर्शडत की िाती ह ै

निसमें राइटर का नववरण, फकया गया बदिाव, नतनथ और पररवतडि का समय िैसा फक नचत्र 3.36 में फदखाया 

गया ह।ै 
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नचत्र 3.35 बदिावों की ररकॉर्ििंग         नचत्र 3.36 टूि रटप में फकए गए पररवतडिों का नववरण फदखाया गया है 

ररकॉर्ििंग को रोकिे के निए, Edit > Track Changes > Record का नसिेक्शि करके ररकॉिड नवकल्प को 

रद्द करें या टूिबार पर ररकॉिड बटि पर नक्िक करें। 

3.4.3 पररवतडि को स्वीकार करिा और अस्वीकार करिा 

सभी reviewers द्वारा पररवतडि फकए िाि े के बाद, मूि राइटर उन्हें स्वीकार या अस्वीकार कर सकता ह।ै 

िॉक  ्यूमेंट खोिें और निम्ननिनखत चरणों का पािि करें। 

चरण 1. फकसी पररवतडि को स्वीकार / अस्वीकार करिे के निए, फकए गए पररवतडि पर नक्िक करें और फिर 

Accept Track Change / Reject Track Change बटि को चुिें। 

चरण 2. िॉक  ्यूमेंट में फकए गए पररवतडिों के बीच िेनवगेट करिे के निए Previous Track Changes and 

Next Track बटि पर नक्िक करें। 

चरण 3. फकए गए सभी पररवतडिों को स्वीकार या अस्वीकार करिे के निए, Accept All Tracked Changes 

/ Reject All Tracked Changes बटि को नसिेक  ्ट करें। 

चरण 4. यफद Manage Track Changes बटि पर नक्िक फकया िाता ह,ै तो Manage Changes 

िायिॉग बॉक्स आता ह ैिैसा फक नचत्र 3.37 में फदखाया गया ह।ै इसमें िॉक  ्यूमेंट में फकए गए सभी पररवतडिों का 

नववरण ह।ै िायिॉग बॉक्स में पररवतडिों को accept and reject करिे के निए बटि होते हैं। 

 

नचत्र 3.37 पररवतडि िायिॉग बॉक्स प्रबांनधत करें 

3.5 Comments (रट्पनणया)ँ िोडिा 

review करते समय रट्पनणयाां िोडिे के निए, हम टै्रक पररवतडि टूिबार का भी उपयोग कर सकते हैं। िॉक  ्यूमेंट 

में उस स्थाि पर नक्िक करें िहाँ comment रखा िािा ह।ै इसके बाद, फकसी िॉक  ्यूमेंट में comment िोडिे के 

निए निम्ननिनखत चरणों का पािि करें। 

चरण 1. टै्रक पररवतडि टूिबार पर Insert Comment बटि पर नक्िक करें। सवांिो के दाईं ओर एक रट्पणी 

बॉक्स िािा िाएगा। इसमें author/ reviewer का िाम और comment की तारीख और समय होगा, िैसा फक 

नचत्र 3.38 में फदखाया गया ह।ै 

चरण 2. comment निखें। 

चरण 3. एक बार िब यह सफिय करिे के निए िॉक  ्यूमेंट पर कहीं भी नक्िक करें। 
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नचत्र 3.38 टै्रक पररवतडि टूिबार के तहत नवकल्प का उपयोग करते हए Comments सनम्मनित करिा 

यफद प्रयोक  ्ता अपिे Comments अिग अिग दतेे हैं, तो नवनभन्न प्रयोक  ्ता द्वारा की गई Comments को नचत्र 3.38 

में अिग-अिग रांगीि रट्पणी बॉक्स में फदखाया गया ह।ै 

3.6 Comments रट्पनणया ँDeleting  

फकसी भी Comments को हटािे के निए, Comments बॉक्स के िीचे दाईं ओर िीचे तीर पर नक्िक करें। िैसा फक 

नचत्र 3.23 में फदखाया गया ह,ै एक पॉप अप मेिू प्रदर्शडत फकया िाएगा। यह फकसी नवशेष राइटर द्वारा केवि 

वतडमाि Comments, सभी Comments को हटािे और सभी Comments को हटािे का नवकल्प दतेा ह।ै इनछछत 

नवकल्प का नसिेक्शि करें।   

 
नचत्र 3.39 पॉप अप मेिू से रट्पनणयाां हटािा 

3.7 Comparing Documents तिुिात्मक िॉक्यमूेंट 

एक बार िब reviewers ि ेबदिाव फकया ह ैऔर अपिा Comments फदया ह,ै तो राइटर में review फकए गए 

िॉक  ्यूमेंट के साथ मूि िॉक  ्यूमेंट की तुििा करिे की सनुवधा नमिती ह ैऔर फिर उस नवकल्प (नवकल्पों) का 

नसिेक्शि करता ह ैिो सबसे अछछा ह।ै दस्तावेिों की तुििा करिे के निए निम्ननिनखत चरणों का पािि करें। 

चरण 1. सांपाफदत िॉक  ्यूमेंट खोिें। 

चरण 2. Edit > Track Changes > Compare Documents नसिेक्शि करें। वैकनल्पक रूप से, टूिबार 

स ेNon-Tracked Changed Document Compare पर नक्िक करें। 

चरण 3. Compare To िायिॉग बॉक्स फदखाई दगेा। नचत्र 3.40 में फदखाए गए अिुसार मूि फ़ाइि को ब्राउज़ 

करें और चिुें। 

 
नचत्र 3.40 मूि फ़ाइि का नसिेक्शि करिा 

चरण 4. Manage Changes िायिॉग बॉक्स नचत्र 3.37 में फदखाया गया ह।ै इनछछत पररवतडिों को स्वीकार 

या अस्वीकार करें। 

चरण 5. िब हो िाता ह ैतो िायिॉग बॉक्स को बांद करें। 

चरण 6. सांपाफदत फ़ाइि सेव करें। 
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प्रायोनगक गनतनवनध 6 - प्रदीप िे 'मिुष्य और प्रकृनत' पर एक िॉक  ्यूमेंट बिाया ह।ै वह चाहता ह ैफक उसके दोस्त 

िॉक  ्यूमेंट की review करें और िहाँ भी आवश्यक हो, अपिा comment दें। निम्ननिनखत प्रफिया प्रदर्शडत करेगी 

फक उिके नमत्र िॉक  ्यूमेंट में comment कैसे िोडते हैं। 

चरण 1. प्रदीप द्वारा बिाए गए िॉक  ्यूमेंट review करिे के निए खोिें। 

चरण 2. टूिबार पर इन्सटड कमेंट बटि पर नक्िक करें। 

चरण 3. comment बॉक्स में comment टाइप करें। 

चरण 4. एक बार िब यह हो िाता ह ैतो सफिय बिािे हतेु िॉक  ्यूमेंट पर कहीं भी नक्िक करें। 

चरण 5. िॉक  ्यूमेंट में अनधक comment िोडिे के निए ऊपर फदए गए चरणों को दोहराएां। 

प्रायोनगक गनतनवनध 7 - शानमि करि ेके बाद प्रदीप िे टै्रक चेंि ऑि के साथ अपिे सांपादक को िॉक  ्यूमेंट मेि 

फकया। मैंिे िॉक  ्यूमेंट में कुछ बदिाव फकए हैं। प्रदीप अपिे मूि िॉक्यूमेंट की review िॉक्यूमेंट के साथ करिा 

चाहते हैं। निम्ननिनखत प्रफिया में यह प्रदर्शडत फकया िाएगा फक प्रदीप मूि िॉक  ्यूमेंट के साथ सांपाफदत िॉक  ्यूमेंट 

की तुििा कैसे करेंगे। 

चरण 1. सांपाफदत िॉक  ्यूमेंट खोिें। 

चरण 2. Edit > Track Changes > Compare Documents नवकल्प का नसिेक्शि करें। 

चरण 3. तुििा करिे के निए िायिॉग बॉक्स फदखाई दगेा। नचत्र 3.40 में फदखाए गए अिुसार मूि फ़ाइि को 

ब्राउज़ करें और चिुें। 

चरण 4 पररवतडि पररवतडि िायिॉग बॉक्स नचत्र 3.37 में फदखाया गया ह।ै इनछछत पररवतडिों को स्वीकार या 

अस्वीकार करें। 

चरण 5. वाांनछत पररवतडिों को स्वीकार या अस्वीकार करें। 

चरण 6. िब फकया िायिॉग बॉक्स को बांद करें। 

चरण 7. सांपाफदत फ़ाइि सेव करें। 

 

अपिी प्रगनत िाांचें 

क. बहनवकल्प वाि ेप्रश्न 

 

1. निम्न में स ेकौि सा Table of Contents, Index or Bibliography dialog box के बारे में सही िहीं ह?ै 

(a) इसके चार टैब हैं 

(b) टाइप टैब पर, निफ़ॉल्ट रूप से, Protected against Manual Changes के निए चेकबॉक्स का नसिेक्शि फकया िाएगा। 

(c) स्टाइि टैब में पृष्ठभूनम का रांग बदििे के नवकल्प होते हैं। (d) उपरोक्त में से कोई िहीं 

 
 

2. निम्ननिनखत में स ेकौि सा टैब निफ़ॉल्ट रूप स ेसफिय ह ैिब Table of Contents, Entries or Bibliography dialog 

box खोिा िाता ह?ै 

(ए) प्रनवनष्टयाां Entries (बी) Background (सी) स्टाइि (िी) Type  

3. निम्ननिनखत में से फकस टैब में टीओसी में नवनभन्न प्रनवनष्टयों के निए स  ्टाइि को सेट करिे के नवकल्प हैं? 

(a) Entries (b) Background (c) Styles (d) Type  

4. निब्र ेऑफिस राइटर में टेबि ऑि कॉन्टेंट्स की पृष्ठभूनम में निम्ननिनखत में से क्या िोडा िा सकता है? 
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(ए) Color में 

(बी) ग्राफिक 

(सी) a और b दोिों 

(िी) ि a तो ि ही b 

5. निम्ननिनखत में स ेकौि सा टेम्पिेट्स के बारे में सच िहीं ह?ै  

(ए) स  ्टाइि और िॉमेट सुनवधाओं का पुि: उपयोग फकया िा सकता है। 

(बी) निब्र ेऑफिस ऑििाइि टेम््िेट प्रदाि करता है 

(सी) हम अपिे स्वयां के टेम््िेट िहीं बिा सकते हैं।  

(िी) उपरोक्त में से कोई िहीं। 

6. टेम््िटे िायिॉग बॉक्स खोिि ेके निए निम्ननिनखत में स ेकौि-सी शॉटडकट कुां िी ह?ै 

(a) Ctrl + Alt + N 

(b) Shift + Ctrl + N 

(c) Ctrl + Alt + T 

(d) Shift + Alt + T 

7. टेम््िटे िायिॉग बॉक्स में निम्ननिनखत में स ेकौि सा बटि, टेम््िटे की निस  ्ट में प्रदर्शडत टेम्पिटे को सवे करि ेके निए नक्िक फकया 

िाएगा? 

(a) Export 

(b) Import  

(c) Move  

(d) उपरोक्त में से कोई िहीं  

8. निम्ननिनखत में स ेकौि सा सांपणूड िॉक्यमूेंट चिुि ेके निए शॉटडकट कुां िी ह?ै 

(a) Ctrl + S 

(b) Ctrl + A 

(c) Ctrl + D 

(d) Ctrl + B  

9. टेम््िटे िायिॉग बॉक्स खोिि ेके निए नवकल्पों में स ेकौि सा अििुम सही ह?ै  

(a) File > Manage Templates > Templates  

(b) File > Templates > Manage Templates  

(c) Insert > Templates >Manage Templates  

(d) Insert > Manage Templates > Templates 

10. राइटर के टै्रक चेंि िीचर के बारे में निम्ननिनखत में स ेकौि सा सही ह?ै 

(ए) आप िॉक  ्यूमेंट में फकए गए बदिाव को ररकॉिड िहीं कर सकते। 

(b) फकसी नवशेष राइटर की रट्पणी को केवि हटाया िा सकता है 

(c) िॉक  ्यूमेंट में फकया गया कोई भी पररवतडि स्थायी ह।ै 

(d) उपरोक्त में से कोई िहीं 

11. निम्ननिनखत में स ेफकस मिे ूमें टै्रक पररवतडि नवकल्प ह?ै 

(a) File 

(b) Edit  

(c) View  

(d) Insert 

12. िॉक  ्यमूेंट में फकए िा रह ेपररवतडिों की ररकॉर्ििंग शुरू करि ेहते ुनिम्ननिनखत में स ेकौि-सी शॉटडकट कुां िी ह?ै 

(a) Ctrl+Shift+C. 

(b) Alt+Shift+C  

(c) Ctrl+Alt+C  
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(d) Shift+C+F2 

 

ख. ररक  ्त स्थाि भरें 

1. TOC से नवषय पर िेनवगेट करिे के निए उस नवषय पर माउस बटि पर नक्िक के साथ _____ कुां िी दबाएां। 

2. टीओसी में िाग ूपैराग्राि स्टाइसिांग को हटािे के निए, आउटिाइि का नसिेक्शि करें स्तर निस  ्ट बॉक्स में स्तर और फिर _______ 

बटि पर नक्िक करें। 

3. यफद ___________ नवकल्प के निए चेकबॉक्स चुिा गया है, तो TOC फकसी आकनस्मक पररवतडि से सुरनक्षत ह।ै 

4. TOC को मैन्युअि रूप से अपिेट करिे के निए, राइट नक्िक करें और _____ नवकल्प पॉप अप मेिू से चुिें। 

5. ________ टैब में कॉिम की सांख्या निधाडररत करिे के नवकल्प होते हैं फक हम अपिे टीओसी िेिा चाहते हैं। 

6. ________ प्रीसेट िेआउट ह ैिो हमें प्रोिेशिि और औपचाररक िॉक  ्यूमेंट आसािी से बिािे में मदद करता ह।ै 

7. राइटर में निफ़ॉल्ट टेम््िेट ____________________ ह।ै 

8. वतडमाि िॉक  ्यूमेंट में उपयोग फकए गए टेम्पिेट खोििे के निए,फ़ाइि मेिू से ______नवकल्प चुिें। 

9. ____________ बटि को ऑििाइि टेम्पिेट्स दखेिे के निए टेम्पिेट िायिॉग बॉक्स में नक्िक फकया िाता ह।ै 

10. राइटर की सुनवधा हमें __________________ मूि िॉक  ्यूमेंट में फकए गए सभी पररवतडिों का ररकॉिड रखिे की नवनध का एक 

नवकल्प प्रदाि करती है। 

11. बदिावों को दिड करिे के निए शॉटडकट कुां िी _________ ह।ै 

12. टै्रक चेंि िीचर ऑि होिे के बाद, अनतररक  त कैरेक  टर हैं, निसे _________ टेक  ्स  ्ट के रूप में फदखाया गया ह।ै 

 

ग. बताएां फक क्या फदए गए कथि सही हैं या गित : 

1. नवषय टेबि में नवषय हाइपरसिांक हैं। 

2. निब्रे ऑफिस राइटर में सामग्री की टेबि अपिे आप अपिेट की िा सकती ह।ै 

3. यफद TABLE of Contents को स्टाइि िहीं फकया गया है, तो भी सामग्री सनम्मनित की िा सकती ह।ै 

4. एक बार TOC बि िािे के बाद, इसे सांपाफदत िहीं फकया िा सकता ह।ै 

5. हम TOC की पृष्ठभूनम के रूप में एक ग्राफिक िहीं िोड सकते। 

6. एक एकि टेम्पिेट का उपयोग कई दस्तावेिों के निए फकया िा सकता ह।ै 

7. एक टेम््िेट में ग्राफिक्स िहीं हो सकते। 

8. राइटर के सभी िॉक्यूमेंट टेम््िेट पर आधाररत हैं। 

9. ऑििाइि टेम्पिेट्स को टेम््िेट िायिॉग बॉक्स में टेम््िेट की निस  ्ट में िहीं िोडा िा सकता है। 

10. एक बार बिाया गया टेम्पिेट बार-बार सांपाफदत फकया िा सकता ह।ै 

11. दिड फकए गए पररवतडिों को मूि राइटर द्वारा स्वीकार फकया िािा चानहए। 

12. हम प्रयोक  ्ता द्वारा िॉक  ्यूमेंट में िोडे गए रट्पनणयों को हटा सकते हैं। 

 
 

घ. निम्ननिनखत प्रश्नों के उत्तर दीनिए 

1. TABLE of Contents की क्या आवश्यकता है? 

2. ‘Protected Against Manual Changes’ के नवकल्प टेबि के प्रकार टैब, निस  ्ट, Index or Bibliography dialog box में 

चयनित िहीं होिे पर क्या होगा? 

3. Table of Contents, Index or Bibliography dialog box में मौिूद पाांच टैब का िाम बताएां। 

4. TOC के अिुकूिि से आपका क्या अनभप्राय ह?ै 

5. TOC में फकसी िॉक  ्यूमेंट के शीषडक और उप-शीषडक कैसे अिग होते हैं? 

6. एक टेम्पिेट को पररभानषत करें। 

7. अपिे िॉक  ्यूमेंट के निए टेम्पिेट का उपयोग करिे का कोई एक िाभ दें। 
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8. टेम्पिेट इांपोटड करिे और Export करिे में क्या अांतर है? 

9. टेम्पिेट की फकसी भी दो श्रेनणयों का िाम दें। 

10. टेम्पिेट्स का Export कब उपयोगी ह?ै कोई भी एक कारण दो। 

11. Accept Track Change and Accept All Tracked Changes बटि के बीच क्या अांतर ह?ै 

12. हम review के निए एक िॉक्यूमेंट कैसे तैयार करते हैं?  

13. निम्ननिनखत Track Changes toolbar के नचत्र में Record button, Insert Comments button, Accept All Tracked Changes, 

Reject Track Change बटि को पहचाि कर िेबि करें। 

 
नचत्र 3.33 टै्रक पररवतडि टूिबार 

14. निम्न टेम्पिेट िायिॉग बॉक्स में “Browse Online Templates button, Export button, 

Import button“पहचािें और िेबि करें। 

 

 
नचत्र  D.10 टेम्पिटे िायिॉग बॉक्स 

अपिी प्रगनत िाांचें  

प्रायोनगक कायड  

1. रििीकाांत िे निब्र ेऑफिस राइटर टूि का उपयोग करके भारत में नशक्षा पर एक नवस्तृत ररपोटड बिाई ह।ै उन्होंिे उनचत पैराग्राि और 

अिुभाग शीषडकों को सनम्मनित करके िॉक  ्यूमेंट को अछछी तरह से स्टाइि फकया है। उिके सहयोगी मुरुगि िे उन्हें सिाह दी फक वे अपिी 

ररपोटड Table of Contents शानमि करें निसे उिकी ररपोटड की एक पूरी झिक नमिेगी। हरी पृष्ठभूनम के साथ टीओसी िाििे के निए 

रििीकाांत की मदद करें। 

2. टीओसी िािे िािे के बाद, रििीकाांत िे ररपोटड में कुछ बदिाव फकए, िेफकि टीओसी में बदिाव िहीं फदखे। क्या उसे फिर से एक िया 

टीओसी िाििा होगा? उसे TOC अपिेट करिे का बेहतर तरीका सुझाएां। 

3. रुखसत िे अभी libreoffice.org से एक टेम्पिेट िाउििोि फकया ह।ै अब वह इसे टेम््िेट फ़ोल्िर के My templates श्रेणी में इांपोटड 

करिा चाहती है। वह अपिा कायड कैसे पूरा कर सकती है? 

4. ररनमत को कां ्यूटर पर कािड बिािा पसांद ह।ै इस बार उन्होंिे अपिे फिसमस कािड बिािे और अपिे दोस्तों को भेििे का िैसिा फकया। 

वह राइटर की टेम््िेट सुनवधा से कायड करिा चाहता है। उसिे वाांनछत टेम्पिेट (card.ott) को पहिे ही सेव और इांपोटड फकया ह।ै अपिे 

कम से कम पाांच दोस्तों के निए कािड बिािे में उसकी मदद करें। 

5. टीिा उिके स्कूि की सांपादकीय टीम की सदस्य हैं। वह अख़बार 2 टेम्पिेट को अपिे निफ़ॉल्ट टेम्पिेट के रूप में सेट करिा चाहती है। 

टीिा को कायड पूरा करिे में मदद करिे के निए चरण निखें। 

6. वेंकट िे भारत की व्यापार review पर एक िॉक्यूमेंट बिाया ह।ै वह चाहता ह ैफक उसके दो दोस्त, टरांकी और सुिॉय अपिे िॉक  ्यूमेंट 

की review करें और यफद आवश्यक हो, तो रट्पणी िोडें। िेफकि उिमें से कोई भी राइटर के टै्रक पररवतडि सुनवधा का उपयोग करिा 

िहीं िािता ह।ै कायड पूरा करिे में उिकी मदद करें। 

7. वेंकट को सांशोधिों और रट्पनणयों के साथ review की गई िाइि नमिी ह।ै अपिे दोस्तों द्वारा फकए गए पररवतडिों को स्वीकार करिे 

या अस्वीकार करिे के निए वह अब क्या कदम उठाएांगे। 

8. वेंकट द्वारा बिाए गए मूि िॉक्यूमेंट और टरांकी और सुिॉय द्वारा भेि ेगए सांपाफदत िॉक्यूमेंट की तुििा करिे के निए कदम निखें।  
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यनूिट 2. निब्र ेऑफिस Calc का उपयोग करत ेहुए इिके्ट्रॉनिक स्प्रडेशीट (एडवाांस) 

पररचय 

आज हम एक नडनजटि दनुिया में रह रह ेहैं, जहाां हम अपिे कई कामों के निए रौद्योनगकी पर निर्भर करते हैं। 

सबसे अनिक उपयोग फकए जािे वाि ेपहिुओं में स ेएक ह ै नगिती और नहसाब फकताब करिा। य ेहमेशा हमारे 

जीवि का एक अनवर्ाज्य नहस्प्सा रह ेहैं। हर पेशे, घर, सांस्प्थाि और यहाां तक फक हमारे स्प्माटभ उपकरणों को 

सांख्याओं के साथ काम करिा पड़ता ह।ै इिेक्ट्रॉनिक स्प्रेडशीट एक सॉफ्टवेयर ह ै नजसके जररए कुशिता स े

सांख्याओं के साथ काम करिे में मदद नमिती ह।ै यह एक एकाउांटेंट की खाता बही से नमिता जुिता ह,ै नजसमें सब 

कुछ उपयुक्त शीर्भकों के तहत नववरण दजभ फकया गया ह।ै आपिे नपछिी कक्षा में पहिे से ही जाि निया ह ै फक 

गणिा करिे और डटेा रस्प्तुत करिे के निए इिेक्ट्रॉनिक स्प्रैडशीट्स फकतिे उपयोगी हैं। आपिे दखेा होगा फक 

इिेक्ट्रॉनिक स्प्रेडशीट में चाटभ का उपयोग करते समय सांख्याओं के नवशाि निड की कल्पिा करिा फकतिा आसाि 

हो जाता ह।ै अब, हम नवशे्लर्ण करिे के तरीके, दोहराए गए कायों को ऑटोमेट (स्प्वचानित) करि,े लिांक, साझा 

करिे और डटेा की समीक्षा करिे के बारे में जाििे के निए एक कदम आगे बढ़ते हैं। इस इकाई में आप निबर 

ऑफिस Calc सांस्प्करण 6.4 के माध्यम स ेइिेक्ट्रॉनिक स्प्रेडशीट की उन्नत नवशेर्ताओं को जािेंगे। इसके उन्नत 

नवर्यों में शानमि हैं - रर्ावी निणभय िेिे के निए उपयोगी जािकारी निकाििे के निए डटेा का नवशे्लर्ण करिा। 

हम कुछ पररदशृ्यों और िक्ष्य की तिाश का उपयोग करके डटेा का नवशे्लर्ण करिा सीखेंगे। स्प्रेडशीट की एक और 

शनक्तशािी नवशेर्ता जो आप सीखेंगे वह मैक्रोज़ ह।ै मैक्रोज़ store फकए गए फां क्ट्शांस का एक सेट ह ै नजसका 

उपयोग अक्ट्सर दोहराई जािे वािी रफक्रयाओं को automate स्प्वचानित करिे के निए फकया जा सकता ह।ै वे ऐस े

उपकरण हैं, नजिका उपयोग अनिकाांश सहज कायों को सापेक्ष रूप से आसािी से करिे के निए फकया जा सकता ह।ै 

अगिे अध्याय में, हम सीखेंगे फक कई शीट कैसे बिािा ह ैऔर डटेा को कई शीट में लिांक करिे का तरीका र्ी 

जािेंगे। यह दो तरीकों से फकया जा सकता ह,ै एक कीबोडभ और माउस का उपयोग करके अन्य शीट्स का सांदर्भ 

बिािा ह,ै और दसूरा बाहरी डटेा को लिांक करके र्ी फकया जा सकता ह।ै LibreOffice Calc में एक से अनिक 

रयोक् ताओं द्वारा स्प्रेडशीट साझा करिे की सुनविा रदाि की जाती ह ैनजससे रयोक् ताओं को इसके द्वारा एक साथ 

पररवतभि करिे की सुनविा नमि सकती ह।ै इसस ेअिग-अिग रयोक् ताओं द्वारा सही एक ही स्प्रेडशीट की कई 

रनतयों का रैक रखिे के निए बचत होती ह।ै साझा करिे Sharing से रयोक् ताओं को सहयोग में समाि स्प्रेडशीट 

पर काम करिे की अिुमनत नमिती ह।ै  
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अध्याय 4. पररदशृ्य और िक्ष्य की तिाश में डटेा का नवश्लरे्ण करिा 

पररचय 

डटेा का नवशे्लर्ण रर्ावी निणभय िेिे के निए उपयोगी जािकारी निकाििे की रफक्रया ह।ै Calc, Excel और 

Python जैसे नवनर्न्न डटेा नवशे्लर्ण सॉफ़्टवेयर हैं जो पैटिभ, रुझािों और सांबांिों की पहचाि करिे के निए डटेा को 

पुिः राप्त करि,े सहसांबांनित करि,े पता िगािे और कल्पिा करिे के निए उपयोग फकए जाते हैं। निबरऑफिस 

कैल्क में स्प्रेडशीट में डेटा में हरेिेर manipulate करिे के निए उपयोग फकए जािे वाि ेकई उपकरण शानमि हैं। 

हम डटेा का नवशे्लर्ण कर सकते हैं और उससे पररणामों की व्याख्या कर सकते हैं। इस अध्याय में, आप निब्र े

ऑफिस Calc का उपयोग करके डटेा का नवशे्लर्ण करिा सीखेंगे। 

 

4.1 डटेा को समफेकत करिा 

समेफकत फां क्ट्शि का उपयोग सूचिा को साराांनशत Consolidate करिे के निए स्प्रैडशीट की कई शीट से जािकारी 

को एक स्प्थाि पर सांयोनजत करिे के निए फकया जाता ह।ै इसका उपयोग रुझािों और सांबांिों की पहचाि के निए 

एक ही स्प्रेडशीट में नवनर्न्न रकार के डटेा को दखेिे और तिुिा करिे के निए फकया जाता ह।ै 

डटेा को समेफकत करिे स ेपहिे आपको निम्ननिनखत की जाांच करिे की आवश्यकता ह।ै 

 स्प्रैडशीट में रत्येक शीट खोिें और जाांचें फक डटेा रकारों का नमिाि होिा चानहए नजसे आप समेफकत 

consolidate करिा चाहते हैं। 

 उि सर्ी शीट्स स ेिेबिों का नमिाि करें जो समेकि के निए उपयोग की जाती हैं। 

 पहिा कॉिम राथनमक कॉिम के रूप में दजभ करें नजसके आिार पर डटेा को समेफकत फकया जािा ह।ै 

डटेा को समेफकत consolidate करिे के निए कदम इस रकार हैं: 

चरण 1. उस स्प्रैडशीट को खोिें नजसमें डटेा को समेफकत फकया जािा ह।ै 

चरण 2. एक िई शीट बिाएां जहाां डटेा को समेफकत फकया जािा ह।ै 

चरण 3 Data > Consolidate नवकल्प चुिें जो Consolidate dialog को खोिेगा जैसा फक नचत्र 4.1 में फदखाया 

गया ह।ै 
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नचत्र 4.1 कांसॉनिडटेेड डायिॉग बॉक्ट्स 

चरण 4. माि िें फक नडफॉल्ट फां क्ट्शि "Sum" को िां क्ट्शि ड्रॉप-डाउि में दखेा जाता ह।ै आप फां क्ट्शि ड्रॉप-डाउि पर 

नक्ट्िक करके नचत्र 4.2 में फदखाए गए कायों की सूची दखे पाएांगे। 

 

 

नचत्र 4.2 कांसॉनिडटे के तहत फां क्ट्शि 
 

चरण 5. ड्रॉप-डाउि सूची स ेआवश्यक फां क्ट्शि चुिें। 

चरण 6. स्रोत डटेा शे्रणी सूची में मौजूदा िामाांफकत शे्रनणयाां हैं जो इससे जल्दी से चुि सकते हैं। िेफकि यफद स्रोत 

सीमा undefined ह,ै तो उस शीट स ेरेंज को नक्ट्िक करें और चुिें नजसे समेफकत फकया जािा ह।ै 

चरण 7. समेकि डायिॉग की कांसॉनिडशेि शे्रनणयों ’के तहत इस सीमा को जोड़िे के निए Add पर नक्ट्िक करें। 
 

चरण 8. अनिक शीट को कांसॉनिडटे करिे के निए चरण 6 और 7 को दोहराएां। 
 

चरण 9. उपयोग ’कॉपी पररणाम’ के तहत निर्दभष्ट िक्ष्य सीमा की जाांच करिा याद रखें। यफद यह उल्िेख िहीं 

फकया गया ह,ै तो शीट के सेि पर नक्ट्िक करें जहाां final data का उत्पादि फकया जािा ह।ै 
 

चरण 10. उि नवकल्पों पर नक्ट्िक करें जो "रो िेबि" और "कॉिम िेबि" द्वारा समेफकत के तहत दो चेकबॉक्ट्स को 

सूचीबद्ध करेंगे और नवकल्प के तहत "स्रोत डटेा से लिांक करें", जैसा फक नचत्र 4.3 में फदखाया गया ह।ै इसमें से आप 

आवश्यकता के अिुसार अनतररक्त सुनविा का चयि कर सकते हैं। रोज़ और कॉिम द्वारा समेफकत नवकल्प को रो 
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िेबि और कॉिम िेबि के अिुसार डटेा को समेफकत करिे के निए जााँच की जाती ह।ै स्रोत डटेा में कोई र्ी 

बदिाव करते हुए समेफकत (िनक्षत) शीट में सांशोिि करिे के निए स्रोत डटेा से लिांक की जााँच की जाती ह।ै 

 

नचत्र 4.3 समेफकत नवकल्प 

चरण 11. अांत में OK बटि पर नक्ट्िक करें। 

हमें निम्ननिनखत गनतनवनि के माध्यम से इसका उदाहरण दें। 

 

रायोनगक गनतनवनि 4.1 - आइए एक उदाहरण िेते हैं फक हमारी दकुाि की दो शाखाएां हैं जैसे एबीसी और 

एक्ट्सवाईजेड। हमारे पास दो अिग-अिग शीटों में दोिों शाखाओं के जिवरी और िरवरी के महीिे के नबक्री 

ररकॉडभ हैं 

ABC_Branch और XYZ_Branch। अब हमें उत्पाद और शाखा के अिुसार नबक्री के बारे में जािकारी राप्त करिे के 

निए मानसक रूप स ेदोिों शीट्स का योग राप्त करिे के निए इि दो शीटों को समेफकत करिा होगा। 

अब एक स्प्रेडशीट नबक्री में निम्ननिनखत शीट बिाते हैं। 

 
नचत्र 4.4 एबीसी_ शाखा के निए डटेा 
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नचत्र 4.5 XYZ _ शाखा के निए डटेा 

 

अब हम स्प्रैडशीट की नबक्री के दो शीट _B ABC_Branch 'और' XYZ_Branch 'का उपयोग करते हैं। निम्ननिनखत 

चरणों का उपयोग करके समेफकत फकया जाएगा: 

चरण 1. एक िई शीट जोड़ें और इसे Consolidate के रूप में िाम बदिें 

चरण 2. डटेा> कांसोि पर नक्ट्िक करें या कीबोडभ शॉटभकट कुां जी ALT + D का उपयोग करें, समेफकत डायिॉग लवांडो 

खुि जाएगी जैसा फक नचत्र 4.6 में फदखाया गया ह।ै 

 

नचत्र 4.6 समेफकत डायिॉग लवांडो 

चरण 3. फां क्ट्शि बॉक्ट्स में, ड्रॉप फां क्ट्शि से हम के रूप में सम फां क्ट्शि चुिें सर्ी शीट से डटेा जोड़िा चाहते हैं। 

चरण 4. सोसभ डटेा रेंज बॉक्ट्स में नक्ट्िक करें और फिर वकभशीट ABC_Branch पर नक्ट्िक करें और समेफकत होि े

वाि ेक्षेत्र का चयि करें और फिर ऐड बटि पर नक्ट्िक करें समेकि रेंज में रनतनिनप सांदर्भ जोड़ दगेा। 

 

 

नचत्र 4.7 शीट स ेस्रोत डटेा शे्रणी का चयि करिा 

 

चरण 5. शीट XYZ_Branch पर नक्ट्िक करें और समेफकत होिे वाि ेक्षेत्र का चयि करें और फिर ADD पर नक्ट्िक 

करें अगिी समेफकत रेंज जोड़ दगेा। 
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चरण 6. सेटटांग्स बदििे के निए समेफकत डायिॉग लवांडो में नवकल्प के बगि में + नचह्ि पर नक्ट्िक करें। 

‘Consolidate by’ में दो नवकल्प रो िेबि और कॉिम िेबि हैं। रो िेबि या कॉिम िेबि या दोिों को जाांचें यफद 

आप िेबि को मेि करके इसे समेफकत करिा चाहते हैं। 
 

यफद लिांक टू सोसभ डटेा की जाांच की जाती ह,ै तो यह चयनित शे्रनणयों में फकए गए फकसी र्ी पररवतभि के साथ 

समेफकत शीट के डटेा को स्प्वचानित रूप से अपडटे करता रहगेा। 

 

नचत्र 4.8 अनिक properties स्प्थानपत करिे के निए नवकल्प 

चरण 7. to कॉपी ररजल्ट्स पर नक्ट्िक करें ’पर नक्ट्िक करें और फिर कांसोनिडटे शीट में फकसी र्ी सेि पर नक्ट्िक 

करें जहाां आप कांसॉनिडशेि के बाद िाइिि ररजल्ट कॉपी करिा चाहते हैं। 

चरण 8. ओके बटि पर नक्ट्िक करें। नचत्र 4.9 में समेकि के बाद डटेा के साथ समेफकत शीट रदर्शभत की जाएगी। 

 

 

नचत्र 4.9 समेफकत शीट 

 

समेफकत शीट में मूि डटेा के साथ सर्ी समेफकत डटेा होंगे। आप दोिों शीट के मूि डटेा को दखे सकते हैं और 

समेफकत रो के सामिे sign + ' पर नक्ट्िक कर सकते हैं। नचत्र 4.10 में मूि डटेा और समेफकत डटेा फदखाया गया ह।ै 
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नचत्र 4.10- रो के सामिे + साइि पर नक्ट्िक करके समेफकत शीट नववरण 

 

रायोनगक अर्् ्यास 4.1 

निम्ननिनखत कॉिम िेकर छात्रों के एक सेट के निए टमभ 1 और टमभ 2 में अांकों को सांिहीत करिे के निए दो शीट 

Marks_Term1 और Marks_Term2 बिाएां।  

1) Name 

2) Marks in English 

3) Marks in Hindi 

4) Marks in Maths 

5) Marks in Science 

6) Marks in Social Science 

7) Total marks (using function Sum) 

8) Percentage (using function Average) 

1) िाम 

2) अांिेजी में अांक 

3) लहांदी में अांक 

4) मैथ्स में माक्ट्सभ 

5) नवज्ञाि में अांक 

6) सामानजक नवज्ञाि में अांक 

7) कुि अांक (फां क्ट्शि सम का उपयोग करके) 

8) रनतशत (फां क्ट्शि औसत का उपयोग करके) 

अब, इि दो शीटों को मजभ करिे के निए समेफकत फां क्ट्शि का उपयोग करें। 
 

4.2 समहू और उप-योग 

Calc में Group और Outline का उपयोग चयनित डटेा की रूपरेखा तैयार करिे के निए फकया जाता ह ैऔर एक 

साथ रो और कॉिम को समूनहत कर सकता ह ैताफक कोई इसे नछपािे collapse के निए (-) इसे एक लसांगि नक्ट्िक 

का उपयोग करके या इसे नवस्प्ताररत expand (+) कर सके। 

समूनहत फकए जािे वाि ेडटेा का चयि करें, Data>Group and Outline पर नक्ट्िक करें। यफद आप रो या स्प्तांर्ों 

के आिार पर डटेा को समूह के आिार पर समूनहत करिा चाहते हैं तो रो को चुिें। 

Calc में उप-योग टूि समूह को स्प्वचानित रूप स ेबिाता ह ैऔर समूहीकृत डटेा पर योग, औसत जैसे सामान्य कायभ 

करता ह।ै डटेा नवशे्लर्ण की आवश्यकता के अिुसार रत्यके कॉिम के निए फकसी र्ी रकार के summary साराांश 

फां क्ट्शि का उपयोग फकया जा सकता ह।ै 

यह शे्रणी का उपयोग करके उप-योगों को समूनहत कर सकता ह ैऔर उन्हें आरोही ascending या अवरोही 

descending क्रम में क्रमबद्ध फकया जा सकता ह ैताफक फकसी को फफल्टर का उपयोग करिे की आवश्यकता ि हो। 
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उप-योग टूि को िाग ूकरिे के निए निम्ननिनखत चरणों का पािि करें। 

चरण 1. नजस शीट पर यह िागू फकया जािा ह,ै उसमें कॉिम में िेबि होिा चानहए 

चरण 2. डटेा मेिू पर नक्ट्िक करें और सबटोटल्स (डेटा> सबटोटल्स) चुिें 

 

Fig 4.11 नचत्र 4.11 डटेा मेिू से subtotal option चुििा 

चरण 3. उप-डायिॉग में सूची के आिार पर समूह में कॉिम चुिें जो फक शीट में डटेा को समूहीकृत करिे के निए 

उपयोग फकया जािा ह।ै 

 

नचत्र 4.12 सूची के आिार पर समूह में कॉिम चुिें 

चरण 4. गणिा उप-योगों के तहत चेकबॉक्ट्स पर नक्ट्िक करके उस कॉिम का चयि करें, नजसके निए आप 

सबटोटल्स बिािा चाहते हैं। 

चरण 5. उस फां क्ट्शि का चयि करें नजसे आप उपयोग फकए गए फां क्ट्शि के तहत फां क्ट्शि पर नक्ट्िक करके चयनित 

कॉिम के निए रदशभि करिा चाहते हैं 

चरण 6  यफद डटेा को आगे के स्प्तरों में समूहीकृत करिा ह ैतो आप दसूरे समूह और तीसरे समूह के टैब का उपयोग 

कर सकते हैं। 

चरण 7. ओके बटि पर नक्ट्िक करें। 

रायोनगक गनतनवनि 4.2 - कक्षा X के छात्रों द्वारा नवनर्न्न नवर्यों में अांकों को सांिहीत करिे के निए एक उदाहरण 

िेते हैं जैसा फक नचत्र 4.13 में दी गई तानिका में फदखाया गया ह।ै 

हम रत्येक कक्षा में चिुे गए नवर्यों का औसत निकाििा चाहते हैं। ऐसा करिे के निए, हम सबटोटि टूि का 

उपयोग करेंगे जो फकसी कॉिम पर डटेा को स्प्वचानित रूप से समूनहत करता ह ैऔर फकसी र्ी कॉिम पर चयनित 

फां क्ट्शि करता ह।ै 

इसे हि करिे के निए, निम्न चरणों का पािि करें: 
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चरण 1  एक वगभ के निए एक शब्द में छात्रों के निए अांक िेिे के निए नचत्र 4.13 में फदखाए अिुसार एक शीट 

बिाएां। 

 

नचत्र 4.13 दो कक्षा में छात्र के अांकों के साथ स्प्रेडशीट 

चरण 2. अब, रत्येक नवर्य में रत्येक कक्षा के छात्रों द्वारा फकए गए औसत अांकों की गणिा करि ेके निए यािी 

कक्षा वार और नवर्य नवशे्लर्ण। 

चरण 3. ऐसा करिे के निए, डटेा> सबटोटि पर नक्ट्िक करें, जैसा फक नचत्र 4.14 में फदखाया गया ह ैसबटोटि 

डायिॉग खुि जाएगा। 

 
नचत्र 4.14 सबटोटि डायिॉग लवांडो 

 चरण 4. हमें 1 समूह में समूह के तहत कॉिम यािी क्ट्िास का चयि करि ेकी आवश्यकता ह,ै नजस पर हमें पूरे 

डटेा को समूनहत करिे की आवश्यकता ह।ै इसके अिावा कैिकुिेट सबटोटल्स के तहत सब्जेक्ट्ट्स यािी इांनग्िश, 

लहांदी, मैथ्स, साइांस और सोशि साइांस का चयि करें। रत्येक नवर्य के निए व्यनक्तगत रूप से उपयोग फां क्ट्शि के 

तहत औसत पर नक्ट्िक करें अन्यथा नडफॉल्ट रूप से सम फां क्ट्शि का उपयोग फकया जाएगा। 

चरण 5. ओके पर नक्ट्िक करें और नचत्र 4.15 में फदखाए अिुसार शीट फदखाई दगेी। 
 

 

नचत्र 4.15 सबटोटि के बाद अांक सूची 
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उस सांख्या सांख्या के बाईं ओर नस्प्थत रूपरेखा को दखेें जो उप-योग टूि को करिे के बाद डािी गई ह।ै यह रूपरेखा 

उस पदािुक्रनमत सांरचिा को दशाभती ह,ै नजसका उपयोग डटेा को सांनक्षप्त करिे के निए समूह सांकेतकों expand + 

'के नवस्प्तार और ‘-' नचन्ह पर नक्ट्िक करके नवनर्न्न स्प्तरों को फदखािे या नछपािे के निए फकया जा सकता ह।ै 

कोई low-level नववरण हाइड कर सकता ह ैऔर केवि final totals और grand totals दखे सकता ह।ै 

यफद आप फकसी र्ी समय शीट से आउटिाइि सुनविा को हटािा चाहत ेहैं तो Data> Group and Outline > 

Remove Outline पर नक्ट्िक करके सांर्व ह।ै 

 

रायोनगक अर्् ्यास 4.2 - नचत्र 4.16 में फदखाए अिुसार शीट बिाएां और फिर क्ट्िास और स्प्रीम के आिार पर 

नवर्यवार औसत के अांकों की गणिा करें। इसके अिावा, रत्येक नवर्य में छात्रों की सांख्या की गणिा करिे के निए 

एक अन्य फां क्ट्शि काउांट करिे की कोनशश करें। 

 

नचत्र 4.16 माकभशीट 

4.3 व्हाट-इि टूि – के पररदशृ्य 

 ‘व्हाट-इि टूि – के पररदशृ्य’ मािों का एक सेट है, जो स्प्रेडशीट में गणिा में उपयोग फकया जा सकता ह।ै पररदशृ्य 

को एक िाम फदया गया ह ैऔर एक ही शीट पर कई पररदशृ्य बिाए जा सकते हैं। 

इसका उपयोग बदिती पररनस्प्थनतयों के आिार पर नवनर्न्न नवकल्पों का पता िगािे और तुििा करिे के निए 

फकया जाता ह।ै इसका उपयोग आउटपुट के अिुकूिि के निए फकसी र्ी पररयोजिा की शुरुआत में फकया जा 

सकता ह।ै इस उपकरण का उपयोग इिपुट / आउटपुट को बदििे के दौराि आउटपुट / पररणाम का अिुमाि 

िगािे के निए फकया जाता ह ैजो आउटपुट को दशाभता ह ैऔर इस रकार कोई र्ी इसके आिार पर सबसे अच्छी 

योजिा का चयि कर सकता ह ै

 

उदाहरण के निए, कार ऋण िेिे वाि ेव्यनक्त को िीचे फदए गए अिुसार कुछ कारकों पर निणभय िेिा ह:ै 

 कार ऋण िेिे के निए वर्ों की सांख्या। 

 कार ऋण की कुि रानश 
 

उपरोक्त दो कारक यािी मूि ििरानश और वर्ों की सांख्या ईएमआई को मानसक र्ुगताि करिे के निए रदर्शभत 

कर सकते हैं। 
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पररदशृ्य बिािे के निए निम्न चरणों का पािि करें। 

चरण 1. उि सैि् ्स का चयि करें नजिमें शीट में माि शानमि हैं नजन्हें बदिि ेकी आवश्यकता ह।ै कई सैि् ्स का 

चयि करिे के निए, Ctrl कुां जी दबाए रखें और चयनित सेि पर नक्ट्िक करें। 

चरण 2. Tools>Scenarios डायिॉग लवांडो खुिेगी जैसा फक नचत्र 4.17 में फदखाया गया ह।ै 

चरण 3. िए पररदशृ्य के निए एक िाम दजभ करें और अन्य फील्ड को अपररवर्तभत छोड़ दें। 

 
नचत्र 4.17 पररदशृ्य डायिॉग लवांडो बिाएाँ 

चरण 4. ओके पर नक्ट्िक करें 

चरण 5. यह एक िया पररदशृ्य बिेगा जो स्प्वचानित रूप से सफक्रय होता ह।ै 

 

रायोनगक गनतनवनि 4.3 - आइए हम ईएमआई, कुि रानश का र्ुगताि और ऋण अवनि (मूििि) पर फदए गए 

कुि ब्याज की जािकारी राप्त करिे के निए एक निनित समय अवनि के निए तय ब्याज दर के निए एक उदाहरण 

िेते हैं। इसनिए, अब हम यह दखेिा चाहते हैं फक ईएमआई क्ट्या होगी और नवनर्न्न ऋण रानश और समय अवनि 

के निए कुि फकतिा ब्याज दिेा होगा। ऐसा करिे के निए, हम निम्ननिनखत चरणों का उपयोग करके पररदशृ्य टूि 

का उपयोग करें: 

चरण 1. निम्ननिनखत शीट बिाएां और बी3 में ईएमआई की गणिा करिे के निए सूत्र िगािे के निए याद रखें  

=ABS(PMT(B2/1200,E1*12,B1)) 

Total Amount in B4 =B3*E1*12 

Total Interest in B8  

=B4-B1 

 

 
नचत्र 4.18: ऋण पत्र 

चरण 2. Ctrl + का उपयोग करके B1 और E1 सैि् ्स का चयि करें इि सैि् ्स पर नक्ट्िक करें क्ट्योंफक य ेदोिों इस 

नस्प्थनत में variables चर हैं। 
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चरण 3. Tools > Scenario चुिें इसमें डायिॉग डायिॉग रदर्शभत होगा, जैसा फक नचत्र 4.19 में फदखाया गया ह।ै 

 नचत्र 4.19: पररदशृ्य डायिॉग लवांडो बिाएाँ 

चरण 4. पररदशृ्य का िाम निखें और OK बटि पर नक्ट्िक करें यह पररदशृ्य सूची में एड हो जाएगा। 

चरण 5. हम ऋण रानश के साथ LAmt_2 और LAmt_3 के रूप में दो और पररदशृ्य बिाते हैं जैसे फक 2500000, 

वर्भ की सांख्या 12 और ऋण रानश 2500000 के रूप में, क्रमशः 10 वर्भ की सांख्या। हम एक ही शीट पर ऐसा करि े

के निए रत्येक तय सैि् ्स में कुछ नर्न्न मािों के साथ अिग-अिग पररदशृ्यों को पररर्ानर्त कर सकते हैं, Tools > 

Scenario पर नक्ट्िक करें पररदशृ्य का िाम निखें और OK नक्ट्िक करें। जसैा नचत्र 4.20 में िोि शीट में फदखाया  

गया ह।ै 

 

नचत्र 4.20 पररदशृ्यों के साथ ऋण पत्र 

6. टूिबार में िेनवगेटर आइकि पर नक्ट्िक करें और फिर पररदशृ्यों पर नक्ट्िक करें। 

पररदशृ्य पर नक्ट्िक करें िाम उस पररदशृ्य के अिुसार सर्ी नववरण रदर्शभत करेगा। 

रायोनगक अर्् ्यास 4.3 - दो वैररएबि इिकम टैक्ट्स स्प्िैब और टैक्ट्स रेट के निए अिग-अिग पररदशृ्यों का 

उपयोग करके वेति दजभ करके आयकर की गणिा करें। शीट को नचत्र 4.22 में फदखाया गया ह।ै 

िीचे फदए गए अिुसार अिग-अिग पररदशृ्य : 

Income Slab Tax rate  

7.5 to 10 lakhs 15% 

10 to 12.5 lakhs 20% 

12.5 to 15 lakhs 25% 

>15 lakhs 30% 

  
नचत्र 4.21 आयकर शीट 
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4.4 व्हाट-इि नवश्लरे्ण टूि 

व्हाट-इि टूि डटेा> मल्टीपि ऑपरेशांस का उपयोग करता ह ैऔर व्हाट-इि सवािों के निए एक प्िालिांग टूि ह।ै 

इसमें आउटपुट को एक ही सेि में िहीं फदखाया जाता ह ैजबफक यह इिपुट के आिार पर आउटपुट को रदर्शभत 

करिे के निए ड्रॉप-डाउि सचूी का उपयोग करता ह।ै Multiple Operations टूि सूत्र में उपयोग फकए गए 

वैकनल्पक मूल्यों की सूची पर सूत्र को िाग ूकरिे वाि ेपररणामों की सूची रदर्शभत करिे के निए एक formula 

array बिाता ह।ै 
 

यह टूि सैि् ्स के दो array का उपयोग करता ह,ै एक array में इिपुट माि होत ेहैं और दसूरा array सूत्र का 

उपयोग करता ह ैऔर पररणाम रदर्शभत करता ह।ै  
 

दक्षता के निए आउटपुट स ेसमझिे के निए शुरुआत में जाांच करिा उपयोगी ह।ै क्ट्या-अगर नवशे्लर्ण उपकरण बहुत 

मददगार होता ह ैजब हम यह जाििा चाहते हैं फक हम फकसी नवशेर् उत्पाद के निए फकतिे िार् कमाते हैं, जो 

बेचि ेवािी इकाइयों की एक शृ्रांखिा के निए ह।ै 

व्हाट-इि नवश्लरे्ण टूि के निए निम्ननिनखत चरणों का उपयोग फकया जाता है: आइए एक सूत्र और एक चर के 

साथ गणिा करें: 

चरण 1. सैि् ्स में डटेा दजभ करें और फिर अन्य सैि् ्स में मूल्यों से पररणाम की गणिा करिे के निए एक सूत्र दजभ 

करें। 

चरण 2. इिपुट मािों की एक array बिाएां नजसके आिार पर सूत्र का उपयोग करके आउटपुट उत्पन्न फकया जािा 

ह।ै 

चरण 3. इिपुट array और आउटपुट array की सेि रेंज का चयि करें। 

चरण 4. Data>Multiple Operations पर multiple operations डायिॉग लवांडो रदर्शभत करेंगे जैसा फक नचत्र 

4.22 में फदखाया गया ह।ै 

नचत्र 4.22 मल्टीपि ऑपरेशि डायिॉग लवांडो 

चरण 5. िामूभिा बॉक्ट्स में उस शीट से cell address दजभ करें नजसमें सूत्र ह ै

चरण 6. अब, सेि का cell address दजभ करें जो एक चर variable ह ैऔर इसका उपयोग कॉिम इिपुट सेि 

बॉक्ट्स में सूत्र में फकया जाता ह।ै 

चरण 7. ओके पर नक्ट्िक करें सूत्र के आिार पर सर्ी सांर्ानवत आउटपुट उत्पन्न होंगे। 

रायोनगक गनतनवनि 4.4 - नबक्री मूल्य, िागत मूल्य और निनित िागत व्यय के आिार पर नबक्री की वार्र्भक 

शृ्रांखिा पर िार् की गणिा करिे के निए एक उदाहरण िेत ेहैं। 
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नचत्र 4.23 नबक्री_ रोत्साहि शीट 

चरण 2. सेि बी 5 में formula = B4 * ( B1 – B2) – B3 दजभ करें 

चरण 3. D2: E11 से सेि रेंज का चयि करें 

चरण 4. Data > Multiple Operations पर नक्ट्िक करें मल्टीपि ऑपरेशि डायिॉग लवांडो रदर्शभत होगा जैसा 

फक नचत्र 4.24 में फदखाया गया ह।ै 

नचत्र में 4.24 मल्टीपि ऑपरेशि करिा 

चरण 5. हमारे पास सेि बी 5 में सूत्र है, क्ट्योंफक हम उसी cell address का उपयोग करिा चाहते हैं, इसनिए, 

हमिे पूणभ सेि सांदर्भ का उपयोग फकया ह ैऔर इसे $B$5 के रूप में निखा ह।ै 

चरण 6. इस उदाहरण में, हमारे पास बेचा जािे वाि ेआइटमों की सांख्या के रूप में एक और चर ह ैजो फक सेि $ B 

$ 4 में है 

चरण 7. ओके पर नक्ट्िक करें जैसा फक नचत्र 4.25 में फदखाया गया ह।ै 

 

नचत्र 4.25 multiple operations के पररणाम 

व्यावहाररक अर्् ्यास 4.4 - िार् की गणिा करिे के निए निम्ननिनखत शीट बिाएां और फिर तय करें फक िार् के 

आिार पर फकतिी books रकानशत की जािी हैं। 
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नचत्र 4.26 व्यावहाररक अभ्यास 

 

4.5 Goal seek (िक्ष्य की तिाश) 

यह सामान्य ह ैफक हम सैि् ्स में values मूल्यों को र्रते हैं और फिर आवश्यक पररणाम राप्त करिे के निए इि 

मूल्यों पर formula सूत्र बिाते हैं। आउटपुट की र्नवष्यवाणी करिे के निए, हम वाांनछत output राप्त करिे के 

निए सर्ी इिपुट मूल्यों को बदिते रहते हैं। Goal seek से नवनशष्ट आउटपुट के निए इिपुट का पता िगािे में 

मदद नमिती ह।ै उदाहरण के निए, यफद आप वाांनछत आउटपुट राप्त करिे के निए उत्पाफदत इकाइयों की सांख्या 

जाििा चाहते हैं तो Goal seek नवशे्लर्ण टूि का उपयोग करें। Goal seek टूि का उपयोग करिे के निए 

निम्ननिनखत चरणों का पािि करें। 

चरण 1. वकभशीट में माि दजभ करें। 

चरण 2. उस सेि में सूत्र निखें जहाां calculation का उपयोग फकया जािा ह।ै 

चरण 3. िामूभिा सेि में कसभर रखें, Tools > Goal Seek चुिें। 

चरण 4. Goal Seek डायिॉग लवांडो नचत्र 1.27 में फदखाया गया ह,ै िॉमूभिा सेि बॉक्ट्स में सही सूत्र होगा। 

 

नचत्र 4.27 Goal Seek लवांडो  

चरण 5  कसभर को वेररएबि सेि बॉक्ट्स पर रखें और उस सेि पर नक्ट्िक करें नजसमें मूल्य को बदििा ह।ै 

चरण 6. Target value बॉक्ट्स में वाांनछत पररणाम दजभ करें। 

चरण 7. ओके बटि पर नक्ट्िक करें। 

 

व्यावहाररक गनतनवनि 1.5 - नवनशष्ट इिपुट के आिार पर एक इिपुट का पता िगािे के निए backward गणिा 

करिे के निए एक बहुत ही सरि उदाहरण िेते हैं। एक छात्र को 4 नवर्यों में अांक राप्त हुए हैं और उसे 5 वें नवर्य 

के निए परीक्षा में उपनस्प्थत होिा ह ैऔर कुि 70 अांक पािे एक समि योजिा ह।ै इसनिए, वह आवश्यक रनतशत 



80 

 

राप्त करिे के निए 5 वें नवर्य में फकतिे अांक राप्त करिे के निए goal seek करिे के निए goal seek tool का 

उपयोग कर सकता ह।ै इस कायभ को करिे के निए निम्न चरणों का पािि करें। 
 

चरण 1. माकभ  शीट बिाएाँ जैसा फक नचत्र 4.2 की sheet में िीचे फदखाया गया ह।ै सेि B7 as = Average(B2:B6)  

िां क्ट्शि दजभ करें।  

नचत्र 4.28 माकभ  शीट 

चरण 2. Tools > Goal Seek टूि पर नक्ट्िक करें Goal seek dialog लवांडो रदर्शभत होगी जैसा फक नचत्र 4.29 में 

फदखाया गया ह।ै 
 

नचत्र 4.29 Goal seek डायिॉग लवांडो  

चरण 4. िॉमूभिा सेि बॉक्ट्स में िॉमूभिा यानि बी 7 का सेि एड्रसे निखें। 

चरण 5. सेि के सेि एड्रसे को निखें जो नसस्प्टम द्वारा वेररएबि सेि बॉक्ट्स में उत्पन्न फकया जािा ह।ै इस उदाहरण 

में, सेि B6 में हम आवश्यक औसत अांकों के अिसुार र्रिा चाहते हैं। 

चरण 6. िक्ष्य माि बॉक्ट्स में पररणाम दजभ करें। हमारे रश्न के अिुसार, हमें न्यूितम 70 aggregate राप्त करिे 

होंग ेइसनिए हम target value में 70 निखेंगे। 

चरण 7. ओके पर नक्ट्िक करिे से एक तु्ररट रदर्शभत होगी क्ट्योंफक निबर ऑफिस Calc खािी होिे के निए 

Variable cell को स्प्वीकार िहीं करेगा। तो यह त्रुरट डायिॉग लवांडो वैररएबि सेि में 0 माि जोड़िे के निए सांकेत 

दगेी जैसा फक नचत्र 4.30 में फदखाया गया ह।ै 

 

नचत्र 4.30 गोि सीक िेि चेताविी 
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चरण 8. Yes पर नक्ट्िक करें और फिर चरण 2 दोहराएां डायिॉग लवांडो रदर्शभत करेगा और सांकेत दतेा ह ैफक क्ट्या 

गणिा मूल्य के साथ सेि को बदििा ह ैजैसा फक नचत्र 4.31 में फदखाया गया ह।ै 

नचत्र  4.31 Goal Seek सिि रहा 

चरण 9. अब Yes पर नक्ट्िक करें शीट में गणिा की गई एक के साथ माि को बदि दगेा जैसा फक नचत्र 4.32 में 

फदखाया गया ह।ै. 

नचत्र 4.32 Goal seek applyकरिे के बाद माकभशीट    
 

रायोनगक अर्् ्यास 4.5 - टैल्क के निए बेची जािे वािी मात्रा का पता िगािे के निए निम्न स्प्रेडशीट बिाएां ताफक 

50000 की कुि रानश राप्त हो सके। 

नचत्र 4.33 व्यावहाररक अभ्यास  
 

अपिी रगनत जाांचें 
 

क. बहुनवकल्पीय रश्न 

1. स्प्रडैशीट में निम्ननिनखत में स ेफकस ेडेटा नवश्लरे्ण का उपकरण मािा जा सकता ह?ै 

(a) Consolidating data  

(b) Goal Seek  

(c) Subtotal 

(D). उपरोक्त सर्ी 

2. निम्ननिनखत में स ेकौि एक नवश्लरे्ण उपकरण िहीं ह?ै 

(a) MS Access  

(b) MS Excel  

(c) Open Office Spreadsheet  

(d) उपरोक्त में से कोई िहीं 

3. निब्र ेऑफिस कैल्क के उपयोग स ेनिम्ननिनखत में स ेकौि सा ऑपरेशि फकया जा सकता ह?ै 

(a) Store and manipulate data  

(b) Create graphical representation of data  

(c) Analysis of data  
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(D) उपरोक्त सर्ी 

4. Calc में स्प्रेडशीट फाइि का extension क्ट्या ह?ै  

(a) .odb                                 (b) .odt                (c) .odg           (d) .ods 

5. Consolidate का उपयोग करते समय नडफॉल्ट कायभ ____________ ह।ै 

(a)  Average                       (b) Sum                           (c) Max                 (d) Count 

6. समूह द्वारा कॉिम पर _____________ टूि का उपयोग summary functions को apply करिे के निए फकया जाता ह ै 

(a) Consolidate function       (b) Group and Outline    (c) What-if Scenario       (d) Subtotal tool 

7. इिपुट बदिते समय आउटपटु का अिुमाि िगािे के निए फकस उपकरण का उपयोग फकया जाता ह?ै Which tool is 

used to predict the output while changing the input?  

(a) Consolidate function           (b) What-if scenario       (c) Goal seek     (डी) उपरोक्त सर्ी 

8. What-if tool में आउटपुट रदर्शभत होता ह?ै  

(a) in the same cells   (b) drop down list    (सी) दोिों (ए) और (बी) (डी) उपरोक्त में से कोई िहीं 

9. absolute cell referencing के निए कौि सा उदाहरण ह?ै  

(a) C5                (b) $C$5       (c) All of the above             (d) उपरोक्त में से कोई िहीं   

10. _______ नवश्लेर्ण उपकरण ररवसभ ऑडभर में काम करता ह,ै आउटपुट के आिार पर इिपुट ढूांढता ह।ै  

(a) Consolidate function          (b) Goal seek            (c) What-if analysis           (d) Scenario 

 
 

ख. यह बताएां फक निम्ननिनखत कथि सही हैं या गित 

1. समेफकत Consolidate फां क्ट्शि का उपयोग दो या अनिक शीट से जािकारी को एक में सांयोनजत करिे के निए फकया जाता 

ह।ै 

2. डेटा को देखिे और तुििा करिे के निए Consolidate फां क्ट्शि का उपयोग िहीं फकया जा सकता ह।ै 

3. स्रोत डेटा से लिांक की जााँच की जाती ह ैयफद स्रोत डेटा में कोई बदिाव फकया गया हो तो target sheet को अपडेट कर 

फदया जाता ह।ै 

4.Calc में subtotal का उपयोग sorting हतेु फफल्टर डेटा का उपयोग करिे की आवश्यकता ह।ै 

5. सबटोटि टूि सर्ी कॉिम के निए केवि एक रकार के summary फां क्ट्शि का उपयोग कर सकता ह।ै 

6. एक शीट के निए केवि एक पररदशृ्य बिाया जा सकता है।  

7. What-if analysis tool सैि् ्स के एक array का उपयोग फकया जाता ह।ै 

8. इिपुट के आिार पर आउटपटु की गणिा करते समय summary का उपयोग फकया जाता है। 
 
 

ग. ररक्त स्प्थाि र्रें : 

1. Consolidate फां क्ट्शि का उपयोग कई शीट्स से जािकारी को _________________ की जािकारी को सांयोनजत करिे 

के निए फकया जाता है। 

2. डेटा को ______________ फां क्ट्शि का उपयोग करके रेंड और ररिेशिनशप की पहचाि के निए एक ही शीट में देखा और 

तुििा फकया जा सकता ह।ै 

3. डेटा की तिुिा करिे के निए डेटा मेि ूके तहत ________________ का उपयोग कई शीट्स से सूचिाओं को एक शीट में 

नमिािे के निए फकया जा सकता ह।ै 
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4. Calc में _________________ उपकरण स्प्वचानित रूप से समूह बिाता ह ैऔर समूहीकृत डेटा पर कायभ करता ह।ै 

5. बदिती पररनस्प्थनतयों के आिार पर नवनर्न्न नवकल्पों का पता िगािे और तुििा के निए _______________ पररदशृ्य 

का उपयोग फकया जाता ह।ै 

6. ______________ what-if questions के निए एक योजिा उपकरण ह।ै  

7. What-if analysis tool ____________सैि् ्स के array का उपयोग करता ह,ै एक array में इिपुट माि होते हैं और 

दसूरा _____________ का उपयोग करता ह।ै 

8. _____________ से नवनशष्ट आउटपुट के निए इिपुट का पता िगािे में मदद नमिती ह।ै 

 

घ. निम्ननिनखत रश्नों के उत्तर दीनजए 

1. (क) Consolidate function (ख) What-if analysis (ग) Goal seek शब्दों को पररर्ानर्त करें।  

2. (क) सबटोटि और व्हाट-इि (बी) व्हाट-इि नसिेररयो और व्हाट-इि टूि के बीच अांतर का एक लबांद ुदीनजए 

3. डेटा नवश्लेर्ण उपकरण के कोई दो िायद ेबताएां। 

4. डेटा नवश्लेर्ण के निए फकसी र्ी दो उपकरणों का िाम दें। 

5. शीट consolidating करिे के निए क्ट्या मािदांड criteria हैं?  

6. selected data (चयनित डेटा) की outline बिािे के निए फकस उपकरण का उपयोग फकया जाता ह?ै 

रयोगशािा अर्् ्यास   

श्री गुरदीप को घर खरीदिे के निए 10 िाख रुपय ेका ऋण िेिा ह।ै अपिी नस्प्थनत का आकिि करिे के बाद, उसिे अिुमाि 

िगाया फक वह 15 वर्ों में 20,000 रु. की ईएमआई का रु्गताि करके ऋण का रु्गताि कर सकता ह।ै 

क) उस ब्याज दर का पता िगािे के निए Goal seek का उपयोग करें नजस पर वह ऋण िे सकता ह।ै 

ख) 10,000 की ईएमआई का रु्गताि करके 25 वर्ों में ऋण के रु्गताि को दशाभिे के निए What If Scenario का उपयोग 

करें। 

ग) सबसे अच्छे नवकि् ्प को खोजिे के निए Scenario manager का उपयोग करें। 

2.पावर मोटसभ की पूरे र्ोपाि में 3 शाखाएाँ हैं। रत्येक शाखा इिेनक्ट्रक स्प्कूटर के नवनर्न्न मॉडिों की मानसक नबक्री का 

रखरखाव करती ह ैऔर महीिे के अांत में स्प्टेट हडे को रे्जती है। एक समेफकत शीट तैयार करें, नजसमें इिेनक्ट्रक स्प्कूटर के 

रत्येक मॉडि के निए कुि नबक्री का औसत फदखाया जाता ह ैऔर शाखाओं द्वारा हडे ऑफिस को रे्जी गई स्प्रेडशीट के सांबांि 

में ह।ै आपको नवनर्न्न शाखाओं के निए कॉिम शीर्भकों की पहचाि करिा आवश्यक ह,ै रत्येक मॉडि के निए कुि नबक्री और 

औसत नबक्री और नवनर्न्न शाखाओं को दशाभते हुए इस का पता िगािे के निए तीि अिग-अिग शाखाओं में डेटा दजभ करें। 
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अध्याय 5. स्प्रेडशीट में मकै्रोज़ का उपयोग करिा 

5.1 पररचय 

कई बार, हमें बार-बार कायों को करिा पड़ता ह ैजसैे फक स्प्कूि का िाम, पता, एक नवनशष्ट रारूपण के साथ सांपकभ  

िांबर या कायभपुनस्प्तका में अिग-अिग शीट के निए एक नवशेर् सेि में एक ही िॉमूभिा िागू करिा। यह फकतिा 

आसाि होगा यफद हम एक बटि के नक्ट्िक पर ऐसा कर सकते हैं? यह सुनिनित करेगा फक हम नबिा फकसी 

टाइलपांग गिती के िॉन्ट स्प्टाइि के सांदर्भ में मािकीकरण बिाए रखें। क्ट्या आप फकसी अन्य िार् के बारे में सोच 

सकते हैं? इस अध्याय में, हम सीखेंगे फक बार-बार फकए जािे वाि ेकायों को स्प्वचानित करिे के निए मैक्रो का 

उपयोग कैसे फकया जाए जो फक बार-बार उसी तरह से फकए जाते हैं। 

 

5.2 मकै्रो ररकॉडभ करिा 

मैक्रो एक एकि निदशे ह ैजो निदशेों का एक सेट executes करता ह।ै निदशेों के ये सेट बाद में फकसी र्ी सांख्या में 

उपयोग फकए जािे वाि ेcommands या कीस्प्रोक्ट्स का अिुक्रम हो सकते हैं। कीस्प्रोक्ट्स और नक्ट्िक जसैी फक्रयाओं 

का एक क्रम ररकॉडभ फकया जा सकता ह ैऔर फिर आवश्यकता के अिुसार चिाया जा सकता ह।ै 

यह जाििा महत्वपूणभ ह ै फक जब हमारे कां प्यूटर पर निबे्र ऑफिस स्प्थानपत होता ह ैतो नडफॉल्ट रूप से मैक्रो 

ररकॉर्डिंग सुनविा को बांद कर फदया जाता ह।ै इसनिए, मैक्रो ररकॉडभ करिे के निए हमें यह सुनिनित करिे की 

आवश्यकता ह ैफक मैक्रो ररकॉर्डिंग enabled ह।ै Tools > Options > LibreOffice > Advanced करके मुख्य मेि ू

बार पर टूि नवकल्प का उपयोग करके मैक्रो ररकॉर्डिंग को enabled फकया जा सकता ह।ै Optional Features 

दखेें। 
 

दो नवकल्प हैं जो चेकमाकभ  िहीं होते हैं। नवकल्प "मैक्रो ररकॉर्डिंग enabled" पर चेकमाकभ  डािें जैसा फक नचत्र 5.1 

में फदखाया गया ह।ै 

 
 

Fig 5.1 a Macro नचत्र 5.1 मैक्रो को Enabling करिा 

 
 

नचत्र 5.2 में दखेें, Tools> Macros के तहत पाया गया ररकॉडभ मकै्रो नवकल्प अब फदखाई द ेरहा ह।ै 
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नचत्र 5.2 मैक्रो को enabling करिे के बाद मैक्रो ररकॉडभ नवकल्प 

 
 

मैक्रो सर्ी कीबोडभ और माउस फक्रयाओं को ररकॉडभ करता ह ैिेफकि निम्ननिनखत फक्रयाएां ररकॉडभ िहीं की जाती हैं। 

 लवांडो खोििा 

 ररकॉर्डिंग शुरू फकए जािे की तुििा में दसूरी लवांडो में फकए गए कायभ। 

  लवांडो नस्प्वलचांग। 

 ऐसे कायभ जो स्प्रेडशीट सामिी से सांबांनित िहीं हैं। उदाहरण के निए, 

 Options डायिॉग में फकए गए पररवतभि, macro organizer, customizing । 

 चयि केवि ररकॉडभ फकए जाते हैं यफद वे कीबोडभ (कसभर यात्रा) द्वारा उपयोग फकए जाते हैं, िेफकि जब 

माउस का उपयोग िहीं फकया जाता ह।ै 

 मैक्रो ररकॉडभर केवि कैल्क और राइटर में काम करता ह।ै 

मैक्रो ररकॉडभ करिे के निए िीचे फदए गए चरणों का पािि करें। 

चरण 1. Tools > Macros पर नक्ट्िक करें और फिर ररकॉडभ मैक्रो नवकल्प पर नक्ट्िक करें। 

चरण 2. अब उि कायों को िेिा शुरू करें जो ररकॉडभ फकए जाएांगे। 

चरण 3. एक बार जब आप ररकॉडभ मैक्रो नवकल्प पर नक्ट्िक करते हैं, तो फक्रयाओं की ररकॉर्डिंग शुरू हो जाती ह ै

और एक छोटा अिटभ रदर्शभत होगा जैसा फक नचत्र 5.3 में फदखाया गया ह।ै "स्प्टॉप ररकॉर्डिंग" बटि पर नक्ट्िक करिे 

स ेactions की ररकॉर्डिंग बांद हो जाएगी। 
 

 
नचत्र 5.3 स्प्टॉप ररकॉर्डिंग बटि 
 

चरण 4. इसमें बिाई गई मैक्रो को सेव करिे और चिाि ेके निए बेनसक मैक्रोज़ डायिॉग लवांडो खोिा जाएगा, 

जैसा फक नचत्र 5.4 में फदखाया गया ह।ै 

चरण 5. मैक्रो को सेव करिे के निए, पहिे उस ऑब्जेक्ट्ट का चयि करें जहााँ आप चाहते हैं फक Save Macro को 

सूची बॉक्ट्स में सहजेा जाए। 
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 नचत्र 5.4 मूि मैक्रोज़ डायिॉग लवांडो 

 

चरण 6. नडफॉल्ट रूप से मैक्रो का िाम Main ह ैऔर इसमें मॉडू्यि 1 में Standard Library मैक्रो का िाम बदििे 

की सिाह दी जाती ह।ै 

चरण 7. सेव बटि पर नक्ट्िक करें। 

एक Library मॉडू्यि का एक सांिह ह ैजो मैक्रोज़ के सांिह को चािू करता ह।ै 
 

रायोनगक गनतनवनि 5.1 - सिे A1 में हलेडांग "डटेा एिानिनसस" के निए निम्ननिनखत स्प्टाइि को िाग ूकरिे के 

निए एक मैक्रो ररकॉडभ करें। 

फॉन्ट शैिी "टाइम्स न्यू रोमि" होिी चानहए 

फॉन्ट का आकार "14" होिा चानहए 

फॉन्ट का रांग "िीिा" होिा चानहए 

A1 स ेG1 की सैि् ्स को मजभ और सेंटर फकया जािा चानहए 

 

रफक्रया 

चरण 1. स्प्रेडशीट बिाएां। सेि A1 में शीर्भक "डटेा नवशे्लर्ण" निखें। 

चरण 2. Tools > Macros > Record Macro चुिें। 

स्प्रेडशीट में रायोनगक गनतनवनि 5.1 में ऊपर उनल्िनखत फक्रयाओं को करें। 

चरण 3. मैक्रो ररकॉडभर को रोकिे के निए Stop Recording पर नक्ट्िक करें। 

चरण 4. बेनसक मैक्रो डायिॉग नचत्र 5.4 में फदखाया गया ह,ै नजसमें आप मैक्रो को सेव कर सकते हैं और चिा 

सकते हैं। 

चरण 5. एक स्प्रेडशीट बिािे और सेव करिे पर Standard िाम का library नडफॉल्ट रूप से मौजूद होता ह।ै 

चरण 6. मैक्रो को सेव करिे पर पहिे उस ऑब्जेक्ट्ट का चयि करें जहााँ आप मैक्रो को सेव करिा चाहत ेहैं उसे सूची 

बॉक्ट्स में सहजेें। नचत्र 5.5 से पता चिता ह ै फक नडफॉल्ट रूप से मैक्रो का िाम मेि ह ैऔर इसे मॉडू्यि 1 में 

Standard Library में सहजेा गया ह।ै मैक्रो का िाम बदििे की सिाह दी जाती ह।ै हमिे मैक्रो को Format 

Heading िाम फदया ह।ै 
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 नचत्र 5.5 एक मैक्रो का िामकरण 
 

िोट - यफद सर्ी मैक्रो को एक ही िाम फदया जाएगा तो वे उस िाम से बिाए गए नपछिे मैक्रो को ओवरराइट कर देंगे। 

मैक्रो, मॉड्यूि या िाइबे्ररी का िामकरण करिे के नियम : 

एक मैक्रो, मॉड्यूि या िाइबे्ररी का िामकरण करते समय िाम होिा चानहए : 

• Begin with a letter 

• Not contain spaces 

• Not contain special characters except for _ (underscore) 
 

 

5.3 मकै्रो चिािा 

आइए अब मैक्रो को एक और शीट के निए चिाते हैं नजसके निए सेि A1 में इसकी हलेडांग की आवश्यकता होती ह ै

नजसे िॉमटे हलैडांग मैक्रो में दजभ फकए गए िॉमटे के समाि फदया जाता ह।ै 

मैक्रो को चिािे के निए हमें निम्न चरणों का पािि करिा होगा। 

चरण 1. सेि A1 में हलेडांग टाइप करें  

चरण 2. Macro Selector dialog box खोििे के निए Tools > Macros > Run Macro उपकरण का उपयोग 

जैसा फक नचत्र 5.6 में फदखाया गया ह।ै 

 नचत्र 5.6 एक मैक्रो का चयि करिा और उसे चिािा 
 

नचत्र 5.6 library में तीि िामों को दशाभया जाता ह।ै नजसमें से 

 निबे्र ऑफिस मैक्रॉस िाइबे्ररी निब्र ेऑफिस द्वारा रदाि की जाती ह ैऔर इसमें री ररकॉडडे मैक्रोज़ के 

साथ मॉडू्यि होते हैं और इन्हें बदिा िहीं जािा चानहए। 

 My Macros में मैक्रोज़ होते हैं नजन्हें हम निबर ऑफिस में निखते हैं या जोड़ते हैं। 

 अिटाइटल्ड 1 उस वकभशीट का िाम ह,ै नजस पर हम काम कर रह ेहैं। चूांफक इस समय हमिे कायभशीट को 

फकसी अन्य िाम से सेव िहीं फकया ह,ै यह Untitled 1 फदखा रहा ह।ै आप आगे दखेेंगे फक Untitled1 को 

स्प्रेडशीट के िाम से बदि फदया जाएगा। 

चरण 3. िाइबे्ररी सूची में िाइबे्ररी और मॉडू्यि का चयि करें। 

चरण 4. मैक्रो िाम सूची में मैक्रो का चयि करें। 

चरण 5. मैक्रो को चिािे के निए चिाएाँ नक्ट्िक करें। 
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रायोनगक गनतनवनि 5.2 - पहिे से बिा मैक्रो िॉमटे हलैडांग चिाएां। 

चरण 1. सेि A1 में हलेडांग टाइप करें। 

चरण 2. Tools -> Macros->Run Macro चिाकर Macro selector डायिॉग बॉक्ट्स खोिें 

चरण 3. MyMacros> Standard> Module1 पर नक्ट्िक करें। फिर मैक्रो िाम बॉक्ट्स से िॉमेट हलैडांग का चयि 

करें और नचत्र 5 में फदखाए अिुसार Run पर नक्ट्िक करें। 
 

आप दखेेंगे फक सेि A1 में हलेडांग िॉमटे की गई ह।ै  

 

मैक्रो द्वारा दजभ की गई कारभवाई को रोिालमांग र्ार्ा में निदशे के रूप में दजभ फकया जाता ह ैनजस ेBASIC कहा जाता 

ह।ै यह दखेिा और मैक्रो के कोड को सांपाफदत करिा र्ी सांर्व ह।ै िेफकि याद रखें, मैक्रो को सांपाफदत करिे की 

सिाह केवि तर्ी दी जाती ह ैयफद आपको उस र्ार्ा का ज्ञाि ह ैनजसमें मैक्रो निखा गया ह ैजो CALC के मामि ेमें 

BASIC ह।ै आप Tools > Macros > Edit Macros पर जाकर मैक्रोज़ के निए उत्पन्न कोड दखे सकते हैं। 

ऑब्जेक्ट्ट कैटिॉग से मैक्रो िाम चुिें और सांबांनित कोड फदखाई दगेा जैसा फक नचत्र 5.7 में फदखाया गया ह।ै 

 नचत्र 5.7 आईडीई में मैक्रो के निए कोड उत्पन्न 
 

चतेाविी - जब तक आपको र्ार्ा की जािकारी ि हो, तब तक कोड में कोई बदिाव ि करें। 

िोट - एक मैक्रो का कोड Sub के बाद मैक्रो के िाम से शुरू होता ह ैऔर End Sub के साथ समाप्त होता ह।ै 

 

5.4 सरि मकै्रो बिािा और व्यवनस्प्थत करिा 

अब तक हमि ेमैक्रो को ररकॉडभ करिा, स्प्टोर करिा और चिािा सीखा ह।ै ररकॉडभ फकए गए मैक्रो को आांतररक रूप 

स ेएक रोिालमांग र्ार्ा में निखे गए निदशेों के रूप में सांिहीत फकया जाता ह ैजो मैक्रो executed या run करि ेपर 

execute होते हैं। 

हमिे अपिे ररकॉडभ फकए गए मैक्रो को सांिहीत करिे के निए एक िाइबे्ररी या मॉडू्यि का चयि फकया, इसी तरह 

एक मैक्रो बिाते समय हमें या तो एक िया िाइबे्ररी / मॉडू्यि बिािे की आवश्यकता होती ह ैया हमारे बिाए गए 

मैक्रो को सांिहीत करिे के निए एक िाइबे्ररी में सांिहीत मौजूदा मॉडू्यि को सांपाफदत करिा होता ह।ै मैक्रो को 

व्यवनस्प्थत करिे के निए निम्न चरणों का उपयोग करें। 
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चरण 1. निबे्र ऑफिस बेनसक मैक्रो डायिॉग लवांडो खोििे के निए Tools > Macros > Organize Macros > 

LibreOffice Basic पर नक्ट्िक करें> जैसा फक नचत्र 5.8 में फदखाया गया ह।ै 

नचत्र 5.8 बेनसक मैक्रो डायिॉग लवांडो 

चरण 2. मूि मैक्रो Organizer डायिॉग खोििे के निए Organizer पर नक्ट्िक करें जैसा फक नचत्र 5.8 में फदखाया 

गया ह।ै 

 नचत्र 5.9 निब्र ेऑफिस बेनसक मैक्रो ऑगभिाइज़र 

 

एक मकै्रो स्प्टोर करि ेके निए िाइब्ररेी बिाएाँ  

मॉडू्यि युक्त एक िई िाइबे्ररी बिािे के निए, Library > New पर नक्ट्िक करें। 

मैक्रो को सांिहीत करिे के निए एक मॉडू्यि बिािे के निए निम्न चरणों का उपयोग करें।  

मॉडू्यि टैब चुिें और एक मॉडू्यि चुिें। िया मॉडू्यि बिािे के निए िया पर नक्ट्िक करें। 

रायोनगक गनतनवनि 5.3 - बेनसक रोिालमांग निदशेों का उपयोग करके एक सरि मैक्रो बिाएां, जो मािक मॉडू्यि 

में सांिहीत डायिॉग बॉक्ट्स में execute होिे पर हिैो रदर्शभत करेगा जैसा फक नचत्र 5.10 में फदखाया गया ह।ै 

नचत्र 5.10 का उपयोग करके एक डायिॉग हिैो का रदशभि 

चरण 1. Tools > Macros > Organize Macros > Libre Office Basic का उपयोग करके निबर ऑफिस बेनसक 

मैक्रो डायिॉग बॉक्ट्स खोिें। 

चरण 2. बेनसक मैक्रोज़ डायिॉग बॉक्ट्स से Organizer का चयि करें 

चरण 3. मॉडू्यि टैब से, My Macros फोल्डर चुिें और िया बटि पर नक्ट्िक करें जैसा फक नचत्र 5.11 में फदखाया 

गया ह।ै 
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 नचत्र 5.11 हैिो के साथ एक मॉड्यूि बिािा 

चरण 4. िए मॉडू्यि को एक िाम हिैो दें और ओके पर नक्ट्िक करें। आप My Macros िाइबे्ररी में स्प्टैंडडभ िाइबे्ररी 

के तहत हिैो दखेें। 

 नचत्र 5.12 बेनसक मैक्रो ऑगभिाइज़र डायिॉग में  मॉड्यूि हैिो  

चरण 5. हिैो का चयि करें और Integrated Development Environment (IDE) को खोििे के निए सांपाफदत 

करें (नचत्र 5.12) पर नक्ट्िक करें। यह एक text editor ह ैजो आपको मैक्रोज़ बिािे और edit करिे की अिुमनत 

दतेा ह।ै Sub Main और End Sub के बीच टाइप करें “हिेो” जैसा फक नचत्र 5.13 में फदखाया गया ह।ै 
 

नचत्र 5.13 हिैो मैक्रो का कोड 

F5. निर्मभत मॉडू्यि को नपछिे अिुर्ाग में बताया गया ह।ैइसके अिावा, मॉडू्यि IDE से रि बटि पर नक्ट्िक 

करके या F5 दबाकर निष्पाफदत फकया जा सकता ह।ै 

 

5.5 एक function के रूप में मकै्रो 

ऐसी नस्प्थनत पर नवचार करें नजसमें आपको गणिा करिे की आवश्यकता होती ह ैजो बार बार दोहराए जाते हैं। 

माि िें फक एक ही सूत्र को अिग-अिग शीट में अिग-अिग डटेा पर िाग ूकरिे की आवश्यकता ह ैऔर इसके निए 

कोई पहिे से तय फां क्ट्शि िहीं ह।ै ऐसी नस्प्थनत में क्ट्या यह सुनविाजिक िहीं होगा यफद हम एक ऐसा मैक्रो बिा 

सकते हैं जो यह गणिा करता ह?ै इससे हमें सूत्रों को याद करिे और टाइप करिे के रयास को कम करिे में मदद 

नमिेगी। ऐसा करिा सांर्व ह ैफक यफद हम एक फां क्ट्शि के रूप में मैक्रो का उपयोग करते हैं। सब और एांड सब के 

बीच निदशे निखि े के बजाय, हम िां क्ट्शि और एांड िां क्ट्शि के बीच निदशे निख सकत े हैं। एक फां क्ट्शि 

arguments/values को स्प्वीकार करि ेमें सक्षम ह।ै यह arguments पर कारभवाई कर सकता ह,ै गणिा कर 

सकता ह ैऔर पररणाम वापस कर सकता ह।ै 
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व्यावहाररक गनतनवनि 2.4 - एक फां क्ट्शि के रूप में मैक्रो का उपयोग करके कमरे के िशभ के निए आवश्यक टाइिों 

की सांख्या की गणिा करें। कमरे की िांबाई और चौड़ाई और टाइि की िांबाई और चौड़ाई शीट में दजभ की गई ह ै

जैसा फक नचत्र 5.14 में फदखाया गया ह।ै 

नचत्र 5.14 शीट िशभ और टाइि की िांबाई और चौड़ाई र्ांडारण 

 

चरण 1. एक शीट में डटेा दजभ करें और इसे Calculate tiles के रूप में िाम के साथ सेव करें।  

चरण 2. निब्र ेऑफिस बेनसक मैक्रोज़ डायिॉग खोििे के निए Tools > Macros > Organize Macros > 

LibreOffice Basic चुिें । 

चरण 3. Calculatetiles.ods. चुिें। न्यू पर नक्ट्िक करें और एक िाम टाइप करें। हमिे इसे Calc टाइल्स का िाम 

फदया ह ैजैसा फक नचत्र 5.15 में फदखाया गया ह ैऔर ओके दबाएां। 

 

 नचत्र 5.15 फां क्ट्शि को पररर्ानर्त करिे के निए एक िया मॉडू्यि बिािा 

चरण 4. टाइल्स की सांख्या की गणिा करिे के निए एक फां क्ट्शि निखें। एक फां क्ट्शि इसमें फां क्ट्शि के िाम के बाद 

फां क्ट्शि के साथ शुरू होता ह ैऔर फिर िशभ, टाइल्स और टाइल्स की सांख्या की गणिा करिे के निए स्प्टेटमेंट टाइप 

करता ह ैऔर फां क्ट्शि के िाम पर अांनतम पररणाम को स्प्टोर करता ह ैजसैा फक नचत्र 5.16 में फदखाया गया ह।ै 

टूिबार पर सेव बटि दबाएाँ या Ctrl + S दबाएाँ। 

 

नचत्र 5.16 टाइि की सांख्या गणिा हतेु फां क्ट्शि की पररर्ार्ा दशाभती आईडीई  

 

िोट: िे में टेक् ्स् ्ट single (लसांगि कोट) से पहिे ह ैयह दशाभता ह ैफक यह एक comment ह।ै कोड का समथभि करि े

के निए वणभिात्मक टेक् ्स् ्ट निखिे के निए एक comment निखा गया ह।ै 
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चरण 5. शीट में फां क्ट्शि का उपयोग करें जैसा फक नचत्र 5.17 में फदखाया गया ह।ै 

नचत्र 5.17 एक function के रूप में मैक्रो का उपयोग करके शीट 

चरण 6. अन्य सैि् ्स के निए फां क्ट्शि को drag के निए fill handle का उपयोग करें। अांनतम शीट नचत्र 5.18 में 

फदखाई गई ह।ै 

नचत्र 5.18 एक function के रूप में मैक्रो का उपयोग करके टाइिों की सांख्या 

रदर्शभत करिा 

अपिी रगनत जाांचें 

क. बहुनवकल्पीय रश्न 

1. मेि ूबार में मैक्रो ररकॉर्डिंग को ________ नवकल्प से enable फकया जा सकता ह।ै  

(a) Sheet (b) Data (c) Tools (d) Window 
 

2. निम्ननिनखत में से कौि सा एक invalid मैक्रो िाम ह?ै 

(a) 1 formatword (b) format word (c) format*word (d) Format_word 

3. इिमें से फकस िाइबे्ररी में पूवभ-नििाभररत मैक्रोज़ वािे मॉड्यूि हैं और उन्हें बदिा िहीं जािा  चानहए? 

(a) My Macros (b) LibreOfficeMacros (c) Untitled1 (d) Test 
 

4. पहचािें फक रोिालमांग र्ार्ा निम्ननिनखत में से कौि सी ह?ै 

(a) Calc                (b) BASIC                     (c) Writer                    (d) Macro 

5. आईडीई से मॉड्यूि को _____ दबाकर निष्पाफदत फकया जा सकता ह ै

(a) F3 (b) F4 (c) F5 (d) F6 

6. निम्ननिनखत में से कौि मैक्रो का नडफॉल्ट िाम ह ै

(a) Default         (b) Main (c) Macro1 (d) Main_Macro         

ख. ररक्त स्प्थाि र्रें 

1. _____________ िाइबे्ररी डॉक् ्यूमेंट खोिे जािे पर स्प्वचानित रूप से िोड हो जाता ह।ै 

2. आईडीई _______________________________ का अथभ ह।ै 

3. एक function के रूप में मैक्रो _____ को accept करिे में और _____ return करिे में सक्षम होता ह।ै 

4. मैक्रो ________________ हमें एक मॉड्यूि को जोड़िे, हटािे की अिुमनत देता ह।ै 
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5. मैक्रो का कोड ________ शुरू होता ह ैऔर उसके बाद मैक्रो के िाम से शुरू होता ह ैऔर __________ के साथ समाप्त 

होता ह।ै (Ans Sub, End Sub) 

6. नडफॉल्ट रूप से एक मैक्रो को _____________ (Ans Standard Library) में सेव फकया जाता ह ै

 

ग. बताइए फक निम्ननिनखत कथि सही हैं या गित 

1. मैक्रो single instruction को executing करिे वािे निदेशों का एक समूह है। 

2. मैक्रो को एक बार बिािे के बाद फकसी र्ी समय उपयोग फकया जा सकता ह।ै 

3. नडफॉल्ट रूप से, मैक्रो ररकॉर्डिंग सुनविा चािू ह।ै 

4. मैक्रो की ररकॉर्डिंग को रोकिा सांर्व िहीं है। 

5. हर मैक्रो को एक िया िाम फदया जािा चानहए।  

6. एक बार बिाया गया मैक्रो बाद में सांपाफदत फकया जा सकता ह।ै 

 

घ. निम्ननिनखत रश्नों के उत्तर दीनजए 

1. मैक्रो क्ट्या ह?ै फकसी र्ी दो वास्प्तनवक जीवि नस्प्थनतयों को सूचीबद्ध करें जहाां उिका उपयोग फकया जा सकता ह।ै 

2. उि कायों को सूचीबद्ध करें जो एक मैक्रो द्वारा दजभ िहीं फकए गए हैं। 

3. निबे्र ऑफिस मैक्रोज़ िाइबे्ररी my Macros से कैसे अिग ह?ै 

4. एक function के रूप में कैल्क और मैक्रोज़ में पूवभनििाभररत फां क्ट्शि के बीच अांतर बताएां  

5. एक मैक्रो का िामकरण करते समय उि नियमों को सूचीबद्ध करें नजन्हें ध्याि में रखा जािा चानहए। 

6. मैक्रोज़ का कोई एक िायदा बताएां। 

 

रयोगशािा अर्् ्यास 

1. एक मैक्रो ररकॉडभ करें जो सेि A1 में हलेडांग पर बोल्ड, अांडरिाइि करता ह।ै मैक्रो को BoldunderlineA1 िाम दें और इसे 

बेनसक िॉमेटटांग िामक एक िए मॉड्यूि में सेव करें जो एक िई िाइबे्ररी में बिाई गई ह ैनजसका िाम Documen Heading 

A1 ह।ै 

2. एक मैक्रो ररकॉडभ करें जो A2 – A9 और K2 to K9 तक सांिहीत डेटा के निए एक बार चाटभ बिाता ह।ै 

3. (i) में दजभ मैक्रो को चिाएां और 2010-2017 से न्यूितम और अनिकतम तापमाि फदखाते हुए निम्ननिनखत डेटा के निए 

एक बार चाटभ रदर्शभत करें। 

 
4. वेबसाइट __ पर दखेें और Calc शीट में दनक्षण एनशयाई दशेों की जिसांख्या फदखािे वािी तानिका को स् ्टोर 

करें। सांिहीत डटेा के निए चाटभ रदर्शभत करिे के निए (i) में बिाया गया मैक्रो चिाएाँ। 
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5. 5% छूट के बाद र्ुगताि की जाि ेवािी रानश की गणिा करिे के निए एक फां क्ट्शि के रूप में मैक्रो बिाएां। उसी 

के निए एक िमूिा पत्र िीचे फदया गया ह:ै 

  नचत्र 5.19 िैब अर्् ्यास 5 

 

6. अिुजा को हर टमभ के निए माक्ट्सभ निस्प्ट बिािी होगी। िॉमेट इस रकार ह:ै 

नचत्र 5.20 सैंपि शीट माक्ट्सभ एांरी के निए 

 

क) नचत्र 5.20 में फदए गए िॉमेट को बिािे के निए दो मैक्रो ररकॉडभ करें। 

ख) सूची में छात्रों के िाम दजभ करिे के निए ताफक उसे िामों को फिर से निखिे या कॉपी करिे की आवश्यकता ि 

हो। एक िई शीट के निए ऊपर बिाए गए मैक्रोज़ को चिाएां। 

7. वाहि के माइिेज की गणिा करिे के निए एक फां क्ट्शि के रूप में मैक्रो का उपयोग करें। माइिेज (फक.मी. / 

निटर में) दरूी की यात्रा के रूप में गणिा की जाती ह ै(फक.मी. में) / ईंिि र्रा (निटर में)। तीि कॉिम के साथ 

यात्रा की दरूी (फक.मी. में), र्रा गया ईंिि (निटर में) और माइिेज (फक.मी. / निटर में) को िेकर एक शीट 

बिाएां।  
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अध्याय 6. स्प्रडेशीट डटेा को जोड़िा 

6.1 पररचय 

हमिे स्प्रेडशीट में डटेा को व्यवनस्प्थत करिे के निए िौवीं कक्षा में सीखा ह।ै आइए हम एक ऐसी नस्प्थनत िेते हैं जहाां 

तीि शब्दों के रत्येक छात्र द्वारा बिाए गए अांकों को तीि टर्मभिि परीक्षाओं में सांिहीत फकया जाता ह,ै नजन्हें तीि 

अिग-अिग शीट टमभ 1, टमभ 2, टमभ 3 में सांिनहत फकया जाता ह।ै अब रत्येक नवर्य के औसत अांक राप्त करके एकि 

पररणाम शीट में अांनतम पररणाम उत्पन्न करिे के निए, आदशभ समािाि क्ट्या होगा? अांक को फिर से र्रिा या 

कॉपी करिा एक समािाि हो सकता ह ैिेफकि यह समय िेिे वािा होगा और टाइलपांग त्रुरटयों को करिे की 

सांर्ाविा र्ी ह।ै  

इसके बजाय, आदशभ समािाि के निए शीट टमभ 1, टमभ 2 और टमभ 3 में सांिहीत अांकों को सांदर्र्भत करिे का एक 

तरीका खोजिा होगा। इस तरीके स,े त्रुरटयों की सांर्ाविा कम हो जाती ह ैऔर अनिक से अनिक यफद फकसी नवर्य 

के अांकों को बदि फदया जाता ह,ै तो यह रनतलबांनबत होगा और इस रकार पररणाम शीट में औसत की गणिा करते 

समय शुद्धता सुनिनित करता ह।ै  
 

इस अध्याय में, हम कई शीट बिािे के तरीका और डटेा को कई शीट में लिांक करिे के निए र्ी सीखेंगे। यह दो 

तरीकों से फकया जा सकता ह,ै एक कीबोडभ और माउस का उपयोग करके अन्य शीट / डॉक् ्यूमेंट के सांदर्भ में बिािा 

ह,ै और दसूरा बाहरी डटेा को लिांक करके बिाया जाता ह।ै 

 

6.2 कई शीट सटे करिा 

आइए टमभ 1 िाम की शीट में पहिे शब्द के वकभशीट के र्ांडारण पर नवचार करें जसैा फक नचत्र 6.1 में फदखाया गया 

ह।ै 

नचत्र 6.1 टमभ 1 में छात्रों द्वारा हानसि फकए गए अांक 

स्प्रेडशीट में एक िई शीट जोड़िे के निए, स्प्रेडशीट के बाईं ओर नस्प्थत (+) नचह्ि पर नक्ट्िक करके Add शीट पर 

नक्ट्िक करें। वैकनल्पक रूप स ेआप शीट टैब पर कहीं र्ी नक्ट्िक कर सकत ेहैं और नचत्र 6.2 में फदखाए गए ड्रॉप-

डाउि सूची स ेसनम्मनित करें शीट नवकल्प का चयि कर सकते हैं। इससे हमें िई शीट िगािे का नवकल्प नमिता 

ह,ै शीट का िाम निर्दभष्ट फकया जाता ह,ै शीट को हटाया जाता ह ैऔर इसी तरह अि् ्य काम फकए जाते हैं। 
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नचत्र 6.2 राइट नक्ट्िक नवकल्प के बाद रदर्शभत रेि मेिू से िई शीट Insert करिा 

िोट - Insert Sheet dialog box को मेिू नवकल्प Sheet > Insert Sheet से शुरू फकया जा सकता ह ै 

रायोनगक गनतनवनि 6.1 - स्प्रेडशीट में टमभ 2 के निए डेटा को स्प्टोर करिे के निए एक िई शीट जोड़ें, नजसमें 

Insert Sheet Dialog box का उपयोग करें। 

चरण 1. Insert Sheet डायिॉग खोिें और After Current Sheet नवकल्प का चयि करके इस शीट के बाद एक 

शीट जोड़ें। करांट शीट हमारी सफक्रय शीट ह ैजो इस मामि ेमें टमभ 1 ह ैजैसा फक नचत्र 6.1 में फदखाया गया ह।ै 

चरण 2. शीट का िाम टमभ 2 ह ैजैसा फक नचत्र 6.3 में फदखाया गया ह।ै 

 नचत्र 6.3 Insert sheet डायिॉग 

चरण 3. टमभ 2 में छात्रों द्वारा राप्त अांकों को दसूरे टमभ की शीट में दजभ करें जैसा फक नचत्र 6.4 में फदखाया गया ह।ै 

नचत्र 6.4 टमभ 2 में छात्रों द्वारा हानसि फकए गए अांक 

आइए अभ्यास करें : 

एक िई शीट डािें और इसे “Result” िाम दें। 

िोट - आप नपछिे अध्याय में पररणाम शीट का format बिाि ेऔर समय बचािे के निए छात्र कॉिम के िाम 

पॉप्युिेट करिे के निए आपके द्वारा बिाए गए मैक्रो का उपयोग कर सकते हैं। 

 

6.3 कीबोडभ और माउस का उपयोग करके अन्य शीट का सांदर्भ बिािा। 

हम कक्षा IX में functions and और formulas को िाग ूकरि ेके निए सेि सांदर्भ का उपयोग कर रह ेहैं। इस खांड 

में हम सीखेंगे फक माउस और कीबोडभ का उपयोग करके अन्य शीट में सैि् ्स को कैसे सांदर्र्भत फकया जाए। 
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अांनतम पररणाम की गणिा करिे के निए, गनतनवनि 6.1 में डािा गया “Result” िाम की शीट में रत्येक नवर्य के 

अांनतम अांकों को स् ्टोर करिा आवश्यक ह।ै जैसा फक हम जािते हैं फक टमभ 1 और टमभ 2 में राप्त अांकों को क्रमशः टमभ 

1 और टमभ 2 िाम की अिग-अिग शीटों में स् ्टोर फकया जाता ह।ै 

 “Result”  शीट के सेि C4 में अांिेजी के अांनतम अांकों की गणिा करिे के निए, जैसा फक नचत्र 6.5 में फदखाया गया 

ह,ै निम्न चरणों का पािि करें। 

चरण 1. सबसे पहिे छात्र के रोि िांबर और िाम को टमभ 1 शीट से ररजल्ट शीट पर कॉपी करें, सर्ी शीर्भकों को 

कॉपी करें और िाइिि ररजल्ट का िाम दें। 

चरण 2. इिपुट िाइि के बगि में = आइकि पर नक्ट्िक करें (या सेि C4 में = टाइप करें), Sum () टाइप करें और 

brackets के बीच नक्ट्िक करें। 

चरण 3. अब टमभ 1 शीट पर नक्ट्िक करें और पहिे छात्र के निए अांिेजी अांक पर नक्ट्िक करें और अगिे मूल्य के 

निए (,) comma जोड़ें 

चरण 4. इसके बाद टमभ 2 शीट पर नक्ट्िक करें और पहिे छात्र के निए इांनग्िश माक्ट्सभ पर नक्ट्िक करें। 

चरण 5. योग के बाद औसत रकार / 2 की गणिा करिे के निए () जैसा फक नचत्र 3.5 में फदखाया गया ह ैऔसत की 

गणिा करें। 

चरण 6. Enter key रेस करें, औसत पररणाम शीट के सेि C4 में रदर्शभत होता ह।ै 

फिर अांनतम छात्र के डटेा तक सैि ्स को र्रिे के निए fill handle का उपयोग करें। 

चरण 7. पररणाम शीट अांिेजी में रत्येक छात्र द्वारा बिाए गए औसत अांक दतेा ह ैजैसा फक नचत्र 6.5 में फदखाया 

गया ह।ै 

चरण 8. आप अन्य नवर्यों के निए एक ही िॉमूभिा कॉपी कर सकते हैं। 

 

नचत्र 6.5 टमभ 1 और टमभ 2 शीट से डेटा सांदर्र्भत करिे पर पररणाम शीट 

 
 

टमभ 1 और टमभ 2 शीट में अांक के निए फकए गए कोई र्ी पररवतभि पररणाम शीट में र्ी फदखाई देंगे। इस तरह स े

शीट एक साथ जुड़ी हुई हैं। हमिे कक्षा पर नक्ट्िक करके सिे सांदर्भ चुिा था। सांदर्भ टाइप करिे के निए एक नवकल्प 

हो सकता ह।ै सबसे पहि,े हमें यह समझिे की आवश्यकता ह ै फक एक ही स्प्रेडशीट डॉक् ्यूमेंट में शीट पर कैसे 

सांदर्र्भत फकया जाता ह।ै इसनिए, फकसी अन्य शीट में एक सेि को सांदर्र्भत करि ेके निए हम '$' नचन्ह के साथ सिे 

सांदर्भ को राथनमकता दतेे हैं। इसके बाद शीट का िाम '' (एकि कोट) और उसके बाद ए. (डॉट) और फिर सेि 

एड्रसे। उदाहरण के निए, टमभ 1 िामक शीट के सेि C4 को सांदर्र्भत करिे के निए हम टाइप करेंगे: $'Term 1'.C4 
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िोट - लसांगि कोट्स (‘') का उपयोग फकया जाता ह ैक्ट्योंफक शीट िाम में टमभ और 1 के बीच एक स् ्पेस होता ह।ै 

 

आइए अभ्यास करें  

सर्ी कॉिम के निए कीबोडभ और अन्य कॉिम के निए माउस के साथ सांदर्र्भत करके सर्ी नवर्यों के निए अांनतम 

अांकों की गणिा करें। 

 

6.4 कीबोडभ और माउस का उपयोग करके अन्य डॉक्ट्यमूेंट का सांदर्भ बिािा 

नपछिे अिुर्ाग में हमिे एक स्प्रेडशीट में अन्य शीट के सांदर्भ बिाए थे। कर्ी-कर्ी हम फकसी अन्य स्प्रेडशीट फाइि 

में स् ्टोर की गई शीट रेिर कर सकते हैं। 

आइए ऐसी नस्प्थनत पर नवचार करें जहाां एक वगभ के रत्येक अिुर्ाग के निए पररणाम शीट के औसत से युक्त साराांश 

ररपोटभ बिािा आवश्यक ह।ै ऐसा करिे के निए, हमें उि शीटों को सनम्मनित करिा होगा जो नवनर्न्न फाइिों में 

स् ्टोर हैं। नचत्र 6.6 कक्षा X-A का अांनतम पररणाम फदखाया गया ह ैऔर नचत्र 6.7 कक्षा X-B का अांनतम पररणाम 

फदखाया गया ह।ै 

नचत्र 6.6 पररणाम X-A की स्प्रेडशीट में स् ्टोर कक्षा X-A के पररणाम 

 

नचत्र 6.7 पररणाम X-B के स्प्रेडशीट में स् ्टोर X-B के पररणाम  

 

रायोनगक गनतनवनि 6.2 - एक स्प्रेडशीट में पररणाम का साराांश बिाएां 

नचत्र 6.8 में फदखाए अिुसार कक्षा X-A और X-B के Result Analysis िाम का डॉक् ्यूमेंट। 
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 नचत्र 6.8 Result Analysis स्प्रेडशीट 

चूांफक दोिों कक्षाओं के अांक अिग-अिग स्प्रेडशीट फाइि में स् ्टोर फकए गए हैं और पररणाम नवशे्लर्ण स्प्वयां एक 

अिग स्प्रेडशीट है, इसनिए हमें अन्य स्प्रेडशीट के सांदर्भ बिािे की आवश्यकता ह।ै 

चरण 1. स्प्रेडशीट अथाभत् Result-X-A, Result-X-B और Result Analysis खोिें। 

चरण 2. पररणाम नवशे्लर्ण स्प्रेडशीट के सेि बी 4 पर नक्ट्िक करें और टाइप करें = मैक्ट्स (), जैसा फक नचत्र 6.9 में 

फदखाया गया ह।ै 

चरण 3. MAX () के कोष्ठक के बीच नक्ट्िक करें और फिर पररणाम-X-A स्प्रेडशीट के पररणाम शीट में अांिेज़ी के अांक 

वाि ेसेि रेंज पर नक्ट्िक करें। 

चरण 4. टाइप करें (), कॉमा पर नक्ट्िक करें और ररजल्ट-एक्ट्स-बी स्प्रेडशीट के ररजल्ट शीट में अांिेजी के अांक वाि े

सेि पर नक्ट्िक करें। 

चरण 5. रेस दजभ करें, अनिकतम अांक सेि B4 में रदर्शभत फकए जाएांगे जैसा फक नचत्र 6.9 में फदखाया गया ह।ै 

नचत्र 6.9 मैक्ट्स िां क्ट्शि के उपयोग से अांिेजी में उच्चतम स्प्कोर रदशभि 

हमिे अिग-अिग स्प्रेडशीट में सैि् ्स पर नक्ट्िक करके सिे सांदर्भ का चयि फकया था और सांदर्भ टाइप करि ेके 

निए एक नवकल्प हो सकता ह।ै सबसे पहि,े हमें यह समझिे की आवश्यकता ह ैफक नवनर्न्न स्प्रेडशीट फाइिों में 

कैसे सांदर्र्भत फकया जाता ह।ै 

एक अिग स्प्रेडशीट में एक सेि को सांदर्र्भत करिे के निए हम लसांगि कोट्स में निखते हैं फाइि का पथ # $ उसके 

बाद शीट का िाम और उसके बाद ए। (डॉट) और फिर सेि एड्रसे। 

उदाहरण के निए: 'file:///C:/Users/ADMIN/Documents/X-A.ods'#$Result.C4 

िोट - फकसी फाइि के पथ में तीि फॉरवडभ स्प्िैश /// हैं। एक फाइििाम में इसके िाम के र्ीतर स् ्पेस हो सकता ह ै

इसनिए एकि कोट (‘ ‘) का उपयोग फकया जाता ह।ै 
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फकसी अन्य फाइि से शीट सनम्मनित करिा र्ी सांर्व ह।ै इांसटभ शीट डायिॉग बॉक्ट्स के फाइि नवकल्प से हमें 

दसूरी िाइि से र्ी शीट डाििे की अिुमनत नमिती ह ै(नचत्र 6.10 दखेें)। 

आइए अभ्यास करें: 

नचत्र 3.9 में फदखाए गए पररणाम नवशे्लर्ण स्प्रेडशीट की सर्ी सैि् ्स को र्रें। 

रायोनगक गनतनवनि 3.3 - मौजूदा डॉक् ्यूमेंट में एक मौजूदा फाइि से एक शीट डािें। 

चरण 1. पररणाम नवशे्लर्ण स्प्रेडशीट में पररणाम-एक्ट्स-ए स्प्रेडशीट से शीट “Result” सनम्मनित करिे के निए, 

Result Analysis स्प्रेडशीट खोिें। 

चरण 2. Sheet > Insert Sheet > From File का चयि करें जैसा नचत्र 6.10 में फदखाया गया ह।ै 

चरण 3. ब्राउज़ बटि पर नक्ट्िक करें, नजससे एक फाइि चयि डायिॉग बॉक्ट्स खुि जाएगा। 

चरण 4. उस फाइि का चयि करें नजससे आप शीट import करिा चाहते हैं। फाइि का चयि करिे के बाद, इसमें 

निनहत शीट सूची बॉक्ट्स में रदर्शभत की जाती हैं, जैसा फक नचत्र 6.10 में फदखाया गया ह।ै फाइि बॉक्ट्स इस बॉक्ट्स 

के िीचे रदर्शभत होता ह।ै सूची बॉक्ट्स स ेडािी जािे वािी शीट का चयि करें। 

चरण 5. फाइि आवश्यक “Result” शीट पर नक्ट्िक करें "“Result- X-A.ods" जैसा फक नचत्र 6.10 में फदखाया 

गया ह।ै 

नचत्र 6.10 पररणाम नवश्लेर्ण-स्प्रेडशीट में Result-X-A स्प्रेडशीट का पररणाम शीट Insert करिा 

चरण 6. Check the Link checkbox to ensure that the changes made in the 

selected sheet “Result” are reflected. चरण 6. यह सुनिनित करिे के निए लिांक चेकबॉक्ट्स की जााँच करें फक 

इसमें फकए गए पररवतभि चयनित शीट “Result”  फदखाई दतेे हैं। 

चरण 7. OK रेस करें। जैसा फक नचत्र 6.11 में फदखाया गया ह,ै आपको शीट टैब में जोड़ी गई ररजल्ट शीट नमि 

जाएगी।  

नचत्र 6.11ResultAnalysis शीट टैब में जोड़ी गई Result sheet  
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आप डटेा को कॉपी और पेस्प्ट र्ी कर सकते थ,े िेफकि एक शीट को लिांक करिे से हमें फकसी अन्य स्प्रैडशीट स े

"िाइव" डटेा राप्त करिे की सुनविा नमिती ह।ै "िाइव" डटेा का अथभ ह ैफक डटेा हमेशा मूि फाइि की तरह ही 

होता ह।ै 

 

लिांक को Tools > Options > LibreOffice Calc > General > Updating, करके चिुा जा सकता ह,ै जैसा फक 

नचत्र 6.12 में फदखाया गया ह,ै जब र्ी फाइि यह सुनिनित करिे के निए खोिी जाती ह ैफक आपके पास हमेशा 

अपडटे फकए गए डटेा तक पहुांच हो। 

 नचत्र 6.12 ऑििाइि अद्यति नवकल्प का चयि करिा 
 

6.5 शीट पर हाइपरलिांक 

कर्ी-कर्ी फकसी डॉक् ्यूमेंट से फकसी अन्य स्प्थाि पर स् ्टोर डॉक् ्यूमेंट पर jump करिा आवश्यक होता ह।ै यह 

हाइपरलिांक बिाकर फकया जा सकता ह।ै हाइपरलिांक बिाकर एक ही स्प्रेडशीट, अिग-अिग स्प्रेडशीट या 

वेबसाइट में एक शीट से jump करिा सांर्व ह।ै 

 

रेिरेटव और एबसॉि् ्यूट हाइपरलिांक 

हाइपरलिांक रेिेरटव और एबसॉि् ्यूट हो सकता ह।ै एक पूणभ हाइपरलिांक सांपूणभ जगह को स् ्टोर करता ह ैजहाां 

फाइि स् ्टोर होती ह।ै इसनिए, यफद फाइि को स्प्थाि से हटा फदया जाता ह,ै तो एबसॉि् ्यूट हाइपरलिांक काम 

िहीं करेगा। उदाहरण के निए: C: \ Users \ ADMIN \ Downloads \ try.ods एक एबसॉि् ्यूट लिांक ह ैक्ट्योंफक 

यह फाइि के पूणभ पथ को पररर्ानर्त करता ह।ै 

एक रेिेरटव हाइपरलिांक वतभमाि स्प्थाि के सांबांि में स्प्थाि को सांिहीत करता ह।ै 

उदाहरण के निए: व्यवस्प्थापक \ डाउििोड \ try.odf एक रेिेरटव हाइपरलिांक ह ैक्ट्योंफक यह वतभमाि स्प्थाि पर 

निर्भर ह ैऔर इस रकार फोल्डर व्यवस्प्थापक को खोजा जाता ह ैजहाां सफक्रय स्प्रेडशीट सांिहीत की जा रही ह।ै यफद 

सफक्रय स्प्रैडशीट वािे सांपूणभ फोल्डर को स्प्थािाांतररत कर फदया जाता ह,ै तो रेिेरटव लिांक अर्ी र्ी सुिर् होगा 

क्ट्योंफक यह उस स्रोत फोल्डर से जुड़ा होता ह ैजहाां सफक्रय स्प्रेडशीट स् ्टोर होती ह।ै 

 

6.6 Creating hyperlinks हाइपरलिांक बिािा 

स्प्रेडशीट में अन्य स्प्रेडशीट डॉक् ्यूमेंट की एक शीट को हाइपरलिांक करिा सांर्व ह।ै माि िीनजए, आपको 

"ररजल्ट-एक्ट्स-ए" स्प्रेडशीट डॉक् ्यूमेंट "ररजल्ट-एक्ट्स-बी" स्प्रेडशीट डॉक् ्यूमेंट का एक पररणाम शीट हाइपरलिांक 

करिा ह,ै तो निम्न चरणों का पािि करें: 

चरण 1. Result-X-B स्प्रेडशीट डॉक् ्यूमेंट खोिें। 
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चरण 2. मुख्य मेिू स ेInsert > Hyperlink पर नक्ट्िक करें। एक हाइपरलिांक डायिॉग बॉक्ट्स खुिेगा जैसा फक नचत्र 

6.13 में फदखाया गया ह।ै 

नचत्र 6.13 हाइपरलिांक डायिॉग बॉक्ट्स 

चरण 3. स्प्रेडशीट डॉक् ्यूमेंट को सनम्मनित करिे के निए, डायिॉग बॉक्ट्स के बाईं ओर नस्प्थत डॉक् ्यूमेंट पर नक्ट्िक 

करें, फिर स्प्रेडशीट डॉक् ्यूमेंट का चयि करिे के निए, पथ के बाद नस्प्थत बटि पर नक्ट्िक करें। आवश्यक डॉक् ्यूमेंट 

का चयि करें। हमारे मामि ेमें हम स्प्रेडशीट डॉक् ्यूमेंट “Result-X-A” का चयि करते हैं। 

चरण 4. इसके बाद नजस बटि को हाइपरलिांक करिा ह ैउसे चुििे के निए टारगेट बटि पर नक्ट्िक करें। डॉक् ्यूमेंट 

में िक्ष्य नवशेर् रूप से डॉक् ्यूमेंट जैसे शीट, टेबि, फे़्रम, नचत्र, हलेडांग और इतिे पर एक िक्ष्य चुििे में मदद करता 

ह।ै यहाां हमारे मामि ेमें हम शीट पररणाम का चयि करेंगे जैसा फक नचत्र 6.13 में फदखाया गया ह।ै 

चरण 5. िक्ष्य डॉक् ्यूमेंट लवांडो से बाहर आिे के निए Apply और Close बटि पर नक्ट्िक करें। 

चरण 6. उस पाठ के हाइपरलिांक को असाइि करिे के निए पाठ बॉक्ट्स में पाठ दजभ करें। हमारे मामि ेमें हमि े

“Result-X-A” के रूप में text डािा ह ैजैसा फक नचत्र 6.14 में फदखाया गया ह।ै 
 

तो हाइपरलिांक को “Result-X-A” text को सौंपा जाएगा। 

नचत्र 6.14 हाइपरलिांक के निए Target और Text निर्दभष्ट करिा 

चरण 7. Click on Apply and Close button to confirm the changes and exit the Hyperlink dialog 

box. 

चरण 7. पररवतभिों की पुनष्ट करिे और हाइपरलिांक डायिॉग बॉक्ट्स से बाहर आिे के निए Apply और Close बटि 

पर नक्ट्िक करें। 

चरण 8. ध्याि दें फक हाइपरलिांक को “Result-X-A” शब्द को असाइि फकया गया ह ैजैसा फक नचत्र 6.15 में 

फदखाया गया ह।ै 
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. नचत्र 6.15 स्प्रेडशीट में हाइपरलिांक डािा गया। 
 

चरण 9. हाइपरलिांक की गई शीट को खोििे के निए, Ctrl कुां जी दबाएां और हाइपरलिांक फकए गए शब्द “Result-

X-A”पर नक्ट्िक करें, शीट को िई लवांडो में खोिा जाएगा जैसा फक नचत्र 6.16 में फदखाया गया ह।ै 

नचत्र 6.16 िई लवांडो में हाइपरलिांक की गई शीट खुिी हुई ह ै

आइए अभ्यास करें  

पररणाम स्प्रेडशीट के निए एक हाइपर लिांक बिाएां। 

 

6.7 हाइपरलिांक की Editing  

फकसी मौजूदा लिांक को सांपाफदत करिे के निए, लिांक में कहीं र्ी कसभर रखें और हाइपरलिांक पर राइट नक्ट्िक करें। 

एक सांदर्भ मेिू नचत्र 6.17 में फदखाया गया ह।ै 

 

 नचत्र 6.17 हाइपरलिांक राइट नक्ट्िक करिे पर सांदर्भ मेिू से एनडट हाइपरलिांक का चयि करिा 

 

एनडट हाइपरलिांक पर नक्ट्िक करें ..., हाइपरलिांक डायिॉग बॉक्ट्स रदर्शभत होगा, जहााँ आप हाइपरलिांक में 

पररवतभि कर सकते हैं। हाइपरलिांक नवकल्प को नक्ट्िक करिे पर, लिांक text से हटा फदया जाएगा और इस तरह 

यह फकसी अन्य स्प्थाि पर इांनगत िहीं करेगा। 
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6.8 बाहरी डटेा स ेजोड़िा 

इांटरिेट सूचिा का एक समृद्ध स्रोत ह,ै नजसे वेब पृष्ठों के रूप में स् ्टोर फकया जाता ह।ै वेब पेज HTML डॉक्ट्यूमेंट्स में 

निख ेगए हैं। एक वेब पेज पर डटेा तानिकाओं के रूप में स् ्टोर फकया जा सकता ह।ै 

एक स्प्रेडशीट की कई रकार की नवशेर्ताएां हमें Calc में HTML डॉक्ट्यूमेंट्स से तानिकाओं को सनम्मनित करिे की 

अिुमनत दतेी ह।ै HTML डॉक् ्यूमेंट से तानिकाओं को सनम्मनित करिे के निए, हम बाहरी डटेा डायिॉग बॉक्ट्स का 

उपयोग कर सकते हैं। उसी के निए चरण िीचे फदए गए हैं। 

 

चरण 1. स्प्रडेशीट खोिें जहाां बाहरी डेटा डािा जािा ह।ै 

चरण 2. बाहरी डेटा में तानिका के पहिे सेि को सांिहीत करिे के निए सेि का चयि करें। 

चरण 3. शीट> बाहरी डेटा का लिांक चुिें। 

चरण 4. बाहरी डेटा डायिॉग बॉक्ट्स नचत्र 6.18 में फदखाया गया ह।ै स्रोत डॉक् ्यूमेंट का URL टाइप करें या यफद यह सूचीबद्ध 

ह ैऔर ड्रॉप-डाउि सूची से इसे चुिें। 

चरण 5. import के निए र्ार्ा का चयि करिे के निए एक डायिॉग बॉक्ट्स रदर्शभत फकया जाता ह ैजैसा फक नचत्र 6.17 में 

फदखाया गया ह।ै वेब पेज की तरह ही र्ार्ा में र्ी स्प्वचानित डेटा का चयि करिा। 

 

 नचत्र 6.18 वेबपृष्ठ के निए import करिे के निए र्ार्ा का चयि करिा 

 

चरण 6. उपिब्ि टेबि / रेंज सूची स,े वाांनछत तानिका चुिें। यफद आप HTML_all नवकल्प चुिते हैं, तो सांपूणभ 

HTML डॉक् ्यूमेंट चुिा जाता ह।ै 

हमारे उदाहरण में माि िें फक हम नचत्र 6.19 में फदखाए गए अिुसार सनम्मनित करिे के निए HTML_10 

तानिका का चयि करते हैं। 

 

नचत्र 6.19 वेबपृष्ठ से एक तानिका सनम्मनित करिा 

तानिका स्प्रेडशीट में डािी गई ह ैजैसा फक नचत्र 6.20 में फदखाया गया ह।ै 
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नचत्र 6.20 HTML_10 वेब पेज से  insert की गई टेबि 

https://en.wikipedia.org/wiki/List_of_gravitationally_rounded_objects_of_the_Solar_System 

#Planets 

 

6.9 registered पांजीकृत डटेा स्रोतों स ेलिांक करिा 

निब्र ेऑफिस Calc हमें डटेाबेस और अन्य डटेा स्रोतों के साथ स्प्रेडशीट डॉक्ट्यूमेंट को लिांक करिे की अिुमनत दतेा 

ह।ै डटेा स्रोत को निबर ऑफिस के साथ पांजीकृत होिा चानहए। पांजीकरण निब्र ेऑफिस को डटेा स्रोत के रकार 

और फाइि के स्प्थाि के बारे में सूनचत करि ेका एक सािि ह।ै हम अपिी चचाभ को निबे्र ऑफिसबेस तक सीनमत 

रखेंगे। LibreOfficeBase का नवस्प्तार .odb ह।ै आप निब्रे ऑफिस बेस के बारे में यूनिट 3 में नवस्प्तार से जािेंगे। 

आप नवनर्न्न डटेाबेस और अन्य डटेा स्रोतों तक पहुांच सकते हैं और उन्हें कैि् क डॉक्ट्यूमेंट से जोड़ सकते हैं। एक डटेा 

स्रोत जो * .odb रारूप में ह,ै को पांजीकृत करिे के निए, िीचे फदए गए चरणों का पािि करें। 

चरण 1. Tools > Options > LibreOffice Base > Databases का चयि करें। Options - LibreOffice Base-

Databases डायिॉग बॉक्ट्स रकट होता ह।ै 

चरण 2. नचत्र 6.21 में फदखाए अिुसार Create Database Link डायिॉग बॉक्ट्स बिािे के निए िए बटि पर 

नक्ट्िक करें। 

 नचत्र में 6.21 पांजीकृत डटेाबेस 

चरण 3. डटेाबेस फाइि का स्प्थाि दजभ करें, या फाइि ब्राउज़र खोिि े के निए ब्राउज़ करें पर नक्ट्िक करें और 

डटेाबेस फाइि का चयि करें। 

चरण 4. डटेाबेस के निए पांजीकृत िाम के रूप में उपयोग करिे के निए एक िाम टाइप करें और OK पर नक्ट्िक 

करें। डटेाबेस पांजीकृत डटेाबेस की सूची में जोड़ा जाता ह।ै 

िोट - ओके बटि को तर्ी enable फकया जाता ह ैजब दोिों फील्ड र्रे जाते हैं। 

अपिी रगनत जाांचें  

क. बहु नवकि ्प रश् ्ि  

1. Insert Sheet डायिॉग इससे invoke फकया जा सकता ह ै
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(a) Sheet (b) Insert (c) Tools  (d) Window. 
 

2. ______________. माय शीट िामक शीट के सेि G5 को सांदर्र्भत करता ह।ै 

(a) $My Sheet.’G5’ (b) $My Sheet_’G5’ (c) $ ‘MySheet’.G5 (d) $ ‘MySheet’_G5 
 

3.फकसी फाइि के पथ में _________ फॉरवडभ स्प्िैश होते हैं।  (a) four (b) three (c) two (d) one 
 

4. निबे्र ऑफिस Calc में मौजूदा स्प्रेडशीट से नवनर्न्न स्प्रेडशीट में jump करिे के निए निम्न में से फकस सुनविा का उपयोग 

फकया जाता ह ै

 (a) Macro             (b) Hyperlink        (c) connect       (d) Copy (Ans. b) 

 
 

ख. ररक् ्त स् ्थाि र्रें  

1. एक ररिेरटव हाइपरलिांक location को ___________________ location के सांबांि में स् ्टोर करता ह।ै 

2. वेबपेज से तानिकाओं को सनम्मनित करते समय _______ सांपूणभ HTML डॉक् ्यूमेंट का चयि करता ह ै

3. निबे्र ऑफिस बेस का नवस्प्तार ______________ ह।ै 

4. __________ का उपयोग शीट िामों को सांिग्न करिे के निए फकया जाता ह ैक्ट्योंफक शीट िामों के अांदर एक स्प्थाि हो 

सकता ह ै(Ans Single quotes (‘ ’)) 

5. ___________ डायिॉग बॉक्ट्स के फाइि नवकल्प से दसूरी फाइि से शीट डाििे की अिुमनत नमिती ह ै

 

ग. बताइए फक निम्ननिनखत कथि सही हैं या गित 

1. एक शीट को केवि वतभमाि शीट से पहिे जोड़ा जा सकता है। 

2. यफद ‘नबक्री’ शीट में ‘cost’ ’शीट का सांदर्भ ह,ै तो’ ‘cost’ शीट में फकए गए फकसी र्ी पररवतभि को नबक्री शीट में र्ी 

फदखाया जाएगा।  

3. एक शीट को दसूरी शीट में सांदर्भ के रूप में जोड़िा सांर्व िहीं ह।ै 

4. हम फकसी वेबपेज पर बिाई गई तानिका से डेटा को एक स्प्रेडशीट में सनम्मनित कर सकते हैं (सत्य) 

5. एक बार शीट पर बिाई गई हाइपरलिांक को हटाया िहीं जा सकता (गित) 

 

घ. निम्ननिनखत रश्नों के उत्तर दीनजए 

1. एक निबर ऑफिस Calc में शीट को लिांक करिे के दो तरीकों का िाम दें। 

2. Relative और Absolute हाइपरलिांक के बीच अांतर बताएां। 

3. स्प्रेडशीट में वेब पेज से एक टेबि निकाििे के निए चरण निखें। 

4. * .odb रारूप में ह ैफक एक डेटा स्रोत रनजस्प्टर करिे के निए कदम निखें। 

5. वेब पेज से डेटा को स्प्रेडशीट में extract करिे के क्ट्या िायद ेहैं। 

 

रयोगशािा अर्् ्यास 

1. जि, िरवरी और माचभ िाम की तीि शीट बिाएां। रत्येक शीट में एक महीिे के निए कमभचाररयों की उपनस्प्थनत को 

सांिहीत करें। पी की नगिती करके कमभचाररयों की सांख्या फकतिी थी, यह जाििे के निए count function िागू करें। 

2. ‘Consolidated Attendance’ िाम की एक और शीट जोड़ें जो तीि महीिे की कुि उपनस्प्थनत को स् ्टोर करती ह ैऔर 

रनतशत की गणिा करती ह।ै 
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3. वेबसाइट से अपिे कायभकाि के साथ-साथ र्ारत के रिािमांनत्रयों की सूची वािी एक स्प्रेडशीट बिाएां। वेबसाइट से एक 

Calc शीट में तानिका निकाििे के निए कदमों का रदशभि करें और र्ारत के अब तक के रिािमांनत्रयों की नगिती रदर्शभत 

करें। 

अि् ्याय 7 क स्प्रडेशीट शयेर और ररव् ्यू करिा 

पररचय 

LibreOffice Calc में, एक स्प्रेडशीट को एक बार में एक से अनिक िोगों द्वारा साझा करके उपयोग फकया जा 

सकता ह।ै एक साझा स्प्रेडशीट एक समाि शीट ह ैनजसे एक से अनिक िोगों द्वारा एक्ट्सेस फकया जा सकता ह ैऔर 

उन्हें इस पर एक साथ बदिाव करिे की अिुमनत द ेसकता ह।ै यह एक ही समय में एक साथ काम करते समय 

फकया जा सकता ह ैया अिग-अिग समय पर इस पर काम कर सकता ह।ै यह एक ही स्प्रेडशीट की कई रनतयों का 

रैक रखि ेकी परेशािी स े हमें बचाएां। साझाकरण सहयोग से काम करिे की अिुमनत दतेा ह ैताफक हर कोई 

योगदाि द ेसके, बदिाव कर सके और उसे दखे सके।  

7.1 स्प्रेडशीट साझा करिा 

स्प्रेडशीट साझा करिा अन्य िोगों के साथ नमिकर काम करिे के निए टीम वकभ  की तरह ह।ै स्प्रेडशीट साझा करि े

के निए निम्ननिनखत चरण हैं। 

चरण 1. एक िया स्प्रेडशीट खोिें और इसे फकसी िाम से सहजेें। 

चरण 2. मुख्य मेिू से Tools > Share Spreadsheet का चयि करें और नक्ट्िक करें। यह Share Document 

डायिॉग लवांडो को खोिेगा जैसा फक नचत्र 7.1 में फदखाया गया ह ैजो साझाकरण नवकल्प को enable या disable 

करिे के निए इस्प्तेमाि फकया जा सकता ह।ै 

 

 
Fig 7.1 Share Document dialog window नचत्र 7.1 शेयर डॉक् ्यूमेंट डायिॉग लवांडो 

 

चरण् 3. Click on the checkbox “Share this spreadsheet with other users” to share the 

spreadsheet and click on OK button. This will open the confirmation dialog window as shown in 
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Figure 7.2 to save the spreadsheet to activate the shared mode. चरण 3. स्प्रेडशीट साझा करिे के 

निए चेकबॉक्ट्स पर नक्ट्िक करें "स्प्रेडशीट को अन्य रयोक् ्ताओं के साथ साझा करें" और ओके बटि पर नक्ट्िक करें। 

यह साझाकरण मोड को सफक्रय करिे के निए स्प्रैडशीट को सहजेि ेके निए नचत्र 7.2 में दी गई पुनष्ट डायिॉग लवांडो 

को खोिेगा। 

 

 
 

नचत्र 7.2 स्प्रेडशीट साझा करिे के निए Confirmation डायिॉग लवांडो 

चरण 4. जारी रखिे के निए Yes पर नक्ट्िक करें। 

चरण 5. स्प्रेडशीट सेव करिे के बाद, टाइटि बार में स्प्रेडशीट का िाम स्प्रेडशीट के िाम के साथ (साझा) रदर्शभत 

होगा। 

 

रायोनगक गनतनवनि 7.1 - नचत्र 7.4 में फदखाए अिुसार स्प्रेडशीट बिाएां और इसे Test_1.ods िाम से सहजेें 

चरण 1. डटेा के साथ स्प्रेडशीट बिाएां और Test.ods के साथ इसे सहजेें, जैसा फक नचत्र 7.3 में फदखाया गया ह।ै 

चरण 2. स्प्रेडशीट सवे करिे के बाद, टाइटि बार में स्प्रेडशीट का िाम स्प्रेडशीट के िाम के साथ (साझा) रदर्शभत 

होगा। 

 

रायोनगक गनतनवनि 7.1 - नचत्र 7.4 में फदखाए अिुसार स्प्रेडशीट बिाएां और इसे Test_1.ods िाम से सेव करें।  

चरण 1. डटेा के साथ स्प्रेडशीट बिाएां और Test.ods के साथ इसे सेव करें, जैसा फक नचत्र 7.3 में फदखाया गया ह।ै 

नचत्र 7.3 स्प्रेडशीट Test.ods की सामिी 
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चरण 2. मुख्य मेिू बार से Tools > Share Spreadsheet का चयि और नक्ट्िक करें। शेयर डॉक् ्यूमेंट डायिॉग 

लवांडो खुिेगी जैसा फक नचत्र 7.1 में फदखाया गया ह।ै चेक बॉक्ट्स पर चेक-माकभ  िगाएां, “Share this spreadsheet 

with other users”, जैसा फक नचत्र 7.1 में फदखाया गया ह।ै 

चरण 3. चेकबॉक्ट्स पर नक्ट्िक करें और ओके बटि पर नक्ट्िक करें। यह sharing मोड को सफक्रय करिे के निए 

पुनष्टकरण डायिॉग लवांडो रदर्शभत करेगा जैसा फक नचत्र 7.2 में फदखाया गया ह।ै जारी रखिे के निए Yes पर 

नक्ट्िक करें। 

चरण 4. िोरटस जो साझा फकया गया ह,ै title bar में डॉक् ्यूमेंट के िाम के साथ जोड़ा गया ह ैजसैा फक नचत्र 7.4 में 

फदखाया गया ह।ै 

नचत्र 7.4 स्प्रेडशीट को shareकरते हुए दशाभता Title bar 

 
 

7.2  एक साझा स्प्रडेशीट को खोििा और सवे करिा 

 

ओपलिांग स्प्रडेशीट 

एक साझा स्प्रडेशीट खोिि ेके निए, निम्ननिनखत चरणों का पािि करें। 

चरण 1. एक साझा स्प्रेडशीट खोििे के दौराि, एक सांदशे फदखाई दगेा जैसा फक नचत्र 7.5 में फदखाया गया ह ैफक 

स्प्रेडशीट shared mode ह ैऔर इस स्प्रेडशीट में उपयोग करिे के निए कुछ सुनविाएाँ उपिब्ि िहीं हैं। 

 नचत्र 7.5 shared mode स्प्रेडशीट खोिते समय सांदशे बॉक्ट्स 

चरण 2. shared mode में स्प्रेडशीट खोििे के निए ओके बटि पर नक्ट्िक करें। 

चरण 3. यफद आप िहीं चाहते हैं फक यह चेताविी नवकल्प फिर से रदर्शभत हो, तो चेकबॉक्ट्स में नचह्ि को चेक करें 

Do not show warning again । 

चरण 4. एक बार स्प्रेडशीट को shared mode में सेव करिे के बाद, कुछ सुनविाएाँ उपयोग के निए अिुपिब्ि हो 

जाएांगी। 
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चरण 5. मुख्य मेिू बार पर Edit मेिू को दखेें। जैसा फक नचत्र 7.6 में फदखाया गया ह,ै जो Undo, Redo, Repeat, 

Paste, Links to External files, ImageMap, Object को दशाभता ह।ै 

 

 नचत्र 7.6 shared spreadsheet का Edit menu  

शेयडभ स्प्रेडशीट सवे करिा 

इस shared स्प्रेडशीट को सेव करिे के निए निम्ननिनखत चरणों का पािि करें: 

 

चरण 1. इस shared स्प्रेडशीट में पररवतभि करिे के बाद, आपको स्प्रेडशीट को बांद करिे स ेपहिे इस ेसहजेिे की 

आवश्यकता ह।ै 

चरण 2. यफद दो या अनिक िोग एक ही समय में काम कर रह ेहैं और पररवतभि conflict िहीं करते हैं, तो यह 

सांदशे आता ह ैफक स्प्रेडशीट को अन्य िोगों द्वारा सेव फकए गए पररवतभिों के साथ अपडटे फकया गया ह।ै 

चरण 3. यफद पररवतभिों के निए कोई conflict ह,ै तो हि करें conflict डायिॉग लवांडो फदखाई दगेी। 

चरण 4. जब आप conflict को हि कर रह ेहों तो कोई अन्य व् ्यनक्त साझा स्प्रेडशीट को सेव िहीं कर सकता ह।ै 

चरण 5. यफद कोई अन्य रयोक् ता साझा फकए गए डॉक् ्यूमेंट को सेव करिे और conflict को हि करि ेकी कोनशश 

कर रहा ह,ै तो आपको एक सांदशे के साथ सूनचत फकया जाएगा फक फाइि िॉक ह।ै 

अब, आप इसे सेव िहीं कर सकते। 

 

7.2 ररकॉर्डिंग में पररवतभि 

निब्र ेऑफिस Calc की यह सुनविा स्प्रेडशीट में एक या अन्य व् ्यनक्त द्वारा फकए गए पररवतभिों को ररकॉडभ करिे के 

निए अिग-अिग तरीके रदाि करती ह।ै पररवतभिों को ररकॉडभ करते समय, स्प्रेडशीट अपिी शेयडभ सुनविा को बांद 

कर दगेी। ररकॉर्डिंग पररवतभि के निए निम्ननिनखत चरणों का पािि करें: 

चरण 1. ररकॉडभ पररवतभिों को enable करिे के निए, पहिे स्प्रेडशीट के shared mode को disable करें। 
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चरण 2. shared mode को disable करिे के निए, स्प्रेडशीट "Test.ods" खोिें। 

चरण 3. मुख्य मेिू बार से Tools > Share Spreadsheet का चयि करें और नक्ट्िक करें। यह शेयर डॉक् ्यूमेंट 

डायिॉग लवांडो खोिेगा जैसा फक नचत्र 7.7 में फदखाया गया ह।ै चेक बॉक्ट्स पर चेक-माकभ  हटाएां, “Share this 

spreadsheet with other users”, और ओके बटि पर नक्ट्िक करें। यह साझाकरण मोड को disable करि ेके 

निए Confirmation डायिॉग लवांडो रदर्शभत करेगा। यह disable करिे के निए चेताविी दगेा एक स्प्रेडशीट का 

sharing mode जैसा फक नचत्र 7.12 में फदखाया गया ह।ै जारी रखिे के निए Yes पर नक्ट्िक करें। 

 

नचत्र 7.7 स्प्रेडशीट के sharing mode को disable करिे के निए Confirmation डायिॉग लवांडो 

चरण 4. ध्याि दें फक स्प्रेडशीट स े(साझा) शब्द स्प्रेडशीट के title bar से गायब हो गया ह।ै 

चरण 5. Track Changes > Record under Edit menu ON ह ैजैसा फक नचत्र 7.8 में फदखाया गया ह,ै जो 

shared spreadsheet में disableऔर काम िहीं कर रहा था। 

चरण 6. अब रैक पररवतभि ररकॉडभ करिे के निए, Edit > Track Changes > Record पर नक्ट्िक करें 

नचत्र 7.8 में फदखाया गया ह।ै 

नचत्र 7.8 Track changes under Edit में ररकॉर्डिंग रैक पररवतभि enabled  

चरण 7. अब सेि B5 में नसया को सीता िाम बदिें जसैा फक नचत्र 7.8 में फदखाया गया ह।ै ध्याि दें फक सेि का 

बॉडभर रांग नजसमें डटेा बदि गया ह,ै िाि हो जाता ह।ै इसके अिावा, यफद कसभर पररवर्तभत सेि में चिा जाता ह,ै 

तो पररवर्तभत सेि नववरण रदर्शभत करेगा। 

 
नचत्र 7.9 रैक पररवतभिों के तहत दजभ फकए गए पररवतभिों की जािकारी रदर्शभत करता ह ै
 

चरण 8. इस रकार, स्प्रेडशीट को दखेकर, अन्य िोग आसािी से सिे में फकए गए पररवतभिों और फकसके द्वारा फकए 

गए पररवतभिों को जाि सकत ेहैं। 
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रायोनगक अर्् ्यास  7.3 - माि िें फक आप अपिे स्प्कूि फक्रकेट टीम के कप्ताि हैं। मौजूदा शैक्षनणक वर्भ के निए 

स्प्रेडशीट में बजट तैयार करें। 

Track Changes > Record ऑि करें और टीम के अन्य सदस्प्यों को स्प्रेडशीट में आवश्यक पररवतभि करिे के निए 

कहें। 

7.3 कमेंट Add, Edit करें और Format करें 

Calc में, रटप्पनणयों को स्प्वचानित रूप से जोड़ा गया ह ैजसैा फक नचत्र 7.9 में दखेा गया है।  

साथ ही, िेखक या समीक्षक अपिी comment र्ी जोड़ सकते हैं। अपिे comment जोड़िे के निए निम्ननिनखत 

चरणों का पािि करें: 

चरण 1. अपिे comment जोड़िे के निए मुख्य मेिू  बार से चुिें और Edit > Track Changes > Comment पर 

नक्ट्िक करें जैसा फक नचत्र 7.9 में फदखाया गया है, । 

 

नचत्र 7.9 रैक पररवतभि के तहत comment का चयि 

चरण 2. ऐड कमेंट लवांडो खुिेगी। अपिा comment दजभ करें। नचत्र 7.9 में दजभ comment को फदखाया गया ह।ै 

 

नचत्र 7.10 comment डायिॉग लवांडो में text दजभ करिा 

चरण 3. अब दजभ की गई comment को दखेिे के निए, सेि B6 पर नक्ट्िक करें जैसा फक नचत्र 7.17 में फदखाया 

गया ह।ै इसमें दजभ comment का पूरा नववरण फदखाया गया ह।ै 

 

 नचत्र 7.11 पूणभ नववरण के साथ रदर्शभत comment 

चरण 4. आप एक सेि में रटप्पनणयाां र्ी डाि सकते हैं। उस सेि पर नक्ट्िक करें जहााँ आप comment डाििा 

चाहते हैं। फिर मुख्य मेिू से Insert > Comment चुिें जैसा फक नचत्र 7.12 में फदखाया गया ह।ै 



113 

 

नचत्र 7.12 comment डािें 

चरण 5. इस रकार की रटप्पनणयों को स्प्रेडशीट में िोट्स या सुझावों के रूप में जािा जाता ह।ै बॉक्ट्स comment 

को निखिे के निए फदखाई दगेा जैसा फक नचत्र 7.19 में फदखाया गया ह।ै comment बॉक्ट्स में " Contains only 

alphabets" के रूप में दजभ comment को फदखाया गया ह।ै एक बार जब यह पाठ टेक्ट्स्प्ट बॉक्ट्स में टाइप हो जाता 

ह,ै तो आप एक अविोकि कर सकते हैं 

सेि के ऊपरी-फकिारे के कोिे में रांगीि डॉट जहाां insert comment का उपयोग करके comment को जोड़ा जाता 

ह।ै 

नचत्र 7.13 बॉक्ट्स में insert Comments 

चरण 6. comment जोड़ फदए जािे के बाद, आप इसे display, edit or delete कर सकते हैं। इि ऑपरेशिों को 

सुिारिे के निए, उस सेि पर राइट नक्ट्िक करें, जहााँ आपिे नचत्र 7.20 में फदखाए गए अक्षरों को डािा ह।ै पॉप अप 

मेिू के तहत नवकल्पों पर ध्याि दें। 

नचत्र 7.14 comment डाििे के बाद राइट नक्ट्िक मेिू नवकल्प 

चरण 7. रटप्पनणयों को सांपाफदत करिे के निए " Edit Comment " नवकल्प का चयि करें। यह आपको फकसी र्ी 

बदिाव करिे के निए फिर स ेcomment पाठ बॉक्ट्स में िे जाएगा। 

चरण 8. comment को हटािे के निए " Delete comment " नवकल्प का चयि करें। 

चरण 9. comment दखेिे के निए "comment फदखाएां" का चयि करें। इस नवकल्प का चयि करके, रटप्पनणयों 

को रदर्शभत फकया जाएगा। दोबारा जब आप सेि पर राइट नक्ट्िक करेंगे, तो आप दखेेंगे फक "Hide Comment" 

नवकल्प "Show Comment" के स्प्थाि पर सफक्रय हो जाएगा। ऐसा इसनिए ह ैक्ट्योंफक जब आप रटप्पनणयों को 

रदर्शभत कर रह ेहैं तो यह पहिे से ही शो मोड में ह,ै नजसे नछपािा होगा। 
 

comment की िॉमटेटांग  
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आप comment बॉक्ट्स की िॉमेटटांग कर सकते हैं, जैसे सेि सामिी को िॉमटे करिा। इसका अथभ पृष्ठर्ूनम रांग, 

सीमा शैिी और एक comment की पारदर्शभता को बदििा ह।ै comment को की िॉमेटटांग करि े के निए 

निम्ननिनखत चरणों का पािि करें। 

चरण 1. उस सेि पर राइट नक्ट्िक करें जहाां comment जोड़ी गई ह।ै 

चरण 2. नवकल्प "िॉमटे सेि" का चयि करें, जो नचत्र 7.15 में फदखाए गए अिुसार Format Cells डायिॉग 

बॉक्ट्स रदर्शभत करेगा। 

  नचत्र 7.15 Format सेि डायिॉग बॉक्ट्स। 

चरण 4. आप इसके टैब से Font, font Effects, Alignment, Borders, Background and Cell Protection 

जैसी नवनर्न्न िॉमटे सुनविाओं को एप् ्िाइ कर सकते हैं। comment बॉक्ट्स के निए font, text colour, fill 

colour, line colour एप् ्िाइ करिे के निए ओके बटि पर नक्ट्िक करें। comment बॉक्ट्स पर िाग ूवाांनछत 

formatting features को दखेें। 

 

व्यावहाररक अर्् ्यास 7.4 - स्प्रेडशीट को फकसी अन्य िाम से सेव करें। साझा सुनविा को बांद करें। अब, स्प्रैडशीट में 

कुछ बदिाव करें। इसके अिावा, पररवर्तभत सैि् ्स में comment जोड़ें। comment को एनडट करिे का रयास करें 

और इसे नवनर्न्न रांगों के साथ formatting करें। 

 

7.3 पररवतभिों का ररव् ्य ू करिा - पररवतभिों को दखेिा, स्प्वीकार करिा या अस्प्वीकार करिा Reviewing 

changes – view, accept or reject changes 

एक बार स्प्रेडशीट को टीम के सर्ी सदस्प्यों द्वारा एनडट फकया जाता ह।ै स्प्रेडशीट जमा करिे से पहिे यह अांनतम 

चरण ह।ै इस चरण में, हम टीम के सदस्प्यों द्वारा फकए गए सर्ी पररवतभिों को दखेिे के बाद अांनतम स्प्रेडशीट तैयार 

करिे के निए स्प्वीकार या अस्प्वीकार करिे के निए पररवतभिों से गुजरेंगे। पररवतभिों के ररव् ्य ूकरिे के निए 

निम्ननिनखत चरणों का पािि करें। 

चरण 1. Edit > Track Changes > Show चुिें और इस पर नक्ट्िक करें। यह शो चेंजसे डायिॉग लवांडो खोिेगा 

जैसा फक नचत्र 7.16 में फदखाया गया ह।ै 

नचत्र 7.16 Show Changes डायिॉग लवांडो 
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चरण 2. इसका उपयोग स्प्रेडशीट की समीक्षा करते समय सर्ी पररवतभिों को रदर्शभत करिे के निए फकया जाता 

ह।ै 

चरण 3. Edit > Track Changes > Manage पर नक्ट्िक और changes को accept or reject करें। जैसा फक 

नचत्र 7.23 में फदखाया गया ह,ै यह मैिेज चेंज डायिॉग लवांडो रदर्शभत करेगा। 

नचत्र 7.23 पररवतभिों को स्प्वीकार या अस्प्वीकार करिे के निए Changes डायिॉग लवांडो  

चरण 3. इस डायिॉग लवांडो में, िाइि तथा Accept or Accept All or Reject All button बटि पर नक्ट्िक करें। 

चरण 4. ररव्यू होिे के बाद क्ट्िोज बटि पर नक्ट्िक करें। 

 

रायोनगक अर्् ्यास 7.5 - व्यावहाररक अभ्यास में अन्य टीम के सदस्प्यों द्वारा फकए गए बदिाव 7.4 के रूप में कैल्क 

में िीचर द्वारा दजभ फकए गए हैं, अब आप केवि उि पररवतभिों की समीक्षा करते हैं और टीम के अन्य सदस्प्यों द्वारा 

फकए गए आवश्यक पररवतभिों को स्प्वीकार या अस्प्वीकार करते हैं। 

7.4 Merging और comparing करिा 

यफद एक ही स्प्रेडशीट की समीक्षा अिग-अिग टीम के सदस्प्यों द्वारा की जाती ह ैऔर आपके पास एक ही स्प्रेडशीट 

फाइि के दो अिग-अिग सांस्प्करण हैं। डॉक् ्यूमेंट मजभ करिे के निए निम्न चरणों का पािि करें। 

 

व्यावहाररक गनतनवनि - दो फाइिों को मजभ करें 

हमारे पहिे से बिाए गए स्प्रेडशीट Test.ods पर काम करिे के निए, Test1.ods फाइि को फकसी अन्य िाम 

Test1.ods के साथ सहजेें और स्प्रेडशीट Test1.ods में कुछ बदिाव करें। अब, हमारे पास दो िाइिें हैं नजन्हें मजभ 

फकया जािा ह।ै 

चरण 1. स्प्रेडशीट फाइि Test.ods खोिें। स्प्रेडशीट टेस्प्ट की सामिी पर ध्याि दें। नचत्र 7.24 में। नचत्र 7.25 में 

मजभ करिे से पहिे स्प्रेडशीट Test1.ods की सामिी पर र्ी ध्याि दें। 

 

  
नचत्र 7.24 मजभ से पहिे Test.ods की सामिी 

  
नचत्र 7.25 मजभ से पहिे Test1.ods की सामिी 
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चरण 2. Edit>Track Changes>Merge Document पर नक्ट्िक करें जैसा फक नचत्र 7.26 में फदखाया गया ह।ै 

नचत्र 7.26 मजभ डॉक् ्यूमेंट नवकल्प का चयि करिा 
 

चरण 3. स्प्रेडशीट फाइि Test1.ods को मजभ के साथ डायिॉग लवांडो से चिुें। स्प्रेडशीट Test1.ods खोििे के निए 

Test.ods के साथ मजभ करें और ओपि बटि पर नक्ट्िक करें जैसा फक नचत्र 7.27 में फदखाया गया ह।ै 

नचत्र 7.27 डायिॉग लवांडो के साथ मजभ से Test1.ods खोिें 

चरण 4. Manage Changes डायिॉग लवांडो खुिेगी जैसा फक नचत्र 7.28 में फदखाया गया ह।ै 

 नचत्र 7.28 Manage Changes डायिॉग लवांडो  

 

चरण 5. नचत्र 7.28 में फदखाए अिुसार Test1.ods स्प्रेडशीट में Test.ods के निए फकए गए सर्ी पररवतभिों को 

स्प्वीकार करिे के निए Accept All पर नक्ट्िक करें। । 

चरण 6. अब नविय के बाद पहिा स्प्रेडशीट टेस्प्ट खोिें। इसकी सामिी को दखेें और जैसा फक नचत्र 7.29 में 

फदखाया गया ह।ै ध्याि दें फक नचत्र 7.29 में Test.ods और Test1.ods मजभ की गई सामिी को फदखाया गया ह।ै 
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 नचत्र 7.29 मजभ होिे के बाद Test.ods की सामिी 

डॉक्ट्यूमेंट की तुििा करिा 

दो स्प्रेडशीट को मजभ करिे के बजाय, डॉक् ्यूमेंट की तुििा करके दो स्प्रेडशीट की तुििा कर सकते हैं। डॉक्ट्यूमेंट की 

तुििा करिे के निए निम्ननिनखत चरणों का पािि करें। आइए हम दो पहिे निर्मभत स्प्रेडशीट Test.ods और 

Test1.ods की तुििा करें 

चरण 1. स्प्रेडशीट फाइि Test.ods खोिें। Edit > Track Changes > Compare Document पर नक्ट्िक करें 

जैसा फक नचत्र 7.30 में फदखाया गया ह।ै 

 नचत्र 7.30 Compare Document चयि डॉक् ्यूमेंट  

चरण 2. यह तुििा डायिॉग लवांडो को खोिेगा, जो स्प्रेडशीट को तुििा करिे के निए खोििे की अिुमनत दगेा। 

स्प्रेडशीट फाइि का चयि करें Test1.odsand ओपि बटि पर नक्ट्िक करें जैसा फक नचत्र 7.31 में फदखाया गया ह।ै 

नचत्र 7.31 तुििा के निएओपि Test1.ods डायिॉग लवांडो चरण 3. 

पररवतभिों को स्प्वीकार / अस्प्वीकार करिे के निए Manage Changes डायिॉग लवांडो खुिेगी। नचत्र 7.32 में 

फदखाए अिुसार Accept पर नक्ट्िक करें। 

नचत्र 7.32 Manage Changes को स्प्वीकार करिा 
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चरण 4. अांत में क्ट्िोज बटि पर नक्ट्िक करें मैिेज चेंज डायिॉग लवांडो को बांद करें जसैा फक नचत्र 7.33 में फदखाया 

गया ह।ै 

 नचत्र 7.33 Closing Manage Changes लवांडो  

अपिी रगनत जाांचें 

क. बहुनवकल्पीय रश्न 

1. Comments हैं : (a) suggestions         (b) notes        (c) Both (a) and (b)       (डी) उपरोक्त कोई िहीं 

2. एक बार comment डाििे पर comment को_________  फकया जा सकता ह ै 

(a) Edit (b) Delete (c) Show (d) उपरोक्त सर्ी 

3. edit menu में रैक पररवतभि करिे में सक्षम ह:ै  

(a) Record (b) Show (c) Compare Document (डी) उपरोक्त सर्ी 
 

ख. यह बताएां फक निम्ननिनखत कथि सही हैं या गित 

1. स्प्रेडशीट को एक से अनिक िोगों के साथ काम करिे के निए साझा िहीं फकया जा सकता है? 

2. जब स्प्रेडशीट साझा मोड में होती ह,ै तो कुछ सुनविाएाँ अिुपिब्ि हो जाती हैं। 

3. जब स्प्रेडशीट को साझा मोड में खोिा जाता ह,ै तो आप स्प्रेडशीट में पररवतभि ररकॉडभ कर सकते हैं। 

4. फाइि मेिू का उपयोग स्प्रेडशीट के पररवतभिों को ररकॉडभ करिे के निए फकया जाता ह।ै 

5. आप Insert comment का उपयोग करके स्प्रेडशीट में एक िोट या सुझाव जोड़ सकते हैं। 

6. Formatting comment का उपयोग comment के फॉन्ट रांग को बदििे के निए फकया जा सकता ह।ै 
 

ग. ररक्त स्प्थाि र्रें: 

1. डॉक् ्यूमेंट का शीर्भक बार स्प्रेडशीट के साझा मोड के निए फाइि िाम के साथ ______________ फदखाता ह।ै 

2. साझा मोड स्प्रेडशीट __________ िोगों को एक ही समय में स्प्रेडशीट तक पहुांचिे और सांपाफदत करिे की अिुमनत दतेी ह।ै 

3. ररकॉर्डिंग स्प्वतः ही स्प्रेडशीट के साझा मोड ____________ को बदि दतेी है। 

4. स्प्रैडशीट में हुए बदिाव ररकॉडभ करिे के निए एनडट मेन्यू, रैक चेंजेस पर नक्ट्िक करें और फिर _________ चुिें। 

5. पररवर्तभत सेि का बॉडभर रांग ________________ होगा। 

6. __________ comment का उपयोग फकसी स्प्रेडशीट में सेि में िोट्स या सुझाव जोड़िे के निए फकया जाता ह।ै 

7. __________ comment का उपयोग फकसी comment की पृष्ठर्ूनम का रांग बदििे के निए फकया जा सकता ह।ै 
 

घ. निम्ननिनखत रश्नों के उत्तर दीनजए 

1. शब्दों को पररर्ानर्त करें (ए) शेयटरांग स्प्रेडशीट (बी) ररकॉडभ पररवतभि 

2. (ए) शेयटरांग स्प्रेडशीट (बी) ररकॉडभ पररवतभि करिे के निए कमाांड निखें 

3. िां क्ट्शि (ए) रैक चेंजेज (बी) सेलवांग स्प्रेडशीट को करिे के निए फकस मेिू का उपयोग फकया जाता है 

4. स्प्रेडशीट में हुए पररवतभिों की समीक्षा करके आप क्ट्या समझते हैं? 

5. Merging और Comparing स्प्रेडशीट के बीच अांतर बताएां। 
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रयोगशािा अर्् ्यास  

अिुष्का और नियाज को कक्षा रनतनिनि बिाया गया ह।ै उसे नवनर्न्न नवर्यों के निए कक्षा असाइिमेंट इकट्ठा करिे के निए कहा गया है। 

रोि िांबर, छात्रों के िाम और नवर्य के िाम स्प्टोर करिे के निए एक स्प्रेडशीट बिाएां। निम्न कायभ निष्पाफदत करें ताफक नियाज़ फाइि तक 

पहुाँच सके: 

1. रैक पररवतभि . Enable करें 

2. उस तारीख को फदखािे के निए comment जोड़ें नजस पर असाइिमेंट सबनमट फकया गया है। 

3. डॉक् ्यूमेंट को कक्षा नशक्षक के साथ साझा करें। 
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िलॄे ऑ�फस बेस का उपयोग कर डेटाबेस मनेैजम�ट िसःटमिलॄे ऑ�फस बेस का उपयोग कर डेटाबेस मनेैजम�ट िसःटमिलॄे ऑ�फस बेस का उपयोग कर डेटाबेस मनेैजम�ट िसःटमिलॄे ऑ�फस बेस का उपयोग कर डेटाबेस मनेैजम�ट िसःटम 

प�रचयप�रचयप�रचयप�रचय 

�कसी भी संगठन के िलए डेटा का ूबंधन बहुत मह'व रखता है। डेटा दज, करने म� आसानी, इसका कुशल 

भंडारण, सट1क और तेज़ पुनूा,ि4 �कसी भी डेटाबेस ूबंधन ूणाली का ूाथिमक उ6ेँय है। इस इकाई म� 

आप िलॄे ऑ�फस बेस का उपयोग करके डेटा ूबंधन के 9विभ:न तर1क; के बारे म� जान�गे, जो एक खलुा 

ॐोत अनुूयोग है। इस इकाई म� पाँच अ?याय ह@। 
 

पहले अ?याय म� आप डेटाबेस ूबंधन ूणाली कA सामा:य अवधारणाओं को जान�गे, �रलेशनल डेटाबेस पर 

फोकस के साथ अलग-अलग डेटाबेस मॉडल। इसम� primary key और foreign key कA अवधारणा और 

RDBMS के 9विभ:न डेटाबेस ऑDजेEFस कA GयाHया कA जाती है। 
 

दसूरे अ?याय म� आप िलॄे ऑ�फस बेस एJलीकेशन इंटरफेस के बारे म� जान�गे, इसे कैसे start शुK कर� और 

कैसे use कर�, डेटाबेस और टेबल कैसे बनाए,ं तािलका म� डेटा दज, कर� और ए�डट कर�। 9विभ:न fields के 

िलए दज, �कए जाने वाले डेटा कA ूकृित 9विभ:न ूकार कA होती है। िलॄे ऑ�फस बेस Mारा उपयोग �कए 

जाने वाले 9विभ:न डेटा ूकार; को शुNआत म� कवर �कया जाता है। 
 

तािलका बनाने के बाद, आप डेटाबेस के उिचत रखरखाव के िलए डेटा अितरेक redundancy और असंगित 

inconsistency को िनयं9ऽत करने के िलए तािलका को ए�डट कर सकते ह@  या delete कर सकते ह@ और 

तािलकाओ ंके बीच संबंध ःथा9पत कर सकते ह@। तीसरे अ?याय म�, आप सीख�गे �क संबंध बनाने के बाद 

संबंिधत तािलकाओ ंम� प�रवत,न कैसे �दखाई देते ह@। 
 

चौथे अ?याय म�, आप वांिछत specifications ूदान करके अपनी आवँयकता के अनुसार डेटाबेस से डेटा 

को पुनः ूा4 करना सीख�गे, Sजसे Eवेर1 कहा जाता है। �दए गए specifications के आधार पर, 9विशT 

�रकॉड, को डेटाबेस के Kप म� खोजा जाता है और �फर वांिछत तर1के से ूदिश,त �कया जाता है। 

आप queries का उपयोग करके तािलका म� ू'येक �रकॉड, म� अलग अलग जाए 9बना डेटा को पुनः ूा4 

कर सकते ह@ और उ:ह�  वांिछत format म� भी ूदिश,त कर सकते ह@। 
 

अिंतम अ?याय म�, आप िलॄे ऑ�फस बेस का उपयोग करके फॉम, और �रपोट, बनाना सीख�गे। फ़ॉम, 

ूयोE ता के अनुकूल डेटा ू9व9T ःबAन है जो �कसी भी ूयोE ता Mारा आसानी से तािलका म� डेटा दज, करने 

कA अनुमित देता है। �रपोट, सु9वधा ूयोE ता को पुनूा,4 �कए गए डेटा को ूयोE ता के अनुकूल, समझने 

योXय और format �कए गए तर1के से ूःतुत करने म� मदद करती है। 
 

अ?यायअ?यायअ?यायअ?याय 8. डेटाबेसडेटाबेसडेटाबेसडेटाबेस ूबंधनूबंधनूबंधनूबंधन ूणालीूणालीूणालीूणाली काकाकाका प�रचयप�रचयप�रचयप�रचय 

8.1 प�रचयप�रचयप�रचयप�रचय 
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डेटाबेस और डेटाबेस िसःटम हमारे जीवन के आवँयक अगं ह@। हम लंबे समय से डेटाबेस का उपयोग  

कई तर1क; से कर रहे ह@। याद रख�, शDदकोश म� एक शDद कA तलाश म� या टेलीफोन िनदYिशका से �कसी 

िमऽ का टेलीफोन नंबर ढंूढना। ूौ[ोिगकA म� ूगित के साथ, क\Jयूटर1कृत डेटाबेस का उपयोग डेटाबेस को 

ःटोर करने, हेरफेर manipulate करने और manage करने के िलए �कया जा रहा है। 
 

आज, हम जीवन के लगभग सभी field म� डेटाबेस का उपयोग करते ह@। जब हम रेलवे �टकट बुक करने के 

िलए जाते ह@, एक पुःतकालय म� एक पुःतक कA खोज करने के िलए, वेतन 9ववरण ूा4 करने के िलए, 

एट1एम से पैसे िनकालने के बाद शेष रािश ूा4 करने के िलए और इसी तरह, यह सूची कई पृ̂ ; म� हो सकती 

है। डेटाबेस म� ः टोर डेटा Text, िचऽ, ऑ�डयो और वी�डयो जैसे 9विभ:न ूकार के हो सकते ह@। यह डेटा तब 

ः टोर और / या संसािधत �कया जाता है ता�क साथ,क जानकार1 ूा4 हो सके। 
 

8.2 डेटाडेटाडेटाडेटा औरऔरऔरऔर सूचनासूचनासूचनासूचना 

ये raw facts डेटा का आधार बनाते ह@। ये facts �कसी भी Gय9_, ःथान, गित9विध या चीज; से संबंिधत 

हो सकते ह@। इसे टेEःट, मा�फEस, ऑ�डयो या वी�डयो के Kप म� ः टोर �कया जा सकता है। उपयोगी और 

साथ,क जानकार1 उ'प:न करने के िलए इस डेटा को �कसी भी कंJयू�टंग मशीन Mारा उिचत तर1के से 

संसािधत �कया जाना चा�हए। डेटा के उदाहरण छाऽ; Mारा �कए गए अकं, वजन, मूaय, लागत, बेची गई 

वःतुओ ंकA संHया, कम,चार1 के नाम, उ'पाद के नाम, पते, कर कोड, पंजीकरण, अंक आ�द ह@। 
 

सूचनासूचनासूचनासूचना डेटा का संसािधत या संग�ठत Kप कहा जा सकता है। य�द डेटा सह1 या सट1क नह1ं है, तो ऐसे डेटा 

को संसािधत करके ूा4 जानकार1 सह1 नह1ं हो सकती है। उदाहरण के िलए, छाऽ; Mारा ूा4 अकं और उनके 

रोल नंबर डेटा ह@, जब�क �रपोट, काड, / शीट सूचना है। अ:य ूकार कA जानकार1 पे-Sःलप, शेcयूल, वक, शीट, 

बार चाट,, चालान, खाता �रटन, आ�द ह@। इसी ूकार दज, �कया गया तापमान डेटा है Sजसे �दन और रात के 

अिधकतम या :यूनतम तापमान का पता लगाने के िलए संसािधत �कया जा सकता है। इसके अलावा यह 

डेटा आम तौर पर सारणीबd Kप म� आयोSजत �कया जाता है जैसा �क तािलका 8.1 म� �दखाया गया है। 
 

�दन�दन�दन�दन �दन�दन�दन�दन काकाकाका तापतापतापतापमानमानमानमान रातरातरातरात काकाकाका तापमानतापमानतापमानतापमान 

र9ववार 35  15 

सोमवार 37  17 

मंगलवार 36  16 

बुधवार 34  15 

गुNवार 35  17 

शुबवार 35  16 

शिनवार 33  14 



122 

 

तािलका 8.1: सारणीबd Kप म� ः टोर डेटा 
 

8.3 डेटाबेसडेटाबेसडेटाबेसडेटाबेस औरऔरऔरऔर ड1बीएमएसड1बीएमएसड1बीएमएसड1बीएमएस  

एक डेटाबेस ता�क, क Kप से संबंिधत डेटा आइटम का एक संमह है जो एक संग�ठत तर1के से ः टोर है। एक 

डेटाबेस म� ः टोर �कया जानकार1 को ूयोE ता कA आवँयकताओ ंके अनुसार जोड़ा, संशोिधत, हटाया या 

ूदिश,त �कया जा सकता है। डेटा को बनाने, अ[तन करने और पुनूा,4 करने के िलए उपयोग �कए जाने 

वाले सॉझटवेयर को डेटाबेस ूबंधन ूणाली (DBMS) के Kप म� जाना जाता है। यह ूयोE ता के िलए डेटाबेस 

कA योजना और रखरखाव कA सु9वधा ूदान करता है। DBMS के कुछ सामा:य उदाहरण MS Access, Open 

Office या LibreOffice Base, Oracle, Ingress, MySQL ह@। इस पुःतक म�, हम ड1बीएमएस के 9विभनन् 

पहलुओ ंको जानने के िलए िलॄे ऑ�फस बेस संःकरण 6.4 का उपयोग कर�गे। 
 

हम सभी जानते ह@ �क हमारे दोःत; के नाम; को याद रखना आसान है, ले�कन उनके फोन नंबर को हमार1 

याद म� बनाए रखना मुSँकल है। य�द नाम और फोन नंबर जैसे 9ववरण एक बमबd तर1के से डायर1 या 

मोबाइल फोन म� ः टोर �कए जाते ह@, तो एक आवँयक Gय9_ के फोन नंबर को पुनः ूा4 करना आसान हो 

जाता है। इस ूकार, फोन बुक को एक सरल डेटाबेस माना जा सकता है और इलेEशॉिनक Kप से इस डेटाबेस 

का ूबंधन करने के िलए, हम� एक डेटाबेस ूबंधन ूणाली या एक ड1बीएमएस कA आवँयकता होगी। 

आइए हम DBMS के कुछ लाभ; पर चचा, करते ह@ : 
 

संग�ठतसंग�ठतसंग�ठतसंग�ठत भंडारणभंडारणभंडारणभंडारण Organized storage - डेटाबेस म� डेटा को एक संग�ठत तर1के से ः टोर �कया जाता है, 

ता�क आवँयक डेटा कA पुनूा,ि4 retrieval तेज और सट1क हो। 

डेटाडेटाडेटाडेटा 9वjेषण9वjेषण9वjेषण9वjेषण - एक डेटाबेस कुछ मानदंड; के आधार पर डेटा के 9वjेषण म� मदद करता है। डेटाबेस का 

उपयोग करके अिधकतम या :यूनतम मूaय, औसत या औसत का पता लगाना आसान है। 
 

डेटाडेटाडेटाडेटा शेय�रंगशेय�रंगशेय�रंगशेय�रंग - य�द एक ह1 डेटा सेट अलग-अलग applications के िलए आवँयक है तो डेटाबेस को अ:य 

applications के साथ साझा �कया जा सकता है। इसिलए डेटाबेस का उपयोग करने का अथ, है एक बार 

बनाना और बार-बार कई जगह इसका उपयोग करना। 
 

:यूनतम:यूनतम:यूनतम:यूनतम डेटाडेटाडेटाडेटा अितरेकअितरेकअितरेकअितरेक - कई तािलकाओ ंम� एक ह1 डेटा फ़Aaड कA आवँयकता होने कA Sःथित म� डेटा फ़Aaड 

को तािलकाओं कA संHया म� दोहराया जा सकता है। इसे डेटा �रडंड�सी कहा जाता है। DBMS टूaस का 

उपयोग करके इसे कम �कया जा सकता है। 
  

डेटाडेटाडेटाडेटा संगितसंगितसंगितसंगित - डेटा अितरेक को कम करने से, असंगत डेटा ः टोर होने कA संभावना कम हो जाती है। उदाहरण 

के िलए, ऐसा नह1ं होना चा�हए �क छाऽ का नाम एक तािलका म� बदला जाए और दसूरे म� नह1ं। DBMS का 

उपयोग करके ऐसी असंगित को कम �कया जाता है। 
 

आइए एक Sःथित पर 9वचार कर�, उदाहरण के िलए, मुNगन एबीसी ःकूल के डेटा ूबंधन का रखरखाव 

करता है। उसके डेटाबेस म� दो टेबल ह@- एडिमशन टेबल और लाइॄेर1 टेबल। ‘राम लाल कुमार' अपने नाम 
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को बदलकर 'राम कुमार' करना चाहते ह@, Sज: ह;ने हाल ह1 म� अपना घर बदल िलया है। तो वह मुNगन को 

एJलीकेशन सmपता है। ड1बीएमएस न होने म�, मुNगन को एडिमशन टेबल म� और लाइॄेर1 टेबल म� छाऽ का 

नाम अलग से बदलना होगा। ले�कन जैसा �क हम DBMS का उपयोग करके दो तािलकाओ ंके बीच एक 

संबंध ःथा9पत कर सकते ह@, �कसी तािलका म� �कया गया कोई भी प�रवत,न ःवचािलत Kप से सभी 

संबंिधत टेबल म� �दखाई देता है बदले हुए नाम के साथ एक और �रकॉड, जोड़ने कA जKरत नह1ं है।उसी 

�रकॉड, को अपडेट �कया जाएगा। इसिलए, इससे डेटा अितरेक और असंगतता कA संभावना कम हो जाती 

है। 

 

दnतादnतादnतादnता बढ़ाताबढ़ाताबढ़ाताबढ़ाता हैहैहैहै - चू�ंक डेटाबेस तािलकाओ ंको OK से GयवSःथत �कया जाता है, डेटा को सेव करने, पढ़ने 

और खोजने का काम कुशलतापूव,क �कया जा सकता है। 

सट1कतासट1कतासट1कतासट1कता बढ़बढ़बढ़बढ़ जातीजातीजातीजाती हैहैहैहै - चूं�क डेटा अितरेक और असंगित को डेटाबेस म� कम से कम �कया जा सकता है, 

इसिलए डेटाबेस से डेटा सट1क Kप से पुनूा,4 retrieve �कया जाता है। 

वैधतावैधतावैधतावैधता बढ़बढ़बढ़बढ़ जातीजातीजातीजाती हैहैहैहै - एक डेटाबेस कA योजना बनाते समय 9विभ:न डेटा फ़Aaड के Properties असाइन 

�कए जा सकते ह@। तो मा:य डेटा दज, �कया जा रहा है या नह1ं, डेटा ू9व9T चरण म� इसकA जाँच कA जा 

सकती है। इससे डेटाबेस कA वैधता बढ़ जाती है। 
 

उदाहरण के िलए, हम तािलका बनाते समय ूितबंध लगा सकते ह@ �क दज, कA जा रह1 फAस कA रािश 1000 

से अिधक होनी चा�हए। 
 

सुरnासुरnासुरnासुरnा - ूयोE ताओ ंको पासवड, असाइन करके अनिधकृत पहंुच को िनयं9ऽत �कया जा सकता है। डेटा का 

इस तरह से अनुवाद �कया जा सकता है �क अनिधकृत ूयोE ता इसे पढ़ नह1ं पा रहे ह@। इसे एS:बJशन कहा 

जाता है। इन दोन; उपाय; से डेटाबेस कA सुरnा बढ़ जाती है। 
 

8.4 डेटाडेटाडेटाडेटा मॉडलमॉडलमॉडलमॉडल 
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ः टोर �कए जा रहे डेटा के आधार पर एक डेटाबेस को 9विभ:न तर1क; से �डज़ाइन �कया जा सकता है। 

डेटाबेस कA इस संरचना को डेटा मॉडल कहा जाता है जो डेटा को ः टोर और पुनूा,4 करने के तर1के का वण,न 

करता है। 

डेटा मॉडल म� डेटा का वण,न करने के िलए घटक होते ह@, उनके बीच संबंध और डेटा को रखने म� बाधाए ंहोती 

ह@। 9विभ:न डेटा मॉडल ह@ जैसे �क hierarchical डेटा मॉडल, नेटवक,  डेटा मॉडल और relational डेटा मॉडल। 

Hierarchical डेटाडेटाडेटाडेटा मॉडलमॉडलमॉडलमॉडल - इस मॉडल म� डेटा को संरचना कA तरह एक tree म� GयवSःथत �कया जाता है। 

डेटा को �रकॉड, के Kप म� ः टोर �कया जाता है। एक �रकॉड, fields और उसके डेटा मूaय; का एक संगर्ह है। ये 

सभी �रकॉड, 9विभ:न ःतर; पर एक-दसूरे से जुड़े हुए ह@, Sजससे एक hierarchy बनता है। उदाहरण के िलए, 

िचऽ 8.1 म� एक कंपनी का डेटा एक hierarchy डेटा मॉडल का उपयोग करके ः टोर �कया गया है। 

 
िचऽ 8.1 Hierarchical डेटा मॉडल 

नेटवक,नेटवक,नेटवक,नेटवक,  डेटाडेटाडेटाडेटा मॉडलमॉडलमॉडलमॉडल - इस मॉडल म�, कई �रकॉड, एक ह1 माःटर फ़ाइल से जुड़े होते ह@। इसे एक inverted tree 

भी माना जाता है, जहां tree के नीचे master मौजूद होता है और शाखाओ ंम� master से जुड़1 जानकार1 होती 

है। िचऽ 8.2 म�, नेटवक,  डेटा मॉडल का उपयोग करके कंपनी के डेटा का ूितिनिध'व �कया जाता है। 

 
िचऽ 8.2 नेटवक,  मॉडल 

संबंधपरकसंबंधपरकसंबंधपरकसंबंधपरक डेटाडेटाडेटाडेटा मॉडलमॉडलमॉडलमॉडल - यह डेटा मॉडल एक ह1 डेटाबेस के दो या अिधक तािलकाओ ंके बीच संबंध ःथा9पत 

करने के िसdांत पर आधा�रत है। यह सबसे अिधक इःतेमाल �कया जाने वाला डेटाबेस मॉडल है। आइये 

इस मॉडल के बारे म� 9वःतार से अ?ययन करते ह@। 
 

8.5 संबंधपरकसंबंधपरकसंबंधपरकसंबंधपरक डेटाबेसडेटाबेसडेटाबेसडेटाबेस मॉडलमॉडलमॉडलमॉडल 
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�रलेशनल डेटाबेस मॉडल को ई. एफ. कोड Mारा 1970 म� ूःता9वत �कया गया था। �रलेशनल डेटाबेस 

मॉडल सबसे सामा:य ूकार का डेटाबेस मॉडल है। डेटा त'व; को rows और columns से बने 9विभ:न 

तािलकाओ ंम� ः टोर �कया जाता है। 
 

9विभ:न तािलकाओ ंम� डेटा आम field के उपयोग से संबंिधत ह@। इसिलए सामा:य field पर आधा�रत 

तािलकाओ ंके बीच संबंध िनधा,�रत �कए जाते ह@। इसीिलए इस मॉडल को �रलेशनल डेटाबेस मॉडल कहा 

जाता है। 
 

संबंधपरकसंबंधपरकसंबंधपरकसंबंधपरक डेटाबेसडेटाबेसडेटाबेसडेटाबेस शDदावलीशDदावलीशDदावलीशDदावली 

आरड1बीएमएस म� इःतेमाल होने वाले कुछ सामा:य शDद; से हम प�रिचत ह@। 
 

इकाईइकाईइकाईइकाई - यह एक वाःत9वक 9वq वःत ुहै Sजसके बारे म� जानकार1 डेटाबेस म� ः टोर कA जानी है। उदाहरण के 

िलए, य�द हम �कसी इकाई ÔछाऽÕ के बारे म� जानकार1 ः टोर करना चाहते ह@, तो हम� उसका ूवेश नंबर, रोल 

नंबर, नाम, 9पता का नाम, ज:म ितिथ आ�द पता होना चा�हए। इकाई से जुड़े इन 9ववरण; को attributes 

कहा जाता है। 

ू'येक इकाई इससे जुड़1 इन 9वशेषताओ ंका एक संमह है। तो रोल नंबर, नाम, ूवेश संHया आ�द इकाई 

छाऽ से जुड़े Properties ह@। इन 9वशेषताओ ंको कॉलम के Kप म� दशा,या जाता है। 

तािलकातािलकातािलकातािलका - एक तािलका ता�क, क Kप से संबंिधत �रकॉड, का एक संमह है। यह columns के एक सेट के Kप म� 

आयोSजत �कया जाता है, और इसम� �कतनी भी rows हो सकती ह@। उदाहरण, कम,चार1 तािलका म� नाम, 

पदनाम, 9वभाग के कॉलम हो सकते ह@ और 100 कम,चा�रय; के डेटा वाले �रकॉड, या rows हो सकती ह@। 

फ़Aaडफ़Aaडफ़Aaडफ़Aaड यायायाया कॉलमकॉलमकॉलमकॉलम यायायाया 9वशेषताएँ9वशेषताएँ9वशेषताएँ9वशेषताए ँ – एक field डेटाबेस कA सबसे छोट1 इकाई है। fields का एक संमह एक 

�रकॉड, बनाता है, �रकॉड, के एक संमह से एक तािलका बनती है और तािलकाओ ंका एक संमह एक डेटाबेस 

बनाता है। फ़Aaड Gय9_गत �रकॉड, 9वशेषताए ँह@ और एक तािलका म� कॉलम के Kप म� ूःतुत कA जाती ह@। 

डेटा मान को फ़Aaड के Kप म� डेटाबेस म� ः टोर �कया जाता है। एक फ़Aaड म� कई Gय9_य; के िलए एक 

ूकार के डेटा के डेटा मान रखा जाता  है। उदाहरण के िलए कम,चार1 तािलका म� फ़Aaड “Emp Name” एक 

संगठन के कम,चा�रय; के नाम रखेगा। 
 

डेटाडेटाडेटाडेटा मानमानमानमान - डेटा मान numeric, character या अaफ़ा:यूमे�रक Kप म� दशा,ए गए raw डेटा ह@। डेटा वैaयू के 

उदाहरण ‘अिभनव 9बंिा’,‘26‘, Ôशू�टंग’, Ôचडं1गढ़’, Ô10-12-2018Õ आ�द ह@। 
 

�रकॉड,�रकॉड,�रकॉड,�रकॉड, यायायाया row - �कसी Gय9_ या वःत ुसे संबंिधत सभी field के डेटा मूaय; को �रकॉड, कहा जाता है। इसे 

एक तािलका म� rows के Kप म� ूःतुत �कया जाता है। एक �रकॉड, म� �कसी भी Gय9_ या ऑDजेEट के िलए 

एक तािलका म� सभी फ़Aaड के डेटा मान होते ह@। उदाहरण के िलए, कम,चार1 तािलका म� नाम, पदनाम, 

9वभाग के नाम के साथ, �कसी कम,चार1 के िलए सभी field के डेटा मूaय (Ôअिभनव’,’ूबंधक’,’9वu’) हो 

सकते ह@ और यह एक �रकॉड, बनाता है। 
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primary key - एक primary key या बस एक कंुजी एक फ़Aaड है जो 9विशT Kप से एक तािलका म� एक row 

को पहचानती है। ूमुख पहचानकता, एकल column या कई columns का मान हो सकता है। primary key 

तािलका के िलए एक 9विशT पहचानकता, है। primary key बनाने वाले columns या column के संयोजन म� 

unique values होते ह@। �कसी भी समय, तािलका म� कोई भी दो rows म� न तो primary key के िलए समान 

मान हो सकता है और न ह1 ऐसे फ़Aaड के िलए डेटा मान को �र_ छोड़ा जा सकता है। उदाहरण के िलए, एक 

छाऽ तािलका म�, ू'येक छाऽ का एक unique रोल नंबर होता है, जो primary key बनाता है। य�द, �कसी 

तािलका म� हम �रकॉड, कA पहचान करने के िलए एक से अिधक फ़Aaड का उपयोग करते ह@, तो इसे एक 

संयु_ कंुजी के Kप म� जाना जाता है। उदाहरण के िलए, हम एक composite key बना सकते ह@ Sजसम� 

फ़Aaड रोल नंबर और नाम शािमल ह@।  
 

�रलेशनल�रलेशनल�रलेशनल�रलेशनल डेटाबेसडेटाबेसडेटाबेसडेटाबेस - एक �रलेशनल डेटाबेस संबंिधत तािलकाओं का एक संमह है। उदाहरण के िलए, िचऽ 

8.3 म�, डेटाबेस म� दो संबंिधत टेबल ह@। 

 
िचऽ 8.3 संबंधपरक डेटाबेस 

Foreign Key 

य�द �कसी तािलका के फ़Aaड या संयोजन को 9विशT Kप से �कसी अ:य तािलका के �रकॉड, कA पहचान 

करने के िलए उपयोग �कया जा सकता है, तो उस 9वशेष फ़Aaड को foreign key कहा जाता है। यह foreign 

key दो तािलकाओ ंके बीच संबंध बनाने म� मदद करती है। 
 

नीचे �दए गए उदाहरण पर 9वचार कर�। 
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primary key - रोल नंबर, Foreign key- छाऽ पंजीकरण तािलका म� नामांकन संHया, _N 

Enrollment_Number ’primary key है और छाऽ अकं तािलका म�, umber Roll_Number’ primary key 

है, जब�क ment Enrollment_Number ’Foreign keyहै। इस Foreign key का उपयोग दो तािलकाओ ंके 

बीच संबंध ःथा9पत करने के िलए �कया जा सकता है। 
 

Candidate Key - सभी फ़Aaड मान जो primary key होने के योXय ह@, उस तािलका के िलए Candidate Key 

ह@। ऐसे field को न तो खाली छोड़ा जा सकता है और न ह1 डुSJलकेट मान हो सकते ह@। इसिलए तािलका म� 

छाऽ अकं, नामांकन संHया और रोल नंबर दोन; Candidate Key ह@। 

Alternate Key - Candidate Key म� से, एक या दो को primary key के Kप म� बनाया जाता है। अ:य 

Alternate Key ह@। इसिलए, य�द रोल नंबर को primary key के Kप म� बनाया जाता है, तो ूवेश संHया 

Alternate Key है। 

8.6 एकएकएकएक RDBMS के Objects 

डेटाबेस म� एक object एक संरचना या एक feature है Sजसका उपयोग डेटा को ः टोर, ूितिनिध'व या 

retrieve करने के िलए �कया जाता है। वाःतव म� एक डेटाबेस इन वःतुओ ंका एक संमह है जो एक दसूरे से 

संबंिधत डेटा के कई सेट; पर काम करते ह@। डेटाबेस म� 9विभ:न objects कA जानकार1 नीचे द1 गई है : 

तािलकातािलकातािलकातािलका - जैसा �क पहले उaलेख �कया गया है, एक तािलका �कसी भी ड1बीएमएस कA मूल इकाई है। डेटा 

को पहले row और column format म� तािलकाओ ंम� ः टोर �कया जाता है। एक column एक फ़Aaड या एक 

9वशेषता का ूितिनिध'व करता है जब�क एक row एक �रकॉड, का ूितिनिध'व करती है। 

Forms - एक फ़ॉम, एक डेटाबेस कA एक 9वशेषता है, Sजसके उपयोग से हम तािलका म� डेटा को आसान और 

ूयोE ता के अनुकूल तर1के से दज, कर सकते ह@। एक फॉम, म� टेEःट बॉEस, लेबल, रे�डयो बटन, सूची 

बॉEस, चेक बॉEस आ�द होते ह@ जो डेटा दज, करने के िलए एक ूयोE ता के अनुकूल इंटरफेस देते ह@। Forms 

के मा?यम से दज, �कया गया डेटा तािलकाओ ंम� ः टोर �कया जाता है। 

Eवेर1Eवेर1Eवेर1Eवेर1 - डेटाबेस से वांिछत जानकार1 ूा4 करने के िलए एक Eवेर1 का उपयोग �कया जाता है। सरल शDद; 

म�, यह डेटाबेस से पूछा गया ूv है। उदाहरण के िलए, य�द हम केवल उन छाऽ; के नाम देखना चाहते ह@, 



128 

 

Sज:ह;ने 50 से अिधक अकं ूापत् �कए ह@, तो हम एक ूv पोःट करते ह@। �दए गए मानदंड से मेल खाते 

डेटा सेट को तािलका से retrieve �कया जाता है और ःबAन पर ूदिश,त �कया जाता है। 

�रपो�रपो�रपो�रपोट, - �कसी Eवेर1 के आउटपुट को �रपोट, के Kप म� ूदिश,त �कया जा सकता है। Eवेर1 का सामा:य 

प�रणाम rows और columns के Kप म� होता है। ले�कन अगर हम चाहते ह@ �क �रपोट, formal औपचा�रक 

और उिचत लेआउट म� हो, तो हम RDBMS कA �रपोट, 9वशेषता का उपयोग कर सकते ह@।  

आइए अw याआइए अw याआइए अw याआइए अw यास कर�स कर�स कर�स कर� 

िन\निलSखत तािलका पर 9वचार कर� और नीचे �दए गए ूv; का उuर द�। 

 

उपरो_ तािलका से primary key को पहचान�। अपनी पसंद का औिच'य सा9बत कर�। 

तािलका म� �कतने fields और �कतने �रकॉड, है? 

अपनीअपनीअपनीअपनी ूगितूगितूगितूगित जांच�जांच�जांच�जांच� 

कककक. बहु9वकaपबहु9वकaपबहु9वकaपबहु9वकaप ूvूvूvूv 

1. िन\निलSखत म� से �कसे डेटाबेस का उदाहरण माना जा सकता है? 

(a) �डEशनर1 (b) टेलीफोन डायरेEटर1 (c) माEस, रSजःटर (d) उपरो_ सभी 

2. िन\निलSखत म� से कौन एक DBMS नह1ं है? 

(a) MS Access (b) Open Office Base (c) MS Excel (d) उपरो_ म� से कोई नह1ं 

3. DBMS का 9वःतार कर�। 

(a) डेटा और बुEस मैनेजम�ट िसःटम        (बी) डेटाबेस ूबंधन ूणाली  

(c) डुJलीकेट बुEस मैनेजम�ट िसःटम         (d) उपरो_ म� से कोई नह1ं 

4. िन\निलSखत म� से दो या अिधक तािलकाओ ंके बीच कौन सा डेटा मॉडल संबंध ःथा9पत करता है?  

(a) �रलेशनल डेटा मॉडल (बी) नेटवक,  डेटा मॉडल 

(c) Hierarchical डेटा मॉडल (d) कनेEशन डेटा मॉडल 

5. एक इकाई से जुड़े 9ववरण को ____________ कहा जाता है। 

(ए) तािलका (बी) Attributes (सी) �रकॉड, (ड1) primary key 

6. एक __________ को एक तािलका म� rows के Kप म� दशा,या गया है।  

(ए) फAaड (बी) Attribute (सी) �रकॉड, (ड1) Candidate key 

7. िन\न म� से �कस Kप म� एक डेटा मूaय का ूितिनिध'व �कया जा सकता है?  
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(ए) :यूमे�रक    (b) कैरेEटर   (c) अaफा :यूमे�रक   (d) उपरो_ सभी 

8. िन\निलSखत म� से कौन सी तािलका म� एक row कA 9विशT पहचान करता है?  

(ए) Primary Key (बी) Alternate Key (सी) Foreign key (ड1) उपरो_ म� से कोई नह1ं 

9. एक ___________ डेटाबेस कA एक feature है Sजसके उपयोग से हम एक आसान और ूयोE ता के 

अनुकूल तर1के से एक तािलका म� डेटा दज, कर सकते ह@।  

(ए) Eवेर1         (बी) �रपोट,         (सी) फॉम, (d) फAaड 

10. _____________ एक डेटाबेस से पूछा गया ूv है।  

(ए) Eवेर1         (बी) �रपोट,             (c) फॉम, (d) फAaड 

खखखख.... यहयहयहयह बताएंबताएंबताएंबताए ं�क�क�क�क िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत कथनकथनकथनकथन सह1सह1सह1सह1 ह@ह@ह@ह@ यायायाया गलतगलतगलतगलत 

1. एक डेटाबेस ऑग,नाइज नह1ं �कया जा सकता है। 

2. डेटा raw facts का संमह है। 

3. एक primary key के 9बना एक तािलका बनाई जा सकती है। 

4. दो टेबल एक नेटवक,  डेटा मॉडल म� संबंिधत हो सकते ह@। 

5. एमएस एEसेस एक डेटाबेस का एक उदाहरण है। 

गगगग.... �र_�र_�र_�र_ ःथानःथानःथानःथान भर�भर�भर�भर�: 

1. raw facts _____________ का गठन करते ह@। 

2. एक ___________ एक वाःत9वक 9वq वःत ुहै Sजसके बारे म� जानकार1 डेटाबेस म� ः टोर कA जानी है 

3. Eवेर1 के आउटपुट को ________ के Kप म� ूदिश,त �कया जा सकता है। 

4. �कसी Gय9_ या वःत ुसे संबंिधत सभी field के डेटा मूaय; को _________ कहा जाता है। 

5. सभी फ़Aaड मान जो उस तािलका के िलए _______ primary key होने के योXय ह@। 

घघघघ.... िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत ूv;ूv;ूv;ूv; केकेकेके उuरउuरउuरउuर द1Sजएद1Sजएद1Sजएद1Sजए 

1. शDद; को प�रभा9षत कर� (ए) डेटाबेस (बी) डेटा redundancy (सी) �रपोट, 

2. (ए) डेटा और सचूना, (बी) फॉम, और Eवेर1, (सी) नेटवक,  और hierarchical मॉडल के बीच अतंर का एक 9बदं ुद� 

3. एक DBMS के कोई चार लाभ बताएं। 

4. नीचे द1 गई तािलका पर 9वचार कर� और आने वाले ूv; के उuर द� 

  

�दए गए तािलका म� फ़Aaड का नाम द�। 

�कस field nेऽ को primary key ूाथिमक कंुजी बनाया जाना चा�हए? 

Eया टेबल म� कोई alternate key वकैSaपक कंुजी है? 



130 

 

अ?यायअ?यायअ?यायअ?याय 9. िलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फस बेसबेसबेसबेस केकेकेके साथसाथसाथसाथ शुKशुKशुKशुK 

9.1 प�रचयप�रचयप�रचयप�रचय 

9पछले अ?याय म� हमने डेटाबेस और डेटाबेस ूबंधन ूणाली (DBMS) के बारे म� सीखा है। िलॄे ऑ�फस 

बेस एक ःवतंऽ और खलुा ॐोत ड1बीएमएस है। इसे www.libreoffice.org से डाउनलोड �कया जा सकता है 

और यह िलनEस और 9वंडोज दोन; ऑपरे�टंग िसःटम के िलए उपलDध है। DBMS का उपयोग करके डेटा 

को एक संग�ठत तर1के से ः टोर �कया जाना है। इसके अलावा, ः टोर �कया जा रहा डेटा एक text, संHया, 

�दनांक या �कसी अ:य Kप म� हो सकता है। इसिलए, हम� 9विभ:न ूकार के डेटा को समझने कA 

आवँयकता है Sज:ह�  एक तािलका म� ः टोर �कया जा सकता है। �कसी डेटाबेस म� तािलकाए ँबनाते समय 

डेटा ूकार; को िन�द,T करना पड़ता है। इसके बाद वैध डेटा है एक तािलका म� enter और ः टोर �कया 

जाता है। 

9.2 डेटाडेटाडेटाडेटा ूकारूकारूकारूकार 

9विभ:न field के िलए दज, �कए जाने वाले डेटा कA ूकृित 9विभ:न ूकार कA होती है। उदाहरण के िलए, 

नाम text के Kप म� ः टोर �कए जाते ह@, संHया म� आय,ु दशमलव संHया म� शुaक, ज:म ितिथ म� 

ज:मितिथ आ�द। डेटा ूकार उस डेटा के ूकार को संदिभ,त करता है Sजसे उस 9वशेष FIELD म� ः टोर �कया 

जाएगा। �कसी फ़Aaड का मेमोर1 साइज़ उसके डेटा ूकार के अनुसार बदलता रहता है। 
 

आम तौर पर उपयोग �कए जाने वाले कुछ डेटा ूकार नीचे वSण,त ह@। 
 

Text डेटाडेटाडेटाडेटा ूकारूकारूकारूकार - Text डेटा अnर;, संHयाओ ंया 9वशेष वणx का एक संयोजन है। Text डेटा पर कोई 

अकंगSणतीय गणना नह1ं कA जा सकती है। Text डेटा ूकार के उदाहरण पैन काड, न,ं नाम, िनशान आ�द ह@। 

नीचे द1 गई तािलका म� 9विभ:न डेटा ूकार; को सूचीबd �कया गया है जो Text डेटा ः टोर कर सकते ह@। 

तािलकातािलकातािलकातािलका 9.1 Text डेटा ूकार डेटा ूकार डेटा ूकार डेटा ूकार  

Name Data type Description 

Memo LONGVARCHAR ूयोE ता Mारा इंिगत अिधकतम लबंाई तक ःटोर करता है। इसका उपयोग 255 

characters से अिधक के कुछ वण,ना'मक डेटा को ः टोर करने के िलए �कया 

जाता है। मेमो डेटा ूकार Text डेटा को 64,000 तक characters ः टोर करने कA 

अनमुित देता है। 
Text (fix)  CHAR डेटा ूकार characters कA िनSyत सHंया दज, करने के िलए उपयोग �कया जाता 

है। इसका उपयोग लाइस�स नबंर, पासपोट, नबंर के िलए �कया जा सकता है 

Eय;�क उनके पास िनSyत सHंया म� character होते ह@। 
Text 

(�फEस) 

VARCHAR िन�द,T लबंाई तक ः टोर करता है। आब�ंटत बाइFस कA सHंया ूयोE ता Mारा दज, 

�कए गए characters कA सHंया पर िनभ,र करती है। उदाहरण के िलए, address 

को varchar (50) के Kप म� प�रभा9षत �कया गया है और य�द ूयोE ता Mारा दज, 

�कया गया address 20 अnर; का है, तो डेटाबेस म� केवल 20 बाइFस occupied 
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ह;गे। 

:यूमे�रक:यूमे�रक:यूमे�रक:यूमे�रक डेटाडेटाडेटाडेटा टाइपटाइपटाइपटाइप - :यूमे�रक डेटा टाइप म� नंबर होते ह@। संHया पूणाzक integer या वाःत9वक real 

संHया हो सकती है, Sजस पर �कसी भी ूकार कA अकंगSणतीय गणना कA जा सकती है। उदाहरण के िलए, 

10, -34.8, 90.6789, -86 संHया'मक डेटा ूकार के होते ह@। तािलका 2.2 9बFस / बाइFस कA संHया और 

इसके उपयोग कA संHया के साथ 9विभ:न संHया'मक डेटा ूकार; को सूचीबd करती है। 

तािलकातािलकातािलकातािलका 9.2 संHया'मकसंHया'मकसंHया'मकसंHया'मक डेटाडेटाडेटाडेटा ूकारूकारूकारूकार 

 

मुिामुिामुिामुिा डेटाडेटाडेटाडेटा ूकारूकारूकारूकार Currency Data Type - मुिा डेटा ूकार मौ�िक मूaय; को इंिगत करता है और 9विभ:न 

देश; कA मुिाओ ंका उपयोग करके ः टोर �कया जा सकता है। उदाहरण के िलए $ 100, £ 500 या 25.50 N.। 

�दनांक�दनांक�दनांक�दनांक डेटाडेटाडेटाडेटा ूकारूकारूकारूकार - यह डेटा ूकार �दनांक और समय को इंिगत करने के िलए उपयोग �कया जाता है। 

उदाहरण के िलए 12/25/2019, 08:45 सुबह। डेटा और समय को 9विभ:न ूाKप; म� ः टोर �कया जा सकता 

है। तािलका 2.3 म� 9विभ:न ूकार के �दनांक डेटा ूकार �दए गए ह@। 

तािलकातािलकातािलकातािलका 9.3 �दनांक�दनांक�दनांक�दनांक डेटाडेटाडेटाडेटा ूकारूकारूकारूकार केकेकेके 9विभ:न9विभ:न9विभ:न9विभ:न KपKपKपKप 

नामनामनामनाम 9ववरण9ववरण9ववरण9ववरण 

Date यह ूणाली म� वष,, मह1ने और �दन के Kप म� ः टोर �कया जाता है। 
Time �दन के समय को घंटे, िमनट और सेकंड के Kप म� ः टोर करता है।  

Time stamp तार1ख और समय कA जानकार1 एक बार म� ः टोर करता है। 
 

बुिलयन - बुिलयन डेटा ूकार म� केवल दो मान हो सकते ह@- { या फाaस। यह भी कई Kप; म� �दया जा 

सकता है, जैसे Yes / No, True / False, On / Off। 
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बाइनर1बाइनर1बाइनर1बाइनर1 - बाइनर1 डेटा ूकार का उपयोग �डSजटल छ9वय; और ?विनय; को ः टोर करने के िलए �कया जाता 

है जो शू:य और एक के लंबे Sःशंग के Kप म� आता है। बेस डेटाबेस म� उ'पाद; या कम,चा�रय; कA तःवीर�, या 

?विन Sःनपेट या ?विन संदेश; को ः टोर करना संभव है। 
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9.3 िलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फस बेसबेसबेसबेस केकेकेके साथसाथसाथसाथ शुKशुKशुKशुK 

Kह1 के ःकूल म� वा9ष,क खेल �दवस आयोSजत �कया जा रहा है Sजसम� 9विभ:न खेल ूितयोिगताए ं

आयोSजत कA जाएंगी। Nह1 को 9विभ:न खेल गित9विधय; और इसके Sखला�ड़य; से िमलकर एक डेटाबेस 

बनाने के िलए कहा गया है। वह एक डेटाबेस बनाने का फैसला करती है, Sजसका नाम है 'ःपोFस, डे' Sजसम� 

एक टेबल है 'इव�Fस' Sजसम� िन\निलSखत फ़Aaड शािमल ह@: 
 

Event_Id - इव�ट पहचान को ःटोर करने के िलए जैसे �क E001, E002, आ�द। 

इव�ट का नाम - इव�ट का नाम ःटोर करने के िलए 

ितिथ - उस तार1ख को ःटोर करने के िलए Sजस पर आयोजन �कया जाएगा 

9वजेता 1 नाम - 9वजेता का नाम 

9वजेता 1 अकं - 9वजेता Mारा अSज,त अकं  

आइए अw याआइए अw याआइए अw याआइए अw यास कर�स कर�स कर�स कर� 

1. Kह1 Mारा बनाए जाने वाले इव�Fस के फ़Aacस का डेटा ूकार Eया होना चा�हए? 

2. �कस field को primary key बनाया जाना चा�हए? एक बार अपने field के साथ तािलका तय करने के 

बाद Kह1 ने िलॄे ऑ�फस बेस का उपयोग करके डेटाबेस बनाना शुK करने का फैसला �कया है। डेटाबेस 

बनाने के िलए िन\न चरण; का पालन कर�। 

चरणचरणचरणचरण 1. 9वंडोज या िलनEस म� एJलीकेशन शुK करने कA मानक ू�बया के अनुसार िलॄे ऑ�फस बेस शुK 

कर�। 9वंडोज म�, िलॄे ऑ�फस डेःकटॉप पर Start > LibreOffice    पर SEलक कर� या िलॄे ऑ�फस 

आइकन पर डबल SEलक कर� या नीचे बाए ंपैनल से बेस डेटाबेस 9वकaप चनु�। 

उबंटू िलनEस म�, िचऽ 9.1 (ए) म� �दखाए गए अनुसार बाए ंपैनल पर Sःथत बेस आइकन पर SEलक कर� या 

शो एJलीकेशन पर SEलक कर� जैसा �क िचऽ 9.1 (बी) म� �दखाया गया है ता�क इसके आइकन कA खोज कA 

जा सके। खोज बॉEस म� बेस टाइप कर�। िलॄे ऑ�फस बेस एJलीकेशन आइकन को िचऽ 9.1 (c) म� �दखाया 

गया है। बेस एSJलकेशन को खोलने के िलए आधार आइकन पर SEलक कर�। 

  
 

िचऽ 9.1 (क) आधार खोलने के िलए बाएं 

पैनल पर बेस आइकन पर SEलक करना 
 

  

िचऽ 9.1 (बी) install �कए गए पैकेज; 
कA खोज के िलए शो एSJलकेशन पर 

SEलक करना 

  
 

िचऽ 9.1 (सी) बेस खोलने के िलए खोजे 
गए बेस आइकन पर SEलक करना 
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चरणचरणचरणचरण 2. एक डेटाबेसडेटाबेसडेटाबेसडेटाबेस 9वज़ाड,9वज़ाड,9वज़ाड,9वज़ाड, िचऽ 9.2 म� �दखाया गया है। यह आपको एक नया डेटाबेस बनाने या मौजूदा 

डेटाबेस खोलने कA सु9वधा िमलती है। 

 
िचऽ 9.2 िलॄे ऑ�फस डेटाबेस 9वजाड, 
 

�टप�टप�टप�टप : िलॄे ऑ�फस बेस खोलने के िलए, आप अपने कंJयूटर पर एSJलकेशन बेस खोज सकते ह@ और िलॄे 

ऑ�फस बेस आइकन पर SEलक कर सकते ह@। 
 

चरणचरणचरणचरण 3. चू�ँक हम एक नया डेटाबेस बनाना चाहते ह@, इसिलए नया डेटाबेस रे�डयो बटन बनाए ँपर SEलक 

कर�। य�द पहले से बनाया गया कोई भी डेटाबेस खोला जाना है तो डेटाबेस को खोलने के िलए चयन करने के 

िलए एक मौजूदा डेटाबेस खोल� 9वकaप चनु�। इसके बाद नेEःट बटन पर SEलक कर�। 
 

चरणचरणचरणचरण 4. अगला चरण हमारे डेटाबेस को LibreOffice.org के साथ पंजीकृत करने का 9वकaप देता है। य�द 

हम डेटाबेस को register करते ह@, तो हमारा डेटाबेस साव,जिनक हो जाता है और इसिलए इसे अ:य लोग; 

Mारा एEसेस �कया जा सकता है। अब तक, हम register नह1ं करना चाहते ह@, इसिलए हम 9वकaप के साथ 

रे�डयो बटन पर SEलक करते ह@ और चयन करते ह@, ‘No, do not register the database । 

 
िचऽ 9.3 तय कर� �क डेटाबेस को सेव करने के बाद कैसे आग ेबढ़� 
 

चरणचरणचरणचरण 5. इस चरण यह भी पूछा जाता है �क Eया आप संपादन के िलए डेटाबेस खोलना चाहते ह@ या 9वज़ाड, 

का उपयोग करके एक तािलका बनाना चाहते ह@। Open the database for editing पहले से ह1 चयिनत है। 

चरणचरणचरणचरण 6. डेटाबेस िनमा,ण ू�बया को पूरा करने के िलए Finish बटन पर SEलक कर�। इस Kप म� Save As 

डायलॉग बॉEस सामने आता है। 
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िचऽ 9.4 डायलॉग बॉEस के Kप म� सेव कर� 

चरणचरणचरणचरण 7. साइव और फ़ोaडर के िलए ॄाउज़ कर� जहां आप अपने डेटाबेस ः टोर करना चाहते ह@। 

चरणचरणचरणचरण 8. फ़ाइल नाम Text बॉEस म� नाम (खेल �दवस) टाइप कर�। 

चरण 9. Save बटन पर SEलक कर�। बेस म� डेटाबेस एक extension.odb के साथ सहेजा गया है। यह भी 

?यान द�  �क य�द डेटाबेस को कोई नाम नह1ं �दया गया है, तो इसे �डफ़ॉaट नाम से NewDatabse.odb के 

Kप म� सेव �कया जाता है। 
 

िलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फस बेसबेसबेसबेस काकाकाका यूजरयूजरयूजरयूजर इंटरफेसइंटरफेसइंटरफेसइंटरफेस 

डेटाबेस बनने के बाद, िचऽ 9.5 म� �दखाया गया ःबAन �दखाई देता है। यह ओपन ऑ�फस बेस का यूजर 

इंटरफेस है। 

 
िचऽ 9.5 िलॄे ऑ�फस बेस का यूजर इंटरफेस 
 

बेस यूजर इंटरफेस के 9विभ:न घटक; कA चचा, नीचे द1 गई है: 
 

टाइटलटाइटलटाइटलटाइटल बारबारबारबार - टाइटल बार एक डेटाबेस का नाम और एक एJलीकेशन ूदिश,त करता है Sजसम� इसे बनाया 

जाता है। 9वंडो बटन अिधकतम, कम करने या बंद करने के िलए title bar के दा�हने कोने पर Sःथत ह@। 
 

मेनूमेनूमेनूमेन ूबारबारबारबार - मेन ूबार शीष,क बार के नीचे �दखाई देता है। इसम� सात मेन ूआइटम - फाइल, ए�डट, Gय,ू इंसट,, 

टूaस, 9वंडो और हेaप शािमल ह@। इन सभी मेन ूआइटम म� कमांड होते ह@ जो डेटाबेस पर 9विभ:न ऑपरेशन 

करने म� मदद करते ह@। 

Standard टूलबारटूलबारटूलबारटूलबार - यह मेन ूबार के नीचे Sःथत है। इसका उपयोग अEसर उपयोग �कए जाने वाले टूल तक 

पहंुचने के िलए �कया जाता है। 

Status bar - यह इंटरफ़ेस 9वंडो के िनचले भाग म� Sःथत है। यह डेटाबेस म� ऑDजेEट के देखने के ूकार के 

बारे म� जानकार1 ूदिश,त करता है। 

डेटाबेसडेटाबेसडेटाबेसडेटाबेस पैनपैनपैनपैन - डेटाबेस पैन 9वंडो के बा} ओर Sःथत है। िलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फसिलॄे ऑ�फस बेस संबंिधत डेटा ऑDजेEFस का संमह 

है Sजसे टेबaस, फॉम,, Eवेर1, �रपोट, और एSJलकेशन मॉcयूल के Kप म� जाना जाता है। चयिनत ऑDजेEट 

के आधार पर, संबंिधत टाःक पेन और ऑDजेEट ए�रया जो �क िनिम,त ऑDजेEट को ूदिश,त करता है, 

�दखाई देता है। 
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9.4 डेटाबेसडेटाबेसडेटाबेसडेटाबेस खोलनाखोलनाखोलनाखोलना 

पहले से िनिम,त डेटाबेस को खोलने के िलए, File > Open पर SEलक कर�। ओपन डायलॉग बॉEस िचऽ 2.6 

म� �दखाया गया है। उस फ़ोaडर के िलए ॄाउज़ कर� जहां डेटाबेस खोला जाना है। वांिछत डेटाबेस का चयन 

कर� और ओपन बटन पर SEलक कर�। 

 
िचऽ 9.6 मेन ू9वकaप से डेटाबेस खोलना 
 

�टप�टप�टप�टप – पहले से मौजूद डेटाबेस खोलने के िलए कAबोड, शॉट, कट Ctrl+O कA दबाएं।    

9.5 एकएकएकएक तािलकातािलकातािलकातािलका बनानाबनानाबनानाबनाना 

डेटाबेस बनने के बाद, हम डेटाबेस कA वःतुओ ं के साथ काम करना शुK कर सकते ह@। सबसे पहले और 

सबसे मह'वपूण, है तािलका का िनमा,ण और �फर तािलका म� डेटा दज, करना। LibreOffice Base म� एक 

टेबल 9वजाड, का उपयोग करके या �डज़ाइन G य ूका उपयोग करके बनाया जा सकता है। 

9.5.1 एकएकएकएक wizard काकाकाका उपयोगउपयोगउपयोगउपयोग करकरकरकर एकएकएकएक तािलकातािलकातािलकातािलका बनानाबनानाबनानाबनाना 

डेटाबेस बनाने के बाद या डेटाबेस बनाने के बाद एक टेबल बनाई जा सकती है। डेटाबेस 9वज़ाड, म� डेटाबेस 

बनाने के समय एक तािलका बनाने के िलए, 9वकaप “Create tables using the table wizard”, के साथ 

रे�डयो बटन चनु�, �फर �फिनश बटन पर SEलक कर�। 
 

चू�ंक हमारा डेटाबेस पहले से ह1 खलुा है, इसिलए हम चयन कर�गे और SEलक कर�गे य�द डेटाबेस खोला 

गया है तो हम टाःक पेन से Use Wizard to create a table का चयन कर सकते ह@। Table Wizard 

डायलॉग बॉEस खलेुगा जैसा �क िचऽ 9.7 म� �दखाया गया है। इS~छत फ़Aaड के साथ तािलका बनाने के 

िलए 9वज़ाड, के िनदYश; का पालन कर�। 

 
िचऽ 9.7 टेबल 9वजाड, 
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बेस के टेबल 9वजाड, म� तैयार टेबल होते ह@। नमूना तािलका सूची बॉEस पर SEलक कर� और �कसी भी एक 

तािलका का चयन कर�, माहक को सॉप डाउन सूची से चनु�।" 

 

माहक तािलका का चयन करने के बाद, 9विभ:न फ़Aaड Available Fields के अतंग,त �दखाई देते ह@। 

Available Fields बॉEस से आवँयक फ़Aaड > बटन िचऽ 9.8 म� �दखाए गए अनुसार बटन का उपयोग 

करके एक-एक करके चयिनत फ़Aaड बॉEस म� ःथानांत�रत �कया जा सकता है। आप Available Fields से 

>> बटन पर SEलक करके एक बार म� उपलDध फ़Aaड के सभी field का चयन कर सकते ह@। 
 

 

 
िचऽ 9.8 फ़Aacस उपलDध फ़Aacस से चयिनत फ़Aacस 

म� ःथानांत�रत हो गए 

  
 

िचऽ 9.9 से�टंग ूकार और format 

 

Next बटन पर SEलक कर�। आप चरण 2 पर चले जाएंगे। िचऽ 9.9 म� �दखाए अनुसार types और format 

सेट कर�। 
 

इसके बाद Next बटन पर SEलक कर�। यह आपको चरण 3 पर ले जाएगा। primary key सेट कर�। चिलए 

CustomerID फ़Aaड को primary key पर सेट करते ह@ जैसा �क िचऽ 9.10 म� �दखाया गया है। 

 
िचऽ 9.10 primary key सेट करना 
 

Next बटन पर SEलक कर�, जो आपको 9वज़ाड, का उपयोग करके तािलका बनाने कA ू�बया को पूरा करने के 

िलए ले जाएगा और ःबAन को ूदिश,त करेगा जैसा �क िचऽ 9.11 म� �दखाया गया है। 

यह ःबAन आपको तीन 9वकaप देगी। �डफ़ॉaट Kप से “Insert data immediately” 9वकaप चनुा गया। 
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िचऽ 9.11 9वज़ाड, का उपयोग करके तािलका बनाना                          िचऽ 9.12 माहक तािलका कA डेटशीट �ँय 

 

तािलका बनाने और 9वज़ाड, का उपयोग करने कA ू�बया को पूरा करने के िलए �फिनश बटन पर SEलक 

कर�। अगली ःबAन चयिनत field के अनुसार डेटा दज, करने कA अनुमित देगी। जैसा �क िचऽ 9.12 म� 

�दखाया गया है डेटा शीट �ँय इंटरफ़ेस खलेुगा जो माहक तािलका म� डेटा दज, करने कA अनुमित देता है। 
 

9.5.2 �डज़ाइन�डज़ाइन�डज़ाइन�डज़ाइन GयूGयूGयूGय ूम�म�म�म� तािलकातािलकातािलकातािलका बनानाबनानाबनानाबनाना 

9वज़ाड, का उपयोग करके तािलका बनाना हम� पूव,िनधा,�रत तािलकाओ ंम� समान फ़Aaड का उपयोग करने 

के िलए ूितबंिधत करता है। यह वाःत9वक प�र�ँय म� उ6ेँय को हल नह1ं कर सकता है, Eय;�क हम� अपने 

उ6ेँय के िलए 9विभ:न field के साथ एक तािलका बनाने कA आवँयकता हो सकती है। �डज़ाइन Gय ूका 

उपयोग करके तािलकाएँ बनाने से हम� अपना काम करने म� अिधक लचीलापन िमलता है। 
 

�डज़ाइन Gय ूका उपयोग करके तािलका बनाने के िलए, मुHय डेटाबेस 9वंडो म�, 9वकaप पर SEलक कर� काय, 

तािलका म� �डज़ाइन Gय ूम� तािलका बनाए ँऔर तािलका �डज़ाइन Gयू को िचऽ 9.13 म� �दखाए अनुसार 

खोला जाएगा। 

 
िचऽ 9.13 �डज़ाइन G यू म� तािलका बनाना 

ःबAन को मोटे तौर पर दो खडं; या nैितज पैन म� 9वभाSजत �कया गया है। 

ऊपर1 आधे म� तीन columns के फAaड नाम, फAaड ूकार और 9ववरण के साथ एक िमड संरचना होती है। 

फ़Aaडफ़Aaडफ़Aaडफ़Aaड नामनामनामनाम - यह तािलका के िनमा,ण के समय असाइन �कए गए फ़Aaड का नाम है। 

फ़Aaडफ़Aaडफ़Aaडफ़Aaड ूकारूकारूकारूकार - यह फ़Aaड को डेटा ूकार िन�द,T करने कA अनुमित देता है। 

9ववरण9ववरण9ववरण9ववरण - यह field के उ6ेँय का वण,न करने कA अनुमित देता है। यह डेटाबेस तािलका का �हःसा नह1ं है, 

ले�कन यह ूयोE ता के field के उ6ेँय को समझने के िलए है। हम फAaड 9ववरण दज, कर सकते ह@ या नह1ं। 
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फ़Aaड Properties पैन 9वंडो के िनचले आधे भाग म� Sःथत है। यह डेटाबेस �डज़ाइनर Mारा िन�द,T फ़Aaड 

Properties ूदिश,त करता है। इन गुण; को आवँयकता के अनुसार बदला भी जा सकता है और उपयोग 

�कए जाने वाले डेटा को िनयं9ऽत करने और मा:य करने के िलए उपयोग �कया जाता है। 
 

आइए हम Kह1 कA मदद करते ह@, ःपोFस, डे डेटाबेस म� ऑJशन �बएट टेबल इन �डज़ाइन Gय ूका उपयोग 

करके एक टेबल बना सकते ह@। ऐसा करने के िलए िन\न चरण; का पालन कर�। 

चरणचरणचरणचरण 1. फ़Aaड नाम कॉलम म� पहला फ़Aaड नाम (EventId) टाइप कर�। टैब कंुजी दबाएं। कस,र दसूरे कॉलम 

यानी फAaड टाइप पर जाता है। 

चरणचरणचरणचरण 2. फ़Aaड ूकार कॉलम म� एक सूची बॉEस होता है। जैसा �क आप नीचे तीर पर SEलक करते ह@, यह 

ूकट होता है और हम सूची बॉEस से वांिछत डेटा ूकार का चयन कर सकते ह@। डेटाटाइप (Varchar) का 

चयन कर�। 

िचऽ 9.14 फAa ड के िलए डेटा ूकार का चयन करना 

चरणचरणचरणचरण 3. देख� �क कुछ Properties फ़Aaड Properties पैन म� �दखाई देते ह@ Eय;�क डेटा ूकार चयिनत है। 

कुछ Properties म� ूवेश आवँयक है, लंबाई, �डफ़ॉaट मान, format उदाहरण। दज, �कए गए फ़Aaड के 

िलए वांिछत Properties सेट कर�। 

चरणचरणचरणचरण 4. अगले कॉलम पर जाने के िलए टैब कA दबाएं। य�द आप चाहते ह@ तो तीसरे कॉलम म� कोई भी 

9ववरण जोड़�। 

चरणचरणचरणचरण 5. field के िलए Properties सेट हो जाने के बाद, अगली row म� जाने के िलए टैब कA दबाएं। 

चरणचरणचरणचरण 6. चरण 1,2 और 3 को दोहराकर अगला फ़Aaड दज, कर�। तािलका म� सभी फ़Aacस जोड़ने कA ू�बया 

को दोहराएं। िचऽ 9.15 सभी field के साथ �डज़ाइन G यू �दखाया गया है। 

 
िचऽ 9.15 �डज़ाइन G यू म� तािलका बनाकर Fields एंटर करना  
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primary key सेटसेटसेटसेट करनाकरनाकरनाकरना 

जैसा �क आपने सीखा है �क हर तािलका म� एक primary key होनी चा�हए जो तािलका म� 9विशT Kप से 

�रकॉड, कA पहचान करती है। �कसी 9वशेष फ़Aaड को primary key के Kप म� बनाने के िलए, फ़Aaड नाम से 

पहले माउस पॉइंटर लगाए,ं हमारे उपरो_ उदाहरण म� इव�ट आईड1 ल� और राइट SEलक कर�। एक पॉप अप 

मेन ूूकट होता है। जैसा �क िचऽ 9.16 म� �दखाया गया है, पॉप अप मेन ू से primary key 9वकaप चनु�। 

फ़Aaड नाम से पहले एक कंुजी आइकन �दखाई देता है जो दशा,ता है �क यह एक primary key है। 

 

िचऽ 9.16 primary key असाइन करना 

अिधकअिधकअिधकअिधक जाननेजाननेजाननेजानने केकेकेके िलएिलएिलएिलए - एक समम कंुजी सेट करने के िलए, यानी एक primary key Sजसम� दो फ़Aaड 

शािमल ह@, Ctrl कंुजी दबाए रख� और �फर उ:ह�  चनुने के िलए कई फ़Aaड पर SEलक कर�। इसके बाद चयिनत 

field पर राइट SEलक कर� और पॉप अप मेन ूसे primary key 9वकaप चनु�। 

एकएकएकएक तािलकातािलकातािलकातािलका सेव करनासेव करनासेव करनासेव करना 

तािलका बनाने के बाद आपको इसे �डःक पर सहेजने कA आवँयकता है। टेबल को बचाने के िलए सेव बटन 

पर SEलक कर� या मेन ू9वकaप का पालन कर� File > Save As के Kप म� सेव कर�। एक डायलॉग बॉEस के 

Kप म� सेव कर� जैसा िचऽ 9.17 म� �दखाया गया है। तािलका का नाम दज, कर� और ओके बटन पर SEलक 

कर�। 

                           
िचऽ 9.17 तािलका सेव करना                                                        िचऽ 9.18 इव�ट तािलका डेटाबेस म� जोड़ा गया 
 

�टप�टप�टप�टप - तािलका को सेव करने के िलए Ctrl + S दबाए ंया टूलबार से Save आइकन पर SEलक कर�। य�द कुछ 

प�रवत,न करने के बाद तािलका को Save �कया जा रहा है, तो बस File-> Save 9वकaप दबाए।ं एक बार 
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टेबल �डज़ाइन पूरा हो जाने के बाद, डेटाबेस ःबAन पर लौटने के िलए टूलबार पर Eलोज बटन पर SEलक 

कर�। तािलका का नाम तािलका ऑDजेEट ए�रया म� �दखाई देगा जैसा �क िचऽ 9.18 म� �दखाया गया है। 

तािलकातािलकातािलकातािलका म�म�म�म� डेटाडेटाडेटाडेटा दज,दज,दज,दज, करनाकरनाकरनाकरना 

तािलका म� डेटा दज, करने के िलए, डेटाबेस ःबAन पर टेबaस ऑDजेEट ए�रया म� बनाए गए टेबल इव�Fस 

आइकन पर डबल SEलक कर�। वैकSaपक Kप से, हम वांिछत तािलका पर राइट SEलक करके तािलका को 

खोल सकते ह@ और �फर सॉप डाउन मेन ूसे ओपन 9वकaप का चयन कर सकते ह@। तािलका का डेटाशीट �ँय 

िचऽ 9.19 म� �दखाया गया है। यह शीष, row म� फ़Aaड नाम; को ूदिश,त करता है। इन फ़Aacस को उसी बम 

म� ूदिश,त �कया जाता है जैसे टेबल बनाते समय उ:ह�  जोड़ा गया था। 
 
 

य�द फ़Aaड कA संHया अिधक है और एकल row म� �फट नह1ं हो सकते ह@, तो आप सभी फ़Aaड देखने के िलए 

nैितज ःबॉल बार का उपयोग कर सकते ह@। दसूर1 row म� कस,र SDलंक �कया जाएगा। ू'येक फ़Aaड के 

िलए डेटा मान िलखना ूारंभ कर�। अगले फ़Aaड पर जाने के िलए टैब का उपयोग कर�। एक बार सभी डेटा 

मान एक �रकॉड, के िलए दज, �कए जाने के बाद, कस,र अगले �रकॉड, पर चला जाता है। इस ू�बया को डेटा 

ू9व9T कहा जाता है। इव�ट तािलका म� 4-5 �रकॉड, दज, कर� जैसा �क िचऽ 9.20 म� �दखाया गया है। 

 

िचऽ 9.19  इव�Fस तािलका का डेटाशीट �ँय 
 

 

िचऽ 9.20 इव�ट तािलका म� डेटा ू9व9T 

 

तािलकातािलकातािलकातािलका केकेकेके मा?यममा?यममा?यममा?यम सेसेसेसे ने9वगेटने9वगेटने9वगेटने9वगेट करनाकरनाकरनाकरना 

फ़Aaड नाम से OK पहले Dलैक पॉइं�टंग एरो () �रकॉड, पॉइंटर है। तािलका के 9विभ:न �रकॉड, के मा?यम से 

ने9वगेट करने के िलए, हम डेटाशीट 9वंडो के नीचे मौजूद ने9वगेशन बॉEस का उपयोग करते ह@ जैसा �क िचऽ 

9.21 म� �दखाया गया है। यह �कसी भी समय तािलका के वत,मान �रकॉड, को इंिगत करता है। 

 

िचऽ 9.21 ने9वगेशन बॉEस 

ने9वगेशन बॉEस के 9विभ:न घटक इस ूकार ह@। 

�रकॉड,�रकॉड,�रकॉड,�रकॉड, Selector बॉEसबॉEसबॉEसबॉEस - यह टेEःट बॉEस है जहां वत,मान म� स�बय �रकॉरड् संHया ूदिश,त कA जाती है। 

हम उस �रकॉड, संHया को दज, कर सकते ह@ Sजसे हम इस टेEःट बॉEस म� देखना चाहते ह@। 
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ने9वगेशनने9वगेशनने9वगेशनने9वगेशन बटनबटनबटनबटन - इनका उपयोग तािलका म� लंबवत ःबॉल करने के िलए �कया जाता है। पहले �रकॉड, पर 

जाने के िलए दबाएँ और बमशः अगले और 9पछले �रकॉड, पर जाने के िलए दबाएँ। 

अिंतम �रकॉड, पर जाने के िलए दबाए ं िचऽ 9.20 तािलका म� चार �रकॉड, दज, करने के बाद डेटाशीट �ँय 

�दखाता है। ?यान द�  �क �रकॉड, पॉइंटर चौथे �रकॉड, पर है, ने9वगेशन बार “Record 4 of 4” �दखाता है। 
 

डेटाडेटाडेटाडेटा काकाकाका संपादनसंपादनसंपादनसंपादन 

पहले से दज, �कए गए डेटा को ए�डट करने या संशोिधत करने के िलए, फ़Aaड मान पर कस,र रख�, Sजसे 

ए�डट करने और नए मूaय दज, करने के िलए ए�डट करना होगा। 
 

ए�डट �कए जाने वाले �रकॉड, से पहले संपादन आइकन () �दखाई देता है। आवँयक प�रवत,न करने के बाद 

तािलका सेव �कए जाने तक यह आइकन ूदिश,त होता है। बनाए गए सुधार; को र6 करने और मूल 

सामिमय; को दोबारा डालने के िलए Esc कंुजी दबाएं। 
 

तािलकातािलकातािलकातािलका सेसेसेसे �रकॉड,�रकॉड,�रकॉड,�रकॉड, हटानाहटानाहटानाहटाना 

तािलका से �कसी भी �रकॉड, को हटाने के िलए, तािलका खोल� और हटाए जाने के िलए �रकॉड, का चयन कर�। 

कAबोड, से डेल कंुजी दबाकर या Edit मेन ूसे Delete Record 9वकaप का चयन करके �रकॉड, को हटाया जा 

सकता है। 
 

वैकSaपक Kप से �रकॉड, पर राइट SEलक करके और पॉप अप मेन ूसे �डलीट रो ऑJशन पर SEलक करके भी 

एक �रकॉड, को हटाया जा सकता है। 
 

�रकॉड, को हटाने का ूयास पु9T बॉEस को ूदिश,त करेगा जैसा �क िचऽ 9.22 म� �दखाया गया है। Yes बटन 

पर SEलक करने पर अतं म� �रकॉड, �डलीट हो जाएगा, जब�क No बटन पर SEलक करने से �रकॉड, �डलीट 

नह1ं होगा।  

 
िचऽ 9.22 �डलीट �रकॉड, एलट,  
 

तािलकातािलकातािलकातािलका म�म�म�म� डेटाडेटाडेटाडेटा सॉट,सॉट,सॉट,सॉट, करनाकरनाकरनाकरना 

तािलका म� डेटा को ascending या descending बम म� GयवSःथत �कया जा सकता है। �कसी भी दायर पर 

9वशेष बम म� �रकॉड, कA Gयवःथा करने कA इस ू�बया को sorting कहा जाता है। तािलका को सॉट, करने 

के िलए िन\न चरण; का पालन कर�। 
 

चरणचरणचरणचरण 1. डेटाशीट �ँय म� इव�ट तािलका खोल� और उस फ़Aaड का चयन कर� Sजस पर आप सॉट, करना चाहते 

ह@। िचऽ 9.23 से पता चलता है �क field "अकं" को ascending बम म� �रकॉड, को बमबd करने के िलए चनुा 

गया है। 
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िचऽ 9.23 पॉइंFस फ़Aaड पर इव�ट टेबल को सॉट, करना 
 

चरणचरणचरणचरण 2. टूल बार से य�द तािलका को चयिनत field के ascending बम म� बमबd �कया जाना है, तो Sort 

Ascending आइकन पर SEलक कर�। वैकSaपक Kप से Sort Descending आइकन चनु� य�द तािलका को 

चयिनत field के descending बम म� बमबd करना है। 

चरणचरणचरणचरण 3. तािलका को अकं के ascending बम म� रखा जाएगा जैसा �क िचऽ 9.24 म� �दखाया गया है। 
 

 

कभी-कभी हम� एक से अिधक field के आधार पर तािलका को बमबd करने कA आवँयकता हो सकती है। 

ऐसे मामले म�, टूलबार पर सॉट, आइकन पर SEलक कर�। Sort Order डायलॉग ूदिश,त �कया जाएगा जैसा 

�क िचऽ 9.25 म� �दखाया गया है। 

  
 

िचऽ 9.24 पॉइंFस फ़Aaड पर सॉट, करने के बाद इव�ट टेबल 

  

िचऽ. 9.25 Sort Order डायलॉग बॉEस 

 

उपयु_ फ़Aaड नाम और फ़Aaड मान Sजसके अनुसार �रकॉcस, को सॉट, करना है, का चयन कर�। ऑड,र सॉप 

डाउन बॉEस से आवँयकतानुसार बढ़ते या घटते बम को चनु�। इस डायलॉग बॉEस म� कई field का चयन 

�कया जा सकता है। एक बार ओके बटन पर SEलक कर�। 

9.4 िलॄेिलॄेिलॄेिलॄे ऑ�फसऑ�फसऑ�फसऑ�फस बेसबेसबेसबेस बंदबंदबंदबंद करनाकरनाकरनाकरना 

िलॄे ऑ�फस बेस कA एSJलकेशन 9वंडो को बंद करने के िलए, File >Close पर SEलक कर� या िलॄे ऑ�फस 

बेस 9वंडो के बॉस (x) बटन पर SEलक कर�। 

आइए अw याआइए अw याआइए अw याआइए अw यास कर�स कर�स कर�स कर� 

Nह1 के ःकूल म� 5 हाउस ह@ - गंगा, यमुना, सतलुज, Dयास और नम,दा। एक बार जब छाऽ हर हाउस से 

पा�ट,कुलर इव�ट म� भाग ले सकते ह@। िन\निलSखत field के साथ एक तािलका Participants बनाएं। 
(i) Event_Id 

(ii) इव�ट का नाम 

(iii) गंगा 
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(iv) यमुना 

(v) सतलुज 

(vi) Dयास 

(vii) नम,दा 

तािलका म� :यूनतम पांच �रकॉड, भी जोड़�। 
 

अपनीअपनीअपनीअपनी ूगितूगितूगितूगित जांच�जांच�जांच�जांच� 
क. बहु9वकaपीयबहु9वकaपीयबहु9वकaपीयबहु9वकaपीय ूvूvूvूv 

1. िन\निलSखत म� से कौन सा Text डेटा ूकार का एक ूकार नह1ं है? 

(ए) मेमो (बी) वरचर (सी) �लोट (ड1) चार Char  

2. एक मुिा डेटा ूकार केवल मौ�िक डेटा ः टोर कर सकता है जो डॉलर म� है। 

(ए) सह1 (बी) गलत (सी) न तो न बी (सी) ए और बी दोन; 

3. िन\निलSखत डेटा म� से कौन डेटा ितिथ ःटोर कर सकता है? 

(ए) ितिथ (बी) समय (सी) ितिथ और समय दोन; (ड1) न तो तार1ख और न ह1 समय 

4. िलॄे ऑ�फस बेस के बारे म� िन\निलSखत म� से कौन सा सह1 है? 

(a) यह एक ःूेडशीट सॉ�टवेयर है 

(b) यह मुझत और खलुा ॐोत सॉझटवेयर है 

(c) यह केवल character डेटा ःटोर कर सकता है 

(d) यह एक लाइस�स ूा4 सॉ�टवेयर है। 

5. बेस म� टेबल बनाने के िलए िन\न म� से �कस 9विध का उपयोग �कया जा सकता है? 

(ए) टेबल 9वजाड, का उपयोग करना (बी) �डजाइन G य ू

(c) a और b दोन; (d) न तो a न ह1 b  

6. बेस डेटाबेस 9वंडो के पैन म� डेटाबेस कA संबंिधत वःतुओ ंको ______ देखा जा सकता है। 

(ए) डेटाबेस (बी) टाःक (सी) टाटल बार (ड1) मेन ूबार 

7. मौजूदा डेटाबेस को खोलने के िलए कौन सी शॉट,कट कंुजी है? 

(a) Ctrl + D (b) Ctrl + O (c) Ctrl + E (d) उपरो_ म� से कोई नह1ं 

8. िलॄे ऑ�फस बेस म� टेबल �बएशन 9वंडो का �डज़ाइन �ँय है ______ खडं या पैन म� 9वभाSजत। 
(a) 2 (b) 3 (c) 4 (d) 5 

9. एक तािलका म� �रकॉड, दज, करते समय, हम _________ कंुजी दबाकर अगले field म� जा सकते ह@। 

(a) टैब (b) Ctrl (c) एंटर (d) िश�ट 

10. िन\निलSखत म� से कौन एक तािलका कA primary key के बारे म� सच है? 

(ए) ू'येक तािलका म� एक primary key होनी चा�हए 
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(b) primary key फ़Aaड म� डेटा मान; को डुSJलकेट नह1ं �कया जा सकता है। 

(c) एक primary key फ़Aaड को खाली नह1ं छोड़ा जा सकता है 

(D. उपरो_ सभी 

खखखख. यहयहयहयह बताएंबताएंबताएंबताए ं�क�क�क�क िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत कथनकथनकथनकथन सह1सह1सह1सह1 ह@ह@ह@ह@ यायायाया गलत।गलत।गलत।गलत। 

1. Text डेटा म� 9वशेष characters हो सकते ह@। 

2. मेमो डेटा ूकार का उपयोग वण,ना'मक डेटा को ःटोर करने के िलए �कया जा सकता है। 

3. एक बुिलयन डेटा ूकार म� दो या दो से अिधक मान हो सकते ह@। 

4. हम िलॄे ऑ�फस बेस म� ऑ�डयो डेटा ःटोर नह1ं कर सकते। 

5. चयिनत डेटा ूकार के अनुसार �कसी फ़Aaड के Properties बदलते ह@। 

6. टेबल �डज़ाइन करते समय फ़Aaड 9ववरण दज, �कया जा सकता है या नह1ं भी �कया जा सकता है। 

7. 9पछले �रकॉड, पर ःथानांत�रत करने के िलए दबाया जाता है। 

8. यह तब ूकट होता है जब �रकॉड, ए�डट �कया जा रहा है। 

9. एक बार डेटाबेस म� बनाई गई तािलका को ए�डट नह1ं �कया जा सकता है। 

10. सॉट, कर�  डायलॉग बॉEस केवल ascending बम म� डेटा को सॉट, करने म� मदद कर सकता है। 

ग. �र_�र_�र_�र_ ःथानःथानःथानःथान भर�।भर�।भर�।भर�। 

1. एक डेटा ूकार उस डेटा के ूकार को संदिभ,त करता है Sजसे उस 9वशेष field म� ः टोर �कया जाएगा। 

2. _____________ डेटा अnर;, संHयाओ ंया 9वशेष characters का एक संयोजन है। 

3. आधार नंबर को ःटोर करने के िलए ________ डेटा ूकार का उपयोग �कया जा सकता है। 

4. �डSजटल छ9वय; को ः टोर करने के िलए ________ डेटा ूकार का उपयोग �कया जाता है। 

5. एक तािलका को सेव करने के िलए शॉट,कट कंुजी _______________ है 

6. बेस इंटरफेस 9वंडो पर ______________ डेटाबेस म� ऑDजेEट के देखने के ूकार के बारे म� जानकार1 

ूदिश,त करता है। 

7. एक ________ आइकन फ़Aaड नाम से पहले यह दशा,ता है �क यह एक primary key है। 

8. डेटा केवल ____________ �ँय म� एक तािलका म� दज, �कया जा सकता है। 

9. �कसी तािलका म� फ़Aaड नाम से OK पहले काला इंिगत करने वाला तीर ____________ कहलाता है। 

10. �कसी भी फ़Aaड पर 9वशेष बम म� अिभलेख; को GयवSःथत करने कA ू�बया को _______________ 

कहा जाता है।  
 

घघघघ. �दए�दए�दए�दए गएगएगएगए ूv;ूv;ूv;ूv; केकेकेके उuरउuरउuरउuर द1Sजए।द1Sजए।द1Sजए।द1Sजए। 

1. इन के बीच अतंर बताए ं: 

(ए) मेमो और वच,र डेटा ूकार 

(b) संHया और दशमलव डेटा ूकार 
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(c) तािलका का �डज़ाइन �ँय और डेटाशीट �ँय 

2. बेस यूजर इंटरफेस पर मौजूद मेन ूआइटम का नाम, 

3. घटक; को लेबल कर� - टाइटल बार, डेटाबेस पैन, टाः क पैन, Sःथित िलॄे ऑ�फस बेस यूजर इंटरफेस 

का बार। 

4. हम एक तािलका म� एक primary key कैसे प�रभा9षत कर सकते ह@? 

5. primary key के अवरोह1 बम म� तािलका को सॉट, करने के िलए चरण िलख�। 

6. एक डेटाबेस म� तािलकाओ ंके संबंध म� ने9वगेशन बॉEस का उपयोग Eया है? 

 

ूायोिगकूायोिगकूायोिगकूायोिगक अwयासअwयासअwयासअwयास 

अनंत ूअपने दोःत; के Serial No, Name, Mobile Number, Email id, Date of birth डेटा यु_ एक 

िनदYिशका बनाना चाहता है। िलॄे ऑ�फस बेस का उपयोग करके एक टेबल बनाए।ं primary key के Kप म� 

सी�रयल न.ं तािलका म� :यूनतम 5 �रकॉड, दज, कर�। तािलका को नाम के वण, के अनुबम म� बमबd कर�। 
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अ?यायअ?यायअ?यायअ?याय 10. कईकईकईकई तािलकाओंतािलकाओंतािलकाओंतािलकाओ ंकेकेकेके साथसाथसाथसाथ कामकामकामकाम करनाकरनाकरनाकरना 

10.1 प�रचयप�रचयप�रचयप�रचय 

हमने एक डेटाबेस म� टेबल बनाना सीखा है। एक बार जब तािलका एक डेटाबेस म� जोड़ द1 जाती है, तो 

आपको तािलका को ए�डट करने या हटाने कA आवँयकता हो सकती है। डेटा अितरेक redundancy और 

असंगतता inconsistency को िनयं9ऽत करने के िलए तािलकाओ ंके बीच भी संबंध ःथा9पत �कए जाते ह@। 

यह �कसी डेटाबेस के उिचत रखरखाव म� यह जाँचने म� मदद करता है �क न तो �रकॉड, डुSJलकेट ह@ और न 

ह1 दो या दो से अिधक तािलकाओ ंम� �कसी 9वशेष FIELD के िलए चर डेटा मान है। य�द आप तािलकाओ ंके 

बीच संबंध ःथा9पत करते ह@, तो एक तािलका म� �रकॉड, जोड़ना या अपडेट करना सभी संबंिधत तािलकाओ ं

म� प�रवत,न को दशा,ता है। 
 

10.2 टेबaसटेबaसटेबaसटेबaस कA ए�ड�टंग कA ए�ड�टंग कA ए�ड�टंग कA ए�ड�टंग औरऔरऔरऔर हटानाहटानाहटानाहटाना 

9पछले अ?याय म�, हमने खेल �दवस डेटाबेस म� एक 9वज़ाड, का उपयोग करके एक माहक तािलका बनाई है। 

तािलका के नाम पर राइट SEलक करके और पॉप पेज मेन ूसे उिचत 9वकaप का उपयोग करके डेटाबेस कA 

तािलका को कॉपी, नाम बदलना, ए�डट करना और हटाना संभव है। 
 

तािलका को ए�डट करने म� काय, शािमल होता है जैसे �क एक नया फ़Aaड जोड़ना या �कसी तािलका म� �कसी 

फ़Aaड को िनकालना या फ़Aaड के �कसी भी Properties को बदलना। तािलका को ए�डट करने के िलए, 

डेटाबेस यूजर इंटरफेस 9वंडो खोल�। डेटाबेस पेन म� टेबल ऑDजेEट का चयन करते हुए, टेबल कA सूची टेबल 

ए�रया म� ूदिश,त कA जाएगी। तािलका नाम पर राइट SEलक कर� और पॉप मेन ूसे संपादन 9वकaप चनु�। 

हमारे उदाहरण म� हमने माहक तािलका का चयन �कया है जैसा �क िचऽ 10.1 म� �दखाया गया है। 

 
िचऽ 10.1 पॉप अप मेनू से संपादन 9वकaप का चयन करना 
 

तािलका का �डज़ाइन �ँय 9वंडो ूदिश,त �कया जाएगा जैसा �क िचऽ 10.2 म� �दखाया गया है। आवँयक 

संशोधन कर� और तािलका को सेव कर�। यह भी ?यान द� �क �कए गए प�रवत,न तािलका म� दज, 9पछले 

�रकॉड, को ूभा9वत नह1ं कर�गे। 
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िचऽ 10.2 �डज़ाइन �ँय 9वंडो म� तािलका                             िचऽ 10.3 पॉप अप मेनू से �डलीट 9वकलप् का चयन करना 

इसी तरह एक तािलका को हटाने के िलए, हटाए जाने वाली तािलका पर राइट SEलक कर�, Customer table 

और पॉप अप मेन ूसे हटाए ं9वकaप का चयन कर� जैसा �क िचऽ 10.3 म� �दखाया गया है। 
 

तािलका को हटाने के िलए पु9T करने के िलए एक पु9T बॉEस ूदिश,त �कया जाएगा जैसा �क िचऽ 10.4 म� 

�दखाया गया है। तािलका को अिंतम Kप से हटाने के िलए हां बटन पर SEलक कर�। 

 
िचऽ 10.4 Deletion Alert कA पु9T कर� 
 

तािलका का नाम बदलने के िलए, तािलका FIELD म� तािलका नाम पर राइट SEलक कर� और पॉप अप मेन ू

से नाम बदल� .. 9वकaप चनु�। एक कस,र �दखाई देगा। नया नाम टाइप कर� और एंटर कA दबाएं। 
 

10.3 तािलकाओंतािलकाओंतािलकाओंतािलकाओ ंकेकेकेके बीचबीचबीचबीच संबंधसंबंधसंबंधसंबंध 

कई तािलकाओ ं के साथ काम करते समय, आपको डेटा कA अितरेक और असंगतता कA जांच करने कA 

आवँयकता होती है। �कसी 9वशेष इकाई के िलए �रकॉड, को न तो दोहराया जाना चा�हए और न ह1 डेटाबेस 

म� एकल इकाई के िलए अलग-अलग डेटा मान �दखाई देने चा�हए। 
 

यह एक डेटाबेस के तािलकाओ ंके बीच संबंध ःथा9पत करके �कया जाता है। संबंध ःथा9पत करने के िलए 

सबसे मह'वपूण, शत, यह है �क संबंध बनाने के िलए दो तािलकाओ ं के बीच एक सामा:य FIELD होना 

चा�हए। 

आइए एक डेटाबेस के उदाहरण पर 9वचार कर� Sजसम� दो तािलकाओ ंका अनुसरण �कया गया है - 

Student_Details और Student_Result 

Table 10.1: Student_Details 
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Table 10.2: Student_Result 

  

तािलका 1 (Student_Details) म�, ूवेश संHया primary key है। तािलका 2 (छाऽ_ प�रणाम) म�, रोल नंबर 

primary key नह1ं है और ूवेश संHया Foreign key है। इसिलए तािलका 2 म� ू'येक �रकॉड, म� ूवेश 

संHया का एक मान है जो तािलका 1 म� एक �रकॉड, से संबंिधत है, जो �क ूवेश संHया के समान मूaय के 

साथ है। यह ?यान रखना मह'वपूण, है �क दोन; तािलकाओ ंम� सामा:य फ़Aaड के डेटा ूकार समान होना 

चा�हए। य�द वे समान नह1ं ह@ तो िलॄे ऑ�फस बेस एक ऽ�ुट संदेश ूदिश,त करेगा और दो तािलकाओ ंके 

बीच संबंध ःथा9पत करने कA अनुमित नह1ं देगा। 

एक बार दो तािलकाओं के बीच संबंध ःथा9पत हो जाने के बाद, डेटा कA अखडंता को ड1बीएमएस Mारा 

ूबंिधत �कया जाएगा। इसका अथ, यह है �क एक बार छाऽ का �रकॉड, Student_Details तािलका म� दज, हो 

जाने के बाद ह1 उस 9वशेष ूवेश संHया को Student_Result तािलका म� दज, नह1ं �कया जा सकता है। 

संबंिधत तािलका म� संबंिधत �रकॉड, करने पर Student_Details तािलका म� ूवेश संHया से संबंिधत �रकॉड, 

को माःटर �रकॉड, माना जाता है (Student_Result) transaction �रकॉड, है। इसिलए Student_Details को 

माःटर टेबल कहा जाता है और Student_Result को transaction table कहा जाता है। 

10.3.1 संबंध;संबंध;संबंध;संबंध; relationships केकेकेके ूकारूकारूकारूकार 

डेटाबेस म� �कसी भी दो टेबल के बीच संबंध का ूकार उन �रकॉड, कA संHया पर आधा�रत होता है जो माःटर 

टेबल के अनुKप transaction तािलका म� मौजूद होते ह@। �रलेशनल डेटाबेस म� मुHय Kप से तीन ूकार के 

संबंध दो तािलकाओ ंके बीच ःथा9पत �कए जा सकते ह@। य़े ह@: 

(i) वन-टू-वन 

(ii) एक से अनेक 

(iii) अनेक -से- अनेक  

वनवनवनवन-टूटूटूटू-वनवनवनवन �रलेशनिशप�रलेशनिशप�रलेशनिशप�रलेशनिशप 

इस ूकार के संबंध; म�, माःटर टेबल के एक 9विशT �रकॉड, म� transaction तािलका म� एक और केवल एक 

ह1 �रकॉड, होता है। उदाहरण के िलए, माःटर टेबल (Student_Detail) म� Admission_No के िलएececord 

म� Student_Result के transaction तािलका म� एडिमशन नंबर के समान मूaय का केवल एक ह1 �रकॉड, 

होगा। ऐसा इसिलए है Eय;�क �कसी भी दो छाऽ; को एक ह1 ूवेश संHया नह1ं द1 जाएगी। इसी तरह एक 
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Gय9_ के पास मैच देखने के िलए ःटे�डयम म� ूवेश पाने के िलए केवल एक �टकट हो सकता है। इसिलए 

ःटूड�ट और एडिमशन नंबर और एक Gय9_ और उसके �टकट नंबर के बीच one - to - one संबंध होगा।  

 िचऽ 10.5 one - to - one संबंध 

एकएकएकएक सेसेसेसे अनेक �रलेशनिशपअनेक �रलेशनिशपअनेक �रलेशनिशपअनेक �रलेशनिशप 

यह डेटाबेस म� तािलकाओ ंके बीच सबसे आम ूकार के संबंध; म� से एक है। जैसा �क नाम से पता चलता है, 

इस ूकार के संबंध; म�, माःटर टेबल के एक 9विशT �रकॉड, म� संबंिधत transaction तािलका म� एक से 

अिधक �रकॉड, होते ह@। उदाहरण के िलए, एक िशnक कई छाऽ; या कई कnाओ ंको पढ़ा सकता है, या एक 

Gय9_ कई उ'पाद बेच सकता है। तो हम कह सकते ह@ �क िशnक और वग, या िशnक और छाऽ या 9वबेता 

और उ'पाद; के बीच संबंध हो सकता है। 

िचऽ 10.6 एक से अनेक �रलेशनिशप 

अनेकअनेकअनेकअनेक -सेसेसेसे-    अनेक �रलेशनिशपअनेक �रलेशनिशपअनेक �रलेशनिशपअनेक �रलेशनिशप 

इस ूकार के संबंध; म�, माःटर तािलका म� कई �रकॉड, ह;गे जो transaction तािलका म� भी कई �रकॉड, के 

अनुKप ह@। 
 

आम तौर पर इस ूकार का संबंध तब िनधा,�रत �कया जाता है जब कुछ संबंिधत अिभलेख; को दोन; 

संबंिधत तािलकाओ ंम� एक से अिधक बार सेव करना पड़ता है। उदाहरण के िलए, एक ःकूल म� एक िशnक 

कnा िशक्षक, एक गित9विध ूभार1 या पर1nा ूभार1 जैसे कई Sज\मेदा�रयां रख सकता है। ू'येक 

Sज\मेदार1 के िलए िशnक को कई छाऽ; के साथ जोड़ा जा सकता है। तो इस ूकार का संबंध कई से कई 

संबंध; तक होगा। इसी तरह एक दकुानदार कई माहक; को कई उ'पाद बेच सकता है। एक उ'पाद और एक 

माहक के बीच कई-से-कई संबंध मौजूद ह@। िचऽ 10.8 माःटर टेबल म� संबंिधत �रकॉड, �दखाता है और 

transaction तािलका एक ह1 रंग म� ह@। 
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Figure 10.8 Many–to-many relationship िचऽ 10.8 नेक -से- अनेक �रलेशनिशप 

10.3.2 एकएकएकएक डेटाबेसडेटाबेसडेटाबेसडेटाबेस म�म�म�म� संबंिधतसंबंिधतसंबंिधतसंबंिधत तािलकाओंतािलकाओंतािलकाओंतािलकाओ ंकाकाकाका लाभलाभलाभलाभ 

एक डेटाबेस म� संबंिधत तािलकाओ ंके 9विभ:न फायदे ह@। उनम� से कुछ नीचे ह@। 

• एक संबंध डेटा अितरेक को रोकने म� मदद कर सकता है। 

• यह हटाए गए डेटा को िसंक से बाहर रखने से लापता डेटा को रोकने म� मदद करता है। इसे संदभा,'मक 

अखडंता कहा जाता है। हम अ?याय म� आगे संदभा,'मक अखडंता के बारे म� 9वःतार से अ?ययन 

कर�गे। 

• तािलकाओ ंके बीच संबंध बनाना ूयोE ता को संदिभ,त field म� अमा:य डेटा दज, करने से रोकता है। 

• माःटर टेबल म� कोई भी अपडेशन ःवचािलत Kप से शांजेEशन टेबल म� �दखाई देता है। 

आइएआइएआइएआइए    अअअअw याw याw याw यास कर�स कर�स कर�स कर� 

िन\निलSखत के िलए संबंध के ूकार को नाम द�: 

• नाग�रक और उसका साइ9वंग लाइस�स 

• माहक और उ'पाद 

• छाऽ और पा�यबम 

• ट1म और मैच 

• Sखलाड़1 और देश 

• कम,चार1 और प�रयोजना 

10.4 तािलकाओंतािलकाओंतािलकाओंतािलकाओ ंकेकेकेके बीचबीचबीचबीच संबंधसंबंधसंबंधसंबंध बनानाबनानाबनानाबनाना 

9पछले अ?याय म� बनाए गए ःपोFस, डे डेटाबेस पर वापस आते ह@। आइए हम एक अ:य फ़Aaड जोड़ते ह@, 

TableID म� कैटगर1 ईव�Fस को ए�डट कर� 9वकaप का उपयोग करके जैसा �क िचऽ 10.9 म� �दखाया गया है। 

9विभ:न ौSेणय; के घटनाबम तािलका म� 10 �रकॉड, दज, कर� जैसा �क िचऽ 10.10 म� �दखाया गया है। 

 
  

िचऽ 10.10 �रकॉड, जोड़ा फ़Aaड 

 

  

िचऽ 10.11 EventCategory table म� �रकॉड, 
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िचतर् 10.9 इव�ट तािलका म� फ़Aaड 

ौणेी जोड़ना 
ौणेीआईड1 के साथ घटना तािलका म� 
दज, �कया गया 

दज, �कए गए 

fields CategoryID, CategoryName, TeacherIncharge के साथ एक और तािलका बनाए ं - fields 

CategoryID, CategoryName, TeacherIncharge और िचऽ 10.11 म� �दखाए गए अनुसार �रकॉड, दज, कर�। 

इसिलए, डेटाबेस म� दो टेबल ह@ - कैटेगर1 के Kप म� एक सामा:य field के साथ इव�ट और इव�ट कैटेिगर1। 

इव�ट तािलका म�, EventID primary key है और Category आईड1 Foreign key है। 

EventCategory तािलका म�, CategoryID primary key है। इन तािलकाओ ंके बीच संबंध ःथा9पत करने के 

िलए िन\निलSखत चरण; का पालन कर�। 

चरणचरणचरणचरण 1. िलॄे ऑ�फस बेस के मुHय मेन ूसे Tools > Relationships पर SEलक कर� ... 

चरणचरणचरणचरण 2 �रलेशनिशप �डज़ाइन ःबAन िचऽ 10.12 म� �दखाया गया है। ःबAन के बीच म� Add Tables 

डायलॉग बॉEस है। दोन; तािलकाओं को डायलॉग बॉEस म� सूचीबd �कया गया है। 

                                                                    
िचऽ 10.12 �रलेशनिशप �डज़ाइन ःबAन म� टेबaस डायलॉग                   िचऽ 10.13 Events and EventCategory Tables   

बॉEस जोड़�                                                                                                              Relationship �डज़ाइन 9वंडो म� जोड़े गए  
 

 चरणचरणचरणचरण 3. Add Tables डायलॉग बॉEस म�, इव�ट तािलका पर SEलक कर� और �फर Add बटन पर SEलक 

कर�। इसी तरह EventCategory Table को �रलेशनिशप ए�रया म� जोड़�।  

चरण 4. तािलका जोड़�  डायलॉग बॉEस को बंद करने के िलए Close बटन पर SEलक कर�। ?यान द�  �क 

तािलकाए ँघटनाए ँऔर EventCategory तािलका अपने सभी फ़Aaड सूची के साथ संबंध field म� जोड़ा गया 

जैसा �क िचऽ 10.13 म� �दखाया गया है। 

चरणचरणचरणचरण 5. जैसा �क पहले चचा, कA गई है, CategoryID दो तािलकाओ ंम� सामा:य field है। इसिलए इसका 

उपयोग दो तािलकाओ ं के बीच संबंध ःथा9पत करने के िलए �कया जाएगा। दो तािलकाओ ं के बीच एक 

संबंध बनाने के िलए, हम� बस इव�ट तािलका से सामा:य फ़Aaड ौणेी को drag करना होगा और 

EventCategory तािलका म� drop करना होगा। दोन; फ़Aacस को सामा:य फ़Aaड (ौणेी) से जोड़ने वाली 

एक row ःबAन पर �दखाई देती है जैसा �क िचऽ 10.14 म� �दखाया गया है। 
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िचऽ 10.14 दो तािलकाओ ंके बीच संबंध 

लाइन को primary key पn पर 'l' और Foreign key पn पर 'n' के Kप म� लेबल �कया गया है। इसिलए 

primary key के Kप म� EventCategory तािलका से कैटगेर1आईड1 म� unique values ह;गे और इसे 

संदिभ,त field कहा जाता है। दसूर1 ओर, इव�Fस टेबल म�, ौणेीआईड1 के मूaय; को दोहराया जा सकता है। 

इसे संदिभ,त field कहा जाता है। िचऽ 10.15 से पता चलता है �क इव�ट टेबल कA ौणेी को संदिभ,त फ़Aaड 

और इव�ट कैटेिगर1 तािलका कA ौणेी को संदिभ,त field कहा जाता है। इस ूकार का संबंध जहां एक 

तािलका का एक मान �कसी अ:य तािलका म� कई मान; से जुड़ा होता है, वह है One-to-many का संबंध। 

 
िचऽ 10.15 इव�ट टेबल कA ौणेी को referencing फ़Aaड और इव�ट ौणेी कA  
तािलका को referencing फ़Aaड कहा जाता है 
 

इस संबंध म� EventCategory माःटर तािलका होती है। तो एक 9वशेष ौणेी के साथ माःटर �रकॉड, पहले 

EventCategory तािलका म� जोड़ा जाना है। तभी इव�ट तािलका म� संबंिधत �रकॉड, जोड़ा जा सकता है। इसके 

अलावा, एक 9विशT CategoryID के साथ केवल एक �रकॉड, माःटर टेबल म� मौजूद होगा ले�कन कै�टगर1 

के कई मूaय transaction तािलका म� मौजूद हो सकते ह@, Sजससे one-to-many संबंध बन सकते ह@। 
 

10.5 Referential Integrity    संदभा,'मकसंदभा,'मकसंदभा,'मकसंदभा,'मक अखडंताअखडंताअखडंताअखडंता 

संदभा,'मक अखडंता के िसdांत के अनुसार, डेटाबेस म� कोई बेमेल unmatched foreign key मूaय नह1ं 

होना चा�हए। इसका मतलब है �क य�द कोई �रकॉड,, कहते ह@ �क एडिमशन संHया 1001 मौजूद नह1ं है या 

छाऽ डेटाबेस के माःटर टेबल (छाऽ_प9ऽकाओ)ं म� मौजूद नह1ं है या हटा द1 गई है, तो transaction तािलका 

(Student_Result) म� भी एडिमशन संHया as1001 के साथ कोई �रकॉड, नह1ं होना चा�हए। इसी तरह, Kह1 

के ःपोFस, डे डेटाबेस म�, य�द �कसी 9वशेष ौणेी के खेल का कहना है �क C003 को माःटर टेबल 

EventCategory से हटा �दया गया है, तो transaction तािलका म� C003 के Kप म� ौणेी के साथ कोई �रकॉड, 
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नह1ं होना चा�हए। इसी तरह, य�द कोई छाऽ ःकूल छोड़ता है और उसका �रकॉड, Student_Details तािलका 

से हटा �दया जाता है, तो उसके पर1nा म� बैठने और प�रणाम होने का कोई सवाल ह1 नह1ं है। इसिलए 

transaction तािलका (Student_Result) म� संगत �रकॉड, या तो NULL मान होना चा�हए या हटाया जाना 

चा�हए। 

Kह1 के खेल �दवस डेटाबेस म� भी, EventCategory तािलका म� मौजूद ौणेी केवल इव�ट तािलका म� दज, कA 

जा सकती है। जैसा �क पहले उaलेख �कया गया है, एक बार दो तािलकाओ ंके बीच संबंध सेट हो जाने के 

बाद, डेटा कA integrity अखडंता को ड1बीएमएस Mारा ूबंिधत �कया जाएगा। िलॄे ऑ�फस बेस केवल उस 

�रकॉड, को transactionतािलका म� दज, करने कA अनुमित देगा जो पहले से ह1 माःटर टेबल म� मौजूद है।  
 

िलॄे ऑ�फस बेस हम� ऐसे मामल; म� संदभा,'मक अखडंता बनाए रखने के िलए चनुने के िलए चार 

9वकaप; का पालन करता है। 

No action कोईकोईकोईकोई कार,वाईकार,वाईकार,वाईकार,वाई नह1ंनह1ंनह1ंनह1ं - यह �डफ़ॉaट 9वकaप है। यह 9वकaप बताता है �क transactionतािलका म� 

�कसी भी संबंिधत �रकॉड, मौजूद होने पर �कसी ूयोE ता को माःटर तािलका म� �कसी भी �रकॉड, को अपडेट 

या हटाने कA अनुमित नह1ं द1 जानी चा�हए। 

अपडेटअपडेटअपडेटअपडेट कैःकेकैःकेकैःकेकैःकेडडडड - यह 9वकaप ूयोE ता को संदिभ,त फ़Aaड को हटाने या अपडेट करने कA अनुमित देता है, 

ले�कन इसके साथ �कसी भी transaction तािलका म� सभी संबंिधत �रकॉड, भी हटा �दए जाएंगे या अपडेट 

�कए जाएंगे। 

NULL सेटसेटसेटसेट कर�कर�कर�कर� - यह 9वकaप सभी संबंिधत field के िलए NULL मान ूदान करता है य�द माःटर �रकॉड, हटा 

�दया गया है या अपडेट �कया गया है। 

�डफ़ॉaट�डफ़ॉaट�डफ़ॉaट�डफ़ॉaट सेटसेटसेटसेट कर�कर�कर�कर� - यह 9वकaप सभी संबंिधत field के िलए कोई िनSyत �डफ़ॉaट मान ूदान करता है य�द 

माःटर �रकॉड, हटा �दया गया है या अपडेट �कया गया है। 
 

�रलेशनिशप ूॉपट� को सेट करने के िलए �रलेशन लाइन पर दो टेबaस, इव�Fस और इव�ट कैटेिगर1 म� डबल 

SEलक कर�। जैसा �क िचऽ 10.16 म� �दखाया गया है एक Relations डायलॉग बॉEस खलेुगा। 

 
िचऽ 10.16 Relations डायलॉग बॉEस 

�डफ़ॉaट Kप से No action 9वकaप के साथ रे�डयो बटन का चयन �कया जाएगा। �कसी भी वांिछत 9वकaप 

को चनु� और दो तािलकाओ ंके बीच संदभा,'मक अखडंता को सेट करने के िलए OK पर SEलक कर�। 
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आइए अw याआइए अw याआइए अw याआइए अw यास कर�स कर�स कर�स कर� 

ःपोFस, डे डेटाबेस म� एक तािलका तैयार कर� Sजसम� एक-से-एक संबंध ःथा9पत �कया जा सके। िलॄे 

ऑ�फस बेस म� इस तरह के संबंध बनाने के िलए कदम िलख�। 

अपनीअपनीअपनीअपनी ूगितूगितूगितूगित जांच�जांच�जांच�जांच� 

A. बहु9वकaपीयबहु9वकaपीयबहु9वकaपीयबहु9वकaपीय ूvूvूvूv 

1. डेटाबेस म� तािलकाए ँबनाने के बाद िन\निलSखत म� से कौन सी �बया कA जा सकती है? 

(a) Add a field in a table (b) Rename a table 

(c) Delete a table (d) All of the above 

2. िन\निलSखत म� से कौन सी एक DBMS Mारा जाँच कA जाती है? 

(a) Redundancy (b) Inconsistency (सी) ए और बी दोन; (ड1) न तो न ह1 बी 

3. दोन; तािलकाओ ंके बीच संबंध ःथा9पत करने के िलए िन\निलSखत म� से �कसकA आवँयकता है?  

(ए) दोन; तािलकाओ ंको अलग-अलग डेटाबेस म� होना चा�हए  

(बी) दोन; तािलकाओ ंका एक सामा:य FIELD होना चा�हए  

(ग) दोन; तािलकाओ ंका नाम समान होना चा�हए  

(ड1) उपरो_ म� से कोई नह1ं  

6. Consider the following tables. Which type of relationship can be established between the 

two tables? (a) One-to-one (b) One-to-many (c) Many-to-many (d) None of the above 

4. य�द कोई �रकॉड, माःटर तािलका म� जोड़ा जाता है, तो transaction तािलका के िलए िन\निलSखत म� से 

कौन सा सह1 नह1ं है 

(ए) माःटर तािलका म� �रकॉड, को माःटर �रकॉड, कहा जाता है  

(बी) transaction तािलका म� संबंिधत �रकॉरड् केवल एक बार दज, �कया जा सकता है। 

(c) transaction तािलका म� �रकॉड, को transaction �रकॉड, कहा जाता है।  

(d) उपरो_ म� से कोई नह1ं 

5. एक छाऽ और उसके Mारा अ?ययन �कए गए 9वषय; के बीच �कस ूकार का संबंध है? 

(a) One-to-one (b) One-to-many (c) Many-to-many (d) उपरो_ सभी  

6. िन\निलSखत तािलकाओ ंपर 9वचार कर�। दो तािलकाओ ंके बीच �कस ूकार का संबंध ःथा9पत �कया 

जा सकता है? (ए) एक से एक (बी) एक से कई (सी) कई से कई (ड1) उपरो_ म� से कोई नह1ं 
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7. िन\न म� से �कस मेन ूम� संबंध 9वकaप है? 

(a) Edit (b) File (c) Tools (d) View 

8. जोड़1 जाने वाली तािलकाओ ंकA सूची को संबंध ःबAन म� ____ डायलॉग बॉEस म� ूदिश,त �कया गया है। 
(a) Add Tables (b) Add Databases 

(सी) ए और बी दोन; (ए) न तो और न ह1 बी 

9. �रलेशनिशप �डजाइन ःबAन म�, __________ ऑपरेशन का उपयोग करके दो टेबल; के बीच संबंध 

बनाया जाता है। 

(a) SEलक (b) डबल SEलक (c) सैग एंड सॉप (d) राइट SEलक 

10. िन\निलSखत म� से Eया एक 9वकaप नह1ं है Sजसका उपयोग डेटाबेस म� संदभा,'मक अखडंता बनाए 

रखने के िलए �कया जा सकता है? (ए) नो एEशन (बी) सेट नल (सी) सेट �डफॉaट (ड1) सेट वैaय ू
 

खखखख.... यहयहयहयह बताएंबताएंबताएंबताए ं�क�क�क�क िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत कथनकथनकथनकथन सह1सह1सह1सह1 ह@ह@ह@ह@ यायायाया गलत।गलत।गलत।गलत। 

1. Redundancy एक डेटाबेस म� पसंद �कया जाता है। 

2. एक तािलका म�, �कसी 9वशेष इकाई के िलए एक �रकॉड, दोहराया नह1ं जाना चा�हए। 

3. एक एकल फ़Aa ड म� हमेशा केवल एक डेटा मान होना चा�हए। 

4. य�द कोई तािलका ए�डट कA जाती है, तो उसम� पहले से दज, �रकॉड, हटा �दए जाते ह@। 

5. �कसी भी �रकॉड, को transaction तािलका म� दज, �कए जाने से पहले माःटर तािलका म� �रकॉड, दज, 

�कया जाना चा�हए। 

6. एक से कई संबंध; म�, माःटर टेबल के एक 9विशT �रकॉड, म� संबंिधत transaction तािलका म� एक से 

अिधक �रकॉड, होते ह@। 

7. 9वंडोज़ मेन ूम� �रलेशनिशप ऑJशन मौजूद है। 

8. एक डेटाबेस म�, ूयोE ता Mारा संदिभ,त अखडंता को बनाए रखा जाता है। 

9. एक संबंध हमेशा एक सामा:य field पर आधा�रत तािलकाओं के बीच िनधा,�रत होता है। 

10. य�द माःटर �रकॉड, हटा �दया जाता है, तो transaction �रकॉड, हमेशा हटा �दया जाएगा। 
 

ग. �र_�र_�र_�र_ ःथानःथानःथानःथान भर�।भर�।भर�।भर�। 

1. ए�डट कA जाने वाली तािलका को ___________ �ँय म� ूदिश,त �कया जाता है। 



157 

 

2. दो तािलकाओ ं के बीच संबंध ःथा9पत करने के िलए सबसे मह'वपूण, शत, यह है �क उनके बीच म� 

________________ होना चा�हए। 

3. ________________relationship म�, माःटर टेबल के एक 9विशT �रकॉड, म� transaction तािलका म� 

एक और केवल एक ह1 �रकॉड, होता है। 

4. ___________________is एक डेटाबेस म� तािलकाओ ंके बीच सबसे आम ूकार के संबंध; म� से एक है। 

5. एक _________ तािलका म� दज, �कया जा रहा एक �रकॉड, हमेशा एक ________ तािलका म� मौजूद 

होना चा�हए। 

6. _______________ का िसdांत हटाए गए डेटा को िसंक से बाहर रखने से �डलीट �कए गए डेटा को खो 

जाने से रोकता है। 

7. तािलकाओ ं के बीच ____________ बनाना ूयोE ता को संदिभ,त field म� अमा:य डेटा दज, करने से 

रोकता है। 

8. डेटा अखडंता integrity ______________ Mारा बनाए रखी जाती है। 

9. माहक; और उ'पाद; के बीच एक संबंध ___________ संबंध का एक उदाहरण है। 

10. ______________ 9वंडो का उपयोग तािलकाओ ंके बीच संबंध ःथा9पत करने के िलए �कया जाता है। 

घघघघ. िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत ूv;ूv;ूv;ूv; केकेकेके उuरउuरउuरउuर द1Sजए।द1Sजए।द1Sजए।द1Sजए। 

1. एक डेटाबेस म� एक टेबल से संबंिधत दो कोई भी लाभ द�। 

2. �कसी डेटाबेस म� redundancy या inconsistency को कैसे िनयं9ऽत �कया जाता है? एक उदाहरण से 

समझाएं। 

3. संदभा,'मक अखडंता को प�रभा9षत कर�। डेटाबेस म� संदभा,'मक अखडंता कौन रखता है? 

4. one to one संबंध म� और one to many संबंध म� अतंर बतए।ं अपना उuर समझाने के िलए उपयु_ 

उदाहरण द1Sजए। 

5. एक उदाहरण के साथ many to many का संबंध समझाएं। 

ूाूाूाूायोिगकयोिगकयोिगकयोिगक अwयासअwयासअwयासअwयास 

1. ूकाशन हैJपी होम सोसाइट1 म� रहता है। वह एक डेटाबेस बनाना चाहता है ता�क सोसाइट1 के �लैट 

मािलक; से ूा4 रखरखाव शुa क को ः टोर और ूबंिधत �कया जा सके। उसके डेटाबेस के िलए िन\न 

तािलकाए ँबनाएँ। 
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दो तािलकाओ ंको आपस म� संबंिधत कर� और उसके बाद दोन; तािलकाओ ंम� :यूनतम पांच �रकॉड, दज, 

कर�। आपने �कस ूकार का संबंध बनाया? आपने पहले �कस तािलका म� डेटा दज, �कया था? 
 

2. उज़ैर एक इंजीिनय�रंग कॉलेज म� लड़क; के छाऽावास का ूबंधन करता है। वह िन\न तािलका के साथ 

एक डेटाबेस बनाकर अपने छाऽावास म� रहने वाले लोग; के �रकॉड, का ूबंधन करना चाहता है और 

तािलकाओ ंके बीच संबंध भी ःथा9पत करता है। 
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अ?यायअ?यायअ?यायअ?याय 11. बेसबेसबेसबेस म�म�म�म� ूvूvूvूv 

11.1 प�रचयप�रचयप�रचयप�रचय 

डेटाबेस को संग�ठत तर1के से डेटा ःटोर करने के िलए उपयोग �कया जाता है ता�क डेटाबेस से इसे आसानी 

से और सह1 तर1के से retrieve �कया जा सके। वांिछत �रकॉड, कA खोज करने और वांिछत डेटा को पुनः ूा4 

करने के िलए, हम� DBMS को इसके 9विनदYश देने ह;गे। इस तरह के 9विनदYश डेटाबेस के ूv; के Kप म� �दए 

गए ह@। उदाहरण के िलए, हम� उन फ़Aacस को िन�द,T करना होगा Sज:ह�  हम ूदिश,त करना चाहते ह@ या 

कोई 9वशेष डेटा मूaय Sजसके आधार पर �रकॉcस, को टेबल से �फ़aटर �कया जाना है। 
 

इसिलए, हम कह सकते ह@ �क एक Eवेर1 एक डेटाबेस से पूछे गए एक ूकार का ूv है। Eवेर1 म� �दए गए 

9विनदYश; के आधार पर, 9विशT �रकॉड, को डेटाबेस म� तािलका (ओ)ं के Kप म� खोजा जाता है और �फर 

वांिछत तर1के से ूदिश,त �कया जाता है। इस तरह कA जानकार1 को केवल एक तािलका या कई तािलकाओ ं

को देखकर खोजना मुSँकल हो सकता है। वाःतव म� जैसे-जैसे �रकॉड, कA संHया बढ़ती जाती है, वांिछत 

जानकार1 ढंूढना अिधक से अिधक क�ठन होता जाता है। 
 

ूv; का उपयोग करके, हम तािलका म� ू'येक �रकॉड, के मा?यम से Gय9_गत Kप से जाने के 9बना डेटा को 

पुनः ूा4 करने म� सnम ह@ और उ:ह�  वांिछत format म� भी ूदिश,त करते ह@। 

11.2 ूvूvूvूv 

एक Eवेर1 �कसी भी DBMS कA सबसे मह'वपूण, 9वशेषता है। एक Eवेर1 का उपयोग करके, हम डेटाबेस म� 

एक या अिधक तािलकाओ ंसे डेटा को पुनः ूा4 और ूदिश,त कर सकते ह@। यह DBMS को 9विशT खोज 

मानदंड देकर �कया जाता है ता�क हम उस सट1क जानकार1 को देख सक�  जो हम चाहते ह@। 
 

िलॄे ऑ�फस बेस हम� एक Eवेर1 बनाने और यहां तक �क इसे डेटाबेस म� एक ऑDजेEट के Kप म� सेव करने 

कA अनुमित देता है। यह हम� Eवेर1 को कई बार चलाने म� मदद करता है। एक Eवेर1 का उपयोग करके, हम 

उन फ़Aacस को िन�द,T कर सकते ह@ Sज:ह�  हम ूदिश,त करना चाहते ह@ और उन मानदंड; को भी Sजनके 

आधार पर �रकॉड, �कया जाना है। इनफॉमYशन को िसंगल टेबल या मaट1पल टेबल से �रकवर �कया जा 

सकता है। 
 

साथ ह1 Eवेर1 का प�रणाम columns म� फ़Aaड नाम; और rows म� �रकॉड, के साथ सारणीबd Kप म� ूदिश,त 

होता है। 
 

उदाहरण के िलए, एक छाऽ डेटाबेस म�, य�द हम प�रणाम तािलका से �कसी 9वशेष कnा म� उन छाऽ; के 

नाम और अकं ूदिश,त करना चाहते ह@, Sज:ह;ने 320 से कम अकं अSज,त �कए ह@, तो हम� डेटाबेस को 

िन\निलSखत जानकार1 देने कA आवँयकता है: 
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Name of the table – Result 

Fields to be specified – Name, Marks 

Criterion – Aggregate marks should be less than 320 

इस अ?याय म� आप एक Eवेर1 बनाना सीख�गे, इसे सेव कर�गे और �फर आवँयकतानुसार इसे चलाएंगे। 

11.3 एकएकएकएक Eवेर1Eवेर1Eवेर1Eवेर1 बनानाबनानाबनानाबनाना 

एक Eवेर1 तीन तर1क; से बनाई जा सकती है। इस अ?याय म� आप Eवेर1 बनाने के िलए पहले दो तर1के 

सीख�गे। 

(i) 9वज़ाड, का उपयोग करना 

(ii) �डज़ाइन G य ूम� 

(iii) SQL �ँय म� 
 

11.3.1 9वज़ाड,9वज़ाड,9वज़ाड,9वज़ाड, काकाकाका उपयोगउपयोगउपयोगउपयोग करकेकरकेकरकेकरके एकएकएकएक Eवेर1Eवेर1Eवेर1Eवेर1 बनानाबनानाबनानाबनाना 

आइए हम 9पछले अ?याय; म� बनाए गए खेल �दवस डेटाबेस को दो तािलकाओ ं- इव�Fस और इव�ट कैटेगर1 

से याद करते ह@। 

 
िचऽ 11.1 इव�Fस टेबल म� �रकॉड, 
 

 
 

िचऽ 11.2 EventCategory तािलका म� �रकॉड, 
 

 

आइए एक Eवेर1 बनाते ह@ जो CID के Kप म� ौणेी के साथ ू'येक ईव�ट के िलए इव�ट का नाम और 9वजेता 

ूदिश,त करेगा। वांिछत डेटा को इव�ट टेबल से retrieve �कया जाना है। 9वज़ाड, का उपयोग करके Eवेर1 

बनाने के िलए, िन\न चरण; का पालन कर�। 
 

चरणचरणचरणचरण 1. Sports Day डेटाबेस खोल�। डेटाबेस �डज़ाइन 9वंडो म�, डेटाबेस पैन म� बा} ओर मौजूद Eवेर1 बटन 

पर SEलक कर� जैसा �क िचऽ 11.3 म� �दखाया गया है। 
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िचऽ 11.3 डेटाबेस पैन म� Eवेर1 आइकन 

 
 

िचऽ 11.4 Eवेर1 9वज़ाड, का पहला चरण 

 

चरणचरणचरणचरण 2. Tasks Area म�, Use Wizard to Create Query पर SEलक कर� ... 9वकaप। 

Eवेर1 9वज़ाड, िचऽ 11.4 म� �दखाए गए अनुसार शुK होगा। इसम� बा} ओर चरण पेन और दा} ओर Query 

Details Area है। 

चरणचरणचरणचरण 3. 9वज़ाड, का पहला चरण संबंिधत तािलकाओ ंसे फ़Aaड का चयन करना है। हमार1 Eवेर1 के िलए, 

इव�ट नाम और 9वजेता को ूदिश,त करने के िलए और ौणेी के आधार पर �रकॉड, को �फ़aटर करने के िलए 

मानदंड। ये सभी फ़Aaड इव�Fस टेबल म� मौजूद ह@। इसिलए टेबaस सूची बॉEस से इव�ट टेबल का चयन कर�। 

उपलDध फ़Aacस उपलDध फ़Aaड सूची बॉEस म� ूदिश,त �कए जाते ह@ जैसा �क िचऽ 11.5 म� �दखाया गया 

है। 
 

 

चरणचरणचरणचरण 4. सूची बॉEस से इव�ट नाम फ़Aaड का चयन कर� और राइट एरो (�) बटन पर SEलक कर�। फ़Aaड नाम 

Eवेर1 सूची बॉEस म� फ़Aaड म� �दखाई देगा। 
 

जैसा �क िचऽ 4.5 म� �दखाया गया है, Winner और CategoryID field के िलए ू�बया दोहराएं। गौर कर�  �क 

इन तीन Fields in the Query सूची बॉEस म� ले जाया जाता है। 

 
िचऽ 11.5 उपलDध फ़Aacस सूची बॉEस म� ूदिश,त चयिनत 

इव�ट तािलका के फ़Aaड 

 

 
िचऽ 11.6 फ़Aaड Eवेर1 सूची बॉEस म� उपलDध फ़Aacस स े

फ़Aacस म� ले जाया गया 
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?यान द� �क एक बार फ़Aaड जोड़ने के बाद उ:ह�  9वज़ाड, के चरम दा} ओर मौजूद � और � बटन पर SEलक 

करके ऊपर और नीचे ले जाया जा सकता है। »बटन पर SEलक करने से Eवेर1 फ़Aacस म� फ़Aacस पर सभी 

फ़Aacस ले जाते ह@ और« बटन सभी फ़Aacस वापस Available fields म� चले जाते ह@। 
 

चरणचरणचरणचरण 5. नेEःट बटन पर SEलक करने से ःबAन को ूदिश,त करने के िलए छँटाई बम का चयन करना होगा 

जैसा �क िचऽ 11.7 म� �दखाया गया है। यह छँटाई बम िनधा,�रत करेगा। Eवेर1 का प�रणाम तािलका के 

�कसी 9वशेष FIELD के ascending या descending बम म� ूदिश,त �कया जा सकता है। चू�ंक हम �कसी 

9वशेष बम म� सेट नह1ं करना चाहते ह@, इसिलए हम नेEःट बटन पर SEलक करते ह@। 

 
िचऽ 11.7 sorting order चुन� 
 

चरणचरणचरणचरण 6. अगला चरण खोज Sःथितय; या मानदंड; को िनधा,�रत करना है Sजसके आधार पर तािलका से 

�रकॉड, �फ़aटर �कए जाएंगे। इस चरण पर वाःतव म� Eवेर1 सेट कA जाती है या डेटाबेस को मानदंड �दया 

जाता है। हमार1 Eवेर1 के अनुसार, मानदंड CID के Kप म� ौणेी के साथ घटनाओ ं के �रकॉड, को ूदिश,त 

करना है। �डफ़ॉaट Kप से, 9वकaप वाला रे�डयो बटन Match all of the following चनुा जाता    है। 
 

चरणचरणचरणचरण 7. फ़Aacस सॉप-डाउन सूची से Event.CategoryID फ़Aaड का चयन कर�, Sःथित सॉप डाउन सूची से 

बराबर है और C001 के Kप म� मान टाइप कर� जैसा �क िचऽ 11.8 म� �दखाया गया है, और SEलक कर� अगला 

बटन पर SEलक कर�। 

 
िचऽ 11.8 खोज कA Sःथित का चयन करना और मूaय िन�द,T करना 
 

9वज़ाड, म� तीन खोज Sःथितयां सबसे अिधक द1 जा सकती ह@। ऑJशन ‘Match any of the following’ पर 

SEलक कर� और चनु� िन\निलSखत म� से �कसी एक Sःथित को �रकॉड, को �फ़aटर करने के िलए िमलान 

�कया जाना है। 
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चरण 8. ःटेJस पैन म� �दए गए चरण 4, 5 और 6, संHया'मक गणना जैसे कायx के साथ ह@। य�द Eवेर1 म� 

कोई संHया'मक फ़Aaड शािमल नह1ं है, तो ऐसे चरण; कA आवँयकता नह1ं है। तो आप इन चरण; को छोड़ 

सकते ह@ और सीधे 9वज़ाड, के “Step 7. Aliases” पर जा सकते ह@। 
 

चरण 9. उपनाम नाम देने के िलए अगला चरण यानी कॉलम हैडर नाम तब ूदिश,त �कया जाएगा जब हम 

Eवेर1 चलाते ह@। �डफ़ॉaट Kप से फ़Aaड नाम कॉलम हेडर के Kप म� ूदिश,त �कए जाएंगे। कई बार फ़Aaड 

नाम ूयोE ता के अनुकूल नह1ं होते ह@, इसिलए एक उपनाम नाम जो अिधक पठनीय है, Eवेर1 आउटपुट म� 

ूदिश,त होने के िलए चनुा जाता है। उदाहरण के िलए, इव�ट तािलका म� फ़Aaड का नाम 9वजेता है। column 

शीष,क के Kप म� 9वजेता का नाम ूदिश,त करने के िलए, ‘Winner Name’ टाइप कर� और अगला बटन पर 

SEलक कर� जैसा �क िचऽ 11.9 म� �दखाया गया है। 
 

 
िचऽ 11.9 Alias Names सmपना 
 

  

िचऽ 11.10 Eवेर1 का अवलोकन 

 

 

चरणचरणचरणचरण 10. Eवेर1 9वज़ाड, का अिंतम चरण Eवेर1 का संपूण, अवलोकन ूदिश,त करता है जैसा �क िचऽ 11.10 

म� �दखाया गया है। अब तक �कए गए सभी चरण; को संnेप म� �दखाया गया है। 
 

इसम�इसम�इसम�इसम� िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत शािमलशािमलशािमलशािमल ह@ह@ह@ह@: 

Eवेर1 का नाम - �डफ़ॉaट Kप से, Eवेर1 का नाम �डफ़ॉaट Kप से Query_Events है। य�द वांिछत है, तो 

टेEःट बॉEस म� नया नाम टाइप कर�। 
 

9वज़ाड, समा4 होने के बाद कA जाने वाली �बया - �डफ़ॉaट Kप से ूदश,न Eवेर1 9वकaप का चयन �कया 

जाएगा। य�द �डज़ाइन �ँय म� Eवेर1 को ए�डट करना है तो SEलक कर� और संशोिधत कर� रे�डयो बटन का 

चयन कर�। 

Eवेर1Eवेर1Eवेर1Eवेर1 काकाकाका पूरापूरापूरापूरा 9ववरण9ववरण9ववरण9ववरण - इस अनुभाग म� बनाए गए Eवेर1 के बारे म� एक सारांश है। 

चरण 12. �फिनश बटन पर SEलक कर�। C001 के Kप म� ौणेी के साथ �रकॉड, ःबAन पर ूदिश,त �कया 

जाएगा जैसा �क िचऽ 11.11 म� �दखाया गया है। column शीष,क; का िनर1nण कर�। Eया वे सभी इव�ट टेबल 

म� फ़Aaड नाम; के समान ह@? 
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िचऽ 11.11 CategoryID C001 के साथ Eवेर1 से ूा4 �रकॉड, 
 

एक बार Eवेर1 बन जाने के बाद, इसे �डज़ाइन �ँय म� ए�डट �कया जा सकता है। हम आने वाले सेEशन म� 

�डजाइन Gय ूके बारे म� अ?ययन कर�गे। 
 

11.3.2 �डज़ाइन�डज़ाइन�डज़ाइन�डज़ाइन ����ँयँयँयँय म�म�म�म� एकएकएकएक Eवेर1Eवेर1Eवेर1Eवेर1 बनानाबनानाबनानाबनाना 

Eवेर1 बनाने का दसूरा तर1का �डज़ाइन �ँय का उपयोग करना है। यह �कसी एकल या �कसी डेटाबेस कA 

एक से अिधक तािलकाओ ंसे Eवेर1 बनाने के िलए अिधक लचीली 9विध है। आइए हम एथले�टEस ौणेी के 

�रकॉड, ूदिश,त करने के िलए एक Eवेर1 बनाएं। इस Eवेर1 के िलए, �रकॉcस, को इव�Fस और 

EventCategory टेबल दोन; से �फ़aटर करना होगा। ःपोFस, डे डेटाबेस खोल� और �डज़ाइन �ँय म� एक ूv 

बनाने के िलए िन\निलSखत चरण; का पालन कर�: 

चरणचरणचरणचरण 1. डेटाबेस 9वंडो म� ऑDजेEFस पैन पर Eवेर1 आइकन पर SEलक कर�। 

चरणचरणचरणचरण 2. �डज़ाइन पैन म� Eवेर1 बनाए ँSEलक कर� ... Tasks Pane म� आइकन। 

Eवेर1 �डज़ाइन 9वंडो ूकट होती है। 9वंडो के म?य म� Add Table या Query डायलॉग बॉEस आता है जैसा 

�क िचऽ 11.12 म� �दखाया गया है। 

 
िचऽ 11.12 �डज़ाइन �ँय म� Eवेर1 बनाएँ 

 

चरणचरणचरणचरण 3. Eवेर1 म� उपयोग कA जाने वाली इव�ट तािलका पर SEलक कर� और �फर ऐड बटन पर SEलक कर�। 

वैकSaपक Kप से ईव�Fस टेबल पर डबल SEलक कर�। तािलका को Eवेर1 �डज़ाइन 9वंडो के शीष, पर मौजूद 

टेबल पैन म� जोड़ा जाएगा। 
 

चरणचरणचरणचरण 4. इसी तरह ईव�टकेटेगर1 टेबल को Eवेर�डजाइन 9वंडो के टेबल पेन म� जोड़�। 
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चरणचरणचरणचरण 5. इसे बंद करने के िलए Add Table or Query डायलॉग बॉEस म� Close बटन पर SEलक कर�। जोड़े 

गए इव�Fस और EventCategory को तािलका पैन म� ूदिश,त �कया जाएगा जैसा �क िचऽ 11.13 म� �दखाया 

गया है। 

  
िचऽ 11.13 तािलकाएँ तािलका पैन म� जोड़1 गई ह@ 
 

चरण 6. अगला चरण फ़Aaड का चयन करना है। हमार1 Eवेर1 के िलए हम ईव�ट नाम और 9वजेता को इव�ट 

टेबल से और ौणेी के नाम को इव�ट कैटेिगर1 टेबल से ूदिश,त करना चाहते ह@। इसिलए इव�ट टेबल कA सूची 

बॉEस म�, EventName और 9वजेता फ़Aaड पर डबल SEलक कर�। इसी ूकार फ़Aaड ौणेी नाम 

EventCategory तािलका जोड़�। तािलका नाम के साथ फ़Aaड का नाम Query Design window के िनचले 

आधे भाग म� मौजूद �डज़ाइन िमड म� ूदिश,त �कया गया है जैसा �क िचऽ 11.14 म� �दखाया गया है। 
 

यह देख� �क 9वSज़बल चेक बॉEस �डफ़ॉaट Kप से चयिनत है। इसका मतलब है �क जब आप Eवेर1 चलाते ह@, 

तो ये सभी तीन फ़Aaड �दखाई द�गे। य�द आप नह1ं चाहते ह@ �क 9वशेष फ़Aaड के डेटा मान ूदिश,त ह;, तो 

संबंिधत चेक बॉEस को अचयिनत करने के िलए SEलक कर�। 

 
िचऽ 11.14 Eवेर1 म� फ़Aacस जोड़ना 

चरणचरणचरणचरण 7. िमड म�, उपनाम कA एक row होती है। जैसा �क पहले उaलेख �कया गया है, इसका उपयोग 

आउटपुट म� साथ,क नाम ूदिश,त करने के िलए �कया जा सकता है। उदाहरण के िलए, 9वजेता के बजाय, 

हम 9वजेता का नाम ूदिश,त करना चाह�गे। इसके िलए, 9वजेता कॉलम के तहत उपनाम Text बॉEस म� 

9वजेता का नाम टाइप कर� जैसा �क िचऽ 11.14 म� �दखाया गया है। 

चरणचरणचरणचरण 8. �डफ़ॉaट Kप से, Eवेर1 के प�रणामःवKप ूदिश,त होने वाला डेटा सॉट, नह1ं �कया जाता है। �कसी 

9वशेष FIELD के Ascending आरोह1 या descending अवरोह1 बम म� �रकॉड, को सॉट, करने के िलए, सॉट, 



166 

 

row को िमड म� �दया जाता है। उदाहरण के िलए, ईव�ट नाम के वणा,नुबम म� �रकॉड, ूदिश,त करने के िलए, 

ईव�ट नाम कॉलम के अतंग,त बमबd row म� �दखाई देने वाली सॉप डाउन सूची बॉEस से आरोह1 का Sort 

कर�। 
 

चरणचरणचरणचरण 9. Eवेर1 �डज़ाइन होने के बाद, टूलबार पर रन Eवेर1 () बटन पर SEलक कर� या F5 कंुजी दबाएं। िचऽ 

11.15 म� �दखाए गए अनुसार Eवेर1 प�रणाम टेबल पैन FIELD म� ूदिश,त �कया जाएगा। 
 
 

चरणचरणचरणचरण 10. Eवेर1 को सेव करने के िलए Save बटन पर SEलक कर�। जैसा �क िचऽ 11.16 म� �दखाया गया है 

Save As डायलॉग बॉEस से सेव कर�। 

  

िचऽ 11.15 तािलका पैन म� Eवेर1 प�रणाम 

 
 

िचऽ 11.16 Eवेर1 को सेव करना 
 

 

चरणचरणचरणचरण 11. �डफ़ॉaट Kप से, Eवेर1 1 के Kप म� Eवेर1 नाम ूदिश,त �कया जाएगा। य�द आवँयक हो तो एक 

अलग नाम िलख�। Eवेर1 को सेव करने के िलए ओके बटन पर SEलक कर�। 

डेटाबेस 9वंडो म� ऑDजेEFस FIELD म� Eवेर1 का नाम �दखाई देगा। Eवेर1 को �फर से चलाने और Eवेर1 का 

प�रणाम देखने के िलए, Eवेर1 नाम पर डबल SEलक कर�। Eवेर1 के प�रणाम एक अलग 9वंडो म� ूदिश,त 

�कए जाएंगे। 

Eवेर1 9वंडो को बंद करने के िलए, 9वंडो के ऊपर1 दाए ंकोने पर बंद बटन पर SEलक कर�। 
 

11.4 एकएकएकएक ूvूvूvूv कA ए�ड�टंगकA ए�ड�टंगकA ए�ड�टंगकA ए�ड�टंग  

�कसी भी Eवेर1 को ए�डट करने के िलए, उस Eवेर1 के Eवेर1 आइकन पर SEलक कर� Sजसे ए�डट �कया जाना 

है। बनाई गई Eवेर1ज़ कA सूची ऑDजेEट ए�रया म� ूदिश,त कA जाएगी। डेटाबेस 9वंडो के ऑDजेEट ए�रया म� 

Eवेर1 नाम पर राइट SEलक कर�, जैसा �क िचऽ 11.17 म� �दखाया गया है। 
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िचऽ 11.17 Eवेर1 ए�डट करने के िलए संपादन 9वकaप का चयन कर� 
 

सॉप डाउन मेन ू से Edit 9वकaप चनु�। Query Design window  ूदिश,त कA जाएगी। आइए हम केवल 

एथले�टEस ौणेी के �रकॉड, ूदिश,त करने के िलए एक मानदंड लाग ूकर�। इस ूकार के िलए ौणेी नाम 

कॉलम के तहत मानदंड row म� एथले�टEस है। अब, Eवेर1 �डज़ाइन पूण, है य�द हम Eवेर1 चलाते ह@, तो 

केवल एथले�टEस ौणेी का �रकॉड, ूदिश,त �कया जाएगा जैसा �क िचऽ 11.18 म� �दखाया गया है। 

 

िचऽ 11.18 एथले�टEस ौणेी के �रकॉड, ूदिश,त करने के िलए मापदंड लागू करने के बाद �डजाइन �ँय म� Eवेर1 प�रणाम 

 

हम कई शतx को लाग ूकरने के िलए मानदंड row का उपयोग कर सकते ह@। यह भी ?यान द�  �क हम सभी 

संबंिधत प�रचालक; जैसे <, >, <=, >=, != और = को उन सभी Sःथितय; के िलए लाग ूकर सकते ह@ जो 

मानदंड row म� द1 जा सकती ह@। उदाहरण के िलए, य�द आप केवल उ:ह1ं अिभलेख; को देखना चाहते ह@ 

जहाँ अकं 10 से अिधक ह@, तो पॉइंFस फ़Aaड को िमड म� जोड़�  और �फर इसके िलए मानदंड सेट कर� >10 

जैसा �क िचऽ 11.19 म� �दखाया गया है। अब Eवेर1 को सेव और रन कर�। िचऽ 11.19 म� �दखाए अनुसार 

आउटपुट का िनर1nण कर�। 
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िचऽ 4.19 एथले�टEस ौणेी के �रकॉड, को ूदिश,त करने के िलए  

मानदंड लागू करने के बाद �डजाइन �ँय म� प�रणाम और Sजनके अंक 10 स ेअिधक ह@ 
 

11.5 :यूमे�रकल:यूमे�रकल:यूमे�रकल:यूमे�रकल डेटाडेटाडेटाडेटा केकेकेके साथसाथसाथसाथ कामकामकामकाम करनाकरनाकरनाकरना 

अब तक, हम Eवेर1 म� तािलकाओ ंसे डेटा ूदिश,त कर रहे ह@। ले�कन यह सब नह1ं है, हम डेटा मूaय; कA 

गणना, योग, :यूनतम, अिधकतम या औसत का पता लगाने के िलए कुछ गSणतीय कायx का भी उपयोग 

कर सकते ह@। आइए ू'येक ौणेी कA घटनाओ ं के औसत 9बंदओुं को ूदिश,त करने के िलए एक Eवेर1 

�डज़ाइन कर�। डेटाबेस 9वंडो म�, Eवेर1 �डज़ाइन �डज़ाइन खोलने के िलए Eवेर1 �डज़ाइन �डज़ाइन… बटन पर 

SEलक कर�। ईव�Fस और EventsCategory तािलकाओ ंको जोड़�। इसके बाद ू'येक ौणेी के िलए औसत 

अकं ूदिश,त करने के िलए िन\निलSखत चरण; का पालन कर�। 

चरणचरणचरणचरण 1. EventCategory तािलका से ौणेी नाम फ़Aaड जोड़�  और घटना तािलका से Points फ़Aaड। 

चरणचरणचरणचरण 2. ौणेी नाम फ़Aaड के अतंग,त, फ़ंEशन row म�, नीचे तीर पर SEलक कर�। िचऽ 11.20 म� �दखाए गए 

अनुसार एक सॉप डाउन सूची ूदिश,त कA जाएगी। 

चरणचरणचरणचरण 3. सॉप डाउन सूची से समूह 9वकaप का चयन कर�। यह 9वकaप ौणेी नाम के कॉलम म� ू'येक डेटा 

मान के िलए समूह बनाता है। 

 
िचऽ 11.20 Function drop down सूची 
 

चरणचरणचरणचरण 4. इसी तरह, पॉइंFस कॉलम के तहत, सॉप डाउन सूची से औसत फ़ंEशन का चयन कर�। 

चरणचरणचरणचरण 5. Eवेर1 को चलाने के िलए F5 दबाएँ। सभी ौSेणय; म� औसत अकं; को दशा,ने वाला Eवेर1 प�रणाम 

िचऽ 11.11 म� �दखाया गया है। 
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िचऽ 11.21 समूह के नाम और औसत फंE शन स ेअंक के िलए समूह फंE शन लागू करने के बाद �डजाइन �ँय म� प�रणाम 

चरणचरणचरणचरण 6. इसके अलावा, हम मानदंड row का उपयोग करके समूह; पर भी शत� रख सकते ह@। उदाहरण के 

िलए, केवल एथले�टEस ौणेी का औसत ूदिश,त करने के िलए, ौणेी नाम कॉलम के तहत मानदंड row म� 

एथले�टEस िलख�। अब, य�द हम Eवेर1 चलाते ह@, तो Eवेर1 प�रणाम म� केवल एथले�टEस ौणेी का औसत 

ूदिश,त �कया जाएगा। 

अपनीअपनीअपनीअपनी ूगितूगितूगितूगित जांच�जांच�जांच�जांच� 

क. बहु9वकaपीयबहु9वकaपीयबहु9वकaपीयबहु9वकaपीय ूvूvूvूv 

1. िन\निलSखत म� से कौन सा डेटाबेस से ूv पूछने का एक Kप है? 

(ए) �रपोट, (बी) तािलका (सी) Eवेर1 (ड1) उपरो_ म� से कोई नह1ं 

2. िन\निलSखत म� से कौन सी Eवेर1 �डजाइन करने के तर1के ह@? 

(ए) 9वज़ाड, (बी) �डजाइन देख� (सी) एसEयूएल (ड1) उपरो_ सभी 

3. Eवेर1 बनाने के िलए कौन सा लचीला तर1का है? 

(ए) 9वज़ाड, (बी) �डजाइन �ँय (सी) ए और बी दोन; (ड1) न तो न ह1 बी 

4. Eवेर1 �डजाइन 9वंडो �कतने भाग; म� 9वभाSजत है? 

(ए) एक (बी) दो (सी) तीन (ड1) चार 

5. ूv; के बारे म� से कौन सा सह1 नह1ं है? 

(ए) यह कई तािलकाओ ंका उपयोग करके बनाया जा सकता है 

(b) एक डेटाबेस म� कई Eवेर1 बनाई जा सकती ह@ 

(c) एक Eवेर1 कई बार चल सकती है 

(d) एक बार बनाई गई Eवेर1 को ए�डट नह1ं �कया जा सकता है 

6. Eवेर1 को चलाने के िलए िन\निलSखत म� से कौन-सी शॉट,कट कंुजी है? 

(a) F3 (b) F4 (c) F5 (d) F6 
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7. Eवेर1 �डजाइन करते समय संHया'मक डेटा पर िन\निलSखत म� से कौन से functions �कए जा सकते 

ह@?  

(a) सम (b) :यूनतम (c) अिधकतम (d) उपरो_ सभी 

8. एक Eवेर1 �डज़ाइन 9वज़ाड, म�, िन\न बटन म� से �कस फ़Aaड को ‘Available fields’’सूची बॉEस से‘ 

Fields in the query ‘िलः ट बॉE सÕ म� ले जाने के िलए SEलक �कया जाता है? 

(a) >        (b) < 9            (c) �        (d) � 

9. िलॄे ऑ�फस बेस म� Eवेर1 �डजाइन करते समय िन\निलSखत म� से कौन सा relational operators 

मानदंड बनाने के िलए लाग ू�कया जा सकता है? 

(a)> (b) = (c)! = 

(D. उपरो_ सभी 

10. Eवेर1 �डज़ाइन 9वंडो पहली बार Eवेर1 �डज़ाइन करने के िलए खोले जाने पर िन\निलSखत म� से कौन सा 

डायलॉग बॉEस मौजूद है? 

(a) Add Table (b) Add Query (c) Add Table or Query (ड1) उपरो_ म� से कोई नह1ं 

11. िन\निलSखत म� से कौन सा कदम अगर कोई संHया'मक नह1ं है, तो �कसी Eवेर1 म� काम नह1ं �कया 

जाएगा? 

(a) Selection of fields (b) Giving Aliases (c) Summarizing (ड1) उपरो_ म� से कोई नह1ं 
 

खखखख. यहयहयहयह बताएंबताएंबताएंबताए ं�क�क�क�क िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत कथनकथनकथनकथन सह1सह1सह1सह1 ह@ह@ह@ह@ यायायाया गलत।गलत।गलत।गलत। 

1. आप एक Eवेर1 केवल एक बार चला सकते ह@ 

2. एक Eवेर1 को कई तािलकाओ ंसे नह1ं बनाया जा सकता है 

3. Eवेर1 चलाने के िलए शॉट,कट कंुजी F5 है। 

4. िलॄे ऑ�फस आधार हम� Eवेर1 बनाने के दो तर1के ूदान करता है। 

5. संHया'मक डेटा वाली Eवेर1 को सहेजा नह1ं जा सकता है। 

6. �डफ़ॉaट Kप से Eवेर1 प�रणाम को हल नह1ं �कया जाता है। 

7. संHया'मक field के औसत मूaय को ूदिश,त करने के िलए एक Eवेर1 का उपयोग �कया जा सकता है। 

8. एक Eवेर1 �डजाइन करते समय, मानदंड केवल एक फ़Aaड पर सेट �कया जा सकता है। 

9. उपनाम Eवेर1 म� फ़Aaड के िलए एक वैकSaपक नाम है। 

10. Eवेर1 �डज़ाइन 9वंडो म�, 9वSजबल चेक बॉEस �डफ़ॉaट Kप से चनुा गया है। 

11. 9वज़ाड, का उपयोग करके बनाई गई Eवेर1 को केवल �डज़ाइन G य ूम� ए�डट �कया जा सकता है।  

गगगग. �र_�र_�र_�र_ ःथानःथानःथानःथान भर�।भर�।भर�।भर�। 

1. ____________ एक ूकार का ूv है जो डेटाबेस से पूछा जाता है। 

2. Eवेर1 का प�रणाम कॉलम म� फ़Aaड नाम; के साथ ____________ Kप म� ूदिश,त होता है 
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3. ________ways म� एक Eवेर1 बनाई जा सकती है। 

4. Eवेर1 �डज़ाइन 9वंडो को __________ अनुभाग; म� 9वभाSजत �कया गया है। 

5. Eवेर1 को चलाने के िलए शॉट,कट ______________ है। 

6. �रकॉड, को �फ़aटर करने कA शतx को _________ row म� सेट �कया गया है। 

7. जब Eवेर1 तािलका म� �कसी तािलका का चयन �कया जाता है, तो संबंिधत फ़Aaड को 

__________________ सूची बॉEस म� ूदिश,त �कया जाता है। 

8. Eवेर1 का प�रणाम तािलका के �कसी 9वशेष FIELD के __________ या _____________ बम म� ूदिश,त 

�कया जा सकता है। 

9. सबसे अिधक __________ खोज Sःथितयां Eवेर1 9वज़ाड, म� द1 जा सकती ह@। 

10. Eवेर1 9वज़ाड, का अिंतम चरण Eवेर1 का संपूण, ____________ ूदिश,त करता है। 

11. Eवेर1 बनाने के िलए _____________ G य ूअिधक लचीली 9विध है। 

12. �कसी भी Eवेर1 को ए�डट करने के िलए, उस Eवेर1 के ________ आइकन पर राइट SEलक कर� Sजसे 

ए�डट करना है। 

13. Eवेर1 �डज़ाइन िमड कA _____________ row म�, हम उस कॉलम हे�डंग को टाइप कर सकते ह@ जो 

फ़Aaड नाम के बजाय ूदिश,त होगी जब Eवेर1 कA गई। 
 

घघघघ. �दए�दए�दए�दए गएगएगएगए ूv;ूv;ूv;ूv; केकेकेके उuरउuरउuरउuर द1Sजए।द1Sजए।द1Sजए।द1Sजए। 

1. एक Eवेर1 प�रभा9षत कर�? डेटाबेस म� Eवेर1 बनाने कA Eया आवँयकता है? 

2. एक 9वज़ाड, का उपयोग करके Eवेर1 बनाने के िलए नीचे �दए गए चरण; को �फर से GयवSःथत कर�। 
a) Give Alias 

b) Select the fields 

c) Set the criterion 

d) Set the sorting order 

e) Give table name 
 

3. Eवेर1 9वज़ाड, के अवलोकन (अिंतम चरण) म� सभी जानकार1 Eया �दखाई देती है? 

4. Eवेर1 �डज़ाइन 9वंडो के �डज़ाइन िमड म� एिलयास row का उपयोग Eया है? 

 

5. ऐसे चार गSणतीय कायx को नाम द�, Sज:ह�  �कसी Eवेर1 म� संHया'मक डेटा पर लाग ू�कया जा सकता है। 

6. िलॄे ऑ�फस बेस म� Eवेर1 बनाने के तीन तर1क; का नाम बताइए? 

 

ूायोिगकूायोिगकूायोिगकूायोिगक अwयासअwयासअwयासअwयास 

ूकाश हैJपी होम सोसाइट1 म� रहता है। उ:ह;ने अपने डेटाबेस म� िन\न तािलकाओ ंका िनमा,ण �कया है 

ता�क सोसाइट1 के �लैट मािलक; से ूा4 रखरखाव शुaक को ः टोर और ूबंिधत �कया जा सके। 
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िन\निलSखत जानकार1 ूदिश,त करने के िलए एक Eवेर1 बनाए ँ 

  

    �लैट नंबर       मािलक         रसीद संHया           �दनांक         रािश  

 

 

(कृपया कॉलम शीष,क म� प�रवत,न पर ?यान द�) 
 

उज़ैर एक इंजीिनय�रंग कॉलेज म� लड़क; के छाऽावास का ूबंधन करता है। अपने छाऽावास म� कह रहे लोग; 

के �रकॉड, को ूबंिधत करने के िलए, उ:ह;ने िन\निलSखत संबंिधत तािलकाओ ं के साथ एक डेटाबेस 

बनाया। 

 

 

ू'येक ौणेी के िलए एक9ऽत कुल मािसक �कराया ूदिश,त करते हुए एक Eवेर1 बनाएँ। 
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अ?यायअ?यायअ?यायअ?याय 12. ूपऽूपऽूपऽूपऽ औरऔरऔरऔर �रपोट,�रपोट,�रपोट,�रपोट, 
12.1 प�रचयप�रचयप�रचयप�रचय 

हम जानते ह@ �क डेटाबेस म� तािलकाओ ंका उपयोग संग�ठत तर1के से डेटा को ःटोर करने के िलए �कया 

जाता है। इसके िलए हम� डेटा को तािलकाओ ंम� दज, करना होगा। जैसा �क 9पछले अ?याय; म� देखा गया है, 

डेटाशीट �ँय का उपयोग तािलकाओ ंम� डेटा दज, करने के िलए �कया जाता है। डेटाशीट �ँय कA row और 

column format बहुत ूयोE ता के अनुकूल इंटरफ़ेस नह1ं है। इसिलए डेटा एंश1 ऑपरेटर या ूयोE ता के 

िलए एक ूयोE ता के अनुकूल डेटा ू9व9T ःबAन 9वकिसत करना आवँयक है, जो कंJयूटर के साथ बहुत 

अ~छ� तरह से वा�कफ नह1ं है। इसके अलावा, डेटा ू9व9T करते समय, ूयोE ता गलती से या जानबूझकर 

तािलका म� डेटा को बदल सकता है। इसिलए िलॄे ऑ�फस बेस म� डेटा ू9व9T उ6ेँय के िलए फॉम, सु9वधा 

ूदान कA जाती है। 
 

साथ ह1, जब ूयोE ता Eवेर1 का उपयोग कर डेटाबेस म� एक या अिधक तािलकाओ ंसे डेटा को पुनूा,4 और 

देखना चाहता है, तो उसे �फर से डेटाशीट �ँय म� ूदिश,त �कया जाता है। OpenOffice Base कA �रपोट, 

सु9वधा retrieve �कए गए डेटा को ूयोE ता के अनुकूल, समझने योXय और format �कए गए Kप म� 

ूःतुत करने म� मदद करती है। 
 

दोन; �रपोटx और Kप; को डेटाबेस कA वःतुओ ं के Kप म� माना जाता है और िलॄे ऑ�फस बेस यूजर 

इंटरफेस के डेटाबेस पैन म� मौजूद ह@। इस अ?याय म� हम िलॄे ऑ�फस बेस का उपयोग करके फॉम, और 

�रपोट, बनाना सीख�गे। 
 

12.2 ूपऽूपऽूपऽूपऽ 

एक फॉम, डेटाबेस का एक ऑDजेEट है Sजसम� एक ूयोE ता के अनुकूल इंटरफ़ेस है जहां डेटा को दज, �कया 

जा सकता है और एक आकष,क और आसान format म� पढ़ा जा सकता है। �कसी भी डेटाबेस के िलए, यह 

डेटा ू9व9T और डेटा संशोधन के िलए अिंतम छोर है। यह हमारे Mारा लेआउट �डज़ाइन म� डेटा ूदिश,त 

करता है न �क केवल एक सरल row और column format म�। 
 

मुHय Kप से, एक ूपऽ म� एक ूःतुित योXय और ूयोE ता के अनुकूल तर1के से GयवSःथत फ़Aaड िनयंऽण 

होता है। ू'येक फ़Aaड िनयंऽण म� एक लेबल और फ़Aaड वैaयूसेट टेEःट होता है। एक लेबल Text का एक 

टुकड़ा है जो उस डेटा को िन�द,T करता है Sजसे फ़Aaड वैaय ूटेEःट बॉEस म� दज, �कया जाना चा�हए। फ़Aaड 

मान टेEःट बॉEस तािलका म� संबंिधत फ़Aaड से जुड़ा हुआ है। हम ूपऽ पर तािलका से सभी या चयिनत 

फ़Aaड जोड़ सकते ह@। FIELD िनयंऽण के अलावा, इसम� कुछ अित�र_ Text जैसे शीष,क, शीष,क और नाम, 

लोगो जैसे मा�फEस, सूची बॉEस और रे�डयो बटन शािमल हो सकते ह@। 

फ़ॉम, बनाने के दो तर1के ह@: 
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• एक wizard का उपयोग करना 

• �डज़ाइन G य ूका उपयोग करना 
 

12.2.1 9वज़ाड,9वज़ाड,9वज़ाड,9वज़ाड, काकाकाका उपयोगउपयोगउपयोगउपयोग करकेकरकेकरकेकरके एकएकएकएक फॉम,फॉम,फॉम,फॉम, बनानाबनानाबनानाबनाना 

फॉम, बनाने का यह सबसे सरल तर1का है। यह समझने के िलए �क 9वज़ाड, का उपयोग करके फ़ॉम, कैसे 

बनाया जाता है, हम 9पछले अ?याय; म� बनाए गए खेल �दवस डेटाबेस म� वापस आ जाएंगे। 9वज़ाड, का 

उपयोग करके एक फॉम, बनाने के िलए, िन\निलSखत चरण; का पालन कर�। 

चरणचरणचरणचरण 1. िलॄे ऑ�फस म� बनाए गए ःपोFस, डे डेटाबेस को खोल�, और डेटाबेस पैन पर फॉम, आइकन पर 

SEलक कर� जैसा �क िचऽ 12.1 म� �दखाया गया है। 
 
 

Tasks Pane पर Use Wizard to Create Form…... 9वकaप पर SEलक कर�। Form wizard पृ̂ भूिम म� 

�डज़ाइन �ँय म� �र_ डेटाबेस फॉम, के साथ खलेुगा जैसा �क िचऽ 12.2 म� �दखाया गया है। 

 
िचऽ 12.1 डेटाबेस पैन से ूपऽ; का चयन करना 
 

  

िचऽ 12.2 ूपऽ 9वज़ाड, और �डज़ाइन �ँय म� डेटाबेस ूपऽ 

 
 

चरणचरणचरणचरण 2. 9वज़ाड, का चरण 1 उन तािलकाओ ंया ूv; का चयन करना है Sजनके िलए फॉम, बनाना है। जैसा 

�क हम ईव�Fस टेबल के िलए एक फॉम, बना रहे ह@, "टेबaस और Eवेyंस" सूची बॉEस से ईव�Fस तािलका का 

चयन कर� जैसा �क िचऽ 12.2 म� �दखाया गया है। 
 

चरणचरणचरणचरण 3. ईव�Fस तािलका का चयन करने के बाद, ईव�ट तािलका के सभी फ़Aaड उपलDध फ़Aaड सूची बॉEस 

म� सूचीबd ह;गे जैसा �क िचऽ 12.3 म� �दखाया गया है। 

 
िचऽ 12.3 उपलDध फ़Aaड म� सूचीबd ईव�Fस तािलका के फ़Aaड 
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चरण 4. जैसा �क हम� फॉम, म� �दखाई देने वाले सभी फ़Aacस कA आवँयकता है, इव�ट टेबल के सभी 

फ़Aacस को Available Fields को Fields in the Form सूची बॉEस से >> बटन का उपयोग करके फॉम, 

सूची बॉEस म� ःथानांत�रत कर�। ?यान द� �क िचऽ 12.4 म�, सभी Fields in the Form सूची बॉEस म� 

ःथानांत�रत कर �दए गए ह@। आगे बढ़ने के िलए Next बटन पर SEलक कर�। 
 

चरणचरणचरणचरण 5. दसूरे चरण म� एक सबफॉम, यानी फॉरम् के भीतर एक फॉम, सेट करना होता है। उप ूपऽ को जोड़ने 

के िलए आपको िचऽ 12.5 म� चेकबॉEस “Add Subform” को चेक करने कA आवँयकता है। चू�ंक हम कोई 

सबफ़ॉम, सेट नह1ं करना चाहते ह@, आगे बढ़ने के िलए नेEःट बटन पर SEलक कर�। 
 

 
िचऽ 12.4 उपलDध फ़Aaड म� ईव�Fस तािलका के सभी फ़Aaड 

Fields in the Form म� ःथानांत�रत कर �दए गए ह@ 
 

 
िचऽ 12.5 चरण 2 एक सबफॉम, सेट कर� 
 

 

  

चरणचरणचरणचरण 6. 9वज़ाड, अगले दो चरण; को छोड़ देता है जो सबफॉम, से संबंिधत होते ह@ और चरण 5 पर आगे बढ़ते 

ह@। यह कदम controls को िनयं9ऽत करता है यानी फॉम, का �डज़ाइन सेट करने के िलए। िचऽ 12.6 म� देख� 

�क, �डफ़ॉaट Kप से, सभी िनयंऽण; को संरेSखत �कया जाएगा। ूपऽ के दा} ओर से िनयंऽण संरेSखत करने 

के िलए दा} ओर संरेSखत कर� रे�डयो बटन पर SEलक कर�। जैसा �क पहले उaलेख �कया गया है, एक फ़Aaड 

िनयंऽण म� दो भाग होते ह@ - लेबल और फ़Aaड मान टेEःट बॉEस। इसिलए इस चरण म� हम लेबल और 

फAaड वैaय ूटेEःट बॉEस कA Gयवःथा करते ह@ Eय;�क हम चाहते ह@ �क वे ःबAन पर �दखाई द�। 

 
िचऽ 12.6 फॉम, के लेआउट का चयन करना 
 

9वज़ाड, के इस चरण म� चनुने के िलए चार लेआउट �दए गए ह@: 

• फ़Aaड मान के बा} ओर लेबल के साथ column के ूदश,न 
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• फ़Aaड मान के शीष, पर लेबल के साथ column के ूदश,न 

• डेटशीट के Kप म� ूदिश,त कर� 

• शीष, पर लेबल के साथ Dलॉक ूदश,न 

 

हम� बा} Gयवःथा पर लेबल के साथ कॉलमनर �डःJले का चयन कर�। यह भी ?यान द�  �क जैसा �क हम 

लेआउट ूकार चनुते ह@, फ़Aaड को फॉम, �डज़ाइन �ँय म� भी GयवSःथत �कया जाता है। 
 

चरण 7. Next बटन पर SEलक कर�। 
 

चरणचरणचरणचरण 8. 9वज़ाड, के चरण 6 म� पूछते ह@ �क Eया फॉम, का उपयोग डेटा ूदिश,त करने, डेटा दज, करने या दोन; 

के िलए �कया जाएगा। जैसा �क हम �डफ़ॉaट से�टंXस के साथ जाते ह@, इसिलए हम अगला बटन SEलक 

करते ह@ जैसा �क िचऽ 12.7 म� �दखाया गया है। 

  
िचऽ 12.7 ूपऽ 9वज़ाड, के चरण 6 

 

चरणचरणचरणचरण 9. अगला चरण styles को बनाए जा रहे फॉम, पर लाग ूकरना है। हम इS~छत पृ̂ भूिम रंग और फ़Aaड 

मान टेEसट् बॉEस के बॉड,र ूकार का चयन कर सकते ह@। िचऽ 12.8 म� देख�, �डफ़ॉa ट Kप से फ़Aaड टेEःट 

मान कA सीमा को 3 ड1 लुक म� ूदिश,त �कया जाता है। य�द आवँयक हो तो हम 9वकaप No Border या 

Flat का चयन कर सकते ह@ 

 
िचऽ 12.8 फॉम, पर styles लागू करना 
 

     

चरण 10. Next बटन पर SEलक कर�। 
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चरणचरणचरणचरण 11. अगला चरण फॉम, का नाम सेट करना है। �डफ़ॉaट Kप से ूपऽ का नाम तािलका के नाम के 

समान है। टेEःटबॉEस म� SEलक कर� और य�द वांिछत है तो एक अलग नाम िलख�, EventForm, जैसा �क 

िचऽ 12.9 म� �दखाया गया है। उसी चरण म�, �डफ़ॉaट Kप से, 9वकaप के साथ रे�डयो बटन Work with the 

form का चयन    करता है। य�द आप 9वज़ाड, समा4 होने के बाद फ़ॉम, को संशोिधत करना चाहते ह@, तो 

Modify the form 9वकaप पर SEलक कर�। 

 

िचऽ 12.9 फॉम, के िलए नाम 

 

िचऽ 12.10 इव�ट तािलका के िलए बनाया गया ूपऽ 

 

 

चरण 12. �फिनश बटन पर SEलक कर�। पहले �रकॉड, के साथ फॉम, को एक अलग 9वंडो म� ःबAन पर 

ूदिश,त �कया जाएगा। यह भी देख� �क िचऽ 12.10 म�, फॉम, का नाम, EventForm िलॄे ऑ�फस यूजर 

इंटरफेस 9वंडो के ऑDजेEट ए�रया म� �दखाई देगा। 
 

जैसा �क िचऽ 12.10 म� �दखाया गया है, फॉम, �डज़ाइन 9वंडो के बा} ओर फ़ॉम, कंशोल टूलबार है और सबसे 

नीचे �रकॉcस, टूलबार है। 
 

फॉम,फॉम,फॉम,फॉम, कंशोलकंशोलकंशोलकंशोल टूलबारटूलबारटूलबारटूलबार - इस टूलबार म� 9विभ:न िनयंऽण होते ह@ Sज:ह�  ूपऽ म� जोड़ा जा सकता है। हम कुछ 

controls के बारे म� बाद म� अ?याय म� जान�गे। 
 

�रकॉcस,�रकॉcस,�रकॉcस,�रकॉcस, टूलबारटूलबारटूलबारटूलबार - �रकॉड, टूलबार म� एकदम बा} ओर ने9वगेशन कंशोल बटन होते ह@। इन बटन; कA मदद 

से, हम फ़ाइल म� �रकॉड, को देख सकते ह@। जैसे ह1 हम एक �रकॉड, से दसूरे �रकॉड, म� जाते ह@, �रकॉड, टेEःट 

बॉEस म� �रकॉड, संHया बदल जाती है। िचऽ 5.11 म� ने9वगेशन िनयंऽण बटन �दखाया गया है, एक नया 

�रकॉड, जोड़ने, एक �रकॉरड् को बचाने, एक �रकॉड, को हटाने आ�द के िलए commands होते ह@। 

 
िचऽ 12.11 �रकॉड, टूलबार 

 

12.2.2 एकएकएकएक Form कोकोकोको संशोिधतसंशोिधतसंशोिधतसंशोिधत करनाकरनाकरनाकरना 
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एक बार �कसी भी तर1के से फॉम, को संशोिधत करना संभव है। संशोधन पृ̂ भूिम के रंग, फ़ॉ:ट आकार और 

Text के रंग या यहां तक �क 9विभ:न controls कA Sःथित को बदलने के िलए हो सकता है। 

पृ̂ भूिमपृ̂ भूिमपृ̂ भूिमपृ̂ भूिम background काकाकाका रंगरंगरंगरंग बदलनाबदलनाबदलनाबदलना 

ूपऽ कA पृ̂ भूिम का रंग बदलने के िलए िन\न चरण; का पालन कर�। 

चरणचरणचरणचरण 1. ःपोFस, डे डेटाबेस के िलए ओपनऑ�फस बेस यूजर इंटरफेस खोल� और डेटाबेस पेन म� फॉम, 

आइकन पर SEलक कर�। सेव �कए गए फ़ॉम, (EventForm) का नाम ऑDजेEट ए�रया म� ूदिश,त �कया 

जाएगा। 

चरण 2. फॉम, के नाम पर राइट SEलक कर� और ए�डट… 9वकaप चनु�। एक अलग फॉम, �डज़ाइन Gय ू

खलेुगा। 

चरण 3. फॉम, का बैकमाउंड कलर बदलने के िलए, फॉम, पर राइट SEलक कर� और पेज ःटाइल ... ऑJशन 

को पॉप अप मेन ूसे चनु� जैसा �क िचऽ 12.12 म� �दखाया गया है। 

 

िचऽ 12.12 ए�डट पॉप डाउन से Page Style option का चयन 

करना 

 
 

िचऽ 12.13 पृ̂  शैली डायलॉग बॉEस म� रंग पैलेट का चयन 

करना 
 

चरणचरणचरणचरण 4. पृ̂  शैली डायलॉग बॉEस �दखाई देगा, जहां आप ए�रया टैब का चयन करते ह@ और पैलेट से वांिछत 

रंग चनुते ह@, जैसा �क िचऽ 5.13 म� �दखाया गया है। 
 

चरण 5. ओके बटन पर SEलक कर�। चयिनत रंग फॉम, पर लाग ू �कया जाएगा जैसा �क िचऽ 12.14 म� 

�दखाया गया है। 

 

िचऽ 12.14 प�रवित,त पृ̂ भूिम रंग के साथ ूपऽ 
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लेलेलेलेबलबलबलबल काकाकाका संपादनसंपादनसंपादनसंपादन 

लेबल को ए�डट करने के िलए, या तो Text को बदलकर या formatting ूभाव को बदलकर, िन\निलSखत 

चरण; का पालन कर�। 

चरण 1. माउस सूचक को लेबल पर रख�, इसे बदलने के िलए EventID को SEलक कर�। 

चरण 2. कAबोड, शॉट,कट कंुजी दबाएं Ctrl + लेबल का चयन करने के िलए SEलक कर�। Sःथित बEसे लेबल 

के आसपास �दखाई द�गे। 

चरण 3. चयिनत लेबल पर राइट SEलक कर� और िनयंऽण Properties चनु� ... िचऽ 12.15 म� �दखाए गए 

अनुसार पॉप अप मेन ूसे 9वकaप। 

चरणचरणचरणचरण 4. Properties: लेबल फ़Aaड डायलॉग बॉEस िचऽ 12.16 म� �दखाया गया है। इसम� चयिनत लेबल के 

9विभ:न Properties ह@। लेबल Properties के बाद Text बॉEस म�, इव�ट आईड1 िलख�। ूपऽ पर लेबल 

कैJशन तदनुसार बदलता रहता है। 

 
िचऽ 12.15 लेबल पर राइट SEलक करके Control Properties 

का चयन कर� 

 
 

िचऽ 12.16 Properties लेबल फ़Aaड से लेबल कैJशन को 
बदलना 

  

इसी ूकार हम चयिनत लेबल के अ:य गुण; जैसे चौड़ाई, ऊंचाई, alignment, फ़ॉ:ट शैली और फ़ॉ:ट 

आकार को बदल सकते ह@। 

चरण 5. वांिछत प�रवत,न करने के बाद, डायलॉग बॉEस के शीष, दा} ओर Sःथत बॉस (x) बटन पर SEलक 

करके Properties डायलॉग बॉEस को बंद कर�। �कए गए प�रवत,न; को चयिनत Text पर लाग ू �कया 

जाएगा। 

एकएकएकएक control को मूव करनाको मूव करनाको मूव करनाको मूव करना 

ूपऽ म� �कसी अ:य ःथान पर ले जाना संभव है। उस िनयंऽण पर SEलक कर� Sजसे ःथानांत�रत करना है। 

फ़Aaड मान के िलए लेबल और टेEःट बॉEस दोन; का चयन �कया जाएगा और Sःथित ह@डलर को िनयंऽण 

के चार; ओर रखा जाएगा। य�द इनम� से केवल एक को �फर से तैनात करना है तो उस िनयंऽण पर SEलक 

करते समय Ctrl कंुजी दबाएं। अब, SEलक कर� और िनयंऽण को इS~छत ःथान पर ले जाने के िलए खींच�। 
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िचऽ 12.17 एक control िनयंऽण को मूव करना 

टेEःटबॉEसटेEःटबॉEसटेEःटबॉEसटेEःटबॉEस control िनयंऽणिनयंऽणिनयंऽणिनयंऽण काकाकाका आकारआकारआकारआकार बदलनाबदलनाबदलनाबदलना 

टेEःटबॉEस िनयंऽण का आकार बदलने के िलए, टेEःट बॉEस पर SEलक करते समय Ctrl बटन दबाएँ। 

यह उसके चार; ओर Sःथित संचालक; के साथ चनुा जाएगा। इनम� से �कसी भी ह@डलर पर माउस पॉइंटर 

लगाएं। यह एक डबल साइडेड तीर म� बदल जाएगा। SEलक कर� और उ:ह�  वांिछत आकार म� खींच�। 
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12121212....2222....3 3 3 3 टूलटूलटूलटूल    �टप�टप�टप�टप    जोड़नाजोड़नाजोड़नाजोड़ना    

टूल-�टप Text का एक छोटा सा टुकड़ा है Sजसे माउस पॉइंटर को �कसी 9वशेष िनयंऽण पर 
रखने पर ूदिश,त �कया जाता है। उदाहरण के िलए कह�, अगर माउस पॉइंटर को ईव�टआईड1 

टेEःट-बॉEस पर रखा गया है, तो एक संदेश the एंटर इव�ट आइड��ट�फकेशन नंबर दज, कर� 

Õूदिश,त �कया जा सकता है। यह ूयोE ता के िलए डेटा दज, करना आसान बना देगा। इस तरह 

के टेEःट जो माउस पॉइंटर को �कसी 9वशेष Control  पर रखे जाने पर �दखाई देते ह@, टूल-�टप 
टेEःट या हेaप टेEःट कहलाता है। आइए नीचे �दए गए चरण; का पालन करके EventID 
िनयंऽण के िलए एक टूल-�टप जोड़�। 
 

चरण    1111 Ctrl.  बटन दबाए ंऔर EventID टेEःट बॉEस पर SEलक कर�। 
चरणचरणचरणचरण    2222. राइट SEलक कर� और िनयंऽण Properties चनु� ... 9वकaप। Properties: Text 
बॉEस डायलॉग बॉEस िचऽ 12.18 म� �दखाया गया है। 

  
िचऽ 12.18 Properties Text बॉEस म� टूल�टप जोड़ना 
 

चरणचरणचरणचरण    3333.... डायलॉग बॉEस म�, मदद Text Properties आने तक नीचे ःबॉल कर�। 

चरण    4444.... टेEःट बॉEस म� 'इव�ट आइड��ट�फकेशन नंबर' टाइप कर�। 

चरणचरणचरणचरण    5555.... बॉस (एEस) बटन पर SEलक करके डायलॉग बॉEस को बंद कर�। अब, य�द माउस 

पॉइंटर को ईव�टआईड1 टेEःट बॉEस पर रखा गया है, तो टूल �टप को िचऽ 12.19 म� �दखाया 

गया है। 

 
िचऽ 12.19 टूल �टप ूदिश,त करना 
 

5.2.3 FormsFormsFormsForms ControlsControlsControlsControls ToolbarToolbarToolbarToolbar         

Forms Controls Toolbar   म� control  जोड़ने या ए�डट करने के िलए 9विभ:न टूल होते ह@। 
आइए हम इनम� से कुछ उपकरण; का उपयोग करना सीख�। 
 

एकएकएकएक    कैल�डरकैल�डरकैल�डरकैल�डर    म� म� म� म� �दनांक�दनांक�दनांक�दनांक    फ़Aaडफ़Aaडफ़Aaडफ़Aaड    datedatedatedate fieldfieldfieldfield        जोड़नाजोड़नाजोड़नाजोड़ना    
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कंJयूटर पर एक फॉम, भरते समय, �यादातर एक कैल�डर ूदिश,त होता है। ऐसा इसिलए है 

Eय;�क इसे टाइप करने के बजाय डेट चनुना आसान होता है। फॉम, म� �दनांक फ़Aaड को जोड़ने 

के िलए, नीचे �दए गए चरण; का पालन कर�: 

चरण    1111. . . . माउस पॉइंटर को डेट टेEःट बॉEस पर रख� और इसे चनुने के िलए Ctrl  + SEलक 
कर�। 

चरणचरणचरणचरण    2222.... राइट SEलक कर� और िनयंऽण Properties चनु� ...। 9वकaप। 
चरणचरणचरणचरण    3333. गुण; म�: �दनांक फ़Aaड डायलॉग बॉEस, �दनांक के फॉमYट कA ूॉपट� के िलए नीचे 

ःबॉल कर�। �डफ़ॉaट Kप से, मानक (लघ)ु format ूदिश,त �कया जाएगा। 
चरणचरणचरणचरण    4444.... सूची बॉEस को खोलने के िलए SEलक कर� और मानक (लंबे) format का चयन कर�। 
चरण    5555.... जब तक आपको सॉपडाउन ूॉपट� नह1ं िमलती है, तब तक नीचे ःबॉल कर�। �डफ़ॉaट 

Kप से इसका मूaय नह1ं, Yes चनु�। िनयंऽण Properties सेट िचऽ 12.20 म� �दखाया गया है। 

 
िचऽ 12.20 �दनांक फ़Aaड के िलए िनयंऽण Properties सेट 

चरणचरणचरणचरण    6666. . . . डायलॉग बॉEस को बंद कर�। फॉम, �दनांक पर चयिनत �दनांक िनयंऽण टेEःट बॉEस 

एक सूची बॉEस म� बदल जाता है Sजसम� िचऽ 12.21 म� �दखाए गए अनुसार तीर को दा} ओर 

ूदिश,त �कया जाता है। 

  
िचऽ 12.21 कैल�डर के साथ �दनांक िनयंऽण field 
 

फॉम,    म�म�म�म�    TextTextTextText    जोड़नाजोड़नाजोड़नाजोड़ना    

फ़ॉम, �डज़ाइन करते समय, हम� ti tles headings,  या सबहे�डंग म� ूवेश करने कA आवँयकता 

हो सकती है। इसे Labels कहा जाता है। �डजाइन करते समय फॉम, म� लेबल बनाना संभव है। 
शीष,क Text को फ़ॉम, म� सS\मिलत करने के िलए िन\निलSखत चरण; का पालन कर�। 
चरणचरणचरणचरण    1111.... फॉम, कंशोल टूल बॉEस पर लेबल () टूल पर SEलक कर� जैसा �क िचऽ 12.22 म� 

�दखाया गया है। 

  
िचऽ FormControls12.22   टूल बॉEस पर लेबल आइकन का चयन करना 
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चरणचरणचरणचरण    2222.... फॉम, पर, लेबल फ़Aaड बॉEस बनाने के िलए माउस को SEलक कर� और drag कर�। 
इसम� पोSजशन ह@डलर भी ह;गे। 

चरणचरणचरणचरण    3333.... Properties को खोलने के िलए बॉEस पर डबल SEलक कर�: PropertiesPropertiesPropertiesProperties LabelLabelLabelLabel: : : :     

FieldFieldFieldField    डायलॉग बॉEस। 
चरणचरणचरणचरण    4444.... लेबल Properties म� "डेटा एंश1 फॉम," के Kप म� शीष,क टाइप कर�, जैसा �क िचऽ 
12.23 म� �दखाया गया है। 

 
िचऽ 12.23 िनिम,त लेबल के िलए Properties लेबल फ़Aaड डायलॉग बॉEस 
    

चरणचरणचरणचरण    5555.... फ़ॉ:ट Properties के सामने फ़ॉ:ट बटन पर SEलक करके फ़ॉ:ट Properties सेट 
कर�। च�रऽ डायलॉग बॉEस िचऽ 12.24 म� �दखाया गया है, जहां आप फ़ॉ:ट ूकार style,  और 

आकार सेट कर सकते ह@। इS~छत फ़ॉ:ट शैली और आकार चनु� और OK बटन पर SEलक कर�। 

 
िचऽ Character12.24  डायलॉग बॉEस म� फ़ॉ:ट ूकार style,  और आकार सेट करना 

चरणचरणचरणचरण    8888.... PropertiesPropertiesPropertiesProperties LabelLabelLabelLabel FieldFieldFieldField: : : :         डायलॉग बॉEस बंद कर�। चयिनत formatting ूभाव 
वाले शीष,क को form पर ूदिश,त �कया जाएगा। 9विभ:न िनयंऽण; को लाग ूकरने और ए�डट 

करने के बाद, इव�Fस टेबल म� डेटा दज, करने का अिंतम Kप िचऽ 12.25 म� �दखाया गया है। 

 
िचऽ 12.25 इव�ट टेबल के िलए संशोिधत डेटा एंश1 फॉम, 
 

12121212....2222....4 4 4 4 एकएकएकएक    फॉम,फॉम,फॉम,फॉम,    काकाकाका    उपयोगउपयोगउपयोगउपयोग    करकेकरकेकरकेकरके    एकएकएकएक    नयानयानयानया    �रकॉड,�रकॉड,�रकॉड,�रकॉड,    जोड़नाजोड़नाजोड़नाजोड़ना    

आपके Mारा फ़ॉम, को �डज़ाइन करने के बाद, आप इस फ़ॉम, का उपयोग करके �रकॉड, ूदिश,त 

या सS\मिलत कर सकते ह@। इस ूयोजन के िलए, आपको FormsFormsFormsForms ControlsControlsControlsControls            toolbar पर 
�डज़ाइन मोड बटन पर SEलक करके �डज़ाइन G य ू से फ़ॉम, G य ूपर ःथानांत�रत करना होगा। 
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फॉम, �ँय 9वंडो पहले �रकॉड, के साथ �दखाई देती है जो संबंिधत Text बॉEस म� ूदिश,त होती 
है जैसा �क िचऽ 12.26 म� �दखाया गया है। 

िचऽ 12.26 फॉम, िनयंऽण पर �डज़ाइन मोड बटन पर SEलक से �डज़ाइन G यू म� फ़ॉम, 
ूदिश,त करना 
 

इस फ़ॉम, का उपयोग करके तािलका म� एक नया �रकॉड, जोड़ने के िलए, �रकॉड, टूलबार पर नए 

�रकॉड, बटन पर SEलक कर� जैसा �क िचऽ 5.27 म� �दखाया गया है। 

 िचऽ 12.27 नए �रकॉड, पर SEलक करके एक नया �रकॉड, जोड़ना 
पहले टेEःट बॉEस यानी EventID म� SDलंक करते कस,र के साथ एक खाली form �डः J ले होगा। 

 िचऽ 12.28 अगला �रकॉड, संHया �दखाते हुए नया �र_ �रकॉड, 
 

िनर1nण कर� �क �रकॉड, पॉइंटर 11 �रकॉड, �दखाता है, Eय;�क तािलका म� पहले से ह1 10 �रकॉड, 

थे। �रकॉड, दज, करने के बाद, तािलका म� �रकॉड, सेव करने के िलए �रकॉcस, टूलबार पर सेव 

�रकॉड, बटन पर SEलक कर�। 
 

�कसी भी �रकॉड, को हटाने के िलए, �रकॉड, टेEःट बॉEस म� �रकॉड, नंबर टाइप करके या 

ने9वगेशन बटन का उपयोग करके �रकॉड, पर ने9वगेट कर�। 

इसके बाद �रकॉcस, टूलबार पर �डलीट बटन पर SEलक कर�। अगला �रकॉड, फॉम, म� ूदिश,त 

�कया जाएगा। फॉम, िनयऽंण टूलबार पर �डज़ाइन G य ूऔर फॉम, G य ूूेस मोड मोड बटन के बीच 

टॉगल करने के िलए। जब हम DesignView  म� एक फॉम, बनाते ह@, तो फॉम, कंशोल टूलबार म� 

�दए गए 9विभ:न टूaस का उपयोग करके सभी कंशोल को फॉम, पर रखा जाता है। 

12121212....3 3 3 3 �रपोट,�रपोट,�रपोट,�रपोट,    

एक �रपोट, डेटाबेस ूबंधन ूणाली कA एक और उपयोगी 9वशेषता है। हमने देखा है �क Eवेर1 का 

उपयोग करके िनकाले गए �रकॉड, को सरल row और कॉलम format म� ूदिश,त �कया जाता है। 
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इसके बजाय, एक �रपोट, का उपयोग करके हम पुनः ूा4 डेटा को एक आकष,क और अनुकूिलत 

तर1के से ूःतुत कर सकते ह@। हम तािलका या Eवेर1 या दोन; के आधार पर एक �रपोट, बना 

सकते ह@। अिधमानतः, य�द एक �रपोट, को कई तािलकाओ ंसे उ'प:न �कया जाना है, तो पहले 

एक Eवेर1 बनाई जानी चा�हए और �फर उस Eवेर1 का उपयोग �रपोट, उ'प:न करने के िलए 

�कया जा सकता है। खेल �दवस डेटाबेस से तािलका घटनाओ ंको लेकर एक �रपोट, बनाएं। 

�रपोट, बनाने के िलए िन\निलSखत चरण; का पालन कर�। 

चरणचरणचरणचरण    1111.... िलॄे ऑ�फस बेस यूजर इंटरफेस म�, डेटाबेस पैन म� �रपोट, आइकन पर SEलक कर�। 

चरणचरणचरणचरण    2222.... टाः क पैन से, UseUseUseUseWizardWizardWizardWizard totototoCreateCreateCreateCreateReportReportReportReport                 ... 9वकaप पर SEलक कर�। 

चरणचरणचरणचरण    3333. �रपोट, 9वज़ारड् के साथ दो अ:य 9वंडो ूदिश,त कA जाएंगी। 9वंडो म� से एक �रपोट, 

9बaडर 9वंडो है और दसूरा ऐड फAaड डायलॉग बॉEस है। हम अपने अ?ययन को 9वज़ाड, तक ह1 

सीिमत रख�गे। 

िचऽ 12.29 �रपोट, 9वज़ाड,, �रपोट, 9बaडर और फ़Aaड जोड़� डायलॉग बॉEस 

चरणचरणचरणचरण    4444.... 9वज़ारड् का पहला चरण तािलका और संबंिधत फ़Aaड का चयन करना है Sजसे हम 

अपनी �रपोट, म� ूदिश,त करना चाहते ह@। तािलकाए ँया Eवेर1ज़ सूची बॉEस से तािलका ईव�ट 

चनु�। 
 

चरणचरणचरणचरण    5555.... ईव�Fस तािलका के सभी फ़Aaड उपलDध फ़Aacस सूची बॉEस म� सूचीबd ह;गे। �रपोट, 

सूची बॉEस म� फ़Aaड को फ़Aaड म� ःथानांत�रत करने के िलए >> बटन पर SEलक कर�। 

 
िचऽ 12.30 ःथानांतरण shi fting के बाद �रपोट, सूची बॉEस म� फ़Aaड �दखाता है। 

 
िचऽ 12.30 �रपोट, सूची बॉEस म� फ़Aacस पर जाने के बाद तािलका ईव�ट और फ़Aaड का चयन करना 
 

चरण    6666. . . . नेEःट बटन पर SEलक कर�। अगला कदम fields को लेबल करना है। �डफ़ॉaट Kप 
से, कॉलम हेडर को फ़Aaड मान के िलए लेबल या कॉलम हेडर के Kप म� ूदिश,त �कया जाएगा। 
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जैसा �क फ़Aaड नाम; को आम तौर पर छोटा �कया जाता है, अिधक ःव-GयाHया'मक नाम; को 

बदलने के िलए, संबंिधत टेEःट बॉEस म� नए नाम टाइप कर�। 

 िचऽ 12.31 fi elds को लेबल करने वाल े9वज़ाड, का चरण 2  
 

चरण    8888.... नेEःट बटन पर SEलक कर�। अगला कदम �रपोट, म� �कसी भी फ़Aaड के आधार पर 

डेटा को समू�हत करना है। चू�ंक हम अब तक समूह नह1ं बनाना चाहते ह@, तो अगला बटन पर 

SEलक कर�। 
 

चरणचरणचरणचरण    9. . . . चौथा चरण सॉट, 9वकaप सेट करना है। य�द �रपोट, म� ूदिश,त �कए जाने वाले डेटा को 

�कसी 9वशेष field के ascending या descending बम म� सॉट, �कया जाना है, तो इस चरण 
म� फ़Aaड और सॉ�टzग बम िन�द,T कर�। उदाहरण के िलए, फ़Aaड EventID का चयन कर�। 
आरोह1 के िलए रे�डयो बटन पहले से ह1 चनुा गया है। िचऽ 12.32 म� �दखाए गए अनुसार 

अवरोह1 बम म� �रकॉड, ूदिश,त करने के िलए अवरोह1 रे�डयो बटन का चयन कर�। 

 
िचऽ 12.32 सॉ�टzग 9वकaप; को सेट करना 
 

चरणचरणचरणचरण    11110.... अगले चरण पर जाने के िलए अगला बटन पर SEलक कर� Sजसम� �रपोट, का लेआउट 

चनुा जाएगा। 

चरणचरणचरणचरण    11111111.... एक लेआउट वह तर1का है Sजसम� लेबल, फ़Aaड मान और शीष,क �रपोट, म� ूदिश,त 

�कए जाएंगे। �दए गए 9विभ:न लेआउट 9वकaप; म� से, वांिछत लेआउट चनु�, टेबुलर और हेडर 

और फ़ुटस, (�डफ़ॉaट) का लेआउट भी चनु�। आप इस चरण म� ओ�रएंटेशन 9वकaप ल@डःकेप या 

पोशYट भी चनु सकते ह@। �डफ़ॉaट अिभ9व:यास 9वकaप रख� ल@डःकेप �डफ़ॉaट Kप से चयिनत 

होता है, जैसा �क िचऽ 12.33 म� �दखाया गया है। 

 
िचऽ 12.33 लेआउट का चयन   
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चरण    13131313.... अिंतम चरण म� जाने के िलए नेEःट बटन पर SEलक कर�। यहां हम �रपोट, को नाम 

देते ह@ और उस तर1के को िन�द,T करते ह@ Sजसम� हम 9वज़ाड, के ख'म होने के बाद आगे बढ़ना 

चाहते ह@। �रपोट, का नाम EventReport के Kप म� टाइप कर�, जैसा �क िचऽ 12.34 म� �दखाया 
गया है। �डफ़ॉaट Kप से �रपोट, का ूकार गितशील है। इसका मतलब है �क बेस टेबल या Eवेर1 

म� फ़Aaड मान बदलते ह@, �रपोट, भी ःवचािलत Kप से बदल जाएगी। य�द आप �रपोट, का 

ःवचािलत अपडेशन नह1ं चाहते ह@, तो ःटे�टक 9वकaप चनु�। इस चरण म�, िन�द,T कर� �क Eया 

आप 9वज़ाड, को समा4 करने के बाद एक बार म� संशोधन करना चाहते ह@ या �रपोट, बनाना 

चाहते ह@। वत,मान से�टंग के साथ �रपोट, बनाने के िलए �डफ़ॉaट 9वकaप चनु�। 

 
िचऽ 12.34 चरण 6 9वज़ाड, कA �रपोट, बनाएँ 
 

चरणचरणचरणचरण    15151515. . . . िचऽ 12.35 के अनुसार �रपोट, ूदिश,त करने हेतु �फिनश बटन पर SEलक कर�। 

 
िचऽ 12.35 घटना तािलका स ेउ'प:न �रपोट, 

12121212....3333....1 1 1 1 �रपोट,�रपोट,�रपोट,�रपोट,    म�म�म�म�    अ:यअ:यअ:यअ:य    controlscontrolscontrolscontrols    सS\मिलतसS\मिलतसS\मिलतसS\मिलत    करनाकरनाकरनाकरना    

जैसा �क आप िचऽ 12.35 म� उ'प:न �रपोट, का अवलोकन कर सकते ह@, �रपोट, बहुत सरल और 

उबाऊ है। हम कुछ और िनयंऽण जैसे शीष,क, लेखक का नाम, �रपोट, बनाने कA तार1ख आ�द 

डालकर इसे और अिधक ूःतुत करने योXय बना सकते ह@। 

िलॄे ऑ�फस यूजर इंटरफेस पर �रपोट, नाम EventReport( ) पर राइट SEलक कर� और �फर 

ए�डटÉ 9वकaप चनु�। जैसा �क िचऽ 12.36 म� �दखाया गया है �रपोट, 9बaडर 9वंडो खलेुगी। इस 

9वंडो म�, �रपोट, कंशोल टूलबार का उपयोग करके 9विभ:न िनयंऽण सS\मिलत �कए जा सकते ह@। 

 
िचऽ 12.36 �रपोट, 9बaडर 9वंडो 
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Ti tlesTi tlesTi tlesTi tles    औरऔरऔरऔर    HeadingsHeadingsHeadingsHeadings    सS\मिलतसS\मिलतसS\मिलतसS\मिलत    करनाकरनाकरनाकरना    

�रपोट, का शीष,क सS\मिलत करने के िलए, िन\निलSखत चरण; का पालन कर�। 

चरण    1111.... �रपोट, कंशोल टूलबार पर उपलDध लेबल टूल पर SEलक कर�। 

चरणचरणचरणचरण    2222.... �रपोट, पर माउस पॉइंटर लाए।ं लेबल टेEःटबॉEस डालने के िलए SEलक कर� और drag 
कर�। 

 
िचऽ 12.37 Properties डायलॉग बॉEस म� लेबल नाम और से�टंग फ़ॉ:ट असाइन कर� 

चरण चरण चरण चरण 3333. . . . PropertiesPropertiesPropertiesProperties    डायलॉग बॉEस खोलने के िलए उस पर डबल SEलक कर�। वह ti tle 
text टाइप कर�, Sजसे आप लेबल ूॉपट� टेEःटबॉEस म� ूदिश,त करना चाहते ह@, "वा9ष,क खेल 

�दवस �रपोट," कह� और फ़ॉ:ट property का उपयोग करके फ़ॉ:ट style और आकार भी सेट 

कर� जैसा �क िचऽ 12.38 म� �दखाया गया है।     
 

चरचरचरचरणणणण    4444.... Properties डायलॉग बॉEस बंद कर�। डेटाबेस पेन कA �रपोट, म� EventReport पर 
डबल SEलक कर�। िचऽ 12.38 म� �दखाए अनुसार �रपोट, को formatted ूभाव के साथ ूदिश,त 

�कया जाएगा। 

 िचऽ formatted12.38  ूभाव; के साथ �रपोट,  

�दनांक�दनांक�दनांक�दनांक    औरऔरऔरऔर    समयसमयसमयसमय    सS\मिलतसS\मिलतसS\मिलतसS\मिलत    ककककरनारनारनारना    

उस �दनांक को सS\मिलत करने के िलए Sजस पर �रपोट, तैयार कA गई है, िन\न चरण; का 

पालन कर�। 

चरणचरणचरणचरण    1111.... पेज हैडर field म� SEलक कर� इसे स�बय करने के िलए। 
चरणचरणचरणचरण    2222.... िचऽ 12.39 म� �दखाए अनुसार सS\मिलत कर� InsertInsertInsertInsert DateDateDateDate andandandandTimeTimeTimeTime    > > > >         É É É É 9वकaप 

पर SEलक कर�। 
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िचऽ 12.39 हैडर म� �दनांक और समय सS\मिलत करना 
 

चरणचरणचरणचरण    3333. . . . DateDateDateDate andandandand TimeTimeTimeTime            डायलॉग बॉEस को िचऽ 12.40 म� �दखाया गया है। �दनांक और 

समय format के िलए वांिछत format का चयन कर� और OKOKOKOK बटन पर SEलक कर�। 

 िचऽ 12.40 �दनांक और समय डायलॉग बॉEस 

�दनांक को पृ̂  शीरष् field के ऊपर1 बाए ँकोने पर डाला जाएगा। आप पेज हैडर field म� 
�कसी भी ःथान पर इसे बदलने के िलए इसे SEलक और drag सकते ह@। 
 

अिंतम �रपोट, जैसा िचऽ 12.41 म� �दखाया गया है। 

 
िचऽ 12.41 शीष,क और तार1ख के साथ �रपोट, 
 

ऐसी �रपोट, बनाने के िलए जो �कसी 9वशेष fi eld के अनुसार retrieve डेटा को समूह1कृत 
करती है, फ़Aaड नाम िन�द,T कर� Sजसके अनुसार retrieve �कए गए डेटा को 9वज़ाड, के चरण 
3 म� समूह1कृत �कया जाना है। उदाहरण के िलए, य�द हम घटनाओ ंके 9ववरण को ौणेीवार 

ूदिश,त करना चाहते ह@, तो CategoryID फ़Aaड को समूह1करण सूची बॉEस म� ःथानांत�रत कर� 
जैसा �क िचऽ 12.42 म� �दखाया गया है। 

 
िचऽ MovingCategoryID12.42   समूह1करण �रकॉड,  
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इसकA category wise  �रपोट, जनरेट कA जाएगी जैसा �क िचऽ 12.43 म� �दखाया गया है। 

  
िचऽ Category wise12.43   उ'प:न �रपोट,  

अपनीअपनीअपनीअपनी    ूगितूगितूगितूगित    जांच�जांच�जांच�जांच�    
क. . . . बहु9वकaपीयबहु9वकaपीयबहु9वकaपीयबहु9वकaपीय    ूvूvूvूv    

1. िन\न म� स े�कस टूलबार म� लेबल टूल है? 

(ए) ःट@डड, टूलबार (बी) फॉम, कंशोल टूलबार (सी) �रकॉcस, टूलबार (ड1) उपरो_ म� स ेकोई नह1ं 

2. �रकॉड, टूलबार के पास जाने के िलए बटन ह@ 

(ए) पहला �रकॉड, (बी) दसूरा �रकॉड, (सी) 9पछल े�रकॉड, (ड1) सभी �रकॉड, 

3. िन\निलSखत म� स ेकौन सा forms के बारे म� सच नह1ं है? 
(ए) यह डेटा ू9व9T के िलए अंितम िसरा है (बी) इसम� केवल Text field  हो सकते ह@ (सी) फाम, पर मा�फEस 

हो सकते ह@ (ड1) उपरो_ म� स ेकोई नह1ं 

4. िन\न म� स े�कस कंुजी को केवल फॉम, पर टेEःटबॉE स चुनने के िलए दबाया जाता है? 

a Al t b Shi ft c Ctrl d( )  ( )  ( )  ( ) टैब 

properties5.  म� िन\निलSखत म� स ेकौन सा Properties का उपयोग: लेबल फ़Aaड टेEःट बॉEस फॉम, पर 
टूल�टप डालने के िलए �कया जाता है?  

a( ) टूल टेEःट b( ) हेaप टेEःट c( ) टूल �टप d( ) हेaप �टप 
6. िलॄे ऑ�फस बेस कA िन\निलSखत म� स े �कस वःतु का उपयोग ूेज�टेबल तर1के स ेएक या एक स ेअिधक 

टेबल स ेूा4 डेटा को ूदिश,त करने के िलए �कया जाता है? 

(ए) Eवेर1 (बी) फॉम, (सी) �रपोट, (ड1) उपरो_ म� स ेकोई नह1ं 

7. फॉम, पर एक कैल�डर देखने के िलए �दनांक format properties  के िन\निलSखत मूaय; म� स ेकौन सा चयन 

�कया जाता है? 

Forms Control8.   टूल बार पर िन\निलSखत म� स ेकौन सी कमांड का उपयोग �डज़ाइन G यू और फॉम, G यू के 

बीच टॉगल करने के िलए �कया जाता है? 

(ए) �डजाइन मोड (बी) टॉगल मोड (सी) Gयू मोड (ड1) उपरो_ म� स ेकोई नह1ं 

9. डेटाबेस म� िन\निलSखत म� स े �कस objects का उपयोग करके एक �रपोट, तैयार कA जा सकती है? (ए) 
टेबaस (बी) Eवेर1 (सी) ए और बी दोन; (ड1) न तो ए न ह1 बी 

10. िन\निलSखत घटक; म� स ेकौन सा �रपोट, 9वज़ाड, के साथ खुला है? 

(ए) �रपोट, 9बaडर (बी) फ़Aaड डायलॉग बॉEस जोड़� (सी) ए और बी दोन; (ड1) न तो ए न ह1 बी 
 

खखखख.    यहयहयहयह    बताएंबताएंबताएंबताएं    �क�क�क�क    िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत    कथनकथनकथनकथन    सह1सह1सह1सह1    ह@ह@ह@ह@    यायायाया    गलत।गलत।गलत।गलत।    

1. �रपोट, एक डेटाबेस का एक ऑDजेE ट है ले�कन फॉम, नह1ं है। 
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2. हम फॉम, का लेआउट चुन सकते ह@। 

3. हम� फॉम, पर तािलका के सभी fi eld को जोड़ना होगा। 
4. दो तर1के ह@ Sजसस ेएक फॉम, बनाया जा सकता है। 

5. एक �रपोट, एक अलग 9वंडो म� उ'प:न होती है। 

6. एक बार िनयंऽण को फॉम, म� जोड़ने के बाद, इस े�फर स ेतैनात नह1ं �कया जा सकता है। 

7. �रकॉड, टूलबार म� एक नया �रकॉड, जोड़ने के िलए बटन है। 

8. हम केवल तािलका का उपयोग करके एक �रपोट, बना सकते ह@। 

9. �डफ़ॉaट Kप स,े एक �रपोट, के �रकॉड, को descending बम म� बमबd �कया जाता है। 
10. हम एक �रपोट, म� �कसी 9वशेष field के आधार पर डेटा को समू�हत कर सकते ह@। 

11. एक �रपोट, म� केवल row और column format  म� डेटा हो सकता है। 

12. हम �रपोट, तैयार करने कA तार1ख और समय दोन; को सS\मिलत कर सकते ह@। 

13. एक बार बनाई गई �रपोट, को ए�डट नह1ं �कया जा सकता है। 

गगगग. . . . �र_�र_�र_�र_    ःथानःथानःथानःथान    भर�भर�भर�भर�।।।।    

1. एक फॉम, का उपयोग __________ और _____________ के िलए �कया जा सकता है। 

2. ू'येक field िनयंऽण म� एक ____________ और ________________ होते ह@ 

3. एक Text____  का एक टुकड़ा है जो उस डेटा को िन�द,T करता है Sजस ेफ़Aaड वैaयू टेEःट बॉEस म� दज, 

�कया जाना चा�हए। 

4. �डफ़ॉaट Kप स ेफ़Aaड टेEःट मान कA सीमा _________ म� ूदिश,त होती है। 

5. एक Text____________  का एक छोटा सा टुकड़ा होता है जो माउस पॉइंटर को फॉम, पर �कसी 9वशेष 

िनयंऽण पर रखे जाने पर ूदिश,त होता है। 

6. एक �रपोट, के िलए �डफ़ॉaट अिभ9व:यास 9वकaप _______________ है। 

7. एक _____ वह तर1का है Sजसम� लेबल, फ़Aaड मान, शीष,क आ�द को �रपोट, म� ूदिश,त �कया जाएगा। 

8. �रपोट, म� �दनांक और समय सS\मिलत करने का 9वकaप ___________ मेनू म� मौजूद है। 

9. एक �रपोट, 9वज़ाड, म� ________ चरण होते ह@। 

10. आधार तािलका या Eवेर1 प�रवत,न म� फ़Aaड मान; के अनुसार _______ ूकार कA �रपोट, ःवचािलत Kप स े

बदल जाती है। 

घघघघ.    िन\निलSखतिन\निलSखतिन\निलSखतिन\निलSखत    ूv;ूv;ूv;ूv;    केकेकेके    उuरउuरउuरउuर    द1Sजए।द1Sजए।द1Sजए।द1Sजए।    

1. फॉम, और �रपोट, म� एक अंतर द�। 

forms2.  के संबंध म� एक fi eld िनयंऽण Eया है? 
3. फॉम, म� टेEःट डालने हेतु फॉम, �रकॉड, टूलबार पर कौन सा टूल इःतेमाल �कया जाता है? 

4. िलॄे ऑ�फस बेस म� एक फॉम, बनाने के िलए दो तर1क; का नाम द�। 

5. ःथैितक और गितशील �रपोट, म� Eया अंतर है? 

FormsControls toolbar6.    और Records toolbar  का काय, िलख�। 

ूायोिगकूायोिगकूायोिगकूायोिगक    अwयासअwयासअwयासअwयास    

1. ूकाशन हैJपी होम सोसाइट1 म� रहता है। उ:ह;ने अपने डेटाबेस म� िन\न तािलकाओ ंका िनमा,ण �कया है ता�क 

सोसाइट1 के �लैट मािलक; स ेूा4 रखरखाव शुaक को ः टोर और ूबंिधत �कया जा सके। 



192 

 

        
 

िन\निलSखत जानकार1 ूदिश,त करने के िलए एक Eवेर1 बनाएँ  

  
     

9पछले अ?याय म�, ूकाशन ने िन\निलSखत जानकार1 ूदिश,त करने के िलए एक ूv बनाया था  

�लैट नंबर       मािलक         रसीद संHया           �दनांक         रािश  

(कृपया कॉलम शीष,क म� प�रवत,न पर ?यान द�) 

िनवास 9ववरण और रखरखाव देय तािलका के डेटा ू9व9T के िलए एक फॉम, बनाएं। ऊपर बनाई गई Eवेर1 के 

आधार पर एक �रपोट, भी बनाएं। 
 

2. उज़ैर एक इंजीिनय�रंग कॉलेज म� लड़क; के छाऽावास का ूबंधन करता है। अपने छाऽावास म� रहने वाले लोग; 

के �रकॉड, को ूबंिधत करने के िलए उ:ह;ने िन\निलSखत संबंिधत तािलकाओ ंके साथ एक डेटाबेस बनाया। 

    

    

ू'येक ौणेी के िलए एक9ऽत कुल मािसक �कराया ूदिश,त करते हुए एक Eवेर1 बनाएँ। 
 

िन\निलSखत सारणीबd format ूदिश,त करने के िलए एक Eवेर1 बनाएँ  
कमरा नं., छाऽ का नाम, ौणेी, मािसक �कराया, ू'येक ौणेी के िलए एकऽ �कए गए कुल मािसक �कराए को 

ूदिश,त �कया जाए। 

दोन; तािलकाओं के डेटा ू9व9T के िलए एक फ़ॉम, बनाएँ। 

दोन; Eवेर1ज़ स ेूा4 जानकार1 को ूेज�टेबल तर1के स ेूदिश,त करने वाली �रपोट, तैयार कर�।  

 












































































































